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Quick Start Guide

Quick summaries of how to ...

Import Photos from your Camera
Find a Folder
Search Folders
Preview Photos
Rotate a Photo
Improve a Photo
Remove Red Eye from a Photo
Remove Blemishes from a Photo
Crop a Photo
Annotate a Photo
Print Images
Email Images
Upload Images
Build a Collage or Scrapbooking Layout
Build a Slide Show
Burn a CD-ROM Slide Show
Create Slide Show Movies
Create a New Image File
Create a Panorama Image
Organize or Create Folders
Review and Remove Open Photos
For Scrapbooking:  Refer to Build a Collage or Scrapbooking Layout below and also the separate Creating Your First Scrapbooking Layout.  FxFoto Quick Layouts does not include photo organization or editing and does not include the Import, Improve, Remove RedEye, or Remove Blemishes commands discussed below.  

Please Note:  The FxFoto Standard Edition cannot save Collage layouts and Slide Show documents for presentations or future editing.  But Save Image As can save individual image files and even images annotated with frames, text and drawing.  Upgraded Editions enable layouts, slide shows and other features.
Import Photos from Your Camera
Connect and turn on your camera, setting it for transferring pictures.  Press the Import button.  Type a new Folder Name and press Next.  View thumbnails of all photos on the camera and choose those to be imported.  You can also rotate them and apply keywords as desired.  For most cameras, press Next again to choose the photos to be erased from camera memory.  Finally press Import and the pictures will appear in the chosen folder.  See Organizing Photos for more detailed step-by-step instructions.
Find a Folder
Left-pane folders can be ordered chronologically or alphabetically with the Folder button’s Alphabetical Folder Order toggle.  Also under Folder, Minimize All Folders just shows folder names, making them easier to find.  You can click a date on the left-hand timeline to show the folder with the closest beginning creation date.  The short blue marks show where your folders fall on the timeline and bright blue marks the selected folder.  Jump to Folder allows you to select a folder from a drop-down menu and quickly scroll the left pane there.  
Search Folders
Beyond scrolling through all of your left-pane folders, you can also use the Search button to look for photos taken on a desired date or with one or more desired keywords.  You can apply keywords of your choosing when you first Import photos or by right clicking on a folder photo and choosing Picture Information.  You can apply the same keywords to multiple photos during Import or by opening them all and using Apply All in the Info Picture Description dialog.  You can also find photos in a given folder or in all folders with the same name beginnings.  The Search dialog can create a special green Search Results folder with copies of All matching photos or can scroll you to the Next matching photo.
Preview Photos
Just click on a left-pane folder photo to preview it the right-pane collage area.  Or you can drag it into the right-pane area.  These also open the photo.  You can cycle through opened photos with the [image: image3.png]
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Next buttons, which are blue arrows on the right side of the toolbar.  Or you can see a slide show of all opened photos with the Viewer button.  To clear out opened preview photos, just press the [image: image5.png]


 Review and Remove Photos button and then choose Clear Whole Collage.
Rotate a Photo
When you take pictures with your camera held sideways, you can rotate them upright during the Import.
After photos are imported or scanned into the left-pane folders, rotate them by clicking or right clicking on the left-pane photo and choosing Rotate Picture Right or Rotate Picture Left from the Folder popup menu.
Once opened into the right collage window and selected, rotation pull tabs appear on the upper-left corner and can rotate the photo to any angle.  Hold down the Ctrl or Shift keys when rotating to lock into 90 degree angles (unless the image is part of a glue group).  However, the pull tabs only rotate the photo as it appears in the collage and do not normally rotate the original photo file.  You can use Rotate Picture Right or Rotate Picture Left from the Edit menu (or after right clicking in the right collage pane) to rotate by right angles and also save the rotation back to the left-pane folder.
Improve a Photo
Click on a left-pane photo to open it.  Press the Correct button and choose the Improve Image tab. Press the Auto Improve button to correct for dark photos and other lighting problems.  Or press Brightness Contrast Gamma or Color Balance Controls to manually tweak the lighting and color balance.  Note that the Gamma adjustment can be effective for bringing out very dark features.  The Use Circle Click Tool brings out very dark (or very light) objects in limited areas of the photo.  Press the button, adjust the Circle Width and Darker - Lighter sliders as desired, and click the circle over an unbalanced photo area to improve.  Once modified, FxFoto will automatically ask if you want the changes permanently saved back to the folder when you open another photo or exit.  Or use Save Image As or Save Mods from the Save toolbar buttton.  See Fixing and Annotating Photos for more detailed step-by-step instructions.
Remove Red Eye from a Photo
Click on a left-pane photo to open it.  Press the Correct button and choose the Remove Red Eye tab. Choose Standard or Extra Sensitivity.  Adjust the Correction Circle Width as needed and position the circle with your mouse over one eye in the right-pane photo.  The circle should be centered on the eye and should be big enough to completely surround the inner red portion.  Click the mouse to automatically remove the redness.  You can right click for Extra Sensitivity even when Standard Sensitivity is chosen.
Remove Blemishes from a Photo
Click on a left-pane photo to open it.  Press the Correct button and choose the Remove Blemish tab. Adjust the Correction Circle Width so that the circle is as small as possible without touching the blemish area to be removed.  Click the mouse over each blemish in the right-pane photo to automatically blend out the area inside the circle.

Crop a Photo
Click on a left-pane photo to open it.  Press the Crop button.  For normal cropping, make sure Pull or Adjust Rectangular Crop Area is pressed.  Position the mouse over one corner of the desired part of the right-pane photo.  Hold down the left mouse button and drag to the opposite corner of the desired rectangle.  Then adjust the crop rectangle if needed by moving the mouse over one of the sides and dragging that edge as desired.  To fade at the edge of the cropped photo, use the Feather slider.  Then press Crop Image to remove portions of the photo outside the selected rectangle.

Annotate a Photo
Press the Correct button and choose the Filter Effects tab to choose from a large library if cool photo effects such as painting simulations and fun distortions.  Most of the Filter Effects are trial-only in the Standard Edition.

Press the Frame button to choose from various custom framing effects.  Remember to press Apply to see the frame.
Press the Text button to add text above, below or over a photo.  Choose the desired text type and a popup Edit Text dialog allows you to type one or more lines of text that immediately appear over the photo below.  Various text formatting and effects can be applied to the entire text object.  Press OK to keep the text.  You can then click on the text object to select it and reposition, resize or rotate it with the standard drag handles. When you click and drag the photo, the associated text annotations automatically move with it.  Note that the right-pane view remains fixed when you re-edit text.  After creating some text and pressing OK, position your view as desired, click the text and use Edit the selected existing text object.
Press the Draw button to draw colored lines and areas over, around or under photos.  Choose the type of drawing pen, the drawing color(s) and the line width as desired.  Then drag with the left mouse button over the right-pane collage window to draw.  Or choose Gyro Smooth to automatically drag smoother lines.  Or chose Click Draw to click a series of line segment mid points before pressing the red X or the Esc key to end each line.

See Fixing and Annotating Photos for more detailed step-by-step instructions.

Print Images
Click on one or more left-pane photos to open or create a collage layout in the right pane.  Press the Save toolbar button and choose Print.  Thumbnails of all open photos appear.  Select one or more to be printed by clicking to toggle on their green tags and press Next.  Choose various Printer Settings, such as title and caption text to print at the top and bottom of each page, and press Next again.  Choose the format style of the images to be printed and see previews of the page or pages.  Choose Entire Collage to print the whole collage layout.  Press Finish and the final printer control dialog appears.

Email Images
Click on one or more left-pane photos to open or create a collage layout in the right pane.  Press the Save toolbar button and choose EMail.  Thumbnails of all open photos appear.  Select one or more to be e-mailed by clicking to toggle on their green tags and press Next.  Choose the style of the images to be e-mailed and see them previewed.  Choose Entire Collage to send the whole collage layout.  Choose how to deresolve the images.  Smaller images have less detail are faster to send.  Check Pass Images to MAPI and press OK and your default e-mail client is called with the chosen photo images already attached to a new message.  Just address and add any message text before sending.  Or check Copy Images to FxFotoUpload for webmail and switch to your browser to attach the image files in the special FxFotoUpload folder in Pictures or My Pictures.
Upload Images
Upload makes it easy to send photos to online printing and sharing sites.  Click on one or more left-pane photos to open or create a collage layout in the right pane.  Press the Save toolbar button and choose Upload.  Thumbnails of all open photos appear.  Select one or more to be uploaded by clicking to toggle on their green tags and press Next.  Choose the upload service from the available list.  FxFoto can automatically send files over the Internet to most listed services.  The Generic choice places your selected photos in a special folder to make it easier to manually upload them from other services.  After pressing Next again, choose the style of the images to be uploaded and see them previewed.  Choose Entire Collage to upload the whole collage layout.  Also choose whether to Deresolve for faster uploading (but too much deresolution can make prints fuzzy).   Press either Next or Finish and follow the instructions for the selected service.
Build a Collage or Scrapbooking Layout
Press the New toolbar button.  Then choose 8x8 or 12x12 for standard scrapbooking layout sizes.
Choose Quick to use a Quick Sketch Template to use a template where you can drop papers or photos into solid background areas.  Note that some FxFoto editions come with a selection of Quick Sketch Template ready to click open in the Templates left-pane folder.
Choose Grid to create your own custom drag-and-drop template with adjustable rows and columns of photos and text using the Custom Grid Template dialog.  Or choose Quick to base a layout on a Quick Sketch Template image.
Choose Theme for a library of collage templates that you can easily drop photos into.  When the theme layout appears, just click or otherwise open photos to fill in the blank frames.  Or drag photos to the desired target frame.  You can drag to replace a photo even after the frame has been filled.  Click on generic text to enter your own information for the collage.  Once all photo frames in the theme are filled, the next photo clicked starts a new collage with the same theme on the next slide.  See Using Themes for more information.

For templates, just drag and drop images into template areas.
For manual collages without a template, make sure the [image: image6.png]


Collage Add button is down and click on multiple left-pane photos or images to open them onto the same slide.  Or just drag them onto the same slide.  To reposition, resize or rotate, click on a right-pane photo and drag its edges.
Use the Crop button to cutout part of a picture for the collage.  Also see Annotate above for tips on how to add frame, text and drawing effects to your collage.  Use Add Accent to include bars and boxes in the collage.
You can right click on a collage photo and choose Show Image on Top or Show Image on Bottom to reorder the selected photo so that it slides over or under another.
FxFoto can move to any desired collage viewpoint, zooming and panning exactly as desired.  See Navigation Tools for various ways to move your right-pane viewpoint.
Press Save and choose Save Collage to save your work to an FxFoto file.  If you have the Standard Edition, an FxFoto Upgrade is required to build and save multi-photo collages.  
You can also use Save Image As to save an image of the collage as a new file in one of your folders or elsewhere on your computer. Image files are not editable collages but they save your layout for use by other software and for sending to people without FxFoto.  You cannot change the photo arrangement with just the saved image, since the collage image is static rather than an editable FxFoto Save Collage document.  Of course, you can save your layouts both ways.
See Creating Multi-Photo Collages and Layouts and also Creating Your First Scrapbooking Layout for more detailed step-by-step instructions.

Build a Slide Show
Slide shows and collages are really the same thing in FxFoto.  A slide show is just a collage with more than one page.  And an FxFoto collage is just a slide with more than one photograph.  Both are saved in FxFoto’s “Collage” files.
Press the New toolbar button and choose Slide Show.
To start a new slide, first make sure that the[image: image7.png]


 Collage Add button is up.  Then click on a left-pane photo to open as the first in a newly created slide.  Use the [image: image8.png]
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Next buttons to switch between slides.
Press the Slide button to review or change various Slide Settings such as the Slide Duration and Cross Fade time in seconds.  Be sure to press the Apply or Apply All button to use new settings you enter on any of the Slide tabs.
To review or rearrange the order of your slides, press the Slide Order button on the Slide Settings (or Review Slides from the View menu or Review Photos dialog) and click the images in the desired new order.
The Special Effects tab allows you to set various entrance and exit effects for the current photo’s slide instead of the normal cross fade.
The Tour Panning tab allows the slide show to move between viewpoints on the same slide rather than just to the next slide.  It can be used to pan the camera slowly over the slide during the show.
To add music to your show, use press the Collage button, the choose Collage Settings and the Background Music tab.  Or from Slide Settings, use the Slide Music or Audio button to start the music at the current slide.
Press the Viewer button to preview the show.  Be sure to use Save Collage (available from the Save button) to save your work to an FxFoto file.

Remember to save your work using Save Collage (available from the Save button).  Collages and slides shows can optionally be saved as special thumbnails in your left-pane folders.
See Creating Slide Shows for more detailed step-by-step instructions.  

Burn a CD-ROM Slide Show
Compose the desired Multi-Photo Collage and/or Slide Show as described above.  Then press the Save button and choose Burn Photos or Show CD-ROM.  Insert a blank recordable CDR and follow the directions.
The Upload command’s Generic Hold for Later or Burn to CD-ROM service also allows you to burn JPEG image files with more control over images names and layouts, but without the auto-start viewer presentation.
The Media Edition can also convert the slide show to a Movie file which can be recorded to Video CD or DVD discs with separate burn software, not included.  These Video CD and DVD discs are compatible with most modern home DVD players.

To burn the CD directly from FxFoto, you must be running FxFoto on a computer with Windows XP or Vista since earlier versions of Windows do not support this feature.  With older versions of Windows or if you choose Use Separate CD Burn Application in Options, FxFoto creates an FxFotoBurnCD directory in Documents or My Documents and you must switch to separate CD creator software to record the contents.  (Once burned, the CD-ROM can be played on any PC with Windows 98 or better.)  If you have the Standard Edition, an FxFoto Upgrade is required to burn CD-ROM slide shows.  

Create Slide Show Movies
FxFoto Media Edition can create MPEG movie files that can be recorded to DVD or CD with separate software, not included.  It can also create MPEG-4, MPEG-2, AVI or WMV movies for viewing from computers, web sites and portable devices.  First create or open the slide show collage.  When the show is finished, press the Save button, choose Transfer Show to Movie and press Begin to create the movie file on your disk.  When complete, you can start separate MPEG-compatible DVD or CD creator software to burn the MPEG file onto a disc compatible with most DVD players.  Note that the CD creator software that comes with most CDR drives must be upgraded to handle MPEG movies.  See Transfer Show to Movie for details.  You must upgrade to the Media Edition to create movies.
Create a New Image File
Build a corrected and/or annotated photo or multi-photo collage.  Press the Save button, choose Save Image As and choose the desired image style.  You can make a copy of the selected photo or can create an image which includes your annotations or even a multi-photo layout.  A preview appears of the image to be created.  Change the Saved Image Pixel Size if desired.  Smaller sizes result in fuzzier images but smaller files.  Press Next and choose the Target Location for the new image.
Create a Stitched Panorama of Photos

You must take horizontally overlapping photos of a scene and properly rotate the camera on its axis to minimize parallax errors.  Open the photos into the right pane.  Press the Add button, choose Stitch Photos and adjust the Photo Stitching Settings.  The default settings are best in most cases.  Press Begin and a new slide appears with the combined panorama image.  If you have the Standard Edition, an FxFoto Upgrade is required for Photo Stitching.  
Organize or Create Folders
To move left-pane photos between folders, simply drag them as desired.  If the target folder does not show, it may help to use Folder Minimize All Folders and then press the [+] to show only the desired folders.  Better yet, use Folder Move Picture(s) to move or copy the selected left-pane photo to any folder.
You can create a new folder when you Import photos.  The Folder Move Picture(s) can also create a new folder.  To re-arrange existing photos into a new folder, use Folder Move Picture(s) to move the selected left-pane photo and type a new target folder name.

The Folder Archive Folder to CD-ROM command writes the entire folder including the selected photo to CD and then allows you to remove the pictures or folder from your computer to save space.

To use any of these Folder commands, click on a left-pane folder photo to open a preview and then press the Folder toolbar button.  Or you can right-click on the photo to select it without opening and choose from the popup menu.
When FxFoto is first installed, it automatically finds photos on your computer.  If you later want to add other Windows folders to the left pane,  use the Import Scan command.    Or use each folder's Rescan Folder to show new or changes photos created from outside of FxFoto.
Review and Remove Open Photos
Press the [image: image10.png]


 Review and Remove Photos button to see all opened or previewed right-pane photos as thumbnails in a popup dialog.  Press Clear Whole Collage to remove them all.  Or select photos by clicking on them and press Remove Red Tagged Photos.  Jump to any photo’s slide by click on it and pressing Show Blue Outlined Photo.  Press Review Slides to switch to the Slide Order with whole-slide thumbnails where you can re-order the sequence.  Review Slides is also available from a small slides icon on the right side of the toolbar.
See also:

Introduction
Introduction

When installing from a CD-ROM, just click the Install FxFoto button on the dialog that automatically appears when you insert the CD or when you run Setup.exe on the CD.  Then follow the instructions.  Many FxFoto editions contain additional graphics files such as scrapbooking papers and elements.  These graphics are automatically installed with FxFoto.
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FxFoto imports, adjusts, crops, prints and manages digital photographs and images.

It also gives you many advanced capabilities in one easy package.  FxFoto edits photos with a variety of correction tools including a clone brush and advanced filter effects.  FxFoto creates collages or scrapbook pages of photographs and other images laid out as you wish.  Move and resize photographs and other images anywhere on the collage, which can be as large as you like.  You can even rotate images to any angle.  FxFoto provides easy ways to add text to your photographs with sophisticated effects.

You can create beautiful collage layouts for scrapbooking and other purposes.  You can also create animated presentations that anyone can see with the free FxFoto Viewer via e-mail, CD’s or web sites.  You can create both photographic tours that animate the viewer from image to image, and slide shows with great transition effects.  A variety of available collage types include scrolling 3D perspectives, similar to the Star Wars® introduction, and albums where the viewer sees small thumbnail images and can click to zoom down for more detail.  And FxFoto really does zoom.  Triscape software animates the viewing window so that you move fluidly over a landscape of photographs and other images, both horizontally and vertically.  FxFoto makes it easy to view your images from any position and any degree of detail.

You can add hyperlinks to photographs or even to web pages and also add popup text which the viewer sees when the mouse hovers over an image.  FxFoto allows you to annotate and draw over and around your images.  It even supports automatic dialog balloon text over your photos.

Plus FxFoto gives you great ways to manage your photographs.  It organizes all of your photographs into easy to browse folders always visible on the left side of the window.  A convenient timeline gives instant access to photos created near a given date.  FxFoto automatically imports photographs from digital cameras and can search for photos by date, folder name or keyword.  And it does more than just photographs, including support for JPEG, TIFF, PNG, BMP and Triscape VIB images as well as the ability to read and use animated GIF graphics and the ability to read WMF metafile images and clipart.  It also supports HTML and can import HTML-formatted text and graphics from word processors and other applications.

FxFoto Features

· Import Photos from your Digital Camera

· Manage All Photos with a Single Scrollable Thumbnail View
· Timeline Shows All Folders - Click for Photos by Date
· Touchup, Frame, Annotate and Link Digital Photographs

· Create Amazing Animated Photo Tours and  Slide Shows
· Easily Create Beautiful Scrapbooking Layouts and Collages 
Photo Management: Features include: Automatic import from digital cameras; Organize photos into scrollable folders chronologically or alphabetically; Click on folder photos to add into collage or slide show; Drag photos to other folders or onto a collage or slide show; Timeline shows filders by date; Click Timeline to jump to closest folder; Search for folders or photos by name, date or keywords; Image preview selector and folder thumbnails make it easy to find photos; Image preview selector and folder thumbnails make it easy to find photos; Easy navigation controls allow you to fly over photos and collages and zoom to any magnification; Archive photos to CD-ROM to save disk space; Supports DCF, WIA, TWAIN and EXIF standards for digital cameras.
Photo Touchup: Blemish remover; Red-Eye correction; Clone Brush; Undo Brush, Color Balance correction (automatic or manual);  Gamma correction; Spot gamma correction with feathering; Contrast correction;  Brightness correction;  HLS adjustment; Flood photo region with color or transparency; De-resolve photos; Sharpen and soften filters; Lighten, Darken, Black & White, Monochrome, Sepia, Faded, Faded Edge, Burnt Edge, Colored Edge, various Painting Effects, Tilt and Spherical distortions, Pixelize, Posterize, Solarize, Duotone and more.  Add realistic drop shadows to any image.
Collages and Layouts: Create collages and scrapbook layouts free form or with drag-and-drop templates; Crop images;  Cutout images;  Feather images; Text with anti-alias, shadow, cutout, outline and other effects; Text titles, captions, overlays and dialog balloons for your photos; Supports Unicode text fonts for languages other than English.  Realistic framing effects including 3D, Matt, Oval and an library of custom stretched Frame Images;  Rotate photos and text to any angle; Link photos to each other or to web browser pages; Create collages with text and photos pasted anywhere; Automatically join photos into stitched panoramas; Layout collages for fixed-size printing using guides and grid dots in inches or centimeters; Or allow collages to grow or shrink to fill the printed page; Automatically add drop shadows to photos and clipart; Supports transparent and partially transparent photos and clipart.  Select multiple images into glue groups to move, resize and rotate together; Draw over and around photos with various pens and effects including Gyro Draw(tm) smoothing.  Use drag & drop Quick Sketch Templates from many designers.  Create Grid Templates for showing lots of photos on the same page in with unlimited variations.
Slide Shows:  Create slide shows with annotated photos or collage layouts for each slide; Fade in and out, move in and out, bounce in, zoom in or pan camera, and various wipe transitions between slides;  Create 3D animated scrolls similar to Star Wars® introductions; Automatically create high-quality push buttons and mouse over effects; Add background music or narration to shows. 
Media Edition: Create VCD/SVCD/DVD, MPEG-4, MPEG-2, AVI and WMV compatible movie files from slides shows or photo tours; Create Flash or FxFoto Viewer slide shows or photo tours for viewing over the web; Create Flash MHT packages for emailing sending shows; Create PDF files from photos, layouts or slides shows.
Photo Publishing: E-Mail and save JPEG photos or entire collages of photos and effects; Print individual photos or multi-photo views; Save collage and slide show presentations to recordable CD-ROM; Upload photos or multi-photo views for online prints or sharing; Print photos and collage layouts as large as your Windows printer can handle.

Miscellaneous: Favorites allow you to categorize and save your photographs and collages. Add HTML-formatted pages and input forms; Import formatted text from other application via HTML copy and paste; Handles JPEG, TIFF, PNG, BMP and VIB images and also reads GIF and animated GIF images; Special compression for faster access over the Internet.

Easy to Use: Simple wizards and dialogs; Unlimited Undo and Redo.

Requires: Windows 98 or better and a Pentium PC or the equivalent with at least 256MB memory and a 800x600 display; Supports MMX for faster display and so at least a Pentium II or equivalent with 512MB of memory is recommended.

The FxFoto Viewer is included with FxFoto.  But it is also free to download and use, so your friends and acquaintances can easily get the full impact of your photo presentations. The free Viewer is only a small download at www.fxfoto.com that typically requires less than three minutes even on slow modem connections.
Quick Layouts

Quick Layouts has all scrapbooking layout features found in the FxFoto Creative Edition.  Quick Layouts provides project-oriented scrapbooking kits in the left pane.  The kits installed for one Quick Layouts project are available from other Quick Layouts projects and also in FxFoto Creative Edition if purchased separately.  Quick Layouts does not include photo organization and editing or effects and cannot create slide shows.  Quick Layouts does not Import photos from cameras and does not organize your photos in left pane folders  Quick Layouts also omits all Correct toolbar photo editing tabs and the Slide toolbar.  However, Quick Layouts does include the Draw toolbar and the Clear Pen tool there allows you to erase hidden portions of paper clips and other embellishments without the Color Brush transparency tool.
The Standard Edition

The FxFoto Standard Edition cannot save collage documents files.  Thus it cannot create or publish collage and slide show presentations.  However, it can save static image files in JPEG and other standard formats that can be re-opened with FxFoto and most other imaging software.  Text and other annotations can be saved as part of the image, but are not editable when the image file is re-opened.

Also, the Standard Edition cannot use the Collage Add Mode to place more than one photo on the same slide and so cannot create multi-photo collages for saving, printing or sending.  But you can create trial multi-photo collages temporarily on the screen.  Using multi-photo New Collage Themes is also trial-only.  The Standard Edition cannot Burn CD-ROM collage and slide show presentations and cannot transfer them to Movies.  Nor can it create s Web Slide Show presentations.  Also, Photo Stitching is not available.  Most Filter Effects (except White Balance and Sharpen with Unsharp Mask) are for trial only in the Standard Edition and the results cannot be saved, copied or printed.  Cropping with special Pattern shapes and Drawing with Stamp images are also trial-only.  The Undo, Color and Stamp brushes are also trial-only, as are Batch Operations.  Finally the Open Multiple Images command for adding many photos to a collage is disabled.
All other FxFoto features are enabled in the Standard Edition, including importing, organizing, fixing, annotating, e-mailing and printing your digital photographs.  Plus the Standard Edition has trial versions of most of the advanced commands which allow you to see the results on screen without saving or printing.
Tutorials
This FxFoto Help document includes a number of tutorials.  There are additional tutorials and demonstrations at the www.FxFoto.com web site. Some of the tutorials in this Help document are also online with additional illustrations.
See also:

Tutorial: Organizing Photos
Tutorial: Fixing and Anotating Photos
Tutorial: Creating Slide Shows
Tutorial: Creating Collages and Layouts
Tutorial: Creating Your First Scrapbooking Layout
Tutorial: Tips for Scrapbooking and Creative Collages
Tutorial: Creating Virtual Albums
Keyboard Commands
Navigation Tools
Upgrade FxFoto
Navigation Tools

Note: Collages and Slide Shows may limit the ways you can navigate in the Viewer, where the NavBar may not be accessible.  Many collages supply simple Next and Home buttons in the Viewer window, where Next steps through the slide show or tour (and you can also use the space bar or Tab key) and Home returns to the beginning of the presentation.

NavBar Controls
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 The NavBar joystick control is available with any of the navigation modes.  Hold down the left mouse button over any of the joystick direction arrows to move in any possible direction.  While holding down the button, your mouse becomes a joystick that allows you to change the speed and direction of horizontal movement.  The further you point from the center of the square, the faster you move and you can reposition the mouse to change direction as you move.

Hold down the left mouse button over the green [+] plus area on the joystick to zoom down to see the collage in greater detail.  The view will zoom toward the last point clicked on the collage.  Or use the blue [-] minus area to zoom up for a wider view of the collage with less detail.

Control your speed with the slider control just under the joystick.  The Options dialog allows you to adjust the three available speeds.  It also has an Easy One-Click option which modfies the joystick control so that you just click to move a fixed distance.
Under the joystick are additional buttons:
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Whole Collage is the same as Whole Collage View  in the View Menu  and zooms up to the altitude where all collage images appear in the window.
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Zoom to Photo also appears in the View Menu and zooms down or up to enlarge the selected or last added image in the right pane.
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Undo is the same as Undo in the Edit Menu to discard the most recent change.
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Redo is the same as Redo in the Edit Menu to undo the last undo. 
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Back moves back to the previous slide or camera view.
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Next moves to the next slide or camera view.
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Collage Add can be pressed to add multiple images to the current slide.  When down new images add to a collage of images.  When up, each new image becomes a new slide.
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Review / Remove / Stop can either stop the current camera movement or stop clicking the current draw line.  If neither is active, then it shows all open collage photos in the Review and Remove Images dialog and allows selected photos to be removed.  It can also clear the collage of all images.

Mouse Navigation Controls

FxFoto allows you to move the right-pane collage “camera” by clicking the mouse.  You drive the camera by clicking in the navigation joystick control at the top or by clicking in the window.  There are also scroll bars in the FxFoto editor for more normal Windows-style navigation, but Triscape’s animated camera navigation makes it easy to get the exact view you need without them.

There are three basic mouse navigation modes that you can switch from the Mouse mode.  First press the Mouse toolbar button.
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Grab Scroll is the normal default.  Just hold down the left mouse button over the collage to drag it horizontally in any direction.  Or hold down the right mouse button and move the mouse up and down to adjust the vertical zoom height.  Plus pointing just inside the edges of the FxFoto window shows a hand-pointer icon and clicking there moves you in that direction.
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Drive Zoom navigation mode is more powerful than Grab Scroll, because you can move up, down and horizontally while holding down the mouse button over the collage.  Drive movement stops when you release the button.  Hold down the left mouse button to zoom down toward the point under the cursor for more detail.  Or hold down the right mouse button to zoom up to a higher level with a wider view.  You can move the mouse while zooming to change the zoom focus and drive your zoom direction.  To move horizontally, point just inside one of the edges of the FxFoto window and see a hand-pointer.  Then hold down the left mouse button to drive in that direction.  But while driving horizontally, the mouse works like a joystick and you can move around your initial click point to change direction and speed.

[image: image23.png]


Grab Zoom mode works similarly to Grab Scroll, but it zooms up and down when you drag up and down with the left mouse button and drags horizontally with the right button.

All of the navigation modes also allow you to grab and scroll horizontally by holding down the middle mouse button or wheel.  This is a convenient way of quickly adjusting the view.  Also, rolling the middle wheel zooms the right-pane vertically up and down and scrolls the left-pane folders. However, some computers have the middle wheel button configured for special purposes, such as automatically moving the scroll bar, and so you may need to configure your Mouse in the Windows Control Panel to use the “middle button” in order for it to work as described in FxFoto.

See also:

Keyboard Commands
Managing Photographs and Images
Managing and Arranging Photographs and Images

Importing and Managing Images

The left side of FxFoto shows all of your photographs as small thumbnails images arranged into folders.  Just click on a thumbnail to open the photograph in the right-side collage area.  Or you can drag it to a selected point on the collage.  You can also drag left-pane thumbnails to another position in the same folder or to a different folder.  Or use the Move Pictures Folder command.  Adjust the relative sizes of the left and right panes by grabbing and moving the divider.
Right click on a thumbnail to see a menu of common choices.  Picture Information allows you to examine and set data about the photo, including keywords that can be used to find the photograph in a Search.  Right clicking also shows information about the photo on the extreme right side of the top dialog bar, visible when FxFoto is maximized.  The right-click menu also appears when you press the Folder button just above the left-pane thumbnails.  It includes commands to show a slide show of the current folder and to adjust the thumbnail size.  Clicking on the small folder title icon (which is a copy if the first folder photograph) shows a more limited menu of commands that apply to the folder.
Adding photographs to the left-side folders is easy.  Use the Import dialog bar button to copy photographs from your digital camera or from a supplied CD-ROM or other disk.  You can also Scan for new photographs or photograph folders on your local disk.
Most FxFoto commands use the photographs you have opened into the right-hand collage window.  This serves as a holding bin for photos you want to examine, modify, print, e-mail, etc.  At the same time, it can be photos and other images from the current collage that you are building or editing.  Many commands work with the last opened or last clicked right-side collage photo.  Others such as Print and EMail show a special Choose Images dialog where you can select one or more of the opened right-side photos by clicking on their thumbnail images.

Only the three blue-text buttons on the lower left side of the toolbar for Import , Search and Folder work directly with the left-side folder photographs.
Adding Images

Adding photographs to your right-pane collage is also easy.  First you can optionally one of the NewWH_NEW1 wizards to to start a new collage document.  There are a variety of available types.  Then just click on left-pane photographs or use one of the Add toolbar options.  Or use Open or Add Image from the File menu or the Favorites menu to choose the desired image files.
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 Collage Add button can be pressed to open multiple photos into the same slide, creating a collage layout.  You can also place multiple photos on the same slide by dragging them from the left pane even when Collage Add is not pressed.  However only the Deluxe, Creative and Media Editions support multi-photo slides.
Another way to add images is Paste in the Edit menu, which allows you to copy most images from other applications.  Or you can drag and drop files from the Windows Explorer into the FxFoto window.

When Collage Add is pressed, opened images are automatically positioned in row-wise album order or in a vertical column, depending on the row-wise collage setting.  Normally drag-and-dropped files are initially located next to the mouse cursor release point.   But you can have them automatically placed at the next standard location by checking Drag and Drop Next to Last Image in the Options dialog.

When the Collage Add button is up, then newly opened images start a new slide number. Normally, the new slide is added at the end of the slide show after all existing slide numbers.  But you can use Insert Slide Mode in the Edit menu to start a new slide in the middle of the presentation.  Also, the Slide Order button in Slide Settings allows you to re-order the slides.
Arranging Images

To rearrange the images in the right-pane window, just drag them around the collage.  When you click on an FxFoto image object, it becomes selected and shows a dotted outline and eight standard pull boxes.

For the normal mouse navigation modes (but not when drawing or using special photo editing tools), when you point just outside the image you can drag or resize the image with the left mouse button.  Pointing anywhere just outside the image except over the pull boxes allows you to drag the image location over the collage.  If you would like the image object to draw on top of another that is currently over it, you may use the Show Image on Top command in the right-click popup menu.

When you point to any of the eight pull boxes around the image, you can drag to change the image size on the collage.  Typically, the collage will de-resolve a smaller image to use fewer pixels for less detail (and a smaller file size) when you save it.  Normally, resizing keeps the image at its natural aspect ratio.  But you can hold down the Shift key while you drag the mouse to drag only in the indicated direction and stretch the image.  You can also hold down the Ctrl key while dragging to keep the image centered over the same point while resizing with the same aspect.  But if the image is part of a glue group, Shift allows you to move or resize it independently of the rest of the group.  Also holding down Ctrl while clicking in the middle of the image lets you add or remove it from a glue group,

There are also two small diagonal arrows next to the upper-left corner pull box.  These are for rotation.  Point to either arrow and drag with the left mouse button to rotate the image to a different angle.  You can optionally hold down the Shift or Ctrl key while rotating to snap the image to any of the standard 90-degree orientations (such as horizontal, sideways or upside down).  However, if it is part of a glue group, Shift allows you to rotate it independently of the group.
You can also rotate your left-pane folder photos in 90 degree increments before opening them into the collage using the Folder button or afterward from the Edit menu.  These commands change the source picture file.  But rotating with the diagonal pull-tab arrows only rotates the collage image and not its source file.
Note: You cannot drag the pull boxes in the Draw mode.  Choose one of the other Mouse Modes (normally one of the three navigation modes) before arranging images.

Arranging Glue Groups

Note that Glue Groups primarily apply to the Deluxe or Creative Editions and not the Standard Edition, which cannot create multi-photo collages.

FxFoto can glue together multiple images in a collage so that they move, resize and rotate together.  The easies way of gluing images is with the Glue Grouped Images button in Mouse toolbar.  Press the Glue Grouped Images button at the bottom so that it is down.  Then drag a box around the images to be glued in the right pane with the left mouse.  A new or different group is created with all images inside the pulled box.  Then when you click on one of the glued images to select it with pull tabs, all of the other images in the group will show dotted outline without the pull tabs.  When you adjust the selected image using its pull tabs, all of the other images glued to it will adjust similarly so that the group stays together.
Without the Glue Grouped Images tool in the Mouse toolbar, you can glue and unglue using the Ctrl key on your keyboard.  When you hold down the Ctrl key and click on an image, you glue it to the previously selected image.  Or if the clicked image was already selected with pull tabs, clicking on it again with the Ctrl key will unglue it.  These Ctrl key operations only apply with normal navigation and may not be available when using one of the special drawing or photo editing brushes.
You can adjust the position, size or rotation of a glued image without ungluing it with the Shift key.  Holding down the keyboard Shift while dragging temporarily unglues the selected image and moves it independently of the rest of the group.  This Shift key operation only applies with normal navigation and may not be available when use one of the special drawing or photo editing brushes.
The Ctrl and Shift keys also perform special functions for regular unglued images.  When you hold them down, rotation snaps to 90 degree angles.  Shift allows you to stretch an image horizontally or vertically when resizing.  Ctrl allows an image to be resized around its center point.  But when the selected image is part of a glue group, the Ctrl and Shift glue functions override.  You must unglue the image to use them for non-glue functions.
You can save a glued group of images as a Matte collage.  This is a special collage document that adds to the current collage when opened rather than replacing it.  In the left-pane folders, Mattes appear with a special [+] icon drawn over them.  Once you have saved grouped images, you can add another copy of them into the same collage or into a different collage latter by simply clicking open the matte group folder thumbnail.
See also:

Tutorial: Organizing Photos
Editing Photographs and Images
Editing Photographs and Images

Correct
FxFoto makes it easy to adjust and correct your photographs.  Just click on an image to select it and then press the Correct button on the top dialog bar.  A multi-purpose tabbed dialog appears at the top of FxFoto.  And remember that FxFoto has a many-step Undo and Redo feature that makes it easy to try things and then undo them if they are not what you want.

Most commonly, you will use the Improve tab to change the photographs overall brightness or contrast.  Just pressing the Auto Improve button is a good bet for most situations, but you can also play with three Brightness, Contrast, Gamma and Color correction sliders.  The Auto Settings button allows you to change a few advanced settings controlling Auto Improve.  The Brightness Contrast Gamma button shows slider controls to adjust the most common image balance settings.  The Color Balance Controls button shows other sliders allowing you to emphasize or de-emphasize chosen colors.

The Remove Red Eye tab allows you to click on redness in eyes normally caused by flash photography to re-color the red.  Center the correction circle on a single eye and click.
Remove Blemish is another great tool which can eliminate facial blemishes and other photographic features in an almost imperceptible way.  Click the circle around a single blemish without touching it.
Clone Brush allows you to copy one area of a bitmap to another area.  This is useful for copying background areas over unwanted features or to duplicate foreground features.
Color Brush allows you to click on background areas of a photograph to fill them with a selected color.  It can also fill areas transparency so that they disappear.  Plus it can set the overall transparency of the photograph, making it slightly clear so that collage photos under it show through.  It also provides a circular or square color brush with transparency tinting and edge feathering.
Stamp Brush provides tools to stamp images on a photo or collage.  There are also Smudge and Translucency brushes for photo editing.
The Filter Effects tab allows you to sharpen or soften the photograph.  It can also apply a number of special effects, possibly to just a roped area of the image.

In addition to the Correct button, other buttons at the top of the dialog bar help you compose collages.

Crop

The Crop button allows you to pull a rope selection box around the part of the photograph you want to save and cut out just that area.  You can choose oval or irregular rope outlines to save exactly the areas you want.  And you can choose to feather the cropped edges.  A feathered oval crop makes a nice presentation of many photographs.

Frame

The Frame button provides a number of exclusive FxFoto framing effects including various frames and border colors and also drop shadows and simulated matt effects.  The scrollable list on the left presents the most common frame types.  Remember to press the Apply or Apply All button to frame the last opened or last clicked image.  The Custom Settings button inside the frame control area presents a secondary dialog giving you full control over the various framing options.
Text

You can also add title and caption text above and below the photograph with the Text button.  FxFoto provides a number of Text Edit features for formatting and effects, including shadowed, raised, cutout or bordered text characters.  You can also create bulleted or numbered presentation outlines and can even add text positioned and rotated on top of your photograph or in cartoon-style dialog balloons.

Drawing

FxFoto provides a number of pens and other drawing tools that you can use to annotate your photographs or even to draw in the blank collage background areas around images.  It also allows you to stamp clipart images onto your collage or slide show.  Press the Draw dialog bar button for common drawing options and to switch to mouse drawing.  Try the Gyro Smooth Draw type which smoothes your mouse for professional-looking results without special drawing input devices.  The Other button gives a few other settings, including Grid Dots to force your drawn lines onto a horizontal and vertical grid of dots for neatly squared-off results.

When drawing, you can either draw on top of a photo image or you can draw on the collage background.  When you draw on top of an image, drawn lines and polygons become part of the image object and move or rotate with it.  If you begin drawing on the background, outside of all images, then the drawing stroke becomes part of the collage background, which always draws underneath all objects.  There are also special “Under” line, pen and polygon drawing tools which draw onto the background even if the drawing stroke begins over one of the images.  A collage can combine both image and background drawing elements.

Slides

This top-level button shows tabs allowing you to control how your collage appears in a slide show or photo tour.  The Slide Settings button allows you to control the duration of the current slide and also has a Slide Order button which allows you to easily click on images to choose their sequence in a slide show.
The Special Effects Slide tab allows you to choose from a wide variety of entrance and exit effects shown for the selected photograph during a collage slide show.  Normally the photos fade in and out.  But you can have them enter and exit from various sides with various special motions such as rotating or bouncing in.

The Tour Panning tab allows you to set up a tour of photos within the current slide’s collage.  Instead of switching to the next slide, the Next button can autopilot the camera view to the next photograph on your tour.

Finally Image Click Link allows you to set up a hyperlink for the selected image.  During a Viewer slide show or photo tour, clicking the image can start the browser to show a chosen web site or page.  It can also move to a different slide or view in the current collage or load a new collage presentation.

Info

This top dialog bar button lets you set non-graphic information about the last clicked or last opened image.  This information includes keywords you can Search.  It also includes a Popup Description that appears in the Viewer when the user hovers the mouse over the photograph.

Mouse

Pressing the Mouse button allows you to switch among the various mouse modes you can use when clicking and dragging the mouse cursor in your right-pane collage area.  When you first press it, the dialog switches to the last used mouse navigation mode.  You can also set other mouse modes such as rope outlining which are typically set automatically when certain other dialogs are visible.

See also:

Tutorial: Fixing and Annotating Photos
Saving Photographs and Images
Saving Photographs and Images

While saving collages and slide shows requires and upgraded FxFoto Edition, the Standard Edition can save individual photographs or image files.
To save an individual photograph or other image file, open in the right pane and click on the image to select.  Press the Save toolbar button and choose Save Image As (also available in the File menu).  Choose the Image Area to be saved.  You can select the Original Image to save the image file at the highest possible resolution without any overlaid text, drawing or frame effects.  The Composed Image saves any annotations and de-resolves if needed to fit the current image size on the collage.  It also saves with any image rotation.  You can also include the surrounding Title and Caption text in the saved image or just save the collage area outlined by the Rope Selection Area, which can include more than one image.  The Image Area dialog also allows you to include all of the collage inside the currently Visible View Area or the Entire Collage with all images.  You may change the default width and height of the saved image to de-resolve to any desired pixel size.  Keep in mind that very large image sizes can result in huge files.  Press Next and then choose the target file.  Choose Replace to overwrite the currently selected left-pane photo.  Or choose Add to add a the image as a new photo to one of your left-pane folders (or to a newly created folder).   If you choose to save the image file in one of your left-pane folder directories, the folder thumbnail is automatically created or updated.  Choose Target given path file name to save the image file elsewhere, possibly in a format other than JPEG.

When you use Save Image As and replace an existing photo, FxFoto automatically creates a backup copy of the original image file (unless a backup already exists).  Original image backups are also created automatically when changes are made to a Files Collage using separate non-encapsulated files.  The original backup file has the same folder and base name as the image file but with an .FXB file name extension.  When you first open the image in the future and press the using Undo (or when you are about to Undo the added image), you are asked whether the original image should be restored.  Or you can use Restore Original Image in the Edit menu.
The Print, EMail and Upload commands also allow you to choose the desired Image Area, either the selected image or a multi-image collage area.  Both allow you to choose from the opened right-pane images.  The Email wizard automatically de-resolves your photos to keep the e0mail small and fast to send.  It uses Windows MAPI to attach the chosen images to a new email message for you to address.  The Print wizard also shows a Settings dialog where you can add printed text at the top and/or bottom of the page  and choose from a variety of snapshot formats that print more than one photo per page.  The Upload wizard allows you to prepare your photos for uploading to online printing and sharing services and can also be used to send photos via web-mail and other non-MAPI e-mail applications.
Note that you can also use Copy and Cut from the Edit menu to send clicked images to other applications via the clipboard.  Switch applications and use the standard Paste command to insert your edited images into most word processors and many other types of documents.

See also:

Tutorial: Importing and Organizing Photos
Tutorial: Importing and Organizing Photos

Following are typical step-by-step instructions for importing photographs and organizing them in FxFoto’s left-pane folders.  In many cases, there are multiple ways of accomplishing a task, though we only present one way here.  And of course there are a number of advanced capabilities that are discussed only in other topics detailing individual dialogs and commands.  The features discussed in this tutorial are available in all versions of FxFoto, including the free Standard Edition.  An illustrated version of this tutorial can be found online at www.FxFoto.com under FxFoto Tour
( http://www.fxfoto.com/fxtour.htm ).
1.  After you have taken one or more pictures, connect your digital camera’s cable to your computer.  You must usually turn the camera on and may need to select its mode for transferring photos.  Follow your camera’s instructions and make sure that you have installed its driver software on your computer first.
2.  In FxFoto, press the Import toolbar button.

3.  Choose a Target Folder Name by typing a new name into the first dialog of the Import Pictures Wizard.
4.  Make sure the Camera or device button is pressed.  If needed, click on the camera in the associated list to highlight it.  If it does not appear, make sure you have your camera turned on and have selected its transfer mode.  Also make sure that you have installed your camera’s driver software on the computer.  If needed, press Cancel and then restart Import after correcting any problems.

5. Press the Next button and FxFoto reads available photo thumbnails from the camera.  Some (twain) and (wia) devices present a custom interface dialog for the device next.  If needed, you must set the device as desired and close this popup device dialog to continue with the Import wizard.
6.  Choose the camera photos to be imported.  Photos with green [ I ] tags in their upper-right corner will be imported.  Click on a photo to show it enlarged on the right.  Click as needed to turn off or on the green include tag.  Or press the Include All or Include None buttons to import or exclude all of the camera’s photos.  Once a photo has been selected and enlarged on the right, click Rotate Left or Rotate Right to orient it as desired.  You can also choose Keywords to be remembered for the photo by clicking on the desired words or phrases.  Press the New button to add a new phrase to list of available keywords.  Press Apply All to apply the current photo’s keywords to all imported photos.

7.  Press the Next button again and choose the photos to be erased from the camera.  Photos to be erased are marked with red [X] tags.  Some camera interfaces do not allow the computer to erase photos and this step may be skipped.
8.  Press Finish and the selected photos are copied from the camera to a new FxFoto left-pane folder.

9.  To review or modify the name, keywords and other information about a left-pane photo, right click on it and choose Picture Information from the drop-down menu.  (Right click means that you should point to the photo with the mouse and click the right mouse button.)  Or left click to both open it and select it and then press the Folder toolbar button and choose Picture Information.
10.  To rotate a photo after it is Imported, right click on it and choose either Rotate Picture Right or Rotate Picture Left from the drop-down menu.
11.  To move a left-pane photo to a different folder or to a different position in the same folder, you can drag and drop it with the left mouse button.  Hold down the button over the photo and drag it to another position as indicated by the red insertion line.  Then release the button to move the photo.

12.  To move a left-pane photo to a distant folder or to move more than one photo from the same folder, use the Move Picture(s) command.  This command can also make copies of photos, leaving the originals in the source folder.  Right click on one of the left-pane photos to be moved or copied and choose Move Picture(s) from the drop-down menu.  Choose one or more photos from the selected source folder with green [ I ] tags and press the Next button.  Then choose a Target Folder Name from the drop-down menu.  If desired, check Copy to make copies and leave the photos in the source folder.  Press Finish to move or copy the chosen photos.
13.  To start a new left-pane folder without using Import, use the same Move Picture(s) command but type a new Target Folder Name in the second dialog.
14. To remove a photo from a left-pane folder, right click on it and choose Delete Picture.  Normally FxFoto only removes the photo’s thumbnail and leaves the underlying photo file.  But you can check Also erase the photo file from your disk to completely remove the photograph (though a copy remains in the Windows Recycle Bin).
15.  If you add or modify photos in a folder from another application outside of FxFoto, you can rescan the folder to see the new or modified images.  Click on the small thumbnail image to the right of the FxFoto folder’s title and choose Rescan Folder from the drop-down menu.  Rescan Folder can also reorder folder photos chronologically or alphabetically by file name and this option appears after the tree dialog.
16.  To change a folder’s name, click on the small thumbnail image to the right of the FxFoto folder’s title and choose Rename Folder from the drop-down menu.  (Note that this does not change the underlying disk directory path name, only the name FxFoto displays for the folder.)
17. Once you have arranged a folder of photos as desired, you can back up the folder and all of its photos to CD-ROM.  Click on the small thumbnail image to the right of the FxFoto folder’s title and choose Archive Folder to CD-ROM from the drop-down menu.  This command can optionally remove the photo files from your disk to save space.  If you choose this option but leave the folder thumbnails in FxFoto, you must insert the CD-ROM in the future when you click a thumbnail to open it.

See also:

Tutorial: Fixing and Annotating Photos
Tutorial: Fixing and Annotating Photos

Following are typical step-by-step instructions for editing and annotating.  In many cases, there are multiple ways of accomplishing a task, though we only present one way here.  And of course there are a number of advanced capabilities that are discussed only in other topics detailing individual dialogs and commands.  The features discussed in this tutorial are available in all versions of FxFoto, including the free Standard Edition.  An illustrated version of this tutorial can be found online at www.FxFoto.com under FxFoto Tour ( http://www.fxfoto.com/fxtour.htm ).
1.  Click one of the left-pane folder photos to open it.  An enlarged version appears in FxFoto’s right-hand window.  You can also drag photos from the left to right pane.

2.  Press the [image: image25.png]


Back and [image: image26.png]


Next toolbar buttons to switch between photos when more than one has been opened into the right-pane window.

3.  Press the [image: image27.png]


 toolbar button to Review all open right-pane photos and optionally close one or all.
4.  To zoom down and enlarge a certain area of the open photo, click on a desired point and then press the green [+] portion of the toolbar’s joystick box.  The right-pane zooms down toward the last clicked point and stops when you release the left mouse button.  Use the blue [-] joystick region to zoom back up for a wider view.  The surrounding grey arrows area moves horizontally (as do the right window’s scroll bars).  

5.  To show the whole right-pane photo, press the [image: image28.png]


Whole Collage toolbar button.
6.  If desired, press the Correct toolbar button and then click the Improve Image tab.  Press the Auto Improve button to automatically improve the open photo’s brightness and contrast.

7.  If only certain areas of the open photo are too dark, press the Use Circle Click Tool button and then move the mouse cursor circle over the open right-pane photo.  Adjust the Circle Width slider as needed to resize the mouse cursor circle.  Then position the circle as desired and click the left mouse button to lighten only that area.

8.  If desired, click the Remove Red Eye toolbar tab.  A circle cursor appears when you move the mouse over the right-pane photo.  Adjust the Correction Circle Width as needed so that it is not too much larger than the eye.  Click the left button over each eye to remove the red.  If red is left, try right clicking over the eye for Extra Sensitivity.
9.  If desired, click the Remove Blemish toolbar tab.  Again, adjust the Correction Circle Width as needed so that the circle cursor surrounds but does not touch the blemished area.  Then click the left button over the blemish to remove.
10.  If desired, press the Crop toolbar button to eliminate portions of the opened right-pane photo.  Make sure Pull or Adjust RectangleCrop Area is pressed.  Then drag the mouse from the upper-left to lower-right corner of the desired new photo edges.  If the dotted crop box is not as desired, hold the mouse over one of the crop line edges and drag it in our out with the left button.  Then press the Crop Image button to reduce the photo to the chosen crop area.
11.  If desired, press the Frame toolbar button.  Click on a desired frame type from the scrolling list such as Colored 3D Frame + Matt.  Click on the associated colored buttons such as Frame Color to choose the desired color.  Then press Apply to add the frame around the right-pane photo.
12.  If desired, press the Text toolbar button.  Press Title text above or Caption text below and the Edit Text dialog appears.  Type the desired text on the left.   Press Font & Size to choose the font and size.  Press Text Color to change the text color.  Press the other formatting buttons as desired and/or choose a text Effect from the drop-down menu.  To center over or under the photo, make sure the Center button just above Cancel is pressed.  Finalize the text by pressing OK.
13.  To place text on top of the photo, press Overlay text on top or Dialog balloon text.  After filling in the Edit Text dialog and pressing OK, you can click on the text object in the right pane to select it with pull handles.  Then move the mouse over the edges of the text so that the four-way arrow cursor appears and drag the text into the desired position over the photo.
14.  To make changes to the text after you press OK, click on the text object in the right pane to select it with pull handles.  Then press Edit the selected existing text object to return to the Edit Text dialog.
15.  If desired, press the Draw toolbar button.  To draw a wide line on the photo, press o Pen and select the desired Line Width on the slider.  Press the Colors buttons to select the fill and outline color to be drawn.  Then drag the mouse over the photo with the left button down to draw.  To draw a straight line, choose Click Draw and then click the line end points and press the Esc key after the last line segment.  Or press the Other button and then check Snap to Grid Dots and press OK in the popup dialog.  Now choose the default Drag Draw and dragged lines are forced onto the guide dots, which makes it much easier to draw straight and regularly spaced lines.  You can also press Ctrl+G on the keyboard to toggle forced grid guide alignment off or on.
16.  To save the annotated right-pane photo, press the Save toolbar button and choose Save Image As.

17.  Choose the Title and Caption with Image button to save the annotated photo image along with any text above or below.  Then press Next.
18.  Choose Add as a new picture in a left-pane folder.  Then choose the target Folder from the drop-down menu.
19.  Press Finish and a copy of the annotated photo is added to the chosen folder.
The new annotated left-pane image is just like any other photograph.  It can be opened by clicking on it in the left-pane folder.  However, it is a static image and you cannot easily change the annotations, which are now part of the photo image file.  To save annotated photos so that the annotations can be changed or removed later, you need an upgraded FxFoto Edition and should use Save Collage Wizard as described in the slide show and collage tutorials.
20.  When you are happy with the photo, you can use a number of other commands to publish it in various ways, all available from the Save toolbar button.
Choose Print to print the opened right-pane photo.  Make sure the desired open photos are selected with green [ I ] tags and press the Next button and then Next again.  Choose the Title and Caption with Image button to print the annotated photo image along with any text above or below.  Press Finish to output to a local printer.
Choose EMail to send the right-pane photo by email.  Make sure the desired open photos are selected with green [ I ] tags and press Next.
Choose the Title and Caption with Image button to email the annotated photo image along with any text above or below.  Choose the desired size such as Medium image to reduce the photo for faster sending over the Internet.  Press OK to start your email application, creating a message with one or more photo file attachments.
Choose Upload to send the right-pane photos to available online services for prints or sharing.  Make sure the desired open photos are selected with green [ I ] tags and press Next.  Choose from the list of available services and press Next again.  Choose the Title and Caption with Image button to print the annotated photo image along with any text above or below.  Press either Next or Finish and follow the instructions.
See also:

Tutorial: Creating Slide Shows
Tutorial: Creating Slide Shows
Following are typical step-by-step instructions for creating and saving an FxFoto slide show.  In most cases, there are multiple ways of accomplishing a task, though we only present one way here.  And of course there are a number of advanced capabilities that are discussed only in other topics detailing individual dialogs and commands.  An illustrated version of this tutorial can be found online at www.FxFoto.com under FxFoto Tour
( http://www.fxfoto.com/fxtour.htm ).  Creating and saving slide shows is not supported by all FxFoto editions.

Note: FxFoto Slide Shows and Collages are very similar.  A multi-photo collage is just a single slide with more than one image and the term “Collage” is used in FxFoto for both single and multi-slide presentations.

1.  The New toolbar button provides a quick way to create common types of new collages, including non-web slide shows.  You can use New and press the Slide Show button.  Then just continue with step 4 below.
Otherwise, choose New Collage Wizard and continue with step 2.
2.  If you intend to publish the show for on-screen viewing in the FxFoto Viewer or send it over the Internet via email or from a web site, choose Web Slide Show Collage.  This de-resolves photos to so that they look fine on screen but would be fuzzy if printed.  Or choose Slide Show Collage and then uncheck Keep Maximum Photo Resolution in the next step.

To keep maximum photo resolution in the show for future printing or editing of encapsulated images, choose Slide Show Collage.  But this will result in a much larger collage file that is possibly slower in the FxFoto Viewer.
Note that the Files Collage type is normally used for browsing and editing individual photos rather than slide shows.  If you do not use New Collage first, Files Collage is the default.  However, Files Collage is normally limited to only 32 open photos and so cannot have more than 32 slides.  You can increase the Maximum Temp Browsed Pictures setting in Options, but it is best to start with the Slide Show Collage or Web Slide Show Collage types, which do not limit the number of open photos.
After choosing the collage type, press Next.
3.  For a more compact show intended only for the FxFoto Viewer rather than printing, make sure that Keep Maximum Photo Resolution is not checked.  If desired, change the Background Color by clicking the colored button and press Finish to start the new slide show.
4.  Open the first slide’s photo by clicking a thumbnail in one of your left-pane folders.  You can also open a photo into the right-pane window with Open or Add Image in the File menu.
To start a slide with just text, make sure the [image: image29.png]


 Collage Add Mode is off (not pressed).  Then press the Text toolbar button and choose New text object.
5.  If desired, use Correct and Crop on the toolbar to edit the photo for the show.
6.  If desired, press the Frame toolbar button.  Click on one of the available frame types, choose colors or the skin as needed and press Apply.
7.  If desired, press the Text toolbar button to label the photo.  To put text above the photo, press the Title Text button.  Or choose Caption Text for a label below the photo.  Choose the desired Font & Size, Text Color, Effect, and Align Left, Center or Align Right.  Type the desired text line or lines on the left and press OK.
8.  Press the Slide toolbar button and click the Slide Settings tab.  Normally Auto Show Next Slide should be checked.  If you uncheck it, then you must remember to provide a Next Navigation Button in the Viewer when you save the show.  The default Slide Duration is 5 seconds.  If desired, change the time and press Apply All to set the same duration for the whole show.  Or press Apply to change the duration for only the current slide.

If desired, press the he Slide Music or Audio button under the same Slide Settings tab to have a chosen music file or recorded narration play with the slide.

9.  By default, slide transitions Cross Fade for a half second. If desired, you can type a new value and press Apply All or Apply.

10.  If desired, click the Special Effects tab.  Here you can choose special entrance and/or exit effects to be used for transitions to and from the current slide or all slides.  The default is Cross Fade but you can pull down the Entrance Effect or Exit Effect menus to choose others.  The bottom choice in both menus is Random which can be used with Apply All to use random entrance or exit effects for all photos already opened into the show.  For a simple slide show, you can skip this step.
11.  If desired, the Tour Panning tab allows you to set up slow camera panning or a photo tour within a slide.

12.  If desired, the Image Click Link tab can make the photo or other object into a hyperlink which calls a selected web page or auto-pilots the collage view when clicked.

13.  If desired, you can open additional photos onto the same slide by dragging them from the left-pane to the right window.  But you cannot start a new slide by dragging and should just click the first photo for each new slide.
14.  Repeat from Step 4 for each additional slide.
You can use the [image: image30.png]
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Next toolbar buttons to switch between slides.  Or use the Slide Order dialog’s Jump to Slide button to switch to distant slides.  For the Slide Order dialog, just press the [image: image32.png]


 button on the right side of the toolbar near the current "Slide …" information.  You can also press the Slide Order button in the Slide Settings toolbar or choose Review Slides in the Edit menu.
Toggle Insert Slide Mode in the Edit menu to insert a new slide immediately after the current one rather than at the end of the show.

15.  To remove the current slide from the show, use the Delete Whole Slide command in the Edit menu.  You can also delete a slide by removing all of its images and text with the [image: image33.png]


 Review and Remove toolbar button or the Del key.
16.  Press the Save toolbar button and choose Save Collage Wizard to save the slide show.
17.  Choose the Target Name for the saved show.  Check Add as a new collage thumbnail in a left-pane folder.  Choose a folder from the pull-down menu and type a descriptive Collage File Name.  Then press Next.
18.  Confirm the Collage Type, which normally should be Slide Show Collage or Web Slide Show Collage for a slide show.  Then press Next again.

19. The Collage Properties dialog has a number of checkboxes for advanced features.  Most of these are already properly set for the chosen collage type.  Looping Slide Show is normally checked and you can uncheck it so that the FxFoto Viewer plays the show once rather than looping from the last back to the first slide forever.  You can check Allow Blowup View to force the FxFoto Viewer to make the photos as large as possible, even if this stretches them beyond their intended resolution.  You might sometimes want to check Disable Printing and Copying to stop the FxFoto Viewer from allowing your photographs to be printed or copied to the clipboard.  In the Media Edition, you can also press Set Expiration Date for a temporary show that cannot be viewed after a given date and which can only be edited by you.  But you can usually press Next again without making any changes to the Collage Properties.
20.  The Viewer Configuration dialog controls how the show appears in the FxFoto Viewer.  Again most settings can be left at their default values.  If you set up the show without Auto Show Next Slide, then you should set Navigation Buttons by checking Below or Above and also at least Next to show a Next button in the Viewer to switch slides.
21. Press the Set Background Music or Audio button in the Viewer Configuration dialog’s lower right corner to choose Background Music for the show.
22.  Press Finish to save the slide show.  This may take a number of seconds or even minutes for a very large show.  The slide show collage will appear as a named beige box in the specified folder and can be clicked to reopen it in the future.
Hint: Several advanced features make it easier to build and manipulate large slide shows.  The Save Collage Wizard's first dialog has checkboxes on the right.  Save Current Slide as Matte allows you to save a single slide as a separate FxFoto collage file.  The slide saved is the one currently shown in FxFoto's right pane.  The saved slide matte file could then be added to another slide show with the File menu's Add Collage to Slide Show command.  Or Save Selected Group as Matte can be checked to save a Glue Group as a separate collage file.  These special "matte" collage files can be added into a slide or layout by just clicking them open or dragging them into the right pane.  Normally collage files replace the current layout or slide show when opened but "matte" collages show a [+] symbol in their left-pane thumbnail and add into the current slide or layout.

Also:  The final Viewer Configuration dialog of the Save Collage Wizard includes Save Only Slide Numbers [  ] through [  ].  The blanks can be filled in with beginning and ending slide numbers to be saved, which causes FxFoto to save only a portion of the whole slide show to the given collage file.  This can allow you to break up a large show into smaller pieces.  Again, the File menu's Add Collage to Slide Show command can be used to add the partial slide show file to the end of another slide show.
23.  Press the Viewer toolbar button to test the show.  You can optionally use Viewer to test the show before it is complete or even saved, but there may be a pause while a temporary copy of the show is saved.  Note that when viewing a long looping slide show, you may need to turn off your screen saver using Windows Start / Control Panel / Display.
24.  When you are happy with the show, you can use a number of other commands to publish it in various ways, which are available from the Save toolbar button.
For example, choose EMail to send the show by email to someone who has the free FxFoto Viewer.  Press Include All to select all photos and then press Next.  Then choose Entire Collage and also check Send Collage Viewer file rather than image to send the complete slide show.
Other ways to publish the show include Burn CD-ROM, Transfer to Movie and Make Web Slide Show.  Use the Save toolbar button to access these commands.
See also:

Tutorial: Creating Multi-Photo Collages
Tutorial: Creating Multi-Photo Collages and Layouts
Following are typical step-by-step instructions for creating and saving an FxFoto collage or scrapbook page.  In most cases, there are multiple ways of accomplishing a task, though we only present one way here.  And of course there are a number of advanced capabilities that are discussed only in other topics detailing individual dialogs and commands.  An illustrated version of this tutorial can be found online at www.FxFoto.com under FxFoto Tour
 ( http://www.fxfoto.com/fxtour.htm ).  Creating and saving collages is not supported by all FxFoto editions.

Note: FxFoto Slide Shows and Collages are very similar.  A multi-photo collage is just a single slide with more than one image and the term “Collage” is used in FxFoto for both single and multi-slide presentations.

1.  The New toolbar button provides a quick way to create common types of new collages, including 8x8 or 12x12 inch scrapbooking page collages.  You can use New and press either the 8x8 or the 12x12 button.  You will be asked to select a Background for the layout.  Then just continue with step 6 below.

Otherwise, choose New Collage Wizard and continue with step 2.
2.  To keep maximum photo resolution in the collage for future printing or editing of encapsulated images, choose Multi-Photo Collage or Image Tour Multi-Photo Collage.  But these will result in a much larger collage file that is possibly slower in the FxFoto Viewer.  For scrapbooking, Multi-Photo Collage is often the best choice.
If you intend to publish the collage only as a show for on-screen viewing in the FxFoto Viewer, or send it over the Internet via email or from a web site, choose Compact Multi-Photo Collage.  This de-resolves photos to so that they look fine on screen but would be fuzzy if printed.  Or choose Multi-Photo Collage or Image Tour Multi-Photo Collage and then uncheck Keep Maximum Photo Resolution in the next step.
Also choose Compact Multi-Photo Collage for printable collages that will contain a large number of photographs, especially for computers without much available memory.  The Compact types turn off Keep Maximum Photo Resolution so that, once saved, your collage requires significantly less computer memory resources.  Yet when you choose Printer Page Layout on the second New Collage dialog, the Compact Multi-Photo Collage retains more than enough resolution for most printers.
The Multi-Photo Collage or Compact Multi-Photo Collage types initially show the whole collage in the FxFoto Viewer and allow you to click on any photo to zoom down for a close up view.  These types normally size opened photos so that they fit in a 4x4 matrix (four rows of four photos).  

Choose Image Tour Multi-Photo Collage to have the FxFoto Viewer start with a closeup with the first photo and then animate between photos with the Viewer’s Next button. Here photos are normally sized for a 2x2 matrix.

You can optionally choose 3D Scroll Collage or 2D Scroll Collage for a special slowly scrolling presentation in the FxFoto Viewer.  For these types, photos are normally added in a single vertical column and the Viewer slowly scrolls down them from top to bottom.  In addition, the 3D Scroll Collage type shows the photos in three-dimensional perspective, fading off into the distance.

Or press Theme and then Browse to choose for a library of prearranged collage theme templates which you can fill in with your own photos and text.  See Using Themes for more information.

You can also choose Grid and then press Next for the Custom Grid Template dialog where you can preview and adjust a template of photos and/or text arranged in rows and columns.  Or you can choose Quick and press Next to use a Quick Sketch Template.
After choosing the collage type, press Next.  If you have chosen a Theme then there are no additional settings and you just press Finish and continue with step 6.  You can change any or all theme defaults latter using Collage Settings.
3. You can optionally choose Page Guide Limits, which show a green line around the intended collage page to help you position the photos within.  You can choose Printer Page Layout if you intend to print the collage rather than send it over the web for viewing.  Press the Select Printer button to have the page guides set for a specified printer, paper size and orientation.
Choose 8x8 Inch Collage or 12x12 Inch Collage for common scrapbook page sizes where you can also see your on-screen layout in inches or cm.  The Custom Page Size allows you to set arbitrary inch or cm dimensions.  Unlike Printer Page Layout, these choices show collage rather than page boundaries and normally center the collage on the printer page.
Or just choose No Limits and make the collage as large as you like.  FxFoto automatically resizes the collage photos as needed to fit the entire collage inside the viewer window or printer page.
For a more compact show intended only for the FxFoto Viewer rather than printing, make sure that Keep Maximum Photo Resolution is not checked.

4.  If you chose Printer Page Layout page guides, check Inches or Centimeters to have the collage print at a fixed size to fit the selected printer page.  You can also check Grid Scale to make FxFoto show a grid of regularly spaced dots along with left and top scale numbers that help you to layout photos, text and other objects in inches or centimeters.  For example, if you choose 2 Dots / inch and the printer paper is 11 inches, then there will be 22 grid guide dots across the collage within the page guides, spaced at half inch intervals.  Spacing photos three dots apart would place 1.5 inches between them.  The Grid Scale dots can optionally also be used to automatically align images onto the grid using the Snap to Grid Dots toggle command.  Use the Show Grid Scale toggle to temporarily view your collage without the dots and scale.  You can adjust the grid spacing later using the Collage Settings Page Guides dialog.
You can optionally change the Maximum Size for Added Images to make collage photos larger or smaller when first opened.  But you can also resize each photo with pull tabs as described later.
5.  If desired, change the Background Color by clicking the colored button and press Finish to start the new collage.
You can optionally check Image and choose a Background Image to specify a scrapbook background paper image to be used.  Use Window Fill mode to have a single large paper image fill the page or press Fill Pattern to repeat a small paper pattern throughout the collage page.  FxFoto includes a number of simple Fill Pattern repeating patterns.  Larger Window Fill paper images can be downloaded or purchased from various scrapbooking vendors and should be JPEG, PNG or GIF image files.  Or you can use a photograph as the Background Image for Window Fill mode.
6.  Open the first collage photo by clicking a thumbnail in one of your left-pane folders.  You can also open photos by dragging them into position in the right window.  Or you can open a photo with Open or Add Image in the File menu.

When you add a photo by the collage by opening it without dragging, FxFoto normally moves the right-pane over and down for a close up of the new photo.  You can uncheck Auto-Pilot to Added Images in Options to have FxFoto leave the right-pane fixed as long as the new photo is completely visible.  When Auto-Pilot to Added Images is unchecked and the new photo is out of view, FxFoto automatically zooms out so you see the entire collage, similar to the Whole Collage View command.
7.  If desired, use Correct and Crop on the toolbar to edit the photo for the collage.

8.  For some toolbar commands such as Crop, the mouse is configured to pull or adjust the rope and cannot move or resize the selected photo.  If needed, press the Mouse toolbar button and press the Grab and scroll with mouse button (or any of the other two Mouse Navigation mode buttons).
9.  If desired, press the Frame toolbar button.  Click on one of the available frame types, choose colors or the skin as needed and press Apply.
10.  If desired, press the Text toolbar button to label the selected photo.  To put text above the photo, press the Title Text button.  Or choose Caption Text for a label below the photo.  Choose the desired Font & Size, Text Color, Effect, and Align Left, Center or Align Right.  For collages you will print, press Anti-Alias to print the text with extra resolution to avoid fuzziness.  Type the desired text line or lines on the left and press OK.
11.  If desired, press the Draw toolbar button to draw colored lines and areas over, under or around the collage photos.  The File Stamp and Clip Stamp buttons allow you to apply clip art images to the collage simply by choosing a width and clicking where you want them.  You can even check Shadow (which appears in the upper right corner of the draw dialog when one of the stamp buttons is pressed) to automatically apply a drop shadow to stamped images.
12.  If desired, press the Slide toolbar button and choose the Tour Panning tab to change the numeric order of tour stops.  Type a new number and press Apply to re-sequence the currently selected photo.  You cannot choose an existing previous stop number, but you can use a fraction such as 2.5 to insert a photo between two stop numbers.

13.  If desired, the Slide Image Click Link tab can make the photo or other object into a hyperlink which calls a selected web page or auto-pilots the collage view when clicked.

14.  You can open additional photos onto the collage dragging them from the left-pane to the right window.

Or click on left-pane thumbnails to add photos in order when the [image: image34.png]


Collage Add toolbar button is down. Initially the photos open into a row-wise grid.  You can toggle off Add Row-wise to Collage in the Edit menu to have newly opened photos initially placed below each other.

Repeat from Step 7 for each additional photo added into the collage.

15.  To move or resize a collage photo, click on it to select it with pull tabs.  Move the cursor over any of the tabs and drag with the left mouse button down to resize the photo.  Move over the small diagonal arrows in the upper-left corner and drag to rotate the photo.  Move the cursor anywhere else around the edge of the photo and drag to move the photo.  If needed, press the Mouse toolbar button and press the any of the Mouse Navigation modes to switch from pulling a rope so that you can move or resize photos.
The Toolbar View menu command allows you to hide the top toolbar so that your right pane collage window is bigger for laying out large collages.  Use it again (or press F5) to toggle it back on and use toolbar commands.  You can also drag the divider bar between the left folders pane and right collage window with the left mouse button to allow more layout area horizontally.

If desired, you can toggle Snap to Grid Dots in the View menu to turn on alignment guides that photos automatically snap to.
16.  Photos can overlap in the collage.  To force a photo to show above another, right click on it in the right-pane collage window and choose Show Image on Top.  Or choose Show Image on Bottom to move it below other photos.
17.  Press the [image: image35.png]


Whole Collage toolbar button to zoom out and see the all photos in the right window.  Other Navigation controls toward the right side of the toolbar allow you to adjust the collage window viewpoint exactly as desired.  For example, to zoom down for a closer view of a particular photo or point, click there and then hold down the mouse in the toolbar’s green [+] area of the square joystick control.  Or press the blue [-] area to zoom back out for a wider view.  Click anywhere in the surrounding grey joystick area (or near the edges of the right collage window) to move the viewpoint horizontally.

18.  Press the Add toolbar button and choose Add Accent Image to choose from a library of bars and boxes that can separate and emphasize your collage photos.  These accent objects can be specially resized without distortion.  They are initially small and should usually be enlarged by resizing in the appropriate dimension.  For example, a horizontal bar should be enlarged by positioning the mouse over the left or right side pull-tab and dragging.  A box accent can be enlarged both vertically and horizontally without distortion.
19.  If desired, press the [image: image36.png]


 Review and Remove toolbar button to remove previously opened photos from the collage.
20.  Press the Save toolbar button and choose Save Collage Wizard to save the collage.

21.  Choose the Target Name for the saved show.  Check Add as a new collage thumbnail in a left-pane folder.  Choose a folder from the pull-down menu and type a descriptive Collage File Name.  Then press Next.
22.  Confirm the Collage Type, which normally should be one of the Multi-Photo Collage, Image Tour, or Scroll types.  Then press Next again.

23. The Collage Properties dialog has a number of checkboxes for advanced features.  Most of these are already properly set for the chosen collage type and you can usually press Next again without making any changes.

24.  The Viewer Configuration dialog controls how the show appears in the FxFoto Viewer.  Again most settings can be left at their default values.  Normally, the Navigation Buttons are set with Back, Home and Next buttons placed Below in the FxFoto Viewer window.  You can check Done for a button which allows easy exit from the Viewer.  You can also check NavBar for a button which toggles a special FxFoto Viewer navigation toolbar that can let the user manually move to any desired viewpoint.  Note that Navigation Buttons are not normally used for scrolling type collages.
25.  Press Finish to save the collage.  This may take a number of seconds or even minutes for a very large collage.  The collage will appear as a named beige box in the specified folder and can be clicked to reopen it in the future.
26.  Press the Viewer toolbar button to test the collage.  You can optionally use Viewer to test the collage before it is complete or even saved, but there may be a pause while a temporary copy of the collage is saved.
27.  When you are happy with the collage, you can use a number of other commands to publish it in various ways, which are available from the Save toolbar button.
For example, choose Print to print the collage on a single page.  Press Next twice to reach the third Print Wizard Format dialog.  Then choose Entire Collage and press Finish to begin printing.  If there is more than one slide, then each can have a separate multi-photo collage and multiple pages can be printed if all photos are selected in the first Print Wizard Choose Images dialog.
Or choose EMail to send the show by email to someone who has the free FxFoto Viewer.  Press Include All to select all photos and then press Next.  Then choose Entire Collage and also check Send Collage Viewer file rather than image to send the complete collage show.  Or uncheck Send Collage Viewer file to send a static image of the entire collage, which can be viewed even without the FxFoto Viewer.
Other ways to publish the collage include Burn CD-ROM and Web Slide Showf  These are often used with slide shows, but can also present collages with zoom down and photo tour animation.  The Transfer to Movie command can be used with Image Tour Multi-Photo type collages that move from photo to photo around the collage.  Movies can also be made with the Multi-Photo Collage type, where the screen shows the whole collage first and then zooms down and tours close-ups of the photos.  Use the Save toolbar button to access these commands.
See also:

Tutorial: Creating Your First Scrapbooking Layout
Tutorial: Creating Your First Scrapbooking Layout

By Susan White, Triscape’s resident digital scrapbooking enthusiast

Following are typical step-by-step instructions for creating and saving a simple scrapbooking page.  An illustrated version of this tutorial can be found online at www.FxFoto.com under FxFoto Tutorials.  Creating and saving collages requires an upgraded FxFoto Edition and this tutorial uses scrapbooking kit graphics included only with the FxFoto Creative Edition.
For your first layout, let's start with something simple.  As you work with FxFoto Creative more, you will no doubt want to try new filters, crop patterns and effects.  But for now let's start with the basics. You can find lots of tutorials on the website at www.FxFoto.com including other step by step layout tutorials

We will be making the layout on below using the Colours of Heritage by Katie Mann which is included in FxFoto Creative Editions.
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The image above is a low resolution version of the scrapbook page and is not nearly as crisp as the real thing.  But it is good enough to help you follow along as this tutorial explains how to create the collage with FxFoto.

Note: If you have not installed the FxFoto Creative Edition or Media Edition CD-ROM, the Colours of Heritage kit will not appear.  Only the Creative Editions on CD-ROM contain extra scrapbooking kits and graphics.  However, most of the features described in this tutorial also apply to the Deluxe Edition and you may still find it helpful.
Getting Started

When you start up FxFoto, you will see a dialog box labeled Startup Shortcuts and Tips.  You can reach it from the File menu.  Click on 8x8 Scrapbooking Page Collage.  From the FxFoto_Clips folder, choose the Colours of Heritage folder and click Open.  Now click the red paper with the sun and click Open.  

The red background will appear in the main working pane of FxFoto.  The green outline around it marks the edge of the 8x8 size. When you print your page, only the material inside the green box will be printed.

Digital Kits

Normally the 8x8 shortcut will jump FxFoto’s left-pane view to show the folder used for the chosen background image.  If not, scroll down the left hand folders until you find a folder with a green background labeled Colours of Heritage.  In the folder, you will find a complete digital scrapbooking kit with papers and embellishments. In the folder, you will see the first box is beige and labeled Collage - Katie Mann.  This is the kit preview. The next three boxes are pre-made pages in which you may just drop your photos.  

Adding Photos and Elements

To add elements and photos to your layout, simply click on the photo or element and it will appear in the right pane.  If you would like more than one of the same item, click on it as many times as you want.  You can click on any element in any of the other kits to add it to your layout too.

If you would like to add elements from kits not included in FxFoto, you can certainly do so.  You can find directions for that and much more in the tutorial Making a Layout with FxFoto on www.FxFoto.com.
Moving and Resizing Photos and Elements

In the layout you may move an element or photo by dragging it. To make an element or photo smaller or bigger, move your mouse over one of the corners until the standard pull box appears.  An arrow pointing in opposite directions will appear.  Once you see it, just hold down on the left button and pull with your mouse.

To rotate an element or photo, simply point to the rotation circle at the top left corner and turn the element.  You can rotate it to any position you want.  You can also rotate by precisely 90 degrees.  To do it, select the object and then right click on it.  A drop down box will appear.  Look for Rotate Collage Image Left and Rotate Collage Image Right and click on one.  The image will turn 90 degrees exactly! 

Deleting a Photo or Element

To get rid of an element or photo, you can delete it from your collage by selecting it.  Then right click on it and a drop down menu will appear. Click on Delete Image from Collage.  A dialog box will appear to make sure you want to delete it.  Click on Yes.

Shadows

Adding shadows gives your layout a 3D appearance and makes the elements look much more real.  In FxFoto, it is best to add the shadows when you open the elements.  Why?  Because then you won't forget!  What happens to the shadow when you rotate an object?  FxFoto automatically changes the shadow so it is in the right place.

To add a shadow, click on the Info button in the upper toolbar.  Now click on the tab that reads Image Placement and Shadow. Click on the Add Shadow and type the number for shadow height you would like.  Then click Apply.  If you don't like it, click on Undo.

How much shadow is up to you!  The larger the shadow, the thicker the object will appear. Very large shadows will make the object appear to be floating above the paper.  Here are some suggestions for shadow height for various elements: 

Photo: 30 to 50

Mat:  30 to 50

Small elements like paperclips, buttons, brads: 1-5

Medium elements like tags, titles: 10-20

It is easy to add a the same shadow to other embellishments by just right clicking on it and checking Add Shadow to Image from the popup menu.  Click Add Shadow to Image in the right-click menu again to uncheck and turn off the shadow.  

Cropping and Editing Photos

You can either edit and crop photos before adding them, or edit and crop your photos while doing the layout.  Here I am going to assume that you have done the basic photo editing already - that you got rid of red eye, used auto improve etc. FxFoto contains a Quick Start Guide which you can find in the Help menu located on the top toolbar. There are lots of tutorials for photo editing. And you will find a Help button in each command box that will take you directly to the area of the Help file that explains that command or box. Lastly, you can find lots of tutorials on Susan's blog at http://susanwhite.typepad.com

You can also crop papers to make your own journaling blocks and mats. And you can choose from a huge variety of shapes - blocks and ovals with edges, shapes like stars and butterflies, alphabet stencils and torn edges.  You can make all sorts of interesting elements by cropping paper and applying filter effects like distress and colored edges. Cropping patterns are found in the Cutters Library. Click on Crop then click on Pull or Adjust Pattern and then click on the down arrow to produce a drop menu. From the drop menu, choose Cutters Library.

You can move or adjust any crop.  Move your cursor along the dotted crop edge.  You will see it change to a double pointed arrow or to the move symbol.  Once it does, left click and hold and use your mouse to move it.

A feathered edge is a nice touch for a photo.  Find the Feather at Outline Edges slider. In our layout, we used feathered edge of 28 on the photo. Be sure to set the feathering before you crop.

Matting Your Photos

To make the photo mats, we have cropped the photo of the girl and the mat papers with the same shape. Then we adjusted the mat by pulling on it to enlarge it a bit beyond the photo.

You can do this by using the Keep Crop Rope check box.  First, select the photo and then click on Crop. Click on the Keep Crop Rope box.  Now click on Pull or Adjust Pattern and choose Some Rounding from the drop down menu. Now click and pull your shape and then adjust it if need be. Move feather slider to 28 and click on Crop Image. Now your photo is cropped.

Now click on Mouse and the crop rope will stay when you click on the collage. Move your cursor so the move symbol appears, then holding down the left mouse button, move the photo from under the blue crop rope.  Click on the black marble-patterned paper and the plain red paper in Colours of Heritage folder to open them in the main pane. Move the black paper under the crop rope and click on the Crop tab. Move the Feather slider to 0 and click on Crop Image. Now do the same thing with the red paper.

To make the journaling block we cropped it out of the gray paper.  We used the same crop shape - Some Rounding - but when we clicked and pulled it, we made it more horizontal.  

Let's add shadows to each of these cropped papers to give them some depth.  First click on the photo or paper to select it.  Then use the sequence Info > Image Placement and Shadow > Add Shadow > 25 > Apply.

Arranging your Layout

Now let's put everything together and arrange our layout. To do this we need to get the various items to go either over or under each other.  In FxFoto, layering is done by right clicking an object and choosing to Show Image on Top/Bottom.

The black marble mat is going to be on the bottom, so click on it and move it into the lower left corner of the red background. Enlarge the black marble mat so that it is about half the width of your page. Now, click on the next mat which is the red cropped one to select it.  Right click it and from the menu, choose, Show Image on Top.  Now it will slide over the black one.  Enlarge it a bit so the black shows around the edges. Lastly, click on the photo to select it.  Right click and choose Show Image on Top.  Now, slide the photo on top of the red mat and adjust the size so you can see some red around it.  Lastly, move the journaling block to the right lower corner and adjust the size.  

Adding the Title

The Colours of Heritage kit comes with an alphabet which we will use to create a title.  Scroll down to the Colours of Heritage folder until you get to the alphabet.  Now click on the letters J, O and Y.  They will open in your main pane.

Let's give them some depth to the letters by adding a shadow.  First click on the letter to select it.  Then use the sequence Info > Image Placement and Shadow > Add Shadow > 15 > Apply.  Do this for each of the letters.  

Move them by dragging them to the upper gray strip and arrange them.  You can make them bigger or smaller if you wish or you can rotate them. 

Text

What would a layout be without text for journaling and word art? You can use any font you have installed on your computer in FxFoto.

Click on the Text toolbar button on top.  Click on New Text Object and the Edit Text box will open. Here you can choose a Font & Size and select a Text Color.  Select a font and type your journaling.  Here we used a font called Jokerman in black with a font size of 72, which may not be installed on your computer.  So you can use some other similar font. Then click on OK and then drag the box over the journaling block. 

There are loads of interesting things you can do with text.  You can arrange in arcs, waves or circles.  And you can jitter the letters to make them a bit crooked.  You can find controls for both of these tools in Background and Arc.  You can also apply some fun effects to your text like beveling, shadows and a raised 3D effect.  To see the list of effects, click on the down arrow next to Effect.

Embellishments

The final touch, and perhaps the most fun, is adding embellishments.  Often called elements in digital scrapbooking, these are ribbons, brads, staples, paperclips etc.  On this page we have added a paperclip to the photo and two ribbons to the journaling block.  

Paperclip:  to make the clip really look like it is holding paper, you need to take away some of the clip.  In paper scraping this part of the metal clip would be behind the paper.  But in digital scraping, we just make that part of the clip transparent.  

First, click on the paper clip to select it.  Now add a shadow of 5 by using Info > Image Placement and Shadow > Add Shadow > 5 > Apply.  Now position it where you would like on the photo.  We rotated it slightly and left a bit of the upper clip above the black mat. Make sure it is top.

Now click on the clip to select it and then zoom way in.   Now click on the Draw toolbar button and then the Clear Pen drawing tool.  The Clear Pen brush will make whatever it touches transparent. Move your cursor to the section of paper clip that would be behind the paper - that is the middle section.  Hold down the left button and move the brush along the middle of the paperclip.  Zoom out and your paperclip will look just like it is holding paper!

Ribbons and Staples

Click on a ribbon twice to get two ribbons.  Now apply a shadow of 10 (Info > Image Placement and Shadow > Add Shadow > 10 > Apply).  Drag the ribbons to the journaling block and resize to get the right proportions. Right click on the ribbon and from the drop menu choose Show Image on Top.  You can rotate them a bit to make them look more natural. 

In paper scrapbooking, these types of ribbons are usually attached using a staple and so we will add a digital staple.  Click on the brass staple in the kit.  Now drag it to the ribbon.  Right click on the staple and from the drop menu choose Show Image on Top. Now adjust the staple size to match the ribbon size.

Saving your Layout

In FxFoto you may save your layout as either a collage or as a static image (JPEG file) or both.  If you save it as a collage, then you can go back and edit it later but you cannot edit a static image.  

To save as a collage, click on the Save toolbar button.  Then click on button down which reads Save Collage Wizard.  Click Add as New College, choose the folder where you would like to put it and type a title. Then click Next. Make sure the Multi-photo Collage button is depressed and then click Finish.

To save as an image, click on the Collage button. Then click on Save Image As (the fourth button from the bottom).  In the dialog box, click on Entire Collage and then click Next. Click on Add as a New Picture and then click Finish.

Learning More

You can learn more about FxFoto Creative Edition by visiting our website at www.FxFoto.com.  There you will find many layouts done with FxFoto in our gallery at www.fxfoto.com/fxgallery.htm  Our resident digital scrapbooker, Susan White, has a blog with lots of examples and tutorials at susanwhite.typepad.com and there are tutorials for many of the layouts in her Layout How To photo album.

See also:

Tutorial: Creating Multi-Photo Collages and Layouts
Tutorial: Tips for Scrapbooking and Creative Collages
Tutorial: Tips for Scrapbooking and Creative Collages

Following are tips and hints for common collage and scrapbook tasks.  Creating and saving collages requires an upgraded FxFoto Edition.
Using the Creative CD Scrapbooking Kits
Installing Your Own Scrapbooking Kits
Creating and Organizing Scrapbook Pages
Setting Backgrounds or Papers
Layers in FxFoto
Using Glue Groups and Mattes
Special Crop Effects
Adding Clipart and Embellishments
Rotating Clipart and Embellishments
Adding Text to Collages
Installing New Fonts
Using the Creative CD Scrapbook Kits

When ordered on CD-ROM, the FxFoto Creative and Media Editions come with a library of scrapbook kits, clipart embellishments and background papers.  The CD-ROM setup asks whether you want the scrapbooking clipart at the end.  This Scrapbooking Clipart requires about 400 MB of extra space on your computer’s disk.  The installed clipart appears in special folders at the bottom of FxFoto’s left-pane.  Scroll down to the end of the left pane folders and look for the special ones with light green backgrounds.  The clipart is installed into an FxFoto_Clips subfolder off of Pictures or My Pictures.
The CD-ROM includes a number of designer scrapbooking kits for special themes or seasons, each in a separate folder.  Kits contain background paper images followed by a selection of embellishment clipart.  Just click on or drag the desired left-pane image to open it into your right pane collage.  But first, you should usually use the the Startup Shortcuts or New Collage commands to start the scrapbooking collages.

Each of the kits has a credits collage image first which gives the designer’s name and contact information.  Following this, there are several example layouts.  These are FxFoto Theme Templates.  Just click on one to open. Then click or drag your own photos to replace the blue and grey Photo images.  You can rearrange the collage as desired and possibly add your own Text.  These example templates are also available in New Collage when you press the Theme Browse button.  They have names beginning with XT (for extra template) and so appear at the end of the alphabetical selector.
One of the special left pane folders is named Scrapbooking Papers and consists entirely of a wide selection of background paper images.  The other included kits also have their own background papers, normally before their embellishments. 

Installing Your Own Kits

You can also use other scrapbooking kits purchased and/or downloaded online.  FxFoto supports JPEG, GIF and PNG transparency and so is compatible with standard scrapbooking kit graphics.  Kits with brushes usually include a standard PNG image for the brush and you can use PNG brushes with FxFoto's Stamp tool.
When you have the Creative Edition, the Install Zipped Kit command makes it easy to unzip a downloaded kit into a left-pane folder.  Click the Tools menu and choose Install Zipped Kit.
Also in the Creative or Media Editions, the Install Unzipped Kit command can scan a kit that was previously unzipped or copied into a Windows folder.  Click the Tools menu and choose Install Unzipped Kit.  Unlike the Import Scan command, Install Unzipped Kit automatically includes PNG elements and sorts the kit images alphabetically by their file names.

To manually install kits, you can unzip the files into a Windows folder.  To unzip you will need one of the popular zip utilities such as WinZip (tm).  Or you can use Windows XP or Vista Explorer to unzip by right clicking on a standard zip file and choose Extract.  Then use FxFoto’s Install Unzipped Kit as described above or the Import Scan command to make a left-pane folder for the kit.  If using Import, choose Scan at the bottom of the Import dialog and press the Browse button.  Navigate to the Windows folder where you have unzipped or installed the kit graphics and press OK.  Make sure you also check Scan gif/png/bmp/vib files so that the PNG embellishments that come with most scrapbooking kits are included in the left-pane folder.
Scrapbooking kits often include multiple embellishments in a single image.  Open the image into FxFoto’s right pane and then use Crop to include only the desired portion.

Creating and Organizing Scrapbook Pages

A scrapbook page is really just a multi-photo collage.  See the Creating Multi-Photo Collages tutorial for general instructions on making collages in FxFoto.

For digital scrapbooking, the paper is just a background image or solid color that appears behind the collage.  Embellishments are usually clipart images that are placed over the collage.  And of course, photos and text are added to the scrapbook page using FxFoto’s normal collage features.

Since an FxFoto slide show is just a series of collages, it is possible to create multiple scrapbook pages in the same FxFoto Collage Document.  However, it is usually better to create each scrapbook page as a separate FxFoto Collage Document for two reasons. Creating a large scrapbook with many large multi-photo collage slides results in a very large document which can be slow to use and can require excessive computer resources.  Also, the collage background image or color (the scrapbook paper) is shared for all slides in the document.
So you will normally create a new collage for each scrapbook page.  You may want to organize an entire scrapbook as a number of separate collage page layouts in its own left-pane folder.  You can drag and drop the collage thumbnails to order the pages as desired and then use the Folder Print command to print some or all of the book.  But be careful not to print too many pages at once, at least at first.  Some printers cannot handle printing too many high resolution image pages all at once.
So you will normally create a new collage for each scrapbook page.  You should usually start the page with the New toolbar button and choose either the 8x8 or 12x12 Scrapbooking Page button.  To drag and drop papers into designer sketch templates with solid colored areas, choose Quick Sketch Template or click open one from the Templates left-pane folder, if available.  To create a simple layout with lots of photos, try the Grid Custom Template.

For advanced options, you can use the New Collage Wizard.  For large scrapbook pages, you should normally choose the Multi-Photo Collage type and then choose 8x8 or 12x12 or Printer Page Layout on the second wizard dialog.  For very large collages that will include many high megapixel photographs, you should uncheck Keep Maximum Photo Resolution in the second wizard dialog to avoid using excessive computer resources.  But for normal scrap book pages with only a handful of photographs, Keep Maximum Photo Resolution provides more flexibility if you decide to crop or blow up a photo after saving the collage.

Use the Save Collage Wizard wizard to save the collage document for later.  You may want to create a new left-pane folder in FxFoto for all colleges associated with a planned scrapbook.  Just choose Add a New Collage Thumbnail to a Left-Pane Folder in the first Save Collage Wizard dialog and type a new Folder name if desired to start a new folder.  Once you have saved a collage to a folder, just click on its left pane collage name to re-open that scrapbook page for further editing or printing.  FxFoto only keeps one collage document open at a time, so opening a new collage will close whatever is currently in the right-pane.
We recommend that you save your collage every few minutes to avoid loosing your creation in the event of a power failure or computer malfunction.  You can use the Save Collage Wizard wizard to save.  But after you have saved it once, you can also just use the Save Collage command in the File menu or press Ctrl+S on the keyboard.

In addition to saving the collage as an FxFoto document (which allows you to edit and rearrange it latter), you may also want to save it as a JPEG image file for use in other applications.  For example, to send scrapbook page images to an online or mail order print service, JPEG image files are needed because services may not support FxFoto collage document files.  FxFoto’s Upload command with Generic Hold for Later or Record to CD-ROM can be used to accumulate collage images in a special FxFotoUpload directory for sending to print services.  It can even handle recording the JPEG images to CD-ROM for you.
To create a permanent JPEG image file of your collage, use the Save Image As command.  You can add the image to the same left-pane folder containing the collage documents for the scrapbook.  But remember that when you open the image file for a scrapbook page, you cannot easily rearrange or add to the collage.  Only the saved collage document has an editable arrangement of separate photo and text images.

Setting Collage Backgrounds or Papers
For Quick Sketch Templates, you just drag and drop paper images and photos onto the various solid colored areas.  You must drag and drop onto the chosen area and cannot just click open images.  Sketch templates with crisp boundaries and very different colors or shades of gray work best.  Use the Drag & Drop Settings to control the way images drop into Quick Sketch Templates.
When building layouts from scratch, you may want to use a paper image or other background graphic behind all of the photos, text and embellishments in your collage.  There are multiple ways to do this in FxFoto.

First, you can choose the Background Image when creating the New Collage.  Press the Window Fill button to have a single image or color fill the entire collage background.  Or press Fill Pattern to repeat a small image row-wise throughout the collage background.  Then just click the Image checkbox on the second dialog of the wizard and press the Background Image button.  For Fill Pattern, there is a small library of Patterns off FxFoto’s installation directory (normally C:\Program Files\FxFoto\Patterns).  For Window Fill, navigate the file selector to the directory where the desired paper background image file exists.  Some versions of FxFoto may come with a library of available papers in the FxFoto_Clips area off of Pictures or My Pictures.  Note that for Window Fill, choosing to use Page Guides automatically sizes the background image to the page guide boundaries.  The Collage Settings Background dialog has these same settings so you can set or change the background for an existing collage.

Or you can use the Startup Shortcuts and choose the 8x8 or 12x12 Scrapbooking Page button.  You can then select the background paper or image using a popup file selector or us a solid color for the background or just leave the background blank.  Choose a scrapbooking kit folder from the drop-down menu and FxFoto will show that folder in the file selector and also jump to that folder in the left pane.  From the left-pane folder it is easy to open embellishments and paper images.

You can use an image from a left-pane folder as the background.  Just right click on the folder image and choose Use as Background.  Or you can even open a background paper image into the collage as a regular foreground image and optionally crop or edit as desired.  Then just right click on the open right-pane image and choose Collage Background from the menu to make the image the new background.  However you must have created the right kind of collage (to set a whole-page background image these ways.  If you used the 8x8 or 12x12 shortcuts or created the new collage with Page Guides and Window Fill enabled, then the collage can accept a single non-repeating background image.
The other method is just to add your desired background paper image as the first photograph of the collage.  This allows you to use a different background image for each slide page in a single collage document.  You can just click on it if in a left-pane folder or use the Open or Add Image command for a file selector.  Once open, you can use the various Correct and Crop functions to improve or alter it as desired.  Then use its grab handles in the right pane to expand and cover the whole collage area (normally the page guides box).  Subsequently added photos, accents and text will appear over this first background image.
Tip:  Try using one of your own photos as the background using FxFoto Wash Out effect.  Open a photo into the right pane and use the Filter Effects Wash Out (about half way down the list) with a fairly high Intensity slider setting (maybe 50 or more).  Click on the photo and drag it larger to cover the page.  Then open other related photos over the washed out background.  You might also want try one of the paint or monochrome Filter Effects (like Oil Painting or Sepia) first before using Wash Out for a more abstract background.
Layers in FxFoto

Unlike some other applications, FxFoto does not use the concept of layers.  But it does show photos, accents and text in a set bottom-to-top order.  So you can easily create layered collages with photos and text over each other and overlapping as desired.  FxFoto can even handle image transparency and partial transparency so that bottom images show through those on top. So in effect, each photo, text or other image object is its own layer.  We think this system makes FxFoto easier to use, while still giving you a lot of creative control.

To rearrange the bottom-to-top order, just right click on a collage image to select it and choose Show Image on Top or Show Image on Bottom from the popup menu.  For example if you have two objects over the background, click on the lower one and use Show Image on Top first then click on the top-most one and use Show Image on Top again.  If the lower image totally covers the top-most one, you may need to move it out of the way temporarily to click on the intended top image.
Hint: You can use the Non-Selectable Image command in the right-click menu to freeze the top image so that you can select and reposition images underneath without moving it.  Right click the top image again and repeat Non-Selectable Image to unfreeze it.
To make a photo or image partially transparent, click the Correct toolbar button and then choose the Color Brush tab.  Choose Set Transparency for Whole Picture and move the Transparency slider somewhere in the middle as desired.  Then click on the desired photo or accent image to make it semi-transparent.

To make parts of a photo or image transparent, choose Flood Color in the same Color Brush dialog and move the Transparency slider all of the way to the right so it reads 255.  Also set the Color Match Tolerance as needed.  Then click in an area of the photo to flood transparency so that lower images show through in that area.  This can be a convenient way to touch up irregularly shaped crop edges.
Note that only PNG (Portable Network Graphics) embellishments and clipart images can be semi-transparent.  GIF images can have full transparency in parts of the image, but GIF does not handle partial transparency.  Normal JPEG photos and images cannot handle transparency at all.
Using Glue Groups and Mattes
FxFoto allows you to glue two or more images together so that you can move, resize and rotate them as a group.  Glue groups can include photos, embellishments, paper images and text.  They let you compose a complete matted photo, journaling area or tag and then easily position it exactly where you want.  Under the Mouse toolbar, you can press the Glue Grouped Images button.  Then just drag a box around a group of images to glue them together.  Remember to turn off the Glue Grouped Images button to avoid adding additional images to the group.  Once glued, when you move, resize or rotate one, the rest will follow.  You can hold down the Shift key while moving, resizing or rotating a glued image to temporarily unglue it so that you can adjust it relative to the group.  With other mouse navigation modes and from most other toolbar dialogs, you can use the Ctrl key to glue or unglue images.  Just hold down Ctrl and click on an image to glue it to the previously selected image or to unglue if it was already selected.

Once you have created a glue group, the Save Collage Wizard lets you save it.  Just check Save Selected Group as Matte and add the matte file to one of your left-pane folders.  FxFoto will save just the selected group and not the whole collage to a special folder thumbnail with a [+] on it to show that it is a Matte Group rather than a whole collage.  Just click on the Matte thumbnail to add a copy of the group to any layout.  You can even save a glue group and then immediately open a second copy into the same layout.
Special Cropping Effects

The Crop toolbar dialog has a library of special Patterns that you can use for interesting effects.
At the top of the list, Cutters Library shows a selection of many special patterns like Bell, Butterfly, Candle, Car, Tree and dozens more.  There are also Symbol patterns for all twenty-six letters, numerals 0-9 and some special characters.  Plus special versions of the standard patterns further down the list.  To use the Cutters Library, you must have the Creative or Media Edition.  Click the Patterns menu to see the drop down list and then click on the top Cutters Library choice and a popup file selector shows the library selections.  Click on a name to select and press Open to pull crop rope with the selected pattern (or to convert the existing rope outline to the new pattern).
The next four choices in the drop-down Patterns menu allow you to crop with rounded edges.  The next three allow zigzag and wave rectangular edges.  All of the bottom choices are variations on oval crop shapes.
To crop with a colored or burnt black border, check Keep crop rope in the Crop dialog.  Then after you crop a photo, switch to the Correct Filter Effects dialog and scroll down to the Burnt Edge (Rope) or Colored Edge (Rope) effects.  Adjust the Edge Feathering slider for the desired width of the colored border before pressing Apply.
You can also use the same Filter Effects to add multiple nested borders.  While keeping the same rope, first apply a wide border and a corresponding border color.  Then reduce the Edge Feathering slider for a narrower border applied nearer the edge and change to a different color.  Or use the Faded Edge (Rope) effect, which will further fade in bands when you re-apply it over a previously faded border.

To apply a cropped matte behind a photo, you can use special matte paper images available with many downloadable scrapbooking kits.  Open the paper image and crop as desired.  Or make blank colored paper with the Insert Blank Sheet command.  You can optionally add a colored or burnt border as described above.  Then open the photo (or right click it and choose Show Image on Top) and slide over the cropped matt.
Sometimes you only need to crop a single side of a photo or image.  This is easily done with a crop rope that only intersects the photo on one side.  The other three sides should be well outside the image box, beyond any feathering.  You may need to zoom your right-pane collage view out so that there is extra room around the photo to draw the crop rope.  To zoom out, press the blue [-] area in the square joystick on the right side of the top toolbar.  Use the slow - fast slider under the joystick to adjust the zoom speed if needed.

You may want to use Crop, especially with special Patterns, to create your own collage embellishments.  You can open an appropriate photo or special paper images (such as those included with the Creative Editions) and crop embellishment shapes.  Or you can use the Insert Blank Sheet command (available in the File menu or from the Add toolbar button) to insert a square colored blank that you can crop or use with rope effects to create monochrome embellishments.

You can also create patterned accents using Crop and a photo, matte or paper image.  Just crop a single side of the photo or image at a time.  Pull or adjust the crop rope so that only one side intersects the photo while the other three sides are well outside the image box.  By cropping one side at a time with the Sawtooth Box or Waves Box Patterns, you can create zigzag or wavy accent strips.

The Crop Torn Edge Box Pattern can be used for a wide variety of torn paper effects.  The torn pattern is random and changes as you pull or adjust the crop rectangle.  Just continue to adjust until the pattern pleases you.  You can apply the torn effect to a separate matte or paper image or to a photo.  And you can apply the torn effect to only one side of the image as described above.  Checking Crop on top and switching to Correct Filter Effects for the Burnt Edge (Box) or Colored Edge (Box) effects allows you to apply a special border to the torn edge.  Note that there are two other versions of torn paper in the top Cutters Library under Less_TornEdgeBox and Max_TornEdgeBox which vary the amount of randomness.  Use Less_TornEdgeBox for a straighter torn edge effect.
Sometimes you may want to spotlight one area of a photo rather than cropping it.  Use the Filter Effects Wash Out (Rope) selection near the end of the list and check Outside.  Draw an oval or other desired rope outside the area of interest, leaving room for Edge Feathering.  Try checking Percent and setting the Edge Feathering slider to about 25 for a gradual transition.  You can Apply the wash out more than once, keeping the same rope, to further lighten the area outside the roped spotlight.  The Defocus (Rope), Monochrome (Rope), Sepia (Rope), Black & White (Rope), Oil Painting (Rope) or Embossed (Rope) can also be used with Outside checked for other sorts of spotlight effects.
You can also use the Color Brush with Circle or Square brushes with the Transparency slider at a non-zero value to tint spotlighted areas or features with a mouse controlled brush.  Try using a black or white New Color to lighten or darken with the brush.
The same Circle or Square Color Brush can be used with the Transparency slider all the way to the right at 255 to make areas of the photo clear so that underlying collage elements show though.  With Transparency 255, the Color Brush becomes a clear brush that can be used to effectively crop unwanted areas inside the photo or embellishment.  You can even use non-zero Feathering to gradually transition from the image into the transparent areas.  For example, you might use this to brush clearness into the middle of a paper clip embellishment, hiding the part of the clip that would disappear underneath the paper it is attached to in real life.
Adding Clipart and Embellishments

Scrapbook embellishments and clipart are basically the same thing.  Both are images that usually use transparency so that the object does not appear as a rectangle.  Sometimes scrapbook embellishments use partial transparency so that the photo or paper below the object shows through at least a little.  WMF and GIF images handle only full transparency and so are common for most clipart.  More sophisticated scrapbook embellishments using partial transparency are usually PNG files.

When embellishments or clipart are downloaded over the Internet, you must remember the Windows directory where you save them so you can find them from FxFoto.  Sometimes many images are packaged in a single Zip file and you must unzip them before they can be used.  Windows XP or Vista can extract zip files.  For older versions of Windows, you may need to get and install a zip utility such as WinZip (tm).  Under XP, start Windows Explorer if needed by right clicking on the Start button and choosing Explore.  Navigate to the zip file folder and right click on the zip file.  Choose Extract All and remember the folder you choose for the extracted files.

There are a variety of ways to add images to your collage.  Most of them can handle any sort of image file type supported by FxFoto, including WMF, PNG and GIF.

You can just use the Open or Add Image command in FxFoto’s File menu.  This command adds collage image in row-wise or vertical order, depending on the collage type.  Make sure the [image: image38.png]


Collage Add mode button is pressed or the image will start a new slide rather than be added to the current collage.

If the image appears in one of your left pane folders (because FxFoto has Scanned the Windows directory where it is found), then you can just click on the left-pane thumbnail (to open it in the next collage position as long as the Collage Add mode button is pressed) or drag to the desired collage location.

The Add Accent Image command adds an image to the center of the current right-pane collage window.  Use the toolbar the navigation tools to position view first.  By default, Add Accent Image shows available bars and boxes that come with FxFoto.  These special accents can be stretched without distortion.  For example, bars can be lengthened without becoming any wider by dragging on the appropriate side pull tab.  These special images are in Accents off of FxFoto’s installation directory (normally C:\Program Files\FxFoto\Accents).  But Add Accent Image can also be used to open any other image file supported by FxFoto by changing the Files of type and navigating the selector to the appropriate Windows directory.
The File Stamp and Clip Stamp buttons in the Stamp Brush and Draw toolbar dialogs can be used to place an image exactly where you want with exactly the size you want.  The Stamp Width slider controls the size and controls the size of the mouse cursor box that appears when you point over the right pane collage.  Press Clip Stamp to use clipart that you have copied onto the Windows clipboard from some other application such as Microsoft Office (tm).  Press File Stamp to choose an embellishment or clipart image using a popup file selector.  Then just click the left mouse button over the desired collage location.  The Stamp Brush dialog also allows a Stutter Brush where you can apply multiple copies of the image in a single mouse stroke with optional jitter.
You can easily use one of your embellishments or photos from a left-pane folder as the stamp.  Just right click on the folder thumbnail and choose Use as Stamp Image from the popup menu.  The selected image is set for use with both the File Stamp or the Clip Stamp tools.
However you add it, the image can be easily moved or resized by clicking on it and dragging its pull tabs.  If needed, press the Mouse toolbar button to switch away from dialogs that use the mouse for special purposes so that you can use the grab handles for moving or resizing images.
Rotating Clipart and Embellishments

FxFoto uses special pull tabs to rotate images.  The diagonal arrows in the upper-left corner rotate collage images.  If you hold down the Ctrl key while dragging the rotation tab, FxFoto will snap the image into vertical or horizontal 90 degree angles.  You can also rotate images to a specified degree angle using the Info Image Placement toolbar dialog.  FxFoto supports rotation of partially transparent embellishments and other images.  To rotate an image a full ninety degrees in either direction, use the right click popup menu’s Rotate commands. 
Adding Text to Collages

Text on scrapbook pages is often separate from photos, so you may want to use the New Text Object button in Text to create new pieces of text.  Once you have typed your text and chosen the font and other settings in the Edit Text dialog, you must press the OK button to close that dialog before you can click on the text object and move it into the desired position.  You can re-edit the text with the Edit the Selected Text Object button.

To associate text with a photo or other image, click the image to select it and then use one of the other Text buttons (but not New Text Object and Edit the Selected Exiting Text Object).  The text becomes a sub-object and moves when you move the main image.  To move the text relative to the main image, click on it and drag it.  There is only one title above and one caption below, but you can add more than one Overlay Text on Top of the image.
When you use text over a photograph or background paper, you may want to make it Clear so that the background shows through the text box except where the text actually exists.  Just press the Background button in the Edit Text dialog and then check Clear.  To help clear text blend into the surrounding image, especially when you use text effects or anti-aliasing, you should set the collage background color to approximate the image under text.  Set the Background Color to match the background image in the New Collage Settings (or set the Blanking or Collage color in the Collage Settings Background).
Sometimes choosing a solid color for the text object can work best even when over a background image.  Uncheck Clear in the Text Background dialog and click the Background Color button to choose a color.  To allow the text box background to blend into the surrounding image, try using the Frame Faded Edge effect for the text object.  Click on the text to select it and press the Frame toolbar button.  Choose Faded Edge near the top of the list of frame effects and press Apply.  By default, the fade transition is 32 pixels, which may not be enough.  If desired, press the Custom Settings frame button and increase the Fade Width to a larger value and press OK to apply.
Use the Font & Size button in the Edit Text dialog to make collage text larger or smaller.  After you press OK to close the Edit Text dialog, you can also resize the text object box by clicking on it and using its pull handles.  However, using a different font size is usually better than resizing the text box after OK.  But for very large text, it is better to pull a bigger text box after OK than to specify a font size over 72.  When you increase the font size, fewer words fit in a text object line.  To increase the line width, use the <+> and <-> buttons or the Background button and enter a larger Text Field Width.
Sometimes Italic text may be partially clipped where it overhangs the end of a line.  Use the &nbsp HTML non-breaking space symbol to add a little extra space at the end of a line.  For example, type WoW&nbsp in the Edit Text dialog.
Very large text using advanced Effects and Anti-Alias at the same time can be excessively slow and you should choose the Normal Text as the Effect and/or un-press Anti-Alias for text objects with very large font sizes that cover a large part of the printer page.
Installing New Fonts

FxFoto Text uses standard Windows fonts.  For a font to appear in FxFoto’s Font & Size selector, it must be installed into Windows.  You may want to use fonts that come with scrapbooking kits and this usually requires getting and installing the font files.  Following is the procedure for installing new fonts under Windows XP.  Installing fonts for other versions of Windows is similar.

1.  If needed, download the font or kit and save it on your computer.  Remember where you saved the file.  For example, if saved in My Documents, the file is normally in the C:\Documents and Settings\???\My Documents folder.

2.  If the font is contained in a compressed Zip file, you must unpack it before it can be installed.  Windows can extract zip files.  For older versions of Windows, you may need to get and install a zip utility such as WinZip(tm).  Under XP, start Windows Explorer if needed by right clicking on the Start button and choosing Explore.  Navigate to the zip file folder and right click on the zip file.  Choose Extract All and remember the folder you choose for the extracted files.

3.  Now you know the name of the font file to be installed and what folder it is in.  Most Windows fonts are True Type files with .TTF filename extensions.
4. At this point you can use FxFoto’s Install New Font command, available in the Tools menu or from the Edit Text Misc button.  Just navigate the file selector that pops up to the place where you saved the font and “Open” it.
FxFoto’s Install New Font command requires the FxFoto Creative or Media editions.  You can also use Windows to add fonts as follows.

A. Open the Windows Control Panel from the Start menu (or in the Settings sub-menu off of Start).  Unless using Classic Windows, choose the Appearance and Themes category. Then click on or open Fonts (which is on the left side under Appearance and Themes or in alphabetical order under Classic Windows).  A list of all installed Windows fonts appears.
B. In the Fonts window, click the File menu at the top and choose Install New Font.

C.  In the Add Fonts dialog, you must select the new font file to be installed.  Do this by navigating to the Folder where the font file exists.  Remember that if it is in My Documents, then you must normally double click C:\, then Documents and Settings, then your user name, and then My Documents.  Under older versions of Windows, My Documents is directly off of C:\.  If it is in My Pictures, then navigate to My Documents first and look for the My Pictures subfolder.
D.  Once you have selected the desired folder at the bottom of the Add Fonts dialog, a list of available fonts in that folder appears at the top.  These font names may be different from the font file name.  You should record the desired font name as it appears, because that is the name you will have to choose for the font in FxFoto and other applications. 

E.  Click on the desired font name to highlight it and press OK.  The font is installed and all Windows applications including FxFoto should now list it.
If you want to remove an installed font to keep your fonts list short, you can use FxFoto’s Remove Font command.  But documents using that font may no longer show the correct font.
See also:

Tutorial: Creating Multi-Photo Collages
Tutorial: Creating Virtual Albums
Tutorial: Creating Virtual Albums

FxFoto Collage files can be used to create collage and slide show presentations.  But they are also useful for creating “virtual albums” which reference photos from a number of different folders.  Creating and saving collages requires an upgraded FxFoto Edition.
Collages and slide shows often encapsulate copies of their photos into a separate file.  But to create a virtual album, you can optionally save a non-encapsulated Files Collage which just has pointers to the photos in their original folders.  Then just open the collage files to see the included photos.  Because you have not encapsulated the photos, changes made to the source folder’s photo appear in the virtual album.  Since it needs both the collage file and all of the referenced photo files, the virtual album cannot be easily moved to another computer.  So you should save encapsulated collages for portable presentations.  But non-encapsulated Files Collages can help arrange your photos into multiple virtual album categories.
Note: FxFoto Slide Shows and Collages are very similar.  A multi-photo collage is just a single slide with more than one image and the term “Collage” is used in FxFoto for both single and multi-slide presentations.

1.  Press the New toolbar button and choose New Collage Wizard.

2.  Choose the Files Collage type and press Finish.
3.  Open one or more photos by clicking thumbnails in one of your left-pane folders.  You can also open photos into the right-pane window with Open or Add Image in the File menu.

You can optionally depress the [image: image39.png]


 Collage Add Mode button to add additional photos to the existing slide rather than place each on a different slide.  But try not to have too many on any one slide, since all slide photos must be visible at the same time, possibly requiring excessive computer memory.
4.  Press the Save toolbar button and choose Save Collage WIzard to save the virtual album.

5.  Choose the Target Name for the saved album.  Check Add as a new collage thumbnail in a left-pane folder.  Choose a folder from the pull-down menu and type a descriptive Collage File Name.  Then press Next.
6.  Confirm the Collage Type, which normally should be Files Collage (Non-Encapsulated).  Then press Next again.

7. The Collage Properties dialog, make sure that Encapsulate image files into the collage file is not checked.  Then press Finish.
8.  To review the virtual album, just click the new Collage icon in the chosen left-pane folder.

See also:

Tutorial: Organizing Photos
Tutorial: Creating Slide Shows
Upgrade or Register FxFoto
Purchase or Register FxFoto
If you already have the Standard Edition, there is nothing new to download when you order FxFoto.  A simple Registration Number enables all features in the standard download.  Plus if you like FxFoto, purchasing a registration is a great way to support Triscape and allow us to continue to support and improve FxFoto.
If you have Quick Layouts, you can purchase FxFoto Creative for complete photo organization and editing effects and still use the scrapbooking kits and layouts from your Quick Layouts projects.  You will need to install the standard download if you have Quick Layouts and purchase FxFoto Creative.
A registration can be purchased on-line at www.FxFoto.com.  Just press the Upgrade or Buy button in the startup screen or on the reminder dialog that appears when for advanced commands.  Or choose Upgrade in the Help menu.  Your web browser pops up at the www.FxFoto.com sales page.  You can pay online with a credit card and receive your registration number immediately.
After the www.FxFoto.com upgrade page pops up, the Registration Number dialog may appear when you switch back to FxFoto so that you can enter the number.  Otherwise, you will find the same dialog under Enter Registration Number in FxFoto's Help menu.  When purchasing FxFoto Creative from Quick Layouts, you must install the standard download and then use Enter Registration Number from the Help menu.

You will receive a 16-character number (e.g. 1234-5678-90AB-CDEF) which you should copy into the Registration Number dialog along with your User Name and optional Organization.  You must enter your name and registration in this dialog exactly as they appear on the notice.  We suggest that you use right-click Copy and Paste commands to transfer the name and number verbatim.  That is all you need to do to fully enable your copy of FxFoto Deluxe.

Register FxFoto Standard

To continue using the free FxFoto Standard Edition, you must register.  After you about a month, a Registration Number must be entered to continue using FxFoto Standard.  You can obtain this online at www.FxFoto.com, where you are asked to enter your name and e-mail.  Triscape protects your privacy and never shares your information with other parties.  Plus we limit e-mail solicitations so that you will not receive more that a few messages a year from us.  There is no charge to register the Standard Edition, though we encourage you to upgrade to the Deluxe Edition or better.  If you are satisfied with the Standard Edition, you can choose to pay a small fee for a Silver Standard registration to eliminate the FxFoto startup message and qualify for support.  Your payment helps support Triscape and makes it possible for us to continue supporting and improving FxFoto.
You enter your Standard Edition registration just like one for the purchased editions.  The Standard Edition registration does not enable extra features, but it is required to start FxFoto and open photos after the initial unregistered trial period.
After the www.FxFoto.com registration page pops up, the Registration Number dialog automatically appears when you switch back to FxFoto so that you can enter the number.  You will receive a 16-character number (e.g. 1234-5678-90AB-CDEF) which you should copy into the Registration Number dialog along with your User Name and optional Organization.  You must enter your name and registration in this dialog exactly as they appear on the notice.  We suggest that you use right-click Copy and Paste commands to transfer the name and number verbatim.

Continue without Purchasing or Registering
To skip purchasing or registering right now, press the Continue with FxFoto button.  If you are exiting, there are Cancel and Exit FxFoto buttons instead.  Press Cancel to avoid loosing any unsaved work and continue using FxFoto without exiting.  Press Exit FxFoto to discard any unsaved work and exit from FxFoto.

After the trial period for some editions has expired, you will be asked to enter a registration when you press the Continue with FxFoto button.  If so, a version of the Registration Number dialog appears.  You must visit www.FxFoto.com sales page or register page (or press the Visit www.FxFoto.com button to popup your browser there) to obtain a User Name and Registration Number you can enter to continue using FxFoto.  You must enter your valid User Name and Registration Number and press OK.  At this point, pressing Cancel without registering simply causes FxFoto to exit.  All of your photographs are still available on your computer even without FxFoto, typically in sub-folders off of Pictures or My Pictures.
See also:

Upgrade from the Help Menu
FxFoto Support
Trial Commands
Trial Commands in the Standard Edition

Some advanced photo editing commands are reserved for the FxFoto Deluxe, Creative or Media Editions.  You can try them in the Standard Edition but cannot save, print, email, or upload the edited photo.  Modified photos produced by these trial commands also cannot be copied to the clipboard or shown in the FxFoto Viewer.  FxFoto warns you before using one of the trial commands in the Standard Edition.  If you continue, the opened photo (but not the original) becomes trial only.  Other commands which save, copy or print will then discard any trial photos beforehand.  To save, copy or print, all photos which have been edited with Deluxe or Creative only capabilities are discarded and the new changes are lost.  But original photos without the edits remain and can be opened again.
Press Continue to proceed with the trial or save command.  Press Cancel to stop before without using the trial or save command.  Press Upgrade to get FxFoto Deluxe, Creative or Media before continuing.
See also:


Upgrade FxFoto

Uninstalling FxFoto
Uninstalling FxFoto

To remove FxFoto from your computer, choose Uninstall FxFoto from the Triscape folder in your Windows Start Programs menu.  Or you can choose Triscape FxFoto or FxFoto from your Control Panel’s Add/Remove Programs.  If you uninstall, your FxFoto folder information is permanently erased but your actual photo files remain.  You are asked twice whether you are sure before the uninstall begins.

See also:

FxFoto Support
Keyboard Commands
Keyboard Commands

FxFoto provides a variety of keyboard controls that allow you to perform various functions without the mouse.  A few of these commands are only active when you are working inside the right-pane collage window.  Note that Ctrl+<letter> means that you must hold down the Ctrl key while you type the given letter.  Alt+<key> mean to hold down the Alt key while pressing the other key.

F1 - New Collage Wizards.  This is the same as pressing the New toolbar button and pops up a dialog of buttons for commands and wizards which start new collage layouts or slide shows.

F2 - Add Image to Collage.  This is the same as pressing the Add toolbar button and pops up a dialog of buttons for common commands and wizards that start new collages or slide shows.

F3 - Save Wizards.  This is the same as pressing the Save toolbar button and pops up a dialog of buttons for common commands and wizards for printing, emailing, uploading and saving images, collages and slide shows.

Alt+F1 - FxFoto Help
Alt+F2 - Startup Shortcuts.  This shows the shortcuts and tips that appear when FxFoto first starts
Shift+F2 - Collage Wizard.  This pops up a dialog of buttons for common New, Add and Save commands and is the same as the old Collage toolbar button in previous versions of FxFoto.
Alt+F3 - Insert Blank Sheet.  This inserts a blank colored square that can be cropped to create collage embellishments.

F4 - Jump to Folder.  This is the same as pressing the Folder toolbar button and then choosing Jump to Folder from the menu.  It shows a menu of all left-pane folders and allows you to jump to a selected folder without scrolling.

Ctrl+F4 - Close Right Pane Image.  This is the same as the Del key and removes the selected image from the collage.

F5 - Hide or Show Toolbar.  This toggles the top toolbar off or back on, allowing you to increase the vertical size of the right pane collage window when doing layouts.  You may need to click in the right or left pane first if you are currently working with the toolbar.
F6 - Full Screen Photo.  Shows only the currently selected photo full screen in the FxFoto Viewer.
F7 - Adjust Visible Framing.  This toggles a mode which allows you to adjust the visible portion of a photo within a frame or even without any frame.

F8 - Collage Add Mode.  This toggles a mode that determines whether newly opened photos are added to the current slide’s collage or start new slides.

F9 - Whole Collage View.  This moves the right pane view so that all images on the current collage or slide appear.

F10 - Zoom to Photo.  This moves the right pane view so that the selected or last added image fills the window.

F11 - Folder Picture Information.  This is the same as pressing the Folder toolbar button and then choosing Picture Information from the menu.  It shows and allows you to modify information about the currently selected left-pane folder photo.  You must have first right or left clicked on the desired folder photo.  The information is blank if no left-pane folder thumbnail is selected with a blue outline.

F12 - FxFoto Settings.  This is the same as pressing the Settings toolbar button and pops up a dialog of buttons for various settings and options.

Alt+<Left Cursor> - Previous Slide (Back).  When you hold down Alt and press the left-arrow cursor key, FxFoto shows the previous slide, which is the same as the left arrow back button on the toolbar.
Alt+<Right Cursor> - Next Slide.  When you hold down Alt and press the right-arrow cursor key, FxFoto shows the next slide, which is the same as the left arrow back button on the toolbar.  Note that the FxFoto Viewer also allows you to press the Spacebar key for the next slide, but only if the slide show has been saved without Any Click for Down checked.

Alt+<Rubout> - Undo.  When you hold down Alt and press the Rubout key (the left arrow near Enter, also called Backspace), the Undo command removes the previous change.

Alt+F - File Menu
Alt+E - Edit Menu
Alt+V - View Menu
Alt+F - Favorites Menu
Alt+T - Tools Menu
Alt+H - Help Menu
Toolbar Dialogs The FxFoto Tools menu gives you a way to switch to any toolbar dialog from the keyboard.  Press Alt+T for the Tools, then type the underlined accelerator letter for the desired dialog.  For those with tabbed dialogs such as Correct Photo, type a second underlined accelerator letter for the desired sub-dialog.
Ctrl+A - Open or Add Images
Ctrl+B - Discard Modified Photographs
Ctrl+C - Copy to Clipboard
Ctrl+D - Add to To Do Folder
Ctrl+E - E-Mail Collage or Images
Ctrl+F - Search Folders
Ctrl+G - Grid Dots Toggle
Ctrl+H - Show Grid Scale Toggle
Ctrl+I  - Import from Camera or Device
Ctrl+M - Collage Add Mode Toggle
Ctrl+O - Open Collage
Ctrl+P - Print Wizard
Ctrl+S - Save Collage
Ctrl+Q - Drag & Drop Settings
Ctrl+T - FxFoto Options
Ctrl+U - Upload Photos Online
Ctrl+V - Paste from Clipboard
Ctrl+W - Save Collage Wizard
Ctrl+X - Cut to Clipboard
Ctrl+Z - Undo
Del - Delete Collage Image
Note that the various Ctrl+<letter> accelerators are shown for the equivalent commands in the menus.

See also:


File Menu
File Menu

Some commands do not appear in all FxFoto editions.
Startup Shortcuts
New Collage
Open Collage
Add Collage to Slide Show
Open or Add Image
Get To Do Folder Image
Add Accent or Matte 
Open Multiple Images
Open Internet URL Image
Save Image AsSAVEAS
Save Modified Images
Save Collage
Save Collage Wizard
Burn Photos or Show CD-ROM
Make Web or Flash Show
Transfer Show to Movie
Print Wizard
Print Selected Image
Send Image EMail
Upload Photos
Convert to PDF
Scan for Photographs
Recent Files
Exit
See also:

Edit Menu
Startup Shortcuts

This dialog appears when you first start FxFoto unless you have unchecked Show shortcuts and tips when FxFoto starts.  It can also be reached from the File menu or the F12 key.  Some commands do not appear in all FxFoto editions.
Press Photo Editing to open individual photos and other image files for correction, cropping, framing, text and drawing annotations.  Then use the Save Image As or Save Modified Images commands to save the edited images to standard JPEG photo files that can be opened any photo or imaging software.  You can also save TIFF, PNG and BMP format image files.
Press Slide Show Collage to start a new slide show with a white background.  This is equivalent the Slide Show type in the New Collage Wizard.
Press 8x8 Scrapbooking Page Collage to start a new collage with 8x8 inch page guides and a background image that you choose in a file selector that pops up next.  This is equivalent the Multi-Photo Collage type in the New Collage Wizard with 8x8 Inch Collage Page Guide Limits and a Background Image.  The Layout Background dialog appears next.
Press 12x12 Scrapbooking Page Collage to start a new collage with 12x12 inch page guides and a background image that you choose in a file selector that pops up next.  This is equivalent the Multi-Photo Collage type in the New Collage Wizard with 12x12 Inch Collage Page Guide Limits and a Background Image.  The Layout Background dialog appears next.

Press Any Scrapbooking Page Size to start a new collage with custom page guides for any desired printer, paper or card size.  The Layout Size dialog appears next, followed by Layout Background.
Note: For the 8x8, 12x12 and Card types, Keep Maximum Photo Resolution is turned on initially if Default Keep Max Resolution Shortcuts is checked in the FxFoto Options dialog.  Turning off Keep Default Max Resolution Shortcuts before starting the collage can save computer memory resources and allow you to build larger or more complex collages with limited computer memory.  You can set Keep Maximum Photo Resolution off for an existing collage in the Collage Settings Page Guides tab.
Press New Collage Wizard to start the full wizard for creating a new collage or slide show with more specialized settings.
Press Quick Sketch Template to use a sketch template image for a layout where you can drag and drop paper and photo images into colored areas.  Quick Sketch Templates require FxFoto Creative, Media or Quick Layouts.
Press Grid Custom Template to create a custom template with rows and columns of photos and/or text.  The Custom Grid Template dialog appears where you can preview and adjust the template.
Press Theme Template Layout to open one of FxFoto’s easy collage or scrapbook page layouts.  A selector pops up next to choose the template.  Click on names to see a preview of each.  The selected layout template opens into the right pane where you can drag and drop photos.  See Using Templates for details.
Press Jump to Folder to quickly move the left-pane view to show a chosen folder.  A popup menu of folder names appears next.  Pull down the menu to select from an alphabetical list or you can type the name or its beginning.  Note that there is a similar Jump to Folder button in the Search dialog.
Press Quick Start Guide to show the Quick Start topic in this documentation.
Below the shortcut buttons, a tip on using FxFoto appears.  Press Next Tip to view another or Close to exit the dialog.  Many tips enable the Help button at the bottom which leads to additional information on the topic in this documentation.  Check Show shortcuts and tips when FxFoto starts to have FxFoto present this dialog when FxFoto is first started.
See also:


Layout Size

New Collage Wizard
Layout Size

This dialog appears after you press the Card Scrapbooking button in New or Startup Shortcuts.  Choose the desired custom page or card size and press Continue for the next Layout Background dialog.  For non-standard sizes, check Custom Page Size near the bottom and fill in the width and height fields, checking inches or cm to specify the units.  Choose Printer Page Layout for the entire printable area of the selected printer page.  Press Select Printer to switch the printer or its settings.
See also:


Layout Background

New Collage Wizard
Layout Background

This dialog appears after you press the 8x8, 12x12 or Card Scrapbooking buttons in New or Startup Shortcuts.  Choose the desired type of collage background.  

Check File to choose a background image from a popup file selector next after you press Continue.  You can choose any image file from anywhere on your computer as the background, but the selector initially shows the folder selected below on the same dialog.  The digital scrapbooking kits from the FxFoto Creative CD are in folders off of a special FxFoto_Clips folder in Pictures or My Pictures.
Check Quick Sketch Template to choose a sketch template from a popup file selector next after you press Continue.  This is similar to the Quick Sketch Template command, except that it forces the layout to the chosen page guide size.  You can change various Drag & Drop Settings at any time before dropping images onto the template.  Quick Sketch Templates require FxFoto Creative, Media or Quick Layouts.
Check Theme Template to choose a template created especially for FxFoto from a popup file selector next after you press Continue.  This is similar the Theme Template command, except that it forces the layout to the chosen page guide size.
Check Color to choose a solid background color from a popup selector next after you press Continue.
Check Blank to leave the background blank for now.  After you Continue, you can open a background paper image from one of your left-pane folders to add it to the collage as a foreground image.  You can crop or edit the image as desired while it is opened in the foreground.  Then just right click on the desired image in the right collage pane and choose Collage Background from the popup menu to move the image to the background, filling the page guides.  Or you can just right-click on any paper or photo image in a left-pane folder and choose Use as Background from the popup menu.
Choose the desired Left-Pane Folder to be used for the collage. This is usually a scrapbooking kit folder with paper and element images to be used.  Choose the desired folder name from the drop-down menu.  You can also type the name or the beginning of the name.  Uncheck Alphabetical Pull-Down Folder Order to see the folders in the drop-down menu in the same order as they currently appear in the left pane.  Check Show Only FxFoto_Clips Folders to omit normal folders from the drop-down menu and show only special scrapbooking kits that come with the Creative Edition CD.  
Check Jump to Folder to show the chosen folder in the left pane after you press Continue.
See also:


Startup Shortcuts
New Collage Wizard

This command is limited in the Standard Edition and simply clears all right-pane photos or initiates a chosen single-photo theme without the wizard steps described below.  If you have the Standard Edition, an FxFoto Upgrade is required to use the full wizard.
This command starts a new multi-photo collage, scrapbook page or slide show.  Note that the Startup Shortcuts command provides a quick way to create common types of new collages.
The first step in this wizard shows standard collage types.  FxFoto uses “Collage” documents for both collages and slides shows.  Some types are not available in Quick Layouts.
The Slide Show collage steps between images with a cross fade or jump (rather than animating camera movement).  The pictures look like slides in the Viewer rather than images placed on a collage landscape.  You can use the Link NavBar button to choose other exciting entrance and exit effects and can even group more than one image onto a single slide’s tour stop number.

The Web Slide Show type works like the next Slide Show choice, but uses different (and normally smaller) Page Guide Limits and unchecks Keep Maximum Photo Resolution in the next Collage Settings wizard dialog.  This normally results in a smaller file because images are further de-resolved to fit the assumed page.  A smaller slide show file downloads more quickly over slower web connections.  It is also recommended for shows intended only for on-screen viewing rather than printing.  For an even smaller file, choose smaller Page Guide Limits, such as 400x300.  You can try checking Deresolve 4x Smaller in the Collage Properties, but viewer images may appear fuzzy.
A Files Collage references images rather than encapsulating them inside the collage file.  The collage is also temporary and does not remind you to save the collage after browsing image files.  This is the default collage type for normal photo browsing when you have not created a new collage.  Use this type when editing individual photo or image files.
An Image Tour arranges photos in row-wise order and the Next button auto-pilots the Viewer from image to image by default.

A Multi-Photo Collage is usually the best choice for creating scrapbooking pages and other complex collages.  It arranges added photos in row-wise order by default, but you can easily rearrange and resize them with selection grab handles.  The Viewer automatically shows all images from as small thumbnails from high up and the user can click on an image to zoom down and examine it in detail.  Pressing Home in the Viewer zooms back up to the whole-album view of thumbnail images.  This type 
The Compact Multi-Photo Collage works like Multi-Photo Collage, but uses different (and normally smaller) Page Guide Limits in the next Collage Settings wizard dialog.  This normally results in a smaller file because images are further de-resolved to fit the assumed page.  A smaller collage file downloads more quickly over slower web connections.  For an even smaller file, choose smaller Page Guide Limits, such as 400x300.  You can try checking Deresolve 4x Smaller in the Collage Properties, but viewer images may appear fuzzy.  Also by default, this type saves small thumbnail images at the beginning of the collage which download quickly before the full resolution photos appear.  These thumbnails appear normal from the whole-collage view but are fuzzy if the user zooms down to an individual photo before it is finished downloading.
Also choose Compact Multi-Photo Collage for printable collages that will contain a large number of photographs, especially for computers without much available memory.  The Compact types turn off Keep Maximum Photo Resolution so that, once saved, your collage requires significantly less computer memory resources.  Yet when you choose Printer Page Layout on the second New Collage Settings, the Compact Multi-Photo Collage retains more than enough resolution for most printers.
A 2D Scroll arranges photos in a top-to-bottom column by default and the Viewer automatically scrolls slowly from top to bottom

A 3D Scroll works like the 2D Scroll except that the images are shown in 3D Perspective  for an effect like the Star Wars® introduction.  It can include one or more possibly large Text objects encapsulated as very compact HTML so that large scrolling presentations can be quite small.  This type assumes small window Page Guide Limits in the next Collage Settings wizard dialog since the 3D effect works most smoothly in small windows.
Unless you are using a Theme, you can press Next to continue with additional advanced settings for the new collage or Finish to start the new collage immediately.   Themes are preset without additional settings and so only enable the Finish button.
Using Templates
Press the Theme button at the bottom to use a pre-built collage template.  Then press the Browse button to select from a library of available themes.  The selector shows previews of the theme templates when you click on the names.  Under most versions of Windows, you can drag the edge of the selector dialog wider or taller to see more frame skin names without scrolling.  Then press Open to use the chosen theme name and return to the wizard dialog.  Press Finish to load the theme template, typically showing one or more photo blanks plus generic text.

Press the Grid button to create a custom template with rows and columns of photos and/or text.  Then press Next or Finish to continue to the Custom Grid Template dialog where you can preview and adjust the template.

Press the Quick button to use a sketch template image for a layout where you can drag and drop paper and photo images into colored areas.  Note:  Quick Sketch Templates work differently than Theme and Grid Templates and most of the discussion below does not apply to them.  You must drag and drop images into Quick Sketch Templates and cannot click them open.  Quick Sketch Templates require FxFoto Creative, Media or Quick Layouts.
Once you have opened or created a template, click on left-pane photos to fill in the theme’s photo frames.  You can also drag photos into particular theme frames and can even replace a previously set photo by dragging another one into the frame.  You can also Open photos to fill the frames.
Many templates use either framed or unframed photos which are automatically adjusted to fit the template.  This means that photos are usually cropped either on the left and right or on the top and bottom to fit the fixed aspect of the theme’s photo blank.  Initially FxFoto will center the visible area of your photo with as much of the image appearing as possible.  You can use the Adjust button in the Frame dialog to move the visible portion so that features near the edge appear.  You can also use Adjust to expand the photo with its pull tabs so that only a smaller zoomed portion is visible.  Note that the same Adjust Visible Framing mode is available in the Edit menu and also in the right-click popup menu.
Click on the default text and the Text dialog pops up so you can fill in your own text titles.  You can also easily change the Font, Color, Effect and other text settings.  Normally theme text objects are click-to-edit only one time.  To re-edit text, select it by clicking again and use the Text Edit the selected existing object button.
Once all photo blanks in the theme have been filled, clicking or opening more photos starts a new collage on the next slide.  The Standard Edition can only use single-photo themes.  When you specify a multi-photo theme, FxFoto will warn you that it is for trial only and cannot save, print or send the results.

The chosen theme is just a starting point and you can indulge your creativity by changing virtually all theme settings including frame and text colors and effects.  You can even create a slide show using multiple themes.  Whenever you change the theme using Collage Settings Background dialog’s Collage Theme Template setting, the new theme will automatically be used for the next slide when you finish filling all photo blanks on the current one.  Note that FxFoto maintains a single set of background colors or background image for the whole show, so changing the theme after the first slide does not change the background.  But you can still switch any of the show’s background colors or image using that same dialog at any time.

Note: You can also choose a template from the 8x8, 12x12 and Card buttons in the New and Startup Shortcuts dialogs, when you check Theme Template on the following Layout Background dialog.  In that case, the template is automatically adjusted to the chosen size.
Note: Collage themes with a large number of photos normally have Keep Maximum Resolution turned off in the Collage Settings Page Guides.  This means that FxFoto only keeps and saves a smaller deresolved copy of the photos for better speed and file size.  Sometimes this may cause printed versions of the collage to look fuzzy, but often not when the photos only occupy a small portion of the printed page.  If you are more concerned about preserving the maximum resolution of collage photos for printing than about display speed, you may want to check Keep Maximum Resolution in Collage Settings Page Guides before you first save the collage.  Themes with only a few photos per page are normally preconfigured to already to Keep Maximum Resolution.  But using Keep Maximum Resolution for collages with many photos may require a more powerful computer with more available memory.
See also:


New Collage Settings

Custom Grid Template

Quick Sketch Template

Adding Collage Images
New Collage Settings

This is the second dialog of the full New Collage Wizard.  Choose the desired Collage Page Guide Limits for the target printer or viewer window.
The No Limits - Free Form Collage choice does not show the green page limit lines around your collage or slide.  The collage can grow as large as desired without limits.  Use this setting for browsing photographs or building simple single-photo slides.
Choose Printer Page Layout for page guides that show the actual page limits for a selected printer and paper type when you also choose Inches or Centimeters.  FxFoto will assume the last printer used or the default printer.  Press the Select Printer button to set for a different printer.  Most printers allow you to select Portrait (tall) or Landscape (wide) paper orientations.  They may have a selection of available paper sizes and other properties.  The selected printer should be the default when you next use the Print Wizard and you should use that the chosen printer with Entire Collage format printing.  The collage layout will only print to the chosen Inches or Centimeters scale when you use Entire Collage printing.

Choose 8 x 8 Inch Collage or 12 x 12 Inch Collage for a square scrapbooking-style page or other complex collage.  Designers often prefer square layouts for more balanced compositions.  The 12 x 12 size is a standard for paper scrapbooking, but 8 x 8 is popular for digital scrapbooking because it is compatible with most printers and requires significantly fewer computer resources.  Unlike Printer Page Layout, these choices do not show the collage relative to the printer paper.  The green page guide lines represent the printable area rather than the edge of the paper.  The area is normally printed centered on whatever printer page you end up using, though you can specify left and top page offsets in the Print Wizard to position the guide box as you like.  If the printer cannot handle the size (as with 12 x 12 for printers that cannot print on wide paper), then FxFoto automatically reduces the printed collage so that it fits on the available printer page.  (Note: You might also use Printer Page Layout with margins of Left 0.5, Right 0.5, Top 0.5 and Bottom 2.5 to create an 8x8 inch collage on 8.5x11 inch paper.)
Choose the Custom Page Size page guides to specify any Page Width and Page Height in inches, centimeters or pixels without specifying a target printer.  When you choose Inches or Centimeters for Custom Page Size, you should enter the desired Page Width or Page Height in those units.  Otherwise you can enter a pixel size.  The green page guide lines represent the printable area rather than the edge of the paper.  The area is normally printed centered on whatever printer page you end up using, though you can specify left and top page offsets in the Print Wizard to position the guide box as you like.
Only the Printer Page Layout through Custom Page Size page guide choices allow you to layout collages with a fixed Inches or Centimeters scale for printing.  Select the other Window page guide sizes (Large, Medium or Small Window) for collages primarily intended for viewing on screen rather than printing.  These other types support Pixel layouts rather than printer Inches or Centimeters.

Press Select Printer to choose the printer and printer page preferences when you have selected Printer Page Layout page guides.  The page guides are set accordingly.
The Page Width and Page Height show the page or window pixel size for the current page choice.  If you have chosen the Custom Page Size, then you should enter the desired page size in Page Width and Page Height.
Note: The pixel page guide width and height are not necessarily the print resolution.  When Keep Maximum Resolution is checked, photos and text can print at higher resolution.  The Page Width and Page Height pixel size (also called document coordinates) give the minimum granularity of photo and text placement and controls the relative thickness of frames. 
When using Printer Page Layout through Custom Page Size you can select Inches or Centimeters for the page layout scale.  The various margin and default image size and spacing settings switch to the chosen units.  For other page guide types, Pixels units are used and FxFoto sizes the collage to fit in the viewer window or printed page.
For Printer Page Layout, the Printer Page Margins (Left, Right, Top and Bottom) are enabled.  The outer green page guide lines in the right-pane collage window represent the edges of the chosen paper.  An inner red line shows the area within the selected margins.  If the margins are left at 0, FxFoto shows the unprintable borders of the page for your printer with the inner red lines.  Use the margins to build a collage that occupies only a portion of the printable page.
When you add images to your collage, the Maximum Added Image Size controls their largest dimension.  If the image is wider or taller, then its size is reduced to fit the maximum.  This allows you to control images sizes to fit your collage without adjusting each new image with pull tabs.  FxFoto automatically arranges added images in row-wise or vertical-column order, depending on the collage setting.  The Default Margin between Images and Maximum Row-Wise Width control the layout of added photos.  The Margin between Text & Images controls how close any text you place is above or below the image initially.  Note that without the Collage Add mode where new images open to a new slide and row-wise placement is not relevant.  Plus you can easily use the selection pull tabs to resize or move a photo as desired after adding it.  All of these settings switch to default values whenever you change the Collage Page Size Limits type, but you can then adjust them as desired.  The default values depend on the Collage Type and normally allow either 1, 4 or 16 images per collage page without further adjustment.

The Grid Scale is enabled only when you have chosen Inches or Centimeters for Printer Page Layout or Custom Page Size page guides.  Check to show a grid of regularly spaced dots that help you to layout photos, text and other objects in inches or centimeters.  Then fill in the desired number of grid ticks per inch or centimeter on the right (labeled Per inch or Per cm).  For example, if you choose 2 grid dots per inch and the paper width is 11 inches, then there will be 22 grid guide dots across the collage within the page guides, spaced at half inch intervals, and spacing photos three dots apart would place 1.5 inches between them.  Fractions allow any desired dot spacing.  For example entering .5 dots / inch would only show grid dots every two inches.

When Grid Scale is checked, you can also check Labels to show scale numbers along the left and top edges of the right-pane collage window.  These scale numbers show inches or centimeters from the top-left corner of the page or collage area.  You can also check Lines to show horizontal and vertical lines for the grid rather than just dots at the intersections.
The Grid Scale allows you to layout the collage in terms of inches or centimeters rather than document coordinate pixels.  They can optionally also be used to automatically align images onto the grid using the Snap to Grid Dots toggle command (or Ctrl+G on the keyboard).  You can also turn the grid scale off and back on with the Show Grid Scale toggle (or Ctrl+H) to temporarily see your collage without the overlaid grid and scale numbers.

The Keep maximum photo resolution checkbox controls whether FxFoto keeps extra resolution for photos that are smaller in the collage than their original size.  When checked, FxFoto keeps as much resolution as possible for printing rather than de-resolving photos for viewing on screen.  FxFoto also keeps extra resolution for printing text with Anti-Aliasing.  Uncheck Keep maximum photo resolution for smaller encapsulated collages and slide shows intended for screen viewing (rather than printing) and for sending over the Internet.
You should usually check Keep maximum photo resolution for collages that will be printed.  However checking this option can slow some FxFoto operations and result in very large collage or slide show document files.  Uncheck Keep maximum photo resolution for printable collages that will contain a large number of photographs, especially for computers without much available memory.  Once saved, your collage requires significantly less computer memory resources.  Yet when you choose Printer Page Layout Page Guides, the collage retains more than enough resolution for most printers.
You can check 600 DPI for higher resolution collages that may print with slightly sharper text.  Normally, FxFoto uses 300 or 400 dots per inch, which requires significantly less computer memory resources.  Generally you should not check 600 DPI unless you have at least 512 MB of computer memory.  Even then, leaving it unchecked will usually give good results and significantly faster operation.
Choose either Window Fill or Fill Pattern by pressing the desired button.  Fill Pattern shows a different Background Color to the borders of the collage and a white blanking color outside the collage area.  Window Fill shows the Background Color everywhere and is the default for slide shows.

Check Image and press the Background Image button to select an image to be used instead of a background color.  For Window Fill mode, the Background Image stretches a single copy of the image across the page guides rectangle or view window.  FxFoto’s supplied Patterns images are generally too small to stretch well and you should usually choose some larger image or photo from elsewhere for Window Fill mode.  For Fill Pattern mode, the image is repeated in a row-wise pattern throughout the collage.  In Fill Pattern mode, you can choose from the folder of Patterns shipped with FxFoto or you may choose another image file elsewhere, but the image width and height should be small to allow it to repeat. Even when there is a Background Image, you may want to set the Background Color to approximate the image so that transparent overlaid text blends better into the image.

For scrapbooking, paper images can be used as the Background Image as long as they are JPEG files or some other format supported by FxFoto.  Since scrapbooking paper backgrounds are normally designed to fill the page, you should usually check Window Fill.  You may also want to use Page Guide Limits to assure that the whole paper image appears on the page rather the just the portion covered by photos and text.
Note: The Background Color or Image is repeated for all slides.  To use a different background image for each slide, open the background as a normal collage photo, move it to the bottom using the right-click menu’s Show Image on Bottom, and stretch it to cover the whole collage.

There are extra background options (including color gradients, outlines and textures) that you can review and change from in Collage Settings Background after finishing the New Collage Wizard.  
You can also choose the Viewer Window Size to be used when the collage is published.  A fixed size forces the viewer window to the given pixel size.  Or you can specify that the viewer be maximized or full screen (at whatever the target screen size).  If no size is specified, the viewer reuses its last window size.
Press the Set Background Music or Audio button to set the Background Music played by the Viewer for the collage or slide show.

See also:


Open Collage

Creating Slide Shows
Custom Grid Template

You reach this dialog by choosing the Grid button in the New wizards or the Startup Shortcuts.  It allows you to create your own custom drag-and-drop template of photos and text.  The grid templates you can create are similar to the large Theme Templates with multiple Photo targets.  But instead of selecting from the available Theme Templates, you can generate virtually any layout with multiple photos and text arranged in rows and columns.  You can even combine rows or columns to vary the size and aspect of the photos for a less regular and more interesting layout.  If you have the Standard Edition, an FxFoto Upgrade is required.
Setting the Sliders

Use the Number of Columns and Number of Rows sliders to adjust the size of the grid.  The layout places Photo, Text or blank cells in a spreadsheet-style grid pattern of rows and columns.  So for example, if the Number of Columns is 3 and the Number of Rows is 2, then there will be three Photos across in each of two rows vertically.

You can also adjust the Photo Separation slider to add more or less space between the Photo and/or Text cells.
Manipulating the Layout Preview

You will see a preview of the layout to be generated with the chosen rows and columns.  When you move the mouse over the row or column lines dividing the Photo or Text cells, the mouse cursor will change to a small + cross.  When the + cross appears, click the left mouse button to join to cells together into a larger Photo or Text area.  You can combine cells either horizontally or vertically by clicking on the appropriate edge line.  Clicking on corners does nothing.  Once you have joined two cells to make a one larger one, you can click on another nearby edge to make the cell even larger.  Or you can click in the middle of the larger joined area to split it back into separate cells.  The + cursor will appear along the row or column divisions even inside a larger joined cell.
Point the mouse inside one of the Photo or Text cells and not over one of the row or column division lines and the mouse cursor changes to a hand pointer. When the hand pointer appears, you can click the left mouse button to change the Photo cell to Text.  Clicking again switches Text to a blank area which shows neither a Photo nor Text.  Clicking a third time switches the cell back to a Photo.  So you can cycle from Photo to Text to blank and back to Photo by clicking in cells.  Note that when you have combined cells into a larger area, the row and column divisions inside the cell will show the + cross cursor and clicking splits the cell.  To switch a combined cell's Photo or Text type, you must point to one side or the other where the hand cursor appears and not in the middle where there is a row or column division.
Other Settings
Select Wide, Tall or Square for the Layout to control the shape of the whole collage.

In the Make Extra Large area, you can check Left, Center and/or Right to make selected columns wider than the rest.  You can also check Top, Middle and/or Bottom to make selected rows taller than the rest.  These allow you to vary the sizing to emphasize certain cells and for a less regular effect.  The Center and Middle checkboxes increase the size of the middle two columns or rows if there are even numbers of columns or rows in the layout.
Click the Background Color button to change the collage background from white to any desired color.

Click the Text Color button to change the color of any Text in the layout.

The Photo Frames setting allows you to apply a few common Frame effects to all of the Photo cells after you press Finish.  The chosen Photo Frames effect does not show in the preview.  Matt Frame applies a beveled edge around the photo as if the background were a matt that is trimmed to show the photo underneath.  Snapshot Frame applies a white boarder around each photo and shows a drop shadow outside the border.  For the Snapshot Frame shadow to appear, the Photo Separation must be large enough and the shadow offset is set to half of the Photo Separation.  Faded Edge feathers the photos into the background color around the edges and you can adjust the Fade Width to control the amount of feathering.  The Fade Width must be a value from 0 to 100.
Press the Reset button to switch all cells back to Photos and to undo any combined cells that span rows or columns.
Press Finish when you are satisfied with the preview layout to create the template in FxFoto's right collage window.  Any previous collage is closed and you are asked to save it if there are unsaved modifications in the old collage.  
Then just click open photos to fill the Photo targets.  Or drag photos and drop them into particular Photo targets.  You can drag another photo to change a target even after you have filled it with another photo.  You can also Open photos to fill the cells.
Photos are automatically adjusted to fit the template.  This means that photos are usually cropped either on the left and right or on the top and bottom to fit the fixed aspect of the theme’s photo blank.  Initially FxFoto will center the visible area of your photo with as much of the image appearing as possible.  You can use the Adjust button in the Frame dialog to move the visible portion so that features near the edge appear.  You can also use Adjust to expand the photo with its pull tabs so that only a smaller zoomed portion is visible.  Note that the same Adjust Visible Framing mode is available in the Edit menu and also in the right-click popup menu.
Click on the Text targets to pop up the Edit Text dialog and type the desired text.  You can easily modify the Font & Size, Text Color or any of the other text settings. 

See also:


Using Templates

Quick Sketch Template
Quick Sketch Template

You reach this dialog by choosing the Quick button in the New wizards or the Startup Shortcuts.  It allows you to choose a sketch template image with gray-scale or colored areas where paper and photo images can be dropped.  This command requires the FxFoto Creative, Media or Quick Layouts.
These sketch template images are available from various digital scrapbooking designers.  Sometimes designers provide templates for Photoshop along with separate PNG or JPEG images for use in other software.  FxFoto cannot use Photoshop-specific templates, but can use standard image files with grey or colored areas marking where papers and photos go.  If possible, choose template images with distinct colors or shades of gray for different areas and without text notes.  Templates with feathered regions without crisp edges may work well unless the designer has converted them into a layered FxFoto template with partially transparent feathering or embellishments.  FxFoto can automatically cover text that is entirely within an area.  But text that crosses areas will show through unless you erase it from the template image as described below.
Choose the Quick Sketch Template Image file name.  Press the Browse button for a file selector.  Any image file can be used, but good results require specially designed sketches where different solid gray or colored areas are used for different paper and photo fields.  Sketch template images are normally downloaded or purchased from digital scrapbooking designers.
Note: Some versions of FxFoto may include a selection of Quick Sketch Templates which appear in a special left pane folder called Templates.  These are FxFoto FXT template files that can contain a Quick Sketch background for drag and drop, plus optional foreground layers with droppable feathered and partially transparent regions as well as click-to-edit text and non-target embellishments.  They can be clicked open to begin a layout without using this Quick Sketch Template command.  If you do use the Quick Sketch Template command, basic versions of these same template will appear in the Templates folder off of FxFoto_Clips (which in turn is off of Pictures or My Pictures). 

Check Use 8x8 Template if Bigger to reduce large templates to 8x8 inch 300 dpi format.  This is recommended, especially on computers without a large amount of ram memory.  Note: You can also choose a sketch template from the 8x8, 12x12 and Card buttons in the New and Startup Shortcuts dialogs, when you check Quick Sketch Template on the following Layout Background.  In that case, the sketch template is automatically adjusted to the chosen size.
Check Add Page Guides Assuming 300 dpi to create a layout with a green page guides box that prints with a specific size.  Otherwise page guides will not be used and the entire collage will print to fill the available paper size.
Check Eliminate Surrounded Text to have FxFoto try to cover text letters that are inside of template fields when you drop in images.  Adjust the Embedded Text Maximum Area Percent setting in the Folder Setup Drag & Drop Settings to avoid eliminating larger photo areas embedded inside paper mattes.  Only embedded areas smaller than this threshold are eliminated, but that may include small embedded patterns that are not text.
Hint: When the template image has text that touches or crosses the border of a template area, it will still show through even with the Eliminate Surrounded Text option.  If possible, choose template images without text to avoid problems.  Otherwise, you may have to erase the text from the template image before using it.  Open the template image file into the right pane normally.  (Or if you have already opened it with this Quick Sketch Template command, right click on it and uncheck Non-Selectable Image so that you can edit it.)  From the Draw toolbar dialog, choose the Get Color tool and click on the adjoining gray or colored area to get its color.  Then choose the Brush Pen tool (and do not check Transpar).  Carefully brush the color over text at the edge of the area.  On the other side of the area boundary, use Get Color again to get the adjoining area color and then use Brush Pen again to erase the text that overhangs the edge on that side.  You can usually leave text letters that are entirely embedded inside a single template area as long as Eliminate Surrounded Text is checked.
Check Make Template Areas Slightly Larger to Overlap to slightly pad images dropped into template areas.  This can help cover gaps between areas.

Check Rope Dropped Photos Without Automatic Crop to adjust dropped photos before cropping them to the template area outline.  As described below, FxFoto distinguishes between dropped paper and photo images and this setting only applies when a photo is dropped.  When unchecked, the photo is automatically centered in the template area and cropped to fit.  When checked, a rope outline is created around the template area and the un-cropped photo is placed under it.  FxFoto automatically switches to the Crop dialog if needed when you drop a photo with this option checked.  Grab and drag, resize and/or rotate the photo to position it as desired.  Then use the Crop toolbar's Crop Image button to finish cropping the photo.

Hint:  It is often better to leave Rope Dropped Photos Without Automatic Crop unchecked, since you can normally use Adjust Visible Framing to adjust the photo after dropping it.  FxFoto automatically keeps the unseen portions of the photo as long as Keep Extra Frame Adjust Margins has been left checked in the Drag & Drop Settings.
When you drop an image onto a Quick Sketch Template, it is treated differently depending on whether it is a photo or a paper image.  Photos only fill a single template area even if there are other areas with the same color.  Paper images span all template areas with the same color and do not re-size to exactly fit the template area (so that different papers all appear at the same template scale).  By default, Automatic Paper vs Photo Detection is checked to have FxFoto guess whether a dropped image is paper.  Only images which are 2400x2400 or 3600x3600 pixels (8x8 or 12x12 inches at 300 dpi) are assumed to be paper.  Other images are assumed to be photos.  You can check Drop Images as Photos or Drop Images as Paper to force all images to be treated as one or the other.  Moreover, you can switch this setting just before dragging and dropping an new image from the Folder Setup Drag & Drop Settings dialog.
Press Finish to open the chosen sketch template image.   Then drag and drop paper images and photos to fill the template areas.  You must drop images into Quick Sketch Templates and cannot click them open.

Note: There are a few additional advanced settings available in the Folder Setup Drag & Drop Settings dialog.  The Color Match Tolerance adjusts how much template field colors can vary without being treated as separate regions.  The Minimum Pixel Threshold for Paper Areas adjusts how large a template colored spot can be before it is treated as a separate matching area when paper is dropped.  Templates which use text often have small spots of gray around the text that is the same color as real template areas and this setting allows FxFoto to ignore such small splotches.
Tip:  The sketch template background and dropped paper images automatically have Non-Selectable Image checked so that they cannot be moved out of position by mistake.  You can right click on and uncheck Non-Selectable Image to move or edited dropped paper images.  Dropped photos are left selectable so that Frame Adjust can be used.  But you may want to right-click and make photos Non-Selectable so that they cannot move.
See also:


Folder Setup

Using Templates

Open Collage
Open Collage

Choose a previously saved collage or slide show document from your disk or network.  Collage files normally have an .FXF extension if ultimately intended for the Viewer or an .FXE extension if they are intended only for the FxFoto editor application.  FxFoto Theme templates use an .FXT extension.  When you open collage files from the Windows Explorer the corresponding application is used.  But either can open both file extensions from a file selector.  You are asked to save (or cancel) any changes to the previous collage before the new one appear.

Some collage and slide show documents have an associated preview thumbnail image, usually of the first slide.  If you are using an edition of FxFoto that can save collage thumbnails, then a special file selector with an extended Preview area at the bottom appears.  Clicking a collage or slide show file that was saved with a thumbnail shows show the small preview image.  No preview image appears if none was saved or if the special preview selector has been turned off in the Options dialog.
You can also open image or collage files by dragging and dropping them from the Windows Explorer.

This command also allows you to add images to your current collage.  Simply select an image (such as a JPEG photo file) and it works like with the Add Image command. 

See also:


Open Image

Open Multiple Images

Adding Collage Images
Add Collage to Slide Show

This File menu command presents the same popup file selector as Open Collage. But instead of replacing the current collage layout or slide show, the Add Collage to Slide Show command adds all slides in the chosen collage to the end of the currently open slide show collage. This allows you to combine two slide shows into one longer one. Note that the final Viewer Configuration dialog of the Save Collage Wizard can optionally save just a part of the current show to a collage file, allowing you to also break up a show.

Warning: When you add a slide show into a collage, the source collage file must remain available until you save the combined show. If you erase or move the added slide show file first, you may be unable to save it with the open collage.

See also:


Open Collage
Open or Add Image

This command opens a selected image file into the right-pane collage window.

Select the image to be added to your current collage.  The File Type normally shows all supported image types, but you can restrict the list to a particular type of image (such as JPEG only) if desired.  Note that most photographs are stored as JPEG images.

If you are not using Windows XP or Vista, this dialog shows an extended Preview area at the bottom.  Just click on an image to see it previewed before deciding to open it.  You also see its pixel width and height size and its last-modified date.  You can even press the Add Favorite button to add the selected file to your FxFoto Favorites for future use without opening it.

The standard Windows XP or Vista file selector can show photo thumbnails and so special FxFoto preview selector is not normally used.  If the Preview does not appear, you can turn it back on with the Options command.  Uncheck Normal Windows XP Selector Previews and check Special File Selector with Image Previews to see the Preview area.  
The image normally appears in a newly created slide, either after the last slide or, if Insert After Current Slide is checked in Options, after the current slide.  But if the Collage Add mode button is down, then the new image is placed in the current slide, either to the right of or below the last image, depending on the current Row-wise setting.

Note that you can also open image files by clicking left-pane photo thumbnails or by dragging and dropping them into the right-pane collage window.

See also:


Add Accent Image

Open Multiple Images

Open Internet URL Image

Adding Collage Images

Save Collage
Get To Do Folder Image

This command adds one or more selected image files to a special To Do Folder in the left pane.  The To Do Folder always appears at the top of the left pane in gray.  Its images can be clicked or dragged into the right-pane collage or slide show just as from other folders.  However images normally disappear from the To Do Folder once then have been opened.  The To Do Folder does not keep separate copies of its images and just points to the original image files.  Use the To Do Folder to keep track of photos or images you plan on adding to a collage layout or slide show.

Select the image to be added to the To Do Folder.  The File Type normally shows all supported image types, but you can restrict the list to a particular type of image (such as JPEG only) if desired.  Note that most photographs are stored as JPEG images.

You can select more than one image from the same place by holding down the Ctrl key and clicking more images before pressing Open.
If you are not using Windows XP or Vista, this dialog shows an extended Preview area at the bottom.  Just click on an image to see it previewed before deciding to open it.  You also see its pixel width and height size and its last-modified date.  You can even press the Add Favorite button to add the selected file to your FxFoto Favorites for future use without opening it.

The standard Windows XP or Vista file selector can show photo thumbnails and so special FxFoto preview selector is not normally used.  If the Preview does not appear, you can turn it back on with the Options command.  Uncheck Normal Windows XP Selector Previews and check Special File Selector with Image Previews to see the Preview area.  
Note that you can also add images to the To Do Folder by dragging them from other left-pane folders or with the Folder Move Pictures command.  The images always also remain in the original folder since the To Do Folder never keeps separate copies.

Tip:  You can optionally keep To Do folder images so that they are not automatically removed when opened when Remove Opened Images from the To Do Folder is unchecked in the Drag & Drop Settings.
See also:


Open or Add Image

Add Accent Image
Add Accent or Matte
If you have the Standard Edition, this command requires an FxFoto Upgrade.
Available both from the File menu and the Add button, this allows you to include various matte groups, divider bars and boxes from a special library folder.  Mattes are groups of images, often with drop-target photo blanks or click-to-edit text that you can easily add and position as a unit in your collage.  Accents are single images, but unlike normal images, accents can be intelligently stretched either horizontally and/or vertically.  Thus a divider bar can be resized horizontally to fit your collage without looking distorted or becoming too fat.

Matte groups open to the right of or below the last collage image.  Initially a new accent is centered in the visible portion of the current slide’s collage.  Before using this command to choose an accent, you can move the right-pane view as desired so that the approximate desired spot is in the center of the window.

This dialog shows an extended Preview area at the bottom.  Just click on a matte or accent image name to see it previewed before deciding to open it.  Under most versions of Windows, you can drag the edge of the selector dialog wider or taller to see more accent names without scrolling.
After choosing and opening a matt, you can click on any of the grouped images to select them all.  When you move, resize or rotate the selected image with its pull tabs, all of the other glued images move together.  The other glued images appear with a dotted selection outline but without pull tabs.  See the Mouse dialog's Glue Grouped Images button to glue grouped objects.
After choosing and opening an accent, you can click and stretch it horizontally or vertically without holding down the shift key as with normal images.  Click on the divider or box in your right-pane collage to select it.  Then place the mouse cursor over the appropriate horizontal or vertical pull tab to stretch to the desired size.  Bars should normally be stretched only horizontally or only vertically, depending on their orientation.  Box accents can grow or shrink as desired in both dimensions.
Accent names which include Box are stretchable rectangles.  Drag any of the four sides and drag to resize without distortion.  Accent names which include Horz are horizontal bars.  Drag horizontal bars on the left or right to stretch them wider or narrower without distortion.  Accent names which include Vert are vertical bars.  Drag them on the top or bottom to stretch without distortion.
By default, you see FxFoto’s library of Accents in its installation folder.  But you can navigate the selector elsewhere and add any sort of supported image file, such as GIF or WMF clipart.  Use the type drop down menu to select other image types.  So you can use this Add Accent Image command to add clipart and other images to your collage.  If you choose an accent image not from FxFoto’ default Accents, FxFoto remembers your choice and its folder for next time.
Note: You can also use the Draw File Stamp tool to add clipart with a slider to control the initial image size.  And you can open image or collage files by dragging and dropping them from the Windows Explorer.

Warning: When you add a matte into a collage, the source matte file must remain available until you save the collage. If you erase or move the matte file first, you may be unable to save it into the open collage.
See also:


Open or Add Image

Open Multiple Images
Open Frame Image

This allows you to choose the skin image to be automatically stretched into the picture frame.  

This dialog normally shows an extended Preview area at the bottom.  Just click on a frame image name to see it previewed before deciding to use it.  Under most versions of Windows, you can drag the edge of the selector dialog wider or taller to see more frame skin names without scrolling.
Initially all available frame skin images appear.  You can optionally choose Wide Fixed Aspect Only or Tall Fixed Aspect Only using the type menu to see only fixed-aspect skin frames.
Press Open to choose the selected frame skin.  Then remember to press Apply in the Frame dialog.
See also:


Frame Options
Open Multiple Images
If you have the Standard Edition, this command requires an FxFoto Upgrade. 
This command allows you to open multiple image files from the same directory at the same time.  The images can either be opened onto the same slide collage or as separate slides.  By default, it also opens the images in a special de-resolved mode on the same slide collage to save memory in case there are a large number.  The images automatically read to full resolution when you first click on them.

Note that the Open Folder Photos command in the Folder menu allows you to easily open multiple photos a left-pane folder.

Choose the source Folder to be used.  Press the Browse Folder button for a tree selector dialog.  The Folder is not essential if you choose Open Selected Images since you can still browse the file selector to the desired place.  Also, the Folder need not be one  of FxFoto’s left-pane folders.  It can be any directory accessible to Windows.
Choose Open Selected Images if you want to click on one or more individual image files to be opened in the folder.  After you press OK, a file selector appears where you can choose more than one image by holding down the Ctrl key will clicking on files (prior to pressing the selector’s Open button).

Choose Open All JPEG Images to add all *.JPG, *.JPEG and *.JPE files from the folder.

Choose Open All Folder Files Matching a Custom Pattern if you want to type a custom file name pattern such as Demo*.jpg or Winter*.* or *.bmp.

If Start a New Collage is un-checked the images are added to your current collage.  Otherwise OK starts a new collage (after asking to save any old changes).

Check Open Images into Separate Slides to create a new slide for each opened photo file, similar to the way the Open Folder Photos command in the Folder menu works.  When unchecked, the images are all added to the current slide collage and the rest of the dialog settings are enabled.
Check Show Only Thumbnail Images Until Clicked when adding a large number of images.  The full resolution version of each thumbnail does not read until you click on it.  This is a good way of browsing through a large folder for a particular image.  Open the whole folder, look through the thumbnails, and then save those desired, possibly in the Favorites for future use.

The dialog also allows you to place the images in a Row-Wise album order with more compact than normal spacing and to specify the Maximum Width or Height size on the collage for large images, plus the Margin Between Images and the Maximum Collage Width.

See also:


Open Internet URL Image

Open Multiple Files Selector

Adding Collage Images
Selecting Multiple Files Selector
Hold down the Ctrl key while clicking on files to select more than one and then press Open.  You may optionally switch to a different folder than the one specified in the previous dialog.

See also:


Open Image

Open Muliple Images
Open Internet URL Image

This command works like Open Image but allows you to type a web address URL (such as http://www.fxfoto.com/photos/screen400.jpg) rather than choose with a file selector.  You can add images to your collage from know addresses over the internet.  You can also add whole HTML web pages.  Note that many photographs and other files available over the Internet are copyrighted and should not be used without the owner’s permission.
See also:


Open Image

Save Image As
Save Image As
Available both from the File menu and the Save button, this command allows you to create a new image file with a copy of a photo or of a right-pane collage or slide image.

FxFoto automatically updates the appropriate left-pane folder when you save the image file in one of your existing folder directories.  You can create a multi-photo collage or annotate a single photo and then save the image file back on top of one of the folder’s photos or as a new file in the folder’s directory.

Note that if you improve or crop a folder photo, FxFoto automatically asks if you want to save the modified picture back to its folder.  Use this command to add collage images to a folder with multiple photos, frames or text annotations.
When you save an image that includes text, you are saving an image of the text rather than editable text.  When you latter re-open the saved image, you will not be able to edit the text.  Use Save Collage (not available in the Standard Edition) to save a collage or slide show with text that can be changed when you re-open it.
First, select the Image Area to be saved.  Some selections may be disabled if not currently possible.  A preview area on the right side of the dialog shows a small version of the selected image to be saved.
Select the Original Image to save the image file at the highest possible resolution without any overlaid text, drawing or frame effects.

The Composed Image saves any image annotations (such as frame effects and overlaid text or drawing) and de-resolves if needed to fit the current image size on the collage.  It also saves any image rotation.

You can also include the surrounding Title and Caption text in the saved image.  You must have clicked on the main image, rather than the title or caption.  Title and Caption also includes any other images that are glued to the selected one.
Save the Roped Selection collage area outlined by a pre-selected rope, which can include more than one image.  You must use the rope toolbar buttons to pull or draw the desired rope outline first before beginning this command.

You can include all of the collage inside the Visible View Area for current widow view.

Choose the Entire Collage to save all images appearing in the current slide.

The Save Collage Wizard button switches to that wizard so that you can save an FxFoto collage or slide show document rather than a static image file.  This allows the Save As command to create both types of files, static images for use with other applications and dynamic collages and slide shows for use with the FxFoto Viewer.  The same Save Collage Wizard is also available as a separate File menu command and from the Save toolbar button.  If you have the Standard Edition, the Save Collage command requires an FxFoto Upgrade.
You may change the default Width and Height of the saved image to de-resolve to any desired pixel size.  Keep in mind that very large image sizes can result in huge files.  The Maximum Size for Saved Images Options setting may initially limit the size shown so that large collages do not result in huge image files that may require excessive computer resources.
Press the Next button for a second wizard dialog where you can choose the Target Image File to be created.  If the target is in a Locked folder, you must enter a password for the folder before continuing.
See also:

Target File for New Image
Save Collage Wizard
Choose Target File for New Image

This is the second and final dialog of the Save Image As wizard.  You choose where the new image file is saved.

Select Replace selected left-pane folder picture to overwrite the old left-pane thumbnail with the new image.  The Old picture shows the existing photo that will be replaced.

Select Add as a new picture in a left-pane folder to create a new photo image in one of the left-pane folders.  The current Folder is initially selected but you can use the drop down menu to add the new image as to any of your folders.  Or you can type a name in the Folder to create a new left-pane folder that receives the image thumbnail.  FxFoto warns you before creating the new folder if the typed name does not already exist.  You can leave the Photo Name field blank to have FxFoto automatically assign a file name.  Since FxFoto's left-pane organizer allows you to find and open photos visually, you may not want to worry about file names.  But if you do, you can type the desired name for the added image file in Photo Name.  This is the base name and FxFoto will automatically add the proper extension such as .jpg.
Select Target given path file name to add or replace any file in any of your computer’s directories and create any of FxFoto’s supported image file types.  You need not write the image file in one of your left-pane folder directories.  Press the Browse button to choose the target path and file name with a standard file selector dialog.  If desired, you can replace the full path file name with just the desired base name to be saved in the same directory folder.  For example, if you type over ...\My Pictures\ Miscellaneous\Image1234.jpg with just Vacation, then a Vacation.jpg image file is saved to the Miscellaneous folder under My Pictures.
You should normally leave the Save As Type set to Default.  This allows the image to be saved in the appropriate file type, normally JPEG.  You can optionally drop down the Save As Type menu and choose another type, such as PNG or TIFF.  Note that the Save As Type overrides any name extension in the target path file name field.  For example, if you choose TIFF, the saved file has a name ending with .tif.

The Transparent PNG type saves a standard PNG file but makes the saved image transparent where the collage background color appears.  Of the standard types, only PNG and Triscape's VIB are capable of saving transparency information.  Unless you chose Original Image in the previous wizard dialog, the various composed formats normally save the background color opaquely.  But the Transparent PNG choice allows you to save an image with transparency in place of the background, though only applications such as FxFoto that allow for transparency will properly handle the image.  
The CMYK TIFF type converts the image to a special CMYK form of TIFF file with Cyan, Magenta, Yellow and Black ink colors rather than Red, Green and Blue color information.  CMYK TIFF format may be required by some commercial printers, but it has the equivalent color information to the RGB format normally used in Windows.  Certain RGB colors, such as bright red, green and blue, do not print well with standard CMYK ink, but FxFoto does not warn when colors may be out of gamut and the printed image may use less intense colors than appear on screen.
By default, FxFoto saves images as JPEG files, the type used for most photographs.  See the JPEG Quality settings in Options to improve the quality of saved JPEG images at the expense of larger disk files.  TIFF photo files are lossless, but use less compression and typically take up much more disk space than JPEG without much gain in image quality.  PNG files work well for non-photographic images with only a limited palette of colors.  BMP images are a Windows standard but are not compressed and usually require a large amount of storage space.  VIB (Vector Image Bitmap) files are a Triscape standard which usually compress as well as JPEG for photographs and as well as or better than PNG (or GIF) for images without many colors.  Unlike normal JPEG files, PNG and VIB images can have transparency.
Press the Finish button to write the new image file.
See also:

Save Image As
Save Modified Images
Save Modified Images

This dialog appears when you have edited photos or their text and annotations and reminds you to save your work.  It appears before you exit FxFoto and when you clear collage images from the right pane.  It can also appear when you open another image after editing.
Save Modified Images in the File menu and the Save Mods button in the Save Wizards shows this dialog if there are edited photos which have not been saved.  
When you are building a mult-photo collage or slide show, FxFoto normally asks you to save the whole collage instead of this dialog.  You are only asked to Save Modified Images if you are editing individual photos using the Files Collage type and have not started a slide show or multi-photo collage.  

The Save Mods button in the Save Wizards shows this dialog for photo editing.  Save Mods saves the whole collage when you are creating a multi-photo collage or slide show.  Use the Save Mods button to save your work either way.
This dialog saves the modified photo image over the old photo file.  You should use the Save Image As command to save the image to another file or folder if you want to keep the original.

Leave Save Composed Images with Text Annotations checked to save any text, frame, drawing or other annotations that appear with the photo.  Title and caption text above and below the photo are also included in the saved image.  But text or framing saved in an image becomes part of the image and cannot be edited later.  This is equivalent to the Title and Caption choice in the Save Image As command.
Uncheck Save Composed Images with Text Annotations to save just the edited image itself without overlaid text and annotations.  This is equivalent to the Original Image choice in the Save Image As command.

When opening a new image, check Also Remove Saved Images to close the saved photos so that they no longer appear in a right-pane slide.  This option only removes each image after it is successfully saved.  Note that this option may be disabled when the open was initiated from outside of FxFoto.

When you are opening a new image, you can check Do Not Ask About Saving Modified Images on Open to avoid being bothered with this Save Modified Images dialog when you open photos in the future.  Once you check this, you can turn the feature back on by checking Ask to Save Modified Images on Open in the Options diaog.
Press Yes to save all modified images open in the right pane back to their files.  
Press No to skip saving for now.
Press Cancel to skip saving and abort the exit, open or clear operation.
Note that once changes are saved, the picture appears as modified when you next open it.  After closing the collage, you cannot undo the modifications one at a time.  But you can return to the original unmodified version of the photograph.  When you first open it again, use the Undo command and you are asked if you want to restore the original.  You can also restore the original by right clicking on an open photo and choosing Restore Original Image.
If you do not want to save the changes, you can use the Clear Whole Collage button in the Review or Remove Photos dialog and choose No when asked to save.
See also:

Save Image As
Replace Dropped Image
Replace Dropped Image

This message may appear when you drag a photo and image and drop it pointing to an existing image already in the right-pane collage.  It allows you to replace the old image rather than adding the new one on top.  It is available only in FxFoto Creative, Media and Quick Layouts.
Check Keep Whole Replacement Image Without Rotation or Cropping and then press OK to replace the old image with the new one, leaving the replacement whole without any cropping or rotation to match the old image.

Check Crop and Rotate the New Image Similarly to the One Being Replace and then press OK to use the old image as a mask to similarly crop the new image into the same shape.  However, the new image is always sized as large as possible to fit the old image's crop shape and is centered.  You can normally use Adjust Visible Framing later slide unseen portions of the photo into view (as long as Keep Extra Frame Adjust Margins is checked in the Drag & Drop dialog).  The new image is also automatically rotated to match the old image being replaced.

Press Cancel to add the newly dropped image on top without replacing the old image.

Check Do Not Ask About Replacing Old Images Again before pressing OK or Cancel to avoid this popup dialog when you drop images in the future and never replace existing images.  You can undo this and allow this question to re-appear using the Folder Setup Drag & Drop Settings.
See also:

Low Memory Warning
Low Memory Warning

This message may appear when you open or add a new image or text to warn you that your computer's RAM memory resources may be running low.  If memory becomes too low, Windows will become extremely slow and may eventually freeze. 
The Collage Memory Usage shows the number of megabytes of RAM memory resources used by currently open collage images and text and also the total RAM memory available to Windows on your computer after a portion of memory is reserved for the operating system. The second number will be somewhat less than your installed memory.
Pressing Cancel (if enabled) aborts adding the new image or text to your collage or slide show and avoids using additional memory resources.   Press OK to continue adding the new image.  However, continuing to add new images when memory is low may eventually freeze your computer.  You can check Do not warn about low memory again to skip this warning until you next clear photos or start a new collage or slide show.
By default, FxFoto warns you when the open photos or show are using more than 66% of available memory (after a portion of memory is reserved for the operating system).  You can change the warning level with Low Memory Warning Percentage in the Options dialog, where a higher number like 75 would delay the warning until 75% of memory is used.  Beware that FxFoto and Windows require memory resources beyond those used by the collage and so you will usually encounter problems well before the collage memory usage reaches 100%.
Tip: You may be able to reduce memory usage by unchecking Keep Maximum Photo Resolution in the Collage Settings Page Guide tab and then saving or re-saving the collage file.  And of course you can control memory usage by using fewer photos on collage layouts.  FxFoto must keep the current collage or slide in memory plus the slide immediately before and after in slide shows.  So a large collage layout or slide with many photos requires more memory resources than a number of different slides each with one photo.
Note: The problem is with RAM memory and not free space on your hard disk.  It is easy to confuse the two, since they are both measured in MB (megabytes).  RAM memory is the volatile memory used by software to hold programs and data while they are running.  Computers come with varying amounts of this memory.  FxFoto needs at least 256 MB and preferably 512 MB of computer RAM memory to build large collages.  Hard disks are much larger, typically measured in GB (gigabytes) and hold data permanently with much slower access.

See also:

Save Collage
Save Collage

If you have the Standard Edition, this command requires an FxFoto Upgrade.
This command simply saves the current collage or slide show document with all recent changes to the disk.  If it is newly created and not yet saved you are asked to choose a target folder and name for the collage in a standard file selector.

See also:


Save Collage Wizard

Saving Images
Save Collage Wizard - Target Name

You can save a collage or slide show document file both from the File menu and the Save button.  FxFoto collage files encapsulate both collages and slide shows.

The Standard Edition allows you to save the current edited photo using this command. Normally, you can use the Save Image As command, which is fully enabled in the Standard Edition, to save modified photos as standard JPEG or TIFF image files. But text and frame annotations become part of the image and you cannot easily change the text or frame later with from an image file. When the edited photo is saved as a collage file using this command, text and frame annotations can be edited when you reopen the saved collage.

This is the first of the four step of the Save Collage Wizard.  It asks you to choose the target folder and file name where the collage or slide show will be created or re-saved.

Select Replace the original left-pane collage thumbnail to overwrite the old left-pane thumbnail with the collage or slide show.  If the current collage opens from a folder, then it is reselected if needed and the modified collage or slide show replaces it.
Select Add as a new collage thumbnail in a left-pane folder to create a new collage or slide show in one of the left-pane folders.  The current Folder is initially selected but you can use the drop down menu to add the new image as to any of your folders.  Or you can type a name in the Folder to create a new left-pane folder that receives the new collage thumbnail.  Enter a Collage Name for the saved document file.  FxFoto warns you before creating the new folder if the typed name does not already exist.

Select Target path name for collage file to add or replace any collage document file in any of your computer’s directories.  You need not write the image file in one of your left-pane folder directories.  For example, you may want to place collages and slides shows in your Documents or My Documents for easy access from Windows Explorer.  Press the Browse button to choose the target path and file name with a standard file selector dialog.  If desired, you can replace the full path name with just the desired base name to be saved in the same directory folder.  For example, if you type over ...\My Pictures\ Miscellaneous\Collage1234.fxe with just Vacation, then a Vacation.fxf image file is saved to the Miscellaneous folder under My Pictures.
Check Show thumbnail (not name) to include a small thumbnail preview image of the collage or first slide.  If checked, the thumbnail image will appear in your left-pane folder (along with a small camera icon to let you know it is a collage or slide show rather than a photo).  Otherwise, text appears as the left pane icon with the word Collage and the chosen Collage Name.  The Show thumbnail rather than name checkbox also applies to the other two target choices, Replace and Target Path, even though it is in the Add section.  Unchecking it will remove the thumbnail image from the saved collage or slide show document, which will result in a slightly smaller file size, but a text name left pane icon and no Open Collage file selector previews.
Check Save Current Slide as Matte to save just the currently visible slide or picture and not the entire slide show. This option automatically saves a single-slide "matte" file rather than a full collage. In left-pane folders, the Matte appears with a special [+] icon over the thumbnail. So when you open the saved slide, it adds into the current slide show or collage rather than replacing it. This option is always checked in the Standard Edition, which can only save the current annotated photo as a matte collage.
If enabled, check Save Selected Group as Matte to save just the images in the currently selected glue group as a special Matte collage.  None of the other photos, images or text in the collage are saved, just the selected glue group.  A Matte adds into a collage when opened rather than replacing it.  So the glued images in the matte can be easily be added to any collage whenever you like.  In left-pane folders, the Matte appears with a special [+] icon over the thumbnail.  Matte files have a special .FXM filename extension rather than .FXF or .FXE for normal collages and checking this adds .fxm to the target path name.  Before saving the collage, you must have created a glue group and it must be selected.  This option is not available in the Standard Edition,
Press Next to continue with the wizard or Finish to save the collage or slide show with default settings for the remaining wizard steps.  The Standard Edition enables Finish and can only save the current photo as a single-slide collage for future editing.
If the target is in a Locked folder, you must enter a password for the folder before continuing.

Note: With the Media Edition, you can create password locked collages and slide shows.  Just Lock one of your left-pane folders with a password and save the collage there.  Or save it without encryption to a left-pane folder and then use the Folder Password Locking command to encrypt the selected collage show to FxFotoUpload with a password.  The FxFoto Viewer will ask for the password before showing the collage or slide show and so you can restrict your work to people you have given the password.  Viewer versions prior to 3.0.055 will be unable to open the show.

See also:


Save Collage Wizard - Collage Type

Creating Viewer Presentations

Save Image As
Save Collage Wizard - Collage Type

This is the second step of the Save Collage Wizard where you choose the basic type of collage or slide show to be created.

The Collage Type dialog shows you the type you have previously selected.  You can change this type if desired.  Some types are not available in Quick Layouts.
The Slide Show collage steps between images with a cross fade or jump (rather than animating camera movement).  The pictures look like slides in the Viewer rather than images placed on a collage landscape.  You can use the Link NavBar button to choose other exciting entrance and exit effects and can even group more than one image onto a single slide’s tour stop number.

The Web Slide Show type works like the next Slide Show choice, but uses different (and normally smaller) Page Guide Limits and disables Keep Maximum Photo Resolution.  This normally results in a smaller file because images are further de-resolved to fit the assumed page.  A smaller slide show file downloads more quickly over slower web connections. It is also recommended for shows intended only for on-screen viewing rather than printing.  For an even smaller file, choose smaller Page Guide Limits, such as 400x300.
A Files Collage references images rather than encapsulating them inside the collage file.  The collage is also temporary and does not remind you to save the collage after browsing image files.  This is the default collage type for normal photo browsing when you have not created a new collage.
An Image Tour arranges photos in row-wise order and the Next button auto-pilots the Viewer from image to image by default.

A Multi-Photo Collage is usually the best choice for creating scrapbooking pages and other complex collages.  It arranges added photos in row-wise order by default, but you can easily rearrange and resize them with selection grab handles.  The Viewer automatically shows all images from as small thumbnails from high up and the user can click on an image to zoom down and examine it in detail.  Pressing Home in the Viewer zooms back up to the whole-album view of thumbnail images.  This type is usually the best choice for creating scrapbooking pages and other complex collages, though the Image Tour type can also be used.
The Compact Multi-Photo Collage works like Multi-Photo Collage, but uses different (and normally smaller) Page Guide Limits in the final Viewer Configuration wizard dialog.  This normally results in a smaller file because images are further de-resolved to fit the assumed page.  A smaller collage file downloads more quickly over slower web connections.  For an even smaller file, choose smaller Page Guide Limits, such as 400x300.  Also by default, this type saves small thumbnail images at the beginning of the collage which download quickly before the full resolution photos appear.  These thumbnails appear normal from the whole-collage view but are fuzzy if the user zooms down to an individual photo before it is finished downloading.
Also choose Compact Multi-Photo Collage for printable collages that contain a large number of photographs, especially for computers without much available memory.  The Compact types turn off Keep Maximum Photo Resolution so that, once saved, your collage requires significantly less computer memory resources.  Yet when using Printer Page Layout Page Guides, the Compact Multi-Photo Collage retains more than enough resolution for most printers.
A 2D Scroll arranges photos in a top-to-bottom column by default and the Viewer automatically scrolls slowly from top to bottom

A 3D Scroll works like the 2D Scroll except that the images are shown in 3D Perspective  for an effect like the Star Wars® introduction.  It can include one or more possibly large Text objects encapsulated as very compact HTML so that large scrolling presentations can be quite small. This type assumes small window Page Guide Limits in the final Viewer Configuration wizard dialog since the 3D effect works most smoothly in small windows.
Press Next to continue with the wizard or Finish to save the collage or slide show with default settings for the remaining wizard steps.
See also:


Save Collage Wizard - Properties

Save Collage Wizard
Save Collage Wizard - Collage Properties

The next Save Collage Wizard step presents the detailed settings implied by the Collage Type you just choose.   You can check or uncheck settings as desired.  In addition to applying to the saved collage, most settings are also remembered for future collages you create with the same type.

Check Encapsulate to include the images inside the collage file.  Encapsulated collages or slide shows have copies of their images included inside the .FXF or .FXE collage document file.  If unchecked, the document file just references separate image files by name and images cannot appear if you move the collage file to another computer without the referenced files.  Non-encapsulated collages and slide shows are smaller but are not portable.  Also, non-encapsulated collages cause image modifications to overwrite the original images when you save the collage.  But encapsulated collage documents save copies of the modified images without changing your original images.  You should usually keep Encapsulate checked.
Check Keep HTML as Text to encapsulate your text as formatted HTML rather than as an image file.  Keeping HTML text generally results in a smaller collage file and also preserves the text for future editing.  If you uncheck this, you will not be able to use the Text command to examine or change any text after the collage has been saved and then re-opened.  However, if you move the collage to another computer with different fonts, the Viewer must try to match the available fonts with those you originally specified.  Therefore, the text may appear a little different in different Viewer systems.  Uncheck this item for a completely uniform look.  It is usually best to uncheck it only when the collage is complete and ready to publish (and you may want to make a backup copy of the original with editable text.)

Check Include Thumbnail Images to save separate small thumbnail images of large photographs that initially appear with less detail from high altitude.  The option is primarily intended for advanced users who publish collages from web pages.  The Viewer loads the thumbnail versions first (if reading the collage directly over the Internet from a web site) and so the user sees them first before the larger full-resolution images have time to load over a slow connection.  This option is less important if the collage is read over a fast network or is e-mailed as a file where the viewer cannot incrementally read it.  In most cases, you should leave it unchecked.

Check De-Resolve Images to a 1:1 View to reduce image sizes as needed to match the 100% Zoom level in the Viewer.  If you have loaded large photographs and especially if you have reduced their size on the collage, this option can save significant space by compacting the images to the standard collage resolution.  However, the Viewer cannot then print the photographs at their higher original resolution.  You can check Deresolve 4x Smaller to make the encapsulated images even smaller than the normal 1:1 size.  Encapsulated collages are much more compact but images are more fuzzy.  Note that the collage Keep maximum photo resolution Page Guides setting this overrides this one.
Check Automatically Assign Tour Stop Numbers to give each image you add to the collage sequentially higher tour stop or slide number.

Check Automatically Add in Row-Wise Order to cause added collage images to be initially placed to the right of the previous image until the end of a row is reached.  Uncheck to place added images below the last in a column.  Note that this setting applies only with the Collage Add mode where new images open to the same slide.  This setting is also available in the Edit menu.
Check Allow Blowup View to show images enlarged beyond their normal 1:1 size when the viewer window is big enough.  Images will be larger in a larger window but may be fuzzy if they are encapsulated and de-resolved to their 1:1 view.
Check Borderless Viewer Window to force all slides to completely fill the Viewer window. FxFoto automatically cuts off a little of each slide image on the top and bottom or on the left and right if needed to make it fit the window or full-screen shape. Borderless works best for single-photo slides without Title or Caption text outside the actual photo (which might be cut off for a borderless slide). Wipe entrance effects usually look best with a single photo on a borderless slide so that the entering photo completely covers the display window. Note that you can also make individual slides borderless in the Slide toolbar's Special Effects tab, using the Borderless checkbox, as long as the Borderless setting here is off.
Check Show Navigation Buttons in the Viewer to include buttons that the user can press to step through your tour or slide show.  Normally Back, Home and Next buttons appear, but this can be changed on the next dialog.

Check Show NavBar Tools in the Viewer to force the NavBar with its navigation joystick and speed slider to appear on the left side of the Viewer.  You cannot check this if you choose to Lock the Camera.

Check Lock the Camera to prevent the user from navigating the Viewer except with the standard Back, Home, and Next buttons.  You cannot check this if you choose Show NavBar Tools.

Check Disable Printing and Copying to stop the Viewer from producing copies of your images.  The Viewer’s Print and Copy commands are disabled.

Check Show 3D Perspective in the Viewer to cause the Viewer to show the collage in 3D mode.

Check Enable Click Zoom Down to cause the Viewer to show a magnifying glass icon when over small thumbnail images from high up.  Clicking on an image zooms the Viewer down to the full 1:1 detail level centered on the image.

Check Start the Viewer with High Image Thumbnails to initially show the entire collage and all images from as high as necessary.  This is overridden if you specify a specific initial camera view in the next dialog.  Note that you need not have Include Image Thumbnails checked for this feature.

Check Start the Viewer North of Images and Scroll Down to show a slow top-to-bottom scroll of the whole collage in the Viewer.  Note that this mode overrides any initial camera view you set in the next dialog.  It causes the 2D or 3D Scroll effect.  The user can press Home to return back to the top and continue scrolling.

Check Looping Slide Show to allow the Viewer to loop back to the first slide after the last.  If unchecked, the show stops after the last slide and the Next and Back buttons cannot loop around the end or beginning of the show.
Check Force the Viewer to a given Window Size to specify a non-default Viewer window in the next dialog.

Press the Set Expiration Date button to stop viewers from using your collage or slide show after a specified date and time.  On the popup calendar, choose a future expiration date or press No Expiration to clear any existing limit.  The calendar initially shows today’s date at 12:00 AM when no expiration date has been set for the collage.  You must choose a future date and time.  FxFoto beeps if you leave the date at 12:00 AM today or try to choose a past date.  When you set an expiration, FxFoto also automatically sets Private Editing Only for the show so that it cannot be modified by others.  Press the No Expiration button to allow the show to be viewed without limit.  The Set Expiration Date is not enabled in all editions of FxFoto and this button may ask you to upgrade if your current edition does not support it.
Press Next to continue with the wizard or Finish to save the collage or slide show with default settings for the remaining wizard step.
See also:

Save Collage Wizard - Viewer Configuration
Save Collage Wizard - Collage Type
Save Collage Wizard
Save Collage Wizard - Viewer Configuration

This is the last step of the Save Collage Wizard where settings controlling the FxFoto Viewer appear.
You can specify a new Default Camera View to Show First in the Viewer.  Press Show Current View to specify the view you currently see.  Press Show Copied View to use the last Copied View you saved in the View menu.  Or press Clear Initial Camera to stop from specifying an initial view and use the default instead.  Note that you cannot override Scroll Down feature for the document with a specified camera.

You can specify the desired Viewer Window Size or choose Max for maximized or Full for full-screen mode in the Viewer.  Or you can allow the collage to be viewed with the user’s default size and placement.  This can override the choice from the previous dialog.

You can also specify whether any of the standard Navigation Buttons appear at the top or bottom of the Viewer window.  The Back and Next buttons step forward and backward through the tour or slides (or return to previous location if the user navigates).  The Home button returns to the beginning of the tour or slide show or the default initial camera you specify.  The NavBar button allows the user to toggle the left-hand navigation toolbar in the Viewer (and is not recommended if you have locked the Viewer camera).  The Done button exits the Viewer (and allows the default slide time to be changed).  
The Allow Slide Time Adjust can be unchecked to stop the user from seeing a Viewer dialog that allows the default time per slide to be adjusted to speed up or slow down the show.  This dialog normally appears when the user clicks on a full screen show or presses a Done button.
The Any Click for Done can be checked to cause any user click (or key press) in the Viewer to work like a Done button, showing the done dialog to exit or adjust slide times (or just exit if Allow Slide Time Adjust is unchecked).  Even when checked, the click for done feature is automatically disabled when the collage has clickable buttons or links.  Note that the Esc key still works like a Done button even when this setting is unchecked.
You can also specify the speed of Navigation in the Viewer when the collage opens.  The User’s Default setting leaves the speed and navigation mode unchanged.  The others set the speed for collages where the camera is not locked.  The Custom setting allows any desired speed.  To change the speed of 3D and 2D Scrolling collages, you must choose Custom and enter the desired speed.
When one of the window-size Page Guide Limits has been set for the collage and especially if you have changed the page guide size, you can check Squeeze images to fit page guides to automatically squeeze images if needed to fit the window limits.  If squeezed, the relative positions and sizes of collage images remain similar and the collage layout does not change even though the pictures shrink.  Note that for 3D and 2D Scrolling collage types, you normally want extra images and text below the bottom page guide that scrolls into view and so should uncheck check Squeeze.  See the Page Guides collage settings for more details.
The Save Only Slide Numbers [  ] through [  ] blanks allow you to save only a portion of the current slide show. Leave them blank (or set to zero) to save the entire slide show or collage. If "Save Current Slide as Matte" was checked on the first Save Collage Wizard dialog, then the saved slide range begins and ends with just the current slide number.

Press the Set Background Music or Audio button to check or set the Background Music played by the Viewer for the collage or slide show.

Press Finish to save the collage or slide show.  Press Back to review or change previous wizard steps.
See also:

Make ave Collage Web Site
Save Collage Wizard - Collage Properties
Save Collage Wizard
Make Web or Flash Show
This command is supported only by the Media Edition.  In other editions, a trial-only version allows you to create trial Flash slide show movies, but cannot save shows that play in the FxFoto Viewer or Clickable Photo Thumbnails. When saving trial Flash slide shows, it marks saved images as "Trial Only" and you must upgrade to the Media Edition to enable this and all other features..
Available both from the File menu and the Save button, this command creates an HTML web page file along with either a Flash slide show movie, an FxFoto Viewer plug-in presentation, or clickable thumbnails with associated JPEG image files for selected photos.  Typically, you must transfer these files to your Internet web server and then link the HTML page into your site to publish the collage over the Internet.  FxFoto handles creating the necessary files but does not transfer them to your web server.  Use separate FTP or other web publishing software to transfer and link to the photo page.

Before using this command, you should set up the collage slide show or presentation as desired with the various Slide controls.
Flash Slide Show Movies

Flash is often the best choice for showing slides shows over the Internet because most users already have the Flash plug-in.  Like FxFoto collage files for its Viewer plug-in, Flash slide shows are typically much smaller than other movie file formats, since they need not include frames where there is no motion. Flash can show entrance and exit movement efficiently. However, some types of movement are not as efficient in Flash and should be avoided for the most compact shows. FxFoto's "wipe" entrance effects and also its "Tour", "2D Scroll", and "3D Scroll" collage presentation types require frame-by-frame images to appear in Flash and so shows using them are much larger and slower to download.

To create a Flash show, choose the Whole Collage Slide Show or Presentation button and make sure that "FxFoto Viewer Plug-In" is not checked.
Set the Width and Height to the desired pixel size of the slide show movie inside the browser page. 640x480 pixels is a good default size. 
Also set the desired Frames per Second.  20 or 30 FPS is usually best to avoid flicker (at least in places that use 60 Hz power).  For shows that use wipe entrances, a lower frame rate will substantially reduce the show file size.  But for normal slide transitions, reducing the frames per second will not affect the show size nearly as much.  Unfortunately, players usually limit Flash movies to 16,000 frames, which is less than 14 minutes at 20 fps.  For longer shows, leave Auto checked and FxFoto will automatically reduce the frames per second so that the entire show fits in 16,000 frames.  Reducing the frame rate can make slide transitions less smooth, but allows the whole show to be viewed.  If Auto is unchecked and the show will not fit in 16,000 frames, then FxFoto shows a popup warning a few seconds after it begins making the movie (after it has determined the show's duration).  From that warning, you can choose Yes to automatically reduce the frames per second so that the show fits in 16,000 frames.  Or you can choose No to allow the show to exceed 16,000 frames, which may cause it to stop before the end during playback.  Finally, you can choose Cancel to abort making the movie.  But this 16,000 frame warning only appears when Auto is unchecked and the show will exceed the 16,000 frame limit.
If the open FxFoto slide show or other collage type uses music or audio narration either for the background or for slides, the Use MP3/WAV Audio from Collage Slide Show will be enabled, but you can uncheck it to omit the collage audio from the Flash show. Including music or audio narration can significantly increase the Flash file size.  Flash can only play MP3 or WAV audio and any MIDI or OGG music will not be included in the Flash show. In addition, Flash cannot play all possible MP3 compression types and you may see an error message when you begin building the show if you happen to an unusual MP3 format. But normal MP3 audio music and any narration that you have recorded with FxFoto for slides can be heard in the Flash slide show. You can adjust the volume for with the Slide Show Volume slider.
The Add Extra Background Music is only available for Flash shows. Check it to add an additional music or audio file that plays mixed together with any collage slide show audio. This is a good way to add MP3 music that plays in the background behind your slide narration. Press Choose Extra Music to select the MP3 or WAV file. Test Music and Stop Text plays and stops the selected audio. Check Loop the Extra Music to have it repeated if it is not as long as the slide show. You can adjust the Extra Music Volume independently of the slide show volume. But the Extra Music Volume is not used by the Test Music playback, which is always at standard volume.
Make sure that FxFoto Viewer Plug-In is unchecked.  When checked, Flash is not used and the slide show requires FxFoto's Viewer plug-in, which requires Windows and must be downloaded.
Check Looping Slide Show to have the show repeat forever.
Check Start Browser to View to have your default web browser popup showing the newly created slide show (though you may need to click on the security warning at the top of the browser window to allow it to run since Internet Explorer treats local files as potentially less secure than Flash shown over the Internet).
Check Fade Audio Cutoffs to have FxFoto fade the music out when switching to another slide's music and at the end of the show. When unchecked, the old audio will cut off more abruptly when a new slide has different music and will keep playing at the end of the slide show.
Check Keep Flash Size Small to switch "wipe" style slide entrances to appear as cross-fades in the Flash version of the show. This makes the resulting Flash dramatically smaller and faster to download for slide shows that use "wipe" entrances.  It can also reduce the size of collages with "tour stops" by not reloading images when the camera moves, which can sometimes make them fuzzy when the camera zooms down.  But it cannot reduce the size of the "3D Scroll" and "2D Scroll" collage types, which normally require a very large Flash file.
Click Background Color to change the background from the default white. Or check From Collage to use the collage Background Color. Type the desired Title to appear above the slide show or photos and click the Title Color if desired to change the title text color.
Set the Target File to Create to the desired HTML file to be created. Press Browse for a popup file selector.  A second Flash movie file with the same location and name but with a .SWF filename extension is also created. When you press Begin at the bottom, you are warned if either file already exists before they are overwritten.
Note:  For slides> that have not specified Slide Duration, the Default Seconds per Slide in Movies setting in the FxFoto Options can be set as desired.  The Flash movie will switch to the next slide after the given number of seconds, which is normally 5.

EMail Slide Show Package

FxFoto can package the HTML slide show browser page and its Flash SWF movie file into a single Microsoft e-mail archive file, also called an MHT file. This can be a convenient way to e-mail a slide show. However, e-mail attachments are usually limited in size an shows larger than 1 MB may be too big to e-mail.  Also, some e-mail or browser software may be unable to play a packaged MHT Flash show. In particular, Outlook Express treats the attachment as unsafe and will not allow the Flash show to play by default. The recipient must click the "Tools" menu in Outlook Express and choose "Options".  Then select the "Security" tab and uncheck "Do not allow attachments to be saved or opened that could potentially be a virus."  For Microsoft's Outlook (rather than Outlook Express), an Administrator must change the security settings in the Windows Registry.  See Microsoft's Knowledge Base article number 829982. From other e-mail clients, the recipient can usually save the MHT attachment file and then open it with Internet Explorer to play the slide show.
Choose the EMail Slide Show Package button. The same Flash show settings described above are used for MHT archive packages. But Start Email to Attach appears instead of "Start Browser to View".  When Start Email to Attach is checked, FxFoto will have Windows popup your default MAPI e-mail software and attach the new MHT slide show package file. It also creates default message text that explains how to allow Outlook Express to open MHT attachments. If you use browser-based web mail or if your e-mail software is not compatible with MAPI, then you may instead need to start your e-mail and browse to the created MHT file to attach it.
Tip: To help make an e-mailed slide show viewable when MHT packages are blocked, you can optionally use separate "Zip" compression software like WinZip or even Windows and create a .ZIP file containing the .MHT slide show. Attach the .ZIP file to your e-mail instead of the .MHT package. The recipient will need to upzip first (which Windows normally does automatically when you open a .ZIP attachment) and then open the included .MHT file to view the show. When sending a .ZIP file you may want to uncheck Start Email to Attach and ZIP the target file first from outside of FxFoto before switching to your e-mail and attaching the ZIP file to a new message.
FxFoto Viewer Plug-In Shows

To use the FxFoto Viewer plug-in instead of flash, choose the same Whole Collage Slide Show or Presentation button, but check FxFoto Viewer Plug-In on the top right. The Flash-only settings are disabled.
The person viewing the page over the web must have the free FxFoto Viewer plug-in.  For persons running Microsoft Internet Explorer, the plug-in automatically downloads and installs on the user’s system the first time it is needed. Users with browsers which use Netscape style plug-ins need to visit http://www.fxfoto.com/FxViewer to download and install the plug-in.  (Note that the FxFoto Viewer is quite small and normally downloads in less than three minutes even with a slow dialup connection.)
Set the Width and Height to the desired pixel size of the slide show movie inside the browser page. 640x480 pixels is a good default size.  However 3D scrolling collages may need to be 320x240 for smooth animation.
Make sure that FxFoto Viewer Plug-In is checked.

Check Start Browser to View to have your default web browser popup showing the newly created slide show (though you may need to click on the security warning at the top of the browser window to allow it to run since Internet Explorer treats local files as potentially less secure than Flash shown over the Internet).
Click Background Color to change the background from the default white. Or check <B>From Collage</B> to use the collage Background Color. Type the desired Title to appear above the slide show or photos and click the Title Color if desired to change the title text color.
Set the Target File to Create to the desired HTML file to be created. Press Browse for a popup file selector. A second FxFoto collage file with the same location and name but with an .FXF filename extension is also created. When you press Begin at the bottom, you are warned if either file already exists before they are overwritten.
Note that FxFoto automatically saves a new copy of the current collage along with the target HTML web page file and overrides the Encapsulate image files Collage Setting so that the web site collage is always encapsulated and so can be easily copied.  It also automatically reduces the collage resolution and squeezes the images as required.
Clickable Photo Thumbnails

Clickable Photo Thumbnails creates an HTML page with rows of thumbnail images which can be clicked to show larger composed versions of the photographs.  It does not require the FxFoto Viewer.  The resulting photo page has small thumbnails.  When clicked, the browser switches to a full-size composed version of each photo.  If you have rotated, cropped, framed or annotated the photograph in with title or caption text in the collage, then that composed version of the photo appears when you click the browser thumbnail.  Press the browser Back button to return from the large size photo to the thumbnails page.
Press <B>Choose Images</B> for a selector with all opened images in the current collage. Click on images to turn the green [I] tag off to exclude them and click again to include them. Initially all are tagged for inclusion. The order shown may not be the real slide order.  You can easily change the Slide Order before hand, which also orders the clickable thumbnails,

Specify the Image Size of the thumbnails. This is the pixel width of the row-wise images which appear on the page.  By default, it is the current thumbnail size specified for your left-pane folders.  Also specify the Spacing between images. The Row Width is the maximum width of the thumbnail rows and also the maximum width of the larger composed images seen when the thumbnails are clicked. 640 is a web standard for pages, but newer monitors can often show 800 pixels or even wider.
Click Background Color to change the background from the default white. Or check From Collage to use the collage Background Color. Type the desired Title to appear above the clickable thumbnails and click the Title Color if desired to change the title text color.
Set the Target File to Create to the desired HTML file to be created. Press Browse for a popup file selector.  Other JPEG photo files with the same location and name but with an __?.jpg ending are also created. Press Begin to create the HTML page.
Transferring Files to Your Web Server

All of the resulting files are in a single directory folder using the HTML or MHT file name you select.  For Whole Collage, the associated Flash or collage file has the same beginning base name as the HTML file ending with .swf or .fxf as the filename extension.
Note:  Renaming both the .htm and the .swf or .fxf files will not work since the .htm contains the .swf or .fxf file name and must be edited if that name is changed.

You must transfer the resulting .htm, .swf and .fxf files to a single directory on your web server using separate FTP, FrontPage extensions, or similar software. But .mht e-mail package files are not normally placed on a web server, where a .htm and .swf slide show is normally preferred.

For Clickable Photo Thumbnails, the associated JPEG image files have the same beginning base name as the HTML file with two added underline characters and an additional name suffix. For example, if you choose C:\Folder\WebShow.htm then the first collage photo will generate two additional files, C:\Folder\WebShow__1.jpg (for the full composed photograph) and C:\Folder\WebShow__T1.jpg (for the small thumbnail version of the photo).
You must also link your web site to the chosen photo page.  For example, your home page might contain this link:
<A HREF='WebShow.htm'>My Photographs</A>

For a Whole Collage Slide Show, it is possible to extract only the Flash or FxFoto Viewer plug-in box HTML and insert it in your own web page. The important part of the created WebShow.htm file begins with the <OBJECT ... > and ends with </OBJECT>. Following is the format for the FxFoto Viewer plug-in:
<OBJECT ID='XFCon'

 CLASSID='CLSID:FE37B651-B02A-4001-B56B-B4AC65395365'

 CODEBASE='http://www.fxfoto.com/download/fxviewer.cab#version=1,2,032,0'

 WIDTH=600

 HEIGHT=450

>

<PARAM NAME='SRC' VALUE='WebShow.fxf'>

<EMBED NAME='XFCon'

 TYPE='application/vnd.triscape.fxf'

 WIDTH=600

 HEIGHT=450

 ARGS='http://www.mysite.com/photos/WebShow.fxf'

>

</OBJECT>

The Flash plug-in format is similar. You can optionally edit this HTML plug-in text or copy it to another web page.  The #version at the end of CODEBASE= is the minimum FxFoto Viewer version number that is needed to view the .fxf document.  Internet Explorer will automatically download ask the user to install the latest version if the computer’s viewer is too old.
Note:  The <EMBED ...> tag for both Flash and FxFoto Viewer plug-ins is only used by Netscape browsers.

Important:  Some web servers such as Windows 2003 block access to non-HTML files by default.  This means that the WebShow.fxf file may not work correctly on your server until you set up a new MIME type for the .FXF filename extension.  Though Flash is more common, the server may also block the Flash .SWF filename extension.  For Microsoft's IIS Manager, select the target server directory (or its parent or ancestor).  Right click and choose Properties.  Choose the HTTP Headers tab and press the MIME Types button. Then press New to add a MIME type.  For Flash "Extension" type .swf and for the MIME type use application/x-shockwave-flash.  For the FxFoto Viewer plug-in "Extension" type .fxf and for the MIME type use application/vnd.triscape.fxf
See also:

Burn Photos or Show CD-ROM
Burn Photos or Slide Show CD-ROM

If you have the Standard Edition, this command requires an FxFoto Upgrade.
Available both from the File menu and the Save button, this creates a slide show or other collage presentation on CD-ROM.  You must have a CDR drive with a recordable CD blank (or one with unused space).

Note:  You can also use the Upload command’s Generic Hold for Later or Record to CD-ROM service to burn images to CD.  That command does not set up a collage viewer presentation on the CD.  Instead it gives you more control over the image names and layouts for sending JPEG image files via CD-ROM to printers and other services.
For FxFoto to directly burn the CD, you must be using Windows XP or better.  For older versions of Windows, FxFoto creates an FxFotoBurnCD directory within Documents or My Documents.  It directs you to start separate CD creator software and copy all files and folders within FxFotoBurnCD to a CD layout for burning.  For the CD-ROM to be playable, you must copy the all of the contents of FxFotoBurnCD and not the directory folder itself.  (This means that AutoRun.inf, FxFoto.fxf and all other files should be recorded in the CD’s root directory)  FxFoto can then erase the FxFotoBurnCD when you press OK after recording the CD-ROM.
Note: Even if you are using Windows XP or Vista, you may not want FxFoto to directly burn to CD.  FxFoto uses the Windows CD Writing Wizard, which does not yet support DVD recorders and which may be incompatible with some third party CD recording software.  If you have CDR software from companies other than Roxio, such as some Sonic software, it may disable the Windows CD Writing Wizard and result in an error message when the wizard attempts to write directly to a CDR.  To avoid this problem, check Separate CD Burn Application.  This causes FxFoto to save files to be burned in a separate FxFotoBurnCD directory off Documents or My Documents so that you can switch to your separate CD or DVD creator software to record.
Basic Options
Select Chosen Photos Only to record only selected photo files that have been opened into FxFoto's right pane.  Normally all open photos are recorded to the CD-ROM.  Press the Choose Photos to Include button for a popup selector where you can select from among the open photos with green tags.  The recorded photo files are normally standard JPEG or sometimes TIFF files which can be opened by most other software.
Select FxFoto Viewer Slide Show Only to record an encapsulated FxFoto Collage file called FxFotoShow.fxf which for the current slide show of all open photos.
Or select FxFoto Viewer Slide Show + Chosen Photo Files to optionally select only some of the open photos to include as separate files on the CD-ROM, which enables the Choose Photos to Include button.  Note that if you have created and saved a slide show, its photos are normally deresolved and encapsulated in the FXF show file.  FxFoto can only copy the smaller screen resolution versions of the show photos to the CD-ROM and they may not have enough resolution to print well.
Select Browser Flash Slide Show Only to record a Flash slide show that plays in a FxFotoShow.htm HTML browser page.  Flash must be installed on the target computer local flash movies must be allowed in CD-ROM browser pages.  On non-Windows computers, try starting the FxFotoShow.htm or opening it from your web browser.

Select Browser Flash Slide Show + Chosen Photo Files to also include selected photo files on the CD-ROM. Unlike FxFoto Viewer slide shows, the Flash movie always shows all open photos or slides even if only some of them are selected with the Choose Photos to Include button. Also, the FxFotoShow.swf Flash movie file encapsulates separate copies of the same slide photo images and so this option may require more space on the CD-ROM than FxFoto Viewer Slide Show + Chosen Photo Files.

The final two Flash Slide Show selections are enabled only in the full FxFoto Media Edition. Use the Make Web Slide Show command for trial Flash shows in other editions.

Settings
The Choose Photos to Include button is enabled with some options above and allows you to omit some open photos from the CD-ROM. A green tag appears in the upper-right corner of all photos to be recorded. Initially all are tagged for inclusion.  Clicking on an image toggles its tag off so that it is not included on the CD-ROM.  Clicking it again turns its include tag on again. Press Include All to mark all images for inclusion or Include None to un-mark all images.
Check Separate CD Burn Application to stop FxFoto from using the Windows CD Writing Wizard to burn to CD-ROM, even when supported under Windows XP, Vista or better.  Instead FxFoto always writes the CD image to a special FxFotoBurnCD directory off Documents or My Documents and allows you to switch to separate software to record the CD or DVD.  This option allows you to use FxFoto to burn a DVD under Windows XP even though the Windows XP CD Writing Wizard does not support recordable DVD drives.  It may also be needed if your CD software is incompatible with the Windows CD Writing Wizard.  This option does nothing under older versions of Windows which always require a separate application to record to CD-ROM. Note that this option is also available in the FxFoto Options dialog.
Check Looping Slide Show to have the FxFoto Viewer or Flash show repeat when it finishes playing.
Check Full Screen FxFoto Viewer to have the Viewer slide show appear is a full-screen application. This enlarges the slide photos as much as possible but may slow down the slide transition effects. When unchecked, the Width and Height settings control the size of the FxFoto Viewer window.  This option is not available for Flash shows.

The Width and Height settings give the screen pixel size of the FxFoto Viewer or Flash slide show window.  The default is 800x600 which fits well on most displays. Smaller sizes will reduce the Flash slide show file size.
The remaining settings apply only to Flash shows created with the full Media Edition. They are also found Make Web Slide Show, which has additional advanced settings and which can make "trial-only" shows in lesser versions of FxFoto.
The Frames / Second applies only to Flash slide show movies.  20 or 30 FPS is usually best to avoid flicker (at least in places that use 60 Hz power).  For shows that use wipe entrances, a lower frame rate will substantially reduce the show file size.  But for normal slide transitions, reducing the frames per second will not affect the show size nearly as much.  Unfortunately, players usually limit Flash movies to 16,000 frames, which is less than 14 minutes at 20 fps.  For longer shows, leave Auto checked and FxFoto will automatically reduce the frames per second so that the entire show fits in 16,000 frames.  Reducing the frame rate can make slide transitions less smooth, but allows the whole show to be viewed.  If Auto is unchecked and the show will not fit in 16,000 frames, then FxFoto shows a popup warning a few seconds after it begins making the movie (after it has determined the show's duration).  From that warning, you can choose Yes to automatically reduce the frames per second so that the show fits in 16,000 frames.  Or you can choose No to allow the show to exceed 16,000 frames, which may cause it to stop before the end during playback.  Finally, you can choose Cancel to abort making the movie.  But this 16,000 frame warning only appears when Auto is unchecked and the show will exceed the 16,000 frame limit.
If the open FxFoto slide show or other collage type uses music or audio narration either for the background or for slides, the Use MP3/WAV Audio from Collage Slide Show will be enabled, but you can uncheck it to omit the collage audio from the Flash show.  Including music or audio narration can significantly increase the Flash file size. Flash can only play MP3 or WAV audio and any MIDI or OGG music will not be included in the Flash show.  In addition, Flash cannot play all possible MP3 compression types and you may see an error message when you begin building the show if you happen to an unusual MP3 format.  But normal MP3 audio music and any narration that you have recorded with FxFoto for slides can be heard in the Flash slide show.  You can adjust the volume for with the Slide Show Volume slider.
Check Fade Audio Cutoffs to have FxFoto fade the music out when switching to another slide's music and at the end of the show.  When unchecked, the old audio will cut off more abruptly when a new slide has different music and will keep playing at the end of the slide show.
The Add Extra Flash Music is only available for Flash shows.  Check it to add an additional music or audio file that plays mixed together with any collage slide show audio.  This is a good way to add MP3 music that plays in the background behind your slide narration.  Press Choose Extra Music to select the MP3 or WAV file. Test Music and Stop Test plays and stops the selected audio. Check Loop the Extra Music to have it repeated if it is not as long as the slide show.  You can adjust the Extra Music Volume independently of the slide show volume.  But the Extra Music Volume is not used by the Test Music playback, which is always at standard volume.
Burning the CD
Press OK to begin.  There may be two successive progress bar waits while FxFoto copies the photo files and then saves the slide show. Then if Separate CD Burn Application is unchecked, the Windows CD Writing Wizard appears.  Under older versions of Windows or if you have checked Separate CD Burn Application, another FxFoto dialog appears asking you to start separate CD creator software to record the CD. But the Windows wizard normally asks you to insert a CDR blank if needed.  You cannot use a CD that has been formatted for Direct CD access. Use a new unformatted CDR or one that has been recorded with separate CD creator software or the Windows CD Writing Wizard, but has space left.

If Separate CD Burn Application is not checked or for older versions of Windows without the Windows CD Writing Wizard, you must switch to the CDR software that came with your compure or CD drive. Look for the FxFotoBurnCD folder in your My Documents or Documents.  Open into the FxFotoBurnCD folder so that it the files that this command places there appear and select all filed inside. Do not select the FxFotoBurnCD folder itself, just all files that appear inside of it.
Once you Finish the wizard, the photos, collage file and viewer or flash show and HTML page are recorded.  The resulting CD-ROM can be inserted into most Windows computers (even without Windows XP or Vista) to automatically view the photos as a slide show (or other presentation if you have created the current collage appropriately).
Note: You can also use the Upload command's Generic Hold for Later or Record to CD-ROM service to burn images to CD.  That command does not set up a collage viewer presentation on the CD. Instead it gives you more control over the image names and layouts for sending JPEG image files via CD-ROM to printers and other services.
See also:

Transfer Show to Movie File
Make Web or Flash Show
Achive Folder to CD-ROM
Upload
Transfer Slide Show to Movie File

This command is supported only by the Media Edition.  In other editions, it asks you to upgrade to the Media Edition and enable this and all other features.  There is no trial version of this command because MPEG is patented and requires a royalty payment when enabled.
Available both from the File menu and the Save button, this creates a MPEG movie file from the currently open slide show or other collage presentation.  They create MPEG files compatible with Video CD and DVD formats that can be placed on recordable CD and DVD discs with separate software not included in FxFoto.  Writable CDR discs can hold Video CD (VCD) and Super Video CD (SVCD) formats, while writable DVD discs can also hold even higher resolution DVD movies.
Note:  FxFoto creates VCD/SVCD/DVD compatible movies, but it does not record them to CD or DVD.  To burn movie discs, you must switch to another CD/DVD creator application capable of burning MPEG files.  The basic software comes recordable CD drives, such as Roxio Easy CD Creator (tm), is typically not capable of recording MPEG movie files to CD.  You must usually upgrade your CD creator software to the vendor’s premium version to record movies.  Or you can install another CD burn application that handles movies.  For example, see www.VCDEasy.org for an inexpensive application that can record movie files to VCD and SVCD discs on most CDR recorders.  The basic software that comes with most Recordable DVD drives, such as Sonic MyDVD (tm), is usually capable of recording MPEG movies to CD and DVD without upgrading.

Before using this command, you must create a slide show or photo collage tour in FxFoto.  Typically, you open a series of photos on separate slides and use the Slide tabs to set durations (Slide Settings), entrance and exit effects (Special Effects), and camera panning (Tour Panning).  Note that Automatic Slide Tour Panning can be particularly effective on video movies and the Random Direction and Apply Panning to All Slides make it easy.  Also the various rotating Special Effects can look even better on video than on the computer viewer.
Video Type

Choose the type of movie file to be created.  (Note that FxFoto can also create Flash SWF movies using the separate Make Web Slide Show command.)
Custom Settings allows you to choose the desired movie size and format. Note that not all settings are compatible with many viewers.  The Width and Height give the pixel size of the movie. 640x480 is often used for web sites while 320x240 is often all that portable devices can handle. The Frames / Second gives the movie frame rate and is often 25 or 30 fps. Rates below 25 fps are generally not allowed.

For Custom Settings, choose the movie file type: MPEG4, MPEG2>, AVI, or WMV.  MPEG4 and WMV are generally smaller and preferred for viewers that support them.  MPEG4 is supported by most Apple products while WMV is supported by Microsoft and the Windows Media Player.  AVI uses the common DIVX format.  Creating WMV video requires Windows Media 8, which may require upgrading the Windows Media Player.
Also for Custom Settings, the 48 KHz checkbox uses somewhat higher quality 48 KHz audio instead of 44 KHz, which is the audio CD standard.  FxFoto will vary the video bits per second (bps) with the chosen Width, Height and fps.  Check 3x bps for a much higher quality video in a much larger movie file with 3 times as many bits per second.  Check both 3x bps and 50% bps for somewhat higher quality video using 1.5 times as many bits per second.  Check only 50% bps to reduce the bits per second (bps) rate by half, resulting in a smaller but lower quality movie file.
iPod Video creates a 320x240, 25 fps MP4 with 48 KHz audio that is compatible with most video-capable Apple iPod ® models. These settings may also be compatible with other portable devices. Check 3x bps for much higher quality and movie file size. Check both 3x bps> and 50% bps for somewhat higher quality and file size. Check only 50% bps for a smaller but lower quality video.
YouTube creates a 640x480, 25 fps MP4 with 44 KHz audio in the format recommended for upload to www.YouTube.com.  These settings may also be compatible with other movie-capable web sites.  Check only 50% bps for a smaller but lower quality video file that is faster to upload. Note that YouTube normally has a 10 minute and 100 MB limit for uploaded videos.  The YouTube settings normally result in a movie file that is less than 100 MB for 10 minutes even when 50% bps is not checked.  Check 3x bps for much higher quality and movie file size. Check both 3x bps and 50% bps for somewhat higher quality and file size.

Video CD (VCD) and Super Video CD (SVCD) can be recorded to normal CDR discs with capable burn software and these CDR video discs play on most modern DVD players.  However, some DVD players, especially older ones, do not read VCD/SVCD formats and/or recordable media.  Some players may handle VCD but not SVCD.  DVD Video can only be recorded on writable DVD discs with a DVD recorder.
VCD and SVCD formats should also be recordable on DVD-RW and DVD+RW, which hold longer shows.  However a normal CDR holds over an hour of VCD and not much less SVCD, so time limitations are not usually a problem.

The SVCD and DVD formats are significantly higher resolution to show your photos with more detail.  Although SVCD resolution is 480 pixels wide, rather than the full 720 pixels on DVD, compatible players stretch the video to the normal 4:3 TV screen aspect and FxFoto automatically compensates so video pictures look normal.
VCD format creates MPEG-1 files which, although lower resolution, can be previewed on many computer players, such as the Windows Media Player (tm), though the aspect may not be correctly displayed on your computer screen.  SVCD and DVD formats create MPEG-2 files which are typically playable only by DVD player software.  Note that the MPEG-2 format used for SVCD and DVD and also the MPEG-4 format are patented.  The MPEG Licensing Association has granted FxFoto Media Edition users a license for personal use, but you may not distribute movies widely or commercially without an additional license from www.MPEGLA.com.  See the notice below.
Check PAL Format to create VCD/SVCD/DVD compatible with the PAL TV standard used in Europe, Australia and most of Asia.  Leave it unchecked to create NTSC standard video compatible with TV in North America and Japan.
Check Fast low-quality movie to speed up the MPEG movie file creation at the expense of movie quality.  Movies created with this fast setting may take significantly less time to create.  But they may be less compatible with some players, especially for the VCD format.
Choose the Default seconds per slide to control the length of slides and tour stops which normally wait for the Next button to be pressed in the FxFoto Viewer.

Background Music

Also choose the background music or other audio that accompanies your slide show video.  You can choose MP3, Ogg Vorbis (OGG) and WAV sound files.  But the MIDI files that are normally used with shows for the FxFoto Viewer cannot be recorded to MPEG movie files.
When the collage or slide show specifies MP3 or WAV Music for the whole show or certain slides, the movie can automatically use the specified collage music.  But MIDI music specified for the collage show cannot be used in the movie.  Otherwise, you can specify one or two Audio files in this dialog as the movie’s background music.  Uncheck Use MP3/WAV Music from the Collage Slide Show to force the movie to use the audio files specified in this dialog even if the show has MP3 or WAV music.  The Use MP3/WAV Music checkbox is disabled (grayed) if the current collage or slide show does not specify any compatible music to be used.
Unless the movie uses MP3/WAV music from the collage slide show, you can select one or two audio files.  The movie normally repeats one or both throughout the show.  The Media Edition comes with a small assortment of OGG music loop files, which although short, sound good when looped.  Moreover, some of the music loops, such as Waves and Waves2 are compatible and can be alternated on the movie sound track for a longer and more interesting musical background.

If the movie does use MP3/WAV music specified by certain slides but the collage slide show does not specify background music to begin the show, then audio specified in this dialog starts the show but changes to the specified slide music later.

Uncheck Use MP3/WAV Music from the Collage Slide Show to make sure the movie uses the Audio 1 and Audio 2 specified in this dialog.  Check it to use MP3 and WAV sounds specified by the show, if any.
Check Play Audio Only Once to play Audio 1 and then Audio 2 (if any) and then fill the rest of the movie with silence.
Check Truncate Audio to Fit the Video to stop the audio piece in the middle when the last slide ends. This can make the movie file significantly shorter.
Check Use for Audio 1 or Audio 2 to select one or two music or audio files.  Audio 2 is normally used for a variation on the Audio 1 loop and the two can alternate.
Press the Choose Audio buttons to select a source MP3/OGG/WAV file for either the Audio 1 or Audio 2. By default, FxFoto presents the standard OGG loop files that ship with the Media Edition. You can also select other music files from elsewhere on your computer. However, most music is copyrighted and should not be included in movies that will be copied to for other people.  Uncheck the Use to turn off the sound for the Audio 2, leaving only the Audio 1 track. You can also uncheck Use for Audio 1 for a silent movie.

Press the Test Audio buttons to hear the current selection.  Press Stop to halt the playback.  The test playback also stops when you leave the dialog.
Normally, the movie sound track alternates between the Audio 1 and Audio 2 pieces, playing each once and then the other.  If Use is unchecked for Audio 2, then Audio 1 repeats throughout the movie.  However, you can choose other sequences for interesting musical effects.  Choose 2X - 2X to play Audio 1 twice and then Audio 2 twice.  Choose 3X - 1X to play Audio 1 three times and then Audio 2 once before playing Audio 1 three times again.  Choose 4X - 4X to play each four times in a row.  Choose 6X - 2X to play Audio 1 six times and then Audio 2 twice.
Target Movie File

Choose the Target Video File Name to be created. Press the Browse button to use a popup file selector dialog.  FxFoto will automatically add the appropriate file name extension, .mpg for DVD/VCD and MPEG2, .mp4 for MPEG4, .avi for AVI, or .wmv for WMV files.  Movie files are typically many megabytes so the chosen target disk should have plenty of free space.  Remember the name and directory you specify so that later you can select the movie file for burning in your creator software or for uploading to a web site or portable device.

Begin Making Movie

Press the Begin button to begin converting the currently open slide show or collage tour to a movie file.  Since MPEG files are quite large, this can take longer than the show normally takes to view in real time.  If you press Cancel on the progress dialog, it may take several seconds or longer before FxFoto stops (depending on the length of the slide currently being processed).  However, the movie created up the point where you cancel may still be viewable.
Notices required by the MPEG Licensing Association:
Any use of this product other than consumer personal use in any manner that complies with the MPEG-2 standard for encoding video information for packaged media is expressly prohibited without a license under applicable patents in the MPEG-2 patent portfolio, which license is available from MPEG LA, LLC, 6312 S Fiddlers Green Circle, Suite 400E, Greenwood Village, Colorado 80111.
This product is licensed under the MPEG-4 Visual Patent Portfolio License for the personal and non-commercial use of a consumer for encoding video in compliance with the MPEG04 Visual Standard ("MPEG-4 Video"). No license is granted or shall be implied for any other use. Additional information including that relating to promotional, internal and commercial uses and licensing may be obtained from MPEG LA, LLC. See http://www.MPEGLA.com.
See also:

Burn Photos or Show CD-ROM
Import Photographs
Import Photographs

This command, reached from the Import toolbar button or from the File menu, allows you to choose photographs from a selected digital camera or other import source and store them in an FxFoto folder.  In can also import photos from a CD-ROM or disk and can scan for new photos.  This command does not appear in Quick Layouts.
You must have already installed any necessary camera driver software on the computer.  Typically, you must insert the CD-ROM that came with the camera and run at least the minimum setup before you can Import from the camera.

Before you start Import, be sure to:

1) Connect the camera cable to the computer.

2) Turn on the camera.

3) Set the camera to transfer mode (if needed).
Many cameras have a USB cable connection.  Sometimes you can remove the memory card from your camera and insert it in card reader attached to your computer.
Choose the Target Folder Name for the imported photographs.  Type a new name to import to a newly created left-pane folder.  Or choose an existing name from the drop-down menu (or by retyping it) to add the imported photographs to an old folder.  (A note for advanced users:  FxFoto normally creates new folders within Pictures or My Pictures.  You can use Import Target Folder Parent Directory in Options to have FxFoto create new import folders elsewhere.) 
To import from a connected camera or camera memory card, press the camera button labeled Camera or device.  Then click on your camera in the list of available sources.  Note that the camera may not appear even when properly connected if the camera memory card is empty and there are no photographs available for import.  If your camera appears with both (wia) and (twain) drivers, the WIA version is usually preferred.
Press the Advanced button for various special Import settings, such as how special camera interfaces handling and whether FxFoto asks about erasing imported photos from the camera.
You can also import pictures from any network or local Disk drive or directory.  Type the desired source path or press the nearby Browse button to choose from a tree of directories available from your computer.  To restore an FxFoto folder from CD when you previously used the Archive Folder to CD-ROM command, you should Browse onto the CD-ROM drive and choose the CD’s sub-directory for the archived folder.  This normally has the same name as the old FxFoto folder you are restoring.  Do not select the whole CD-ROM drive.  Instead select the appropriate folder within the CD-ROM drive.  FxFoto imports all JPEG and TIFF files from the selected directory folder (but not sub-directories of the selected directory folder).  It can also import movie files.

To scan or re-scan local disks or directories and include FxFoto folders for all their photos, press the Scan button and type the desired path.  Scanning does not import the photos.  It leaves them where they are on your computer and adds left-pane folders and thumbnails that point to the newly found photos.  If you leave the scan folder or disk blank, then FxFoto re-scans all of your local fixed drives.  Or you can choose a local disk folder to be scanned with Browse.  Sub-directories of the specified folder can be scanned as well when Scan Subdirectories is left checked.  FxFoto normally ignores subdirectories which usually contain application images that are not user photographs, but you can check Scan All Subdirectories to include these.  Each included directory or subdirectory with picture files creates a new FxFoto folder (or updates an existing folder with new or changed files).  You can also check Scan gif/png/bmp/vib files to look for these extra image types in addition to standard jpeg and tiff photos.  Note that FxFoto can show but cannot modify gif images.
Press the Next button to continue with the second step, Choosing Photos to Import.  There will typically be a delay while the photograph thumbnail images are gathered from the chosen camera or disk.  In most cases the entire photograph must be transferred to your computer in this step, so actually importing chosen photos to your FxFoto folder in a later step is faster.
Some (twain) and (wia) devices will show their own custom interface after you press Next.  In this case, you must choose any applicable device settings and close the popup device dialog before the next Choosing Photos to Import Import wizard dialog appears.  You can choose whether these device interface dialogs should appear with the Advanced button (but some devices will always show their interface dialog).

If the target is in a Locked folder, you must enter a password for the folder before continuing.

See also:

Choose Photographs to Import
Choose Photographs to Erase
Advanced Import Settings
Print Wizard
Advanced Import Settings
Some cameras can take movies as well as still photographs.  FxFoto can import these Windows .AVI or Apple QuickTime .MOV movies and then play them through the Windows or Apple media players.  But you can uncheck Import Movies to import only JPEG or TIFF still photographs.

Normally, the first Import Wizard dialog leaves the Target Folder Name blank for you to fill in.  It will not allow you to continue to the next step until you enter a folder name.  You can check Allow automatically created folder name to initially see a default name based on the last import folder name you used with an incremented ending number.  You can use the automatically created name or type a new one.  Note that if you check or uncheck this setting, you will not see the change until the next time you start the Import Wizard.
FxFoto arranges your photographs chronologically given the date and time they were taken.  But sometimes the source photo does not have a known creation date, typically when the date was not set on your camera after a battery change.  FxFoto uses the current date for photos which specify no creation date.  But sometimes the camera defaults to a date like January 1, 2001 at 12:00AM when no date is set.  A Current Date checkbox in this dialog allows FxFoto to assume that such photos have no creation date and time (even though Jan 1 at 12:00Am is specified) and use the current date and time.
For WIA (Windows Image Acquisition) cameras and other devices, FxFoto normally reads all photographs (and movies if enabled) to present in its second import dialog.  You can optional check Show WIA interface dialog to show a custom dialog for your camera to select only those photos to appear in the second FxFoto import step.  This introduces another step after you press Next in the initial Import dialog.  However some cameras supply their own WIA interface dialog that can show thumbnail images more quickly than they make available to external applications such as FxFoto.  If you do not plan to import all of the photos from you camera, checking this can save you time.  After selecting photos from the camera’s dialog, FxFoto’s Choose Photographs dialog appears and you can, if desired, narrow down your selection further and choose not to import some that you have pre-selected.

TWAIN cameras and devices also have their own optional pre-selection dialog that can appear before the second FxFoto Choose Photographs step.  Since most TWAIN drivers assume their own dialog interface will be used, Show TWAIN interface dialog is checked by default.  You can uncheck it to use any and all photos the TWAIN device provides in the second import step.  Note that some TWAIN sources do not support this and show their own interface regardless of this setting.
Many TWAIN cameras and devices transfer memory image bitmaps rather than files.  FxFoto can handle either, but some devices may incorrectly report that they can transfer files when in fact they cannot.  You can uncheck Allow TWAIN to transfer files to force FxFoto to request only memory bitmaps from TWAIN devices and not files.  By default this setting is checked so that FxFoto uses file transfers if supported by the device.
A few TWAIN devices may be incompatible with FxFoto’s normal import handler.  Check Simple TWAIN import handler to avoid import errors for such devices.  The simple handler is most appropriate for scanners and may not be able to import more than a single photo at a time.
Import normally presents a third step where you can select those photos to be erased from the camera or other source.  However, you can check Always erase imported photos from the source to skip the third step.  When checked, FxFoto automatically erases only those pictures which have been imported.  Note that some sources (such as TWAIN devices) do not allow photograph files to be erased from the PC.

Or you can check Never erase imported photos from the source to skip the third step.  When checked, FxFoto never erases imported photos from the camera or device.
Uncheck Rotate imported photos automatically using camera's EXIF Orientation if possible to stop from automatically rotating imported photos to match their EXIF Orientation settings if available. When checked, Import initially shows photos in with the camera's recommended rotation.

Note: Many cameras connect to your PC without using either WIA or TWAIN.  Such cameras show a disk drive of photograph files when connected and FxFoto supports the DCF (Design rule for Camera File system) specification to import their files.  Other cameras typically support both WIA (Windows Image Acquisition) for Windows ME, Windows XP or Vista systems and TWAIN (an older standard originally intended for scanners) for earlier versions of Windows.  Typically such cameras install either the WIA or TWAIN, depending on your version of Windows.  Most cameras also support the EXIF (Exchange image file format) standard for adding supplemental information to JPEG image files, such as the camera make and the date the photo was taken.
See also:

Import Photographs
Choose Photographs to Import
Choose Photographs to Import

Thumbnail images appear for all the photographs found on the chosen camera or disk.  Green [I] tags appear in the corner of those that FxFoto does not recognize as having been previously imported.  You can click on photo thumbnails to include or exclude them from the import, toggling the green tag on or off.  You can also use Include All or Exclude All to turn import on or off for all.
Also when you click on a photo thumbnail, a larger preview appears on the right.  You can right click to show the preview without toggling the green include tag.  When you click on a different photo for preview, its green include tag stays on and you must click a second time to exclude it.

Use Rotate Left or Rotate Right to rotate the selected photo 90 degrees as desired.  To rotate all photos with green include tags at once, depress the Rotate All button further down the dialog.  When Rotate All is down, then all included photos are rotated when you press either Rotate Left or Rotate Right.  When you click Rotate All again so that it is up, then Rotate Left and Rotate Right only rotate the previewed or selected photo.
You can also click on one or more keywords that apply to the selected photo.  Click keywords again to unselect them.  The New button allows you to add another keyword to FxFoto’s list of standard photo keywords.  The Purge button removes the last selected keyword from FxFoto’s list and from the selected photo.  (But Purge does not remove that keyword from any previous photos to which it has been applied.)  The Apply All button applies the currently selected keywords to all of the import photographs.
You also see the Creation Date for the blue-outlined photograph and can optionally press Change Date to modify it.  From the popup calendar dialog, you can choose a new date and/or time and press OK to set the selected photo or Apply All to apply the same new date and time to all import photos.
When you select an imported movie, the Play Movie button calls the appropriate media viewer to show it.

Press the Next button to continue to the last import step where you can Choose photographs to erase from the source.
TWAIN devices cannot erase source photos and so if your camera interfaces via TWAIN (but not via WIA or DCIM), Finish appears rather than Next on this dialog and the Import is finalized when you press it.  Finish also appears if you checked Always erase imported photos from the source or Never erase imported photos form the source in the Advanced Import Settings.
Also note that TWAIN devices cannot import movies.  When using TWAIN, choosing to import movies usually results in an error message.  However, most cameras which support TWAIN also support WIA.  WIA does not have these limitations on newer versions of Windows (Windows ME and Windows XP or better).
See also:

Import Photographs
Choose Photographs to Erase
Choose Photographs to Erase from Source

This final Import dialog works much like the previous Choose Photographs to Import, but allows you to select those photos that will be removed from your camera or other source after being imported.  Here red [X] tags appear for photos which will be deleted.  By default, only photos chosen to be imported are tagged for removal from the source.  Press the Erase All or Keep All buttons to add or remove red tags from all photos.
Note that not all cameras or other sources allow FxFoto to erase the source photographs.
Also when you click on a photo thumbnail, a larger preview appears on the right.  You can right click to show the preview without toggling the red erase tag.  When you click on a different photo for preview, its red erase tag stays on and you must click a second time turn erase off.
You can rotate, choose keywords and change the date for the selected photo during this erase dialog exactly as you did in the previous dialog, but of course you should do so only for photos chosen for import.
You can also press Show Included to show both the red [X] and green [I] tags.  However, clicking still toggles only the red [X] erase tags. Use the Back button to return to the previous dialog to change the green [I] include tags.
Press the Finish button to complete the import.  Before continuing and to avoid mistakes, FxFoto may ask if you are sure you want to erase the imported photographs.  It does not ask if you have made changes to the list of photos to be erased.  There may be another wait while photo files are transferred.
See also:

Import Photographs
Choose Photographs to Import
Print Wizard
Scan for Photographs

This command scans or rescans selected disks and folders for new photographs to appear in the left-hand folders.  You first see a selection tree where you select the disk and/or directory to be scanned.    All sub-folders of the selected disk or folder are also scanned.  This command allows you to add folders that are not normally included in the initial installation or to add new photographs from other applications.  This command is not available in Quick Layouts.
See also:

Import Photographs
Print Wizard - Choose Images

Before printing, open one or more photos or images by clicking on them in the left-pane (or by dragging them into the right pane or using Open or Add Image in the File menu).  To print multiple copies of the same photo, just open it more than once.
To print photos or slides or collage images, press the Save toolbar button and choose Print, or choose this command from the File menu.

Choose Images is the first step of the Print Wizard.  The second Print Wizard - Settings step shows configuration settings.  The third Print Wizard - Format step shows a print preview of the available page layout styles.  This third step also provides an Upload for Online Photo Prints or Sharing button that allows you to send images to a selected web service.  Otherwise, the final step is the Print control dialog for your printer.

In the first step, you see all open pictures in the collage.  Choose one or more to be printed by clicking on the images.  A green tag appears in the upper-right corner of all images to be included.  Clicking on a photo toggles the green tag either on or off.  Press Include All to mark all images with green tags for inclusion or press Include None to un-mark all images.

The chosen photos apply to most, but not all, of the print formats.  The Roped Area and View Area formats do not use these image tags since they always print either the photos showing in the current slide or in all slides.  Note that the Choose Images to Print button in the final print wizard dialog shows a popup dialog similar to this one for quick changes.
Press Next when the desired image or images have been chosen to continue with the configuration settings dialog.
Note: Before you start the Print Wizard, you can set the Print Size in the Options dialog.  This advanced setting limits the portion of the page that is printed to a given width and height in inches.  It allows you to specify the size of the printed image.  Be sure that this Print Size setting is 0 (zero) for normal full-page printing.  Also note that some printers allow the page size to be arbitrarily set within the print dialog preferences.  The Options Print Size setting only limits the printed image if smaller than the printer’s page setting.
See also:

Print Wizard - Settings
Print Wizard - Format
Saving Images
Print Wizard - Settings
This is the second step of the Print Wizard where you can specify various advanced print settings.  These settings can be controlled by and remembered in your collage file if you set Collage Controls Printing Parameters in the Collage Properties .
Check Print White Background to print white instead of the collage background color, which saves ink and may look better on many printers.  However, Theme Templates override this setting and always print the theme’s background.  Also, any background image for the collage is always printed.
Normally FxFoto resolves the print source image to 6400 pixels width or height, the equivalent of about 600 dots per inch.  When your computer’s physical memory is limited (less than about 420 MB), FxFoto may use a smaller resolution to avoid overtaxing your computer resources, but uses at least 3000 pixels of resolution.  For example, FxFoto might use about 5000 pixels resolution on a computer with 256 MB of memory.  To send as much resolution as possible to the printer, check Print Maximum Resolution, but this may be slow, especially if the computer has limited resources.  Or you can check Print Custom Resolution and enter a number of pixels either smaller than 6400 (for faster printing) or larger as desired.  A few printer drivers may run out of memory with large resolutions and require a smaller custom setting, but this is unusual.  To reduce the memory requirements or for faster printing, try the custom resolution set to 3000, 2600, 2000, 1600 or 1000.  Some printers may blend colors better at lower resolutions for a better looking result.

Check Rotate Image to Best Fit the Page if you want wide photos or images to be rotated 90 degrees relative to your printer’s current setting (whether landscape or portrait) so that they best fit the available page.  However and Title and/or Caption you select to print on this dialog are always printed at the top and bottom of the page (given your current landscape or portrait printer configuration) and so can end up sideways relative to the image.  When printing snapshots, the individual photographs are rotated as needed to best fit and not all photos on the page may be oriented in the same direction.

Check Rotate an extra 90 degrees and/or Rotate an extra 180 degrees to fix image rotation as desired.  This feature is useful for producing greeting cards and also for snapshot albums where all shots of the page need the same orientation.
Check Fit Snapshots to Given Size to force your printed snapshots (only for 1x1, 2x3, 3x5 and 4x6 print formats) to completely fill the intended area.  When checked, the snapshots will all print with uniform width and height.  They are automatically cropped on the left and right or top and bottom to fit.  When unchecked, the full photograph is fitted within the given snapshot size with extra white space left and right or above and below if needed.

Check Print Snapshots with Associated Frames and Text to include any frames plus title and caption text in printed snapshots (only for 1x1, 2x3, 3x5 and 4x8 print formats).  Normally snapshots are printed without frame and text annotations, but this setting allows them to print as they do for the Title and Caption print format.  You cannot set both Fit Snapshots to Given Size and Print Snapshots with Associated Frames and Text.
Check Print Snapshots with 4:3 Aspect to adjust the dimensions of printed snapshots (1x1, 2x3, 3x5 and 4x6 formats) so that they have the aspect used by most digital photos.  This allows the entire photo to appear without automatic cropping even when Fit Snapshots to Given Size is checked above.  When unchecked, FxFoto uses common print sizes such as 4x6 and 3.5x5.  When checked, FxFoto makes 4.5x6 and 3.75x5 inch snapshots, plus the 2x3 wallet size is less wide.
Check Borderless Printing to force non-snapshot printing (where there is one photograph per page) to completely fill the printer page.  When checked, the photo images are automatically cropped on the left and right or top and bottom to exactly fit the printer’s selected page size without extra margins.  If your printer can print to the edges of the paper size you select, then this option can produce borderless prints without any surrounding white area.  But for true borderless prints, your printer must be capable and you must choose a borderless paper type and/or the borderless option in the final Print dialog’s Preferences at the end of this wizard.  You should normally uncheck Add Title and Caption for borderless printing.  Framed photos or those with outside text annotations are poor candidates for borderless printing since parts of the frame or annotation text can be cut off.

Check Show Crop Mark Lines Outside the Printed Image to draw short black guide lines at the four image corners indicating the horizontal and vertical edges as an aid for cutting out the image.  Note that depending on the image size and the printable paper size, there may not be room for the crop marks and some may not appear.  For example, an 8x8 inch layout printed on 8.5x11 inch paper may not show horizontal crop marks on many printers because the printable area is not large enough.  It is usually a good idea to also keep the next Center Image Inside the Physical Printer Page options checked to leave as much room as possible for the crop marks.
Check Center Image Inside the Physical Printer Page to have FxFoto attempt to center the printed image or images so that the top versus bottom and left versus right borders are equalized on the printed page.  Many printers have a printable area that is not centered on the paper, often because they reserve a last strip to paper while printing the page bottom.  By checking this setting, FxFoto will add an equal strip of border on the other side of the page to center the printing.  This can result in a smaller printed image.  To maximize the printed image size, uncheck this setting to allow unequal borders around the printed image.  FxFoto depends on the printer settings being properly set for the paper you are using and cannot center the printing if the paper size is incorrectly set or if the printer incorrectly reports its printable page area.  When you use the Limit Printed Area described below, this Center Image checkbox also forces the limited print box to be centered on the paper rather than printed in the upper-left corner.
Check Add Page Margins to force FxFoto to move the left and top edges of the print.  Then fill in the desired non-zero left and/or top margins in inches or cm (which can be fractions such as 1.25 inches).  Non-zero margins include the unprintable area at the edge of the paper and must exceed the minimum blank area the printer requires at the edge.  The margins are ignored if larger than your printer’s page size or if they are set to zero.    Be sure to leave enough room after the margins the required print area.  The margins are automatically reduced if they are too big to allow the required print area, if any.  Note that unless you uncheck the previous Center Image setting, the printed image will be centered in the page area remaining right and below the given margins, which can have the effect of further increasing the margins.  Uncheck Center Image when using Add Page Margins and Limit Printed Area for better control of image placement on the page.  Leave Add Page Margins unchecked to have FxFoto fill the available printer page.
Check Limit Printed Area to force FxFoto to print only a limited page area.  Then fill in maximum width and height values in inches or cm (which can be fractions such as 3.5 inches).  Normally this setting should be left unchecked so that FxFoto fills the available printer page.  If you need FxFoto to limit the printed area of the page to a specific width and height, check and set the desired size in inches or centimeters.  For example, passport photos may require a specific image size.  The rest of the printer page right and below the printed area is left blank.  This setting only limits the printed image if smaller than the page size set in the printer’s preferences.  If your printer is set for a smaller paper size, the limits are ignored.  To force a single photo to print to the exact width and height dimensions, you should also check Borderless Printing (which is just above the Limit Printed Area checkbox).  With borderless printing, the photo will be automatically cropped as needed to fit the specified size.  Without borderless printing, extra white area may be added above and below or left and right in order to show the entire photograph.  When printing multiple snapshots per page, the limits are for the entire page of photos and not the individual images, which will be smaller.  Use the Center Image checkbox described above to print the given size centered on the paper rather than in the upper left corner.
Please Note: Collages using Printer Page Layout inch or centimeter Page Guides ignore the Add Page Margins and Limited Print Area settings when printing with the Entire Collage Format.  The margins and limits set on this dialog have no effect for Printer Page Layout collages because the layout predetermines the page margins and size. Collages using inch or cm Custom Page Size guides also ignore the Limited Print Area for Entire Collage.  In addition, FxFoto ignores Borderless Printing and may ignore the Center Image setting when printing collage layouts.

Also Note:  Some collage themes intended for printing on special paper may override various print settings, including specifying margins and a fixed print area.  FxFoto’s print settings will revert to your normal defaults when you next print without loading the theme.
Check Add Title and Caption to place a custom message at the top and/or bottom of the page.  You can type whatever you like in two lines that appear centered on the page.  Typing [[NAME]] inserts the image or folder name and [[DATE]] inserts the image or collage last-modified date in your text. You can also specify [[PAGE]] for the page number.  By default, the name appears at the top and the date and page number at the bottom.  Since title and caption text usually detracts from the greeting card style, it is automatically omitted.

Press Next to continue with the layout format and preview dialog.  Or press Finish to go directly to the final Print dialog to start the print job with the current default options.

See also:

Print Wizard - Format
Print Wizard - Choose Images
Saving Images
Print Wizard - Format
This is the third step of the Print Wizard. You are asked for the print area layout option (where some selections may be disabled if not currently possible).
Note:  If you are printing a collage layout with a specified Print Size (see Collage Settings Page Guides), then you should choose Entire Collage.  The layout prints at your specified Print Size in inches or centimeters only with the Entire Collage format and only if the required size fits on your printer page.
Select the Original Image to print the image file at the highest possible resolution without any overlaid text, drawing or frame effects.  If there are two or more pictures in the collage, press Choose Images to Print to add or remove open photos from those being printed.
The Composed Image prints any image annotations (such as frame effects and overlaid text or drawing.  It also shows any image rotation.  If there are two or more pictures in the collage, press Choose Images to Print to add or remove open photos from those being printed.
You can also include the surrounding Title and Caption text in the saved image.    You must have clicked on the main image, rather than the title or caption.  Title and Caption also includes any other images that are glued to the selected one.  If there are two or more pictures in the collage, press Choose Images to Print to add or remove open photos from those being printed.
Print the Roped Selection collage area outlined by a pre-selected rope, which can include more than one photo.  You must use the Mouse to rope modes to pull the desired rectangle outline first before beginning the print command.

You can also print include all of the collage inside the Visible View Area for current widow view.

Choose the Entire Collage to print all images for the each slide reduced as needed to fit the single page.  Each selected slide prints on a separate page.  Choose the Entire Collage format to print a Printer Page Layout or Custom Page Size collage with an inch or centimeter scale layout.  White appears as the background color unless the Print White Background setting has been unchecked on the previous dialog or in Options.
The Greeting Card type prints the image on the right side of the paper so that you can fold it into a card.  Only one image prints per page.  Unlike the snapshot types, the greeting card image is composed with its frame, title and caption annotations if applicable.  If there are two or more pictures in the collage, press Choose Images to Print to include or exclude collage images from the printed pages.  Note that you can use the Rotate 90 and Rotate 180 checkboxes in the previous Print Settings to rotate your picture so that it appears on the front rather than inside the card or so that the card opens vertically.
Choose 1x1 Contact Sheet to print tiny thumbnails without annotations for all or selected collage images.  If there are two or more pictures in the collage, press Choose Images to Print to include or exclude collage images from the printed pages.

Choose 2x3 Snapshots to print nine wallet-size snapshots per page without annotations, each approximately 2.125 by 3.125 inches (or 2.125 by 2.833 if 4:3 aspect snapshots are chosen in the previous Print Settings  dialog).  If there are two or more pictures in the collage, press Choose Images to Print to include or exclude collage images from the printed pages.  

Choose 3x5 Snapshots to print four snapshots per page without annotations, each approximately 3.5 by 5 inches (or 3.75 by 5 if 4:3 aspect snapshots are chosen in the previous Print Settings  dialog).  If there are two or more pictures in the collage, press Choose Images to Print to include or exclude collage images from the printed pages.  Note: The full 3.5 x 5 inch snapshots require the printable area for the selected printer page type to be sufficient.  If you have checked Center image inside the physical printer page in the previous Settings dialog, the centered printable area may be too small, resulting in smaller snapshots.  With most printers set for 8.5x11 inch paper, 3x5 Snapshots can print full size if Center image inside the physical printer page is unchecked.
Choose 4x6 Snapshots to print two snapshots per page without annotations, each 4 by 6 inches (or 4.5 by 6 if 4:3 aspect snapshots are chosen in the previous Print Settings  dialog).  If there are two or more pictures in the collage, press Choose Images to Print to include or exclude collage images from the printed pages.  

Note that by default, 1x1, 2x3, 3x5 and 4x6 Snapshots print only the photo without any frame or text you have added.  However you can check Print snapshots with associated frames and text in the previous Print Settings dialog to include frame and text annotations for these snapshot print modes.
The right side of this dialog gives you a low resolution preview of the printed page.  The blue buttons can be used to preview other pages.

The Choose Images to Print button pops up an image selector showing all primary images in the collage so that you can include or omit specific photographs from the print job.  This button does not apply to certain print styles.
The Upload for Online Prints or Sharing button allows you to sent the chosen print images to an online web service rather than to a local printer.  This button is disabled if no online services are available.
Press Finish to present the Windows Print dialog where you can select the desired printer and change its Preferences before starting the print job. You must set the printer's preferences for the type or size paper being used. Neither FxFoto nor the printer can tell what paper is loaded. FxFoto can only print as large as the paper size selected in your printer preferences. So if you are using small photo paper, then FxFoto can print a full page photo to the desired size if you have chosen its Original Image, Composed Image or Title and Caption with Image formats, but only if the printer supports the desired paper size and only if you have set that size in your printer's Preferences after you press Finish in the FxFoto Print Wizard. Conversely, if your printer is set for small photo paper, snapshot formats cannot print at the proper size because they need full size paper, and FxFoto must reduce each page to fit the printable area reported by your printer. The Preferences dialog is part of your printer driver and will vary from printer to printer, so check you printer documentation for details.
Hint: FxFoto keeps a copy of the last printer settings used from FxFoto and supplies them as the default when it prints the next time. You can clear those remembered settings so that your printer's default settings are used with the Restore FxFoto Default Settings button in FxFoto's Options dialog.
See also:


Print Wizard – Choose Images

Print Wizard - Settings

Upload for Online Prints

Print Image
Print Selected Image

This command prints only the selected or last-clicked right-pane image.

See also:

Send Image Email
E-Mail Image

Available from the Save toolbar button (and also from the File menu), EMail prepares images for emailing and can use your default e-mail application to send the selected images. Before emailing, open one or more images by clicking on them in the left-pane (or by dragging them into the right pane or using Open or Add Image in the File menu).
A preliminary Choose Images to E-Mail dialog appears. Only the last clicked or last opened image is initially selected with a green [I] tag, but you can include or exclude images by clicking on them. Press Next to continue with the main Email dialog. Note the green-tagged images are irrelevant to some of the choices such as Roped Selection or Visible View Area.  But for Original Images, Composed Images, or Title and Caption Images you can send multiple image attachments by selecting more than one image.
A preview area on the right side of the dialog shows a small version of the selected image to be e-mailed. If more than one image or slide has been chosen, press the blue right or left arrows to preview the other images. The current preview image number and the total number of chosen images, such as 1 / 3 appear below the preview.  Press the Back button to change the images selected for e-mailing.
Select the Original Images to send the image file or files at the highest possible resolution without any overlaid text, drawing or frame effects.  If there are two or more pictures in the collage, press Choose Images to E-Mail to add or remove open photos from those being e-mailed.
The Composed Images sends any image annotations (such as frame effects and overlaid text or drawing.  It also shows any image rotation.  If there are two or more pictures in the collage, press Choose Images to E-Mail to add or remove open photos from those being e-mailed.
You can also include the surrounding Title and Caption text in the e-mailed image.    You must have clicked on the main image, rather than the title or caption.  Title and Caption also includes any other images that are glued to the selected one.  If there are two or more pictures in the collage, press Choose Images to E-Mail to add or remove open photos from those being e-mailed.
Send the Roped Selection collage area outlined by a pre-selected rope, which can include more than one image.  You must use the rope toolbar buttons to pull or draw the desired rope outline first before beginning this command.

You can include all of the collage inside the Visible View Area for current widow view.

Choose Entire Collage to send the whole slide or layout. When neither Send Collage Viewer File nor Send Flash MHT Package are checked, FxFoto sends a de-resolved image file showing the entire collage or for each chosen slide. White appears as the background color unless the Print, Email, Upload White Background setting has been unchecked in Options.
When Entire Collage is chosen, check Send Collage Viewer File just below to send the full collage presentation requiring the free FxFoto Viewer. The image size settings on this dialog are ignored with this option.  Send Collage Viewer File is not enabled in the Standard Edition and requires an upgrade.
When Entire Collage is chosen, check Send Flash MHT Package to send the entire current slide show. See the Make Web Slide Show for MHT limitations and details. All slides are included even if not all photos were selected for emailing. This option uses the default settings from Make Web Slide Show and you should use that command instead to change settings or add a title. The image size settings on this dialog are ignored with this option.  Send Flash MHT Package is only enabled in the Media Edition, though a trial-only version is available using Make Web Slide Show.
Check Send TIFF to send TIFF format image files rather than JPEG. TIFF images are much larger but are usually somewhat higher quality since TIFF does not use "lossy" compression.

You can deresolve the emailed images. Smaller sizes result in significantly faster e-mails but with fuzzier image quality.  Some email systems cannot handle huge attachments and you may need to reduce the size if you are sending many large images.  Choose Full Image email full-size images.  The Maximum Size for Saved Images Options setting may limit the Full image size so that large collages do not result in huge image files that may require excessive computer resources.  Choose 2 Megapixel or 1 Megapixel for smaller images that may still be suitable for printing. Choose Large, Medium or Small Image for an even smaller email where the images may not be suitable for close examination.  Or check Custom size and type the desired width or height pixel limit.

You may also choose an Image Name for each photo or collage image to be e-mailed.  By default, this is the base name of the associated original photo file or, if you have entered a popup description for the photo, the first line of this description.  (See Picture Information or Picture Description)  Use the right and left arrow buttons to view each of selected images and type a new name or label as desired for each.  Some online services may have the name field disabled.  Note that changing formats and choosing photos can reset to default names, so choose the format and tagged photos first before changing photo names.

Check Zip Images with Secure Password Encryption to send a zip file containing all of the specified images.  Enter a Zip Password to encrypt the zip file so that the recipient must re-enter the same word or phrase to view the images.  The password is case sensitive and cannot exceed 30 characters. You must enter the same password a second time in Repeat Password.  You may leave the passwords blank to send a non-encrypted zip file that can be viewed without a password. Zip Images is only enabled in the Creative and Media Editions.
FxFoto's EMail can start your default email software, passing it the images you specify for attachments. This requires a MAPI-compatible email client and cannot be used with most browser-based web mail services. EMail can also just prepare the attachments files for webmail and email software that is not MAPI-complaint.
Check Copy Images to FxFotoUpload for Webmail to prepare image attachment files without starting your email application.  A special FxFotoUpload folder is created within My Documents or Documents, where it is easily found from your email's Attach file selector.  Any previous FxFotoUpload files are automatically erased and the new image files are copied there.  After you press Finish, just switch to your email application or web browser email, start a new message and use its Attach button, which may have a different name. Navigate your email's file selector to My Documents or Documents and then into the FxFotoUpload sub-folder. Choose all files inside FxFotoUpload for sending, since these are the images chosen from the most recent FxFoto EMail command.
Check Pass Images to MAPI email application to start the default email software, asking it to create a new email message with the FxFotoUpload image attachments. This requires MAPI-complaint email and does not work with most browser-based webmail. When the new email message pops up, simply address it and add your own subject and text.
Press Finish to copy the selected images to FxFotoUpload and optionally start your email application to send a message. Press Back to return to the Choose Images to E-Mail dialog.
See also:


Upload Wizard

Saving Images
Upload Wizard for Online Prints or Sharing

Before uploading, open one or more photos or images by clicking on them in the left-pane (or by dragging them into the right pane or using Open or Add Image in the File menu).

This command makes it easy to upload selected photos or images.  You can use online services to order professional quality prints or to share your photos across the web.  It is reached by pressing the Save toolbar button and then choosing Upload or via the File menu.
The Upload wizard also allows you to easily send photos to other applications, such as email clients that are not compatible with FxFoto’s EMail command.  Available services can even burn image files to CD-ROM or change the Windows wallpaper image.
Choose Images

In the first step, you see all open pictures in the collage.  Choose one or more to be printed by clicking on the images.  A green tag appears in the upper-right corner of all images to be included.  Clicking on a photo toggles the green tag either on or off.  Press Include All to mark all images with green tags for inclusion or press Include None to un-mark all images.

The chosen photos apply to most, but not all, of the upload formats.  The Roped Area and View Area formats do not use these image tags since they always use either the photos showing in the current slide or in all slides.  Note that the Choose Images to Upload button in the third upload wizard dialog shows a popup dialog similar to this one for quick changes.
Press Next when the desired image or images have been chosen to continue with the wizard.

Choose Service

First Choose a Service by clicking on the desired line to highlight it.  Then press Next to continue.

Some services enable an associated Sign Up button which you can press if you do not already have an account there.  If enabled, press Sign Up to popup your web browser at the new members’ page and follow the directions there.  Record your information such as user name and password so that you can enter them later in the upload wizard.  Return to FxFoto by closing the browser window or switching back to the FxFoto window.  Once you have enrolled, there may be a delay before your account is active and continuing with the upload may not work immediately.
Note: Some online services may not be compatible with older versions of Windows (such Windows 98 or Windows 2000) until you update to Microsoft’s Internet Explorer 6 or latter.  FxFoto may be unable to sign up or log into these services unless you have Internet Explorer 6.  Also, Windows 2000 may need to be updated with Service Pack 4 (or possibly with 128 bit SSL encryption) for some services.
The Generic Upload Service places your chosen photos in an easy to find FxFotoUpload directory off of Documents or My Documents, but does not do the upload.  Instead you use the web site’s upload, choosing the FxFotoUpload files.
Use Generic Hold for Later / Record to CD / Save to Key Disk or Memory Card to add images to FxFotoUpload without removing previous ones and/or to burn the images to CD-ROM.  This service is similar to Generic Upload Service, but with additional flexibility.  It allows you to accumulate photos or collage images to be uploaded or burned to CD.  A Delete any previous images checkbox at the end of the wizard allows you to optionally erase old FxFotoUpload images.  Otherwise, the new images are added to any FxFotoUpload photos you previously created.
The same Hold for Later / Record to CD / Save to Key Disk or Memory Card also presents three additional checkboxes at the end of the Upload wizard.  Include Captions.txt can be checked at the end of the wizard to log the names and descriptions of added images as a separate text file in FxFotoUpload.  Save to Key Disk or Memory Card can be checked to copy the images to a removable device that you can carry to a photo printing kiosk or elsewhere.  Record to CD-ROM can be checked to burn all FxFotoUpload files to CD at the end of the wizard.  Note that recording images using this Upload command is similar to FxFoto’s Burn CD-ROM Photos Collage, but it does not make the CD into a self-starting collage viewer presentation.  Instead, it always records JPEG image files and gives you control over image names and layout formats.  Using Upload to burn a CD-ROM may be better when you need to send images via CD to a print service.  If you have the Standard Edition, CD recording requires an FxFoto Upgrade.
The Set Windows Desktop Wallpaper service does not upload the chosen image.  Instead it makes the photo image your desktop background image.  Only a single photo image is used, even if you have chosen more than one.  It places a BMP version of the image in a special FxFotoWinSet directory off of Documents or My Documents and sets Windows to display it as your desktop wallpaper.  Some versions of Windows may revert to your old wallpaper when you restart the computer. To make the photo wallpaper permanent, you can use the Window Control Panel's Display Desktop settings and choose the image file FxFoto saves in FxFotoWinSet. You can also use the Windows Control Panel to switch back to a standard image.

Format

The third step of the Upload Wizard asks for the image area layout format (where some selections may be disabled if not currently possible).

A preview area on the right side of the dialog shows a small version of the selected image to be uploaded.  If more than one image or slide has been chosen, press the blue right or left arrows to preview the other images.  The current preview image number and the total number of chosen images, such as “1 / 3” appear below the preview.  Press the Choose Images button to change the photos selected for uploading.

Select the Original Image to upload the image file without any overlaid text, drawing or frame effects.  If there are two or more pictures in the collage, press Choose Images to Upload to add or remove open photos from those being uploaded.
The Composed Image uploads any image annotations (such as frame effects and overlaid text or drawing).  It also shows any image rotation.  If there are two or more pictures in the collage, press Choose Images to Upload to add or remove open photos from those being uploaded.

You can also include the surrounding Title and Caption text in the saved image.    You must have clicked on the main image, rather than the title or caption.  Title and Caption also includes any other images that are glued to the selected one.  If there are two or more pictures in the collage, press Choose Images to Upload to add or remove open photos from those being uploaded.
Use Roped Selection to upload the collage area outlined by a pre-selected rope, which can include more than one photo.  You must use the Mouse to rope modes to pull the desired rectangle outline first before beginning the Upload command.

You can also upload an image including all of the collage inside the Visible View Area for current widow view.

Choose Entire Collage to upload an image for each slide or layout.  Each selected slide uploads as a separate photo.  White appears as the background color unless the Print, Email, Upload White Background setting has been unchecked in Options.
For online prints, you should normally choose Full Image.  But for online viewing and sharing, you can greatly speed up the time it takes to upload by choosing one of the other Deresolve choices.  Smaller maximum pixel width or height limits result in smaller uploaded photo files and faster uploading.  Also, deresolved photos take up less space on the online service and you may be able to store many more photos online without exceeding your space allotment.  But if you allow FxFoto to deresolve, paper prints of the uploaded photos may be fuzzy.  The Maximum Size for Saved Images Options setting may limit the Full Image size so that large collages do not result in huge image files that may require excessive computer resources.
Hint:  For good quality photo prints, you may want to upload photos with at least 300 dots per inch.  If you deresolve for faster uploading, try keep enough pixels so that the print width or height in inches multiplied by 300 is the chosen resolution.  For example, a 4x6 inch print would need 6 inches x 300 DPI or 1800 pixels across and you could deresolve photos larger than two megapixels to Custom size 1800 or maybe 2 megapixel 1600 resolution.
You may also choose a Photo Name for each photo or collage image to be uploaded.  Some services may call this a Label or a Caption and it may be disabled for other services.  By default, this is the base name of the associated original photo file or, if you have entered a popup description for the photo, the first line of this description.  (See Picture Information or Picture Description)  Use the right and left arrow buttons to view each of selected images and type a new name or label as desired for each.  Note that changing formats and choosing photos can reset to default names, so choose the format and tagged photos first before changing photo names.
Depending on the chosen online service, you must either press the Next or the Finish button to continue.  If the service cannot accept automatic uploading, then FxFoto will present Manual Upload Directions for finding and uploading the chosen photo image files in a special FxFotoUpload folder off of Documents or My Documents.
Login

When FxFoto automatically uploads the photos, the online service may require that you authenticate your account by supplying your user name or email and a password.  You must already have an account with most services before you can upload to them.
Some services may also ask for your gallery address or sub-domain name.  If required, this field appears first, above the user name or e-mail.  It is usually the browser address for your gallery such as mygallery.service.com, where you normally enter only the mygallery name before the first dot.

The user e-mail and password may be optional with some services.  If optional, you should only enter a password if you have already set up an account at the service.  Otherwise, you will be asked for your information at the service’s web site after you have uploaded the selected photos.

Enter the required information and press Next to log into the online service.  If the fields are disabled, just press Next.  If the service does not require a target album, a Finish button appears instead of Next and uploading begins immediately.
A progress bar dialog appears while FxFoto waits for the service to reply to your login information.  While waiting, you may press Cancel to abort and return to the Login dialog.
Target
Some services allow you to specify a target album or folder to receive the uploaded photos.  There may be a list of available targets in the drop down menu or you may be able to type the desired name.  If the service does not allow you to create a new target at this time, FxFoto may beep and refuse to continue if you type a name that is not one of the available choices.
Some services also allow you to specify a category for a new album or folder.  Again there may be a list of available categories in the drop down menu or you may be able to type the desired name.  If the service does not allow you to create a new category at this time, FxFoto may beep and refuse to continue if you type a name that is not one of the available choices.  Even if enabled, the chosen category may be ignored unless you enter a new target album or folder name that does not already exist.
After choosing the target, press the Finish button to begin uploading your photo images.  If the both target fields are disabled, just press Finish.
Note:  FxFoto gets a new list of available target album or folder names from the service when you login.  If you switch to your web browser and add a new album or folder, you should backup and redo the login step of FxFoto’s Upload wizard to include new additions in the drop-down menu.
Uploading
A progress bar dialog appears while FxFoto uploads the chosen photos.  Uploading can take a long time, especially if you have chosen many full resolution photos or have a slow Internet connection.  The progress bar shows the number of photos that have finished uploading and estimates the percentage of the total upload time that has gone by.  However, the bar size may not accurately predict the remaining upload time, especially if your connection speed varies.  If FxFoto underestimates the time required, the progress bar may reach 100% and may jump to a lower percentage before the upload actually finishes.  When finished, FxFoto makes a completion sound and the progress bar disappears.
You can press the Hide button to have FxFoto continue uploading in the background.  FxFoto still sounds the completion beep and pops up the browser showing the chosen online service when uploading finishes in the background.  You cannot exit FxFoto while uploading in the background.  You need to cancel or finish uploading before FxFoto will exit.  After you press Hide, you can press the Upload toolbar button again at any point to return to the upload progress bar dialog.
Press Cancel from the progress bar dialog to abort the uploading.  Previously uploaded files may still be available at the online service.
When uploading finishes, FxFoto may automatically pop up you default web browser showing the chosen online service.  Note that some online services may be configured so that FxFoto never pops up the web browser after uploading.  If so, just start your browser and visit the service to work with your uploaded photos.  After finishing with the service, close the browser to return to FxFoto.
Note: Some services may popup your browser immediately rather than uploading via the FxFoto progress bar dialog described above.  These services typically require that you use Microsoft Internet Explorer as your default browser.  The browser pops up immediately and uses an ActiveX control from the service to upload your photos.  The first time you upload, the service’s upload control will be automatically downloaded (which takes some extra time) and Internet Explorer will ask your permission to install it.  You must allow the service’s control to be installed to automatically upload your photos.  (Though you can also visit service’s web site and manually upload photos by looking for them in the FxFotoUpload directory off of Documents or My Documents.)
See also:


Open Recent Files

Manual Upload Instructions
Directions for Manually Uploading Photos
You reach this dialog from the Upload Wizard when you must manually upload from the online service.  If the chosen service does not accept automatic uploading, FxFoto still makes it easy to upload your chosen photo images.  It places all of the chosen photo image files in a special easy-to-find directory.  Only copies of the chosen photos or collage images are placed in the FxFotoUpload folder.
For some selected services, this dialog may show a few extra checkbox options.  However these options do not appear for other services.  Most of these extra checkboxes are only available if you have selected the Hold for Latter / Record to CD-ROM / Save to Key Disk or Memory Card service.
If it appears, uncheck Delete any previous images already in FxFotoUpload to add more photos without removing old upload files.  When checked and also when this extra checkbox does not appear, any old FxFotoUpload files are removed.
Also if it appears, you can check Erase source folder photos after copying to save space to delete selected photos from the original left-folder after they are copied to FxFotoUpload.  You should normally leave this option unchecked unless using a small portable device with limited disk space.  This option is normally available only for FxFoto Portable Pictures Hold for Kiosk.
If Maximum Quality Upload Files appears, check it to save JPEG images at the maximum 100 quality level.  Upload files will be significantly larger but may represent text and other fine features with more clearly.

If TIFF Upload Files appears, check it to use TIFF format images rather than JPEG for uploading.  TIFF files will usually be many times larger and may not be accepted by all online services.  But they do not have compression artifacts inherent in JPEG images.
If Include Captions.txt log of photo names and decriptions appears, it can be checked to create or add to a text file in FxFotoUpload.  The Captions.txt logs each added photo with text lines giving its name and any popup description.  Captions.txt allows you to document the images and can be read with any word processor or text editor.
If Save FxFotoUpload image files to Memory Card or Key Disk appears, it can be checked to place the images on a removable disk that you can carry to a photo processor or elsewhere.  The chosen images are saved to a key disk or camera memory card that must be plugged into the computer, normally via a USB port.  This checkbox may be disabled if no device is available and you must cancel and restart the FxFoto Upload wizard after plugging in the device.  When checked, the image files are saved in a folder named FxFotoUpload within the device disk (rather than in Documents or My Documents on the fixed disk).  
If Record FxFotoUpload image files to CD-ROM appears, it can be checked it to burn a CD with your chosen upload images after you press Continue.  You can either start a new CD-ROM or add more files to a CD.  FxFoto requires Windows XP (or better) to directly write to CD.  For older versions of Windows or when you have checked Use Separate CD Burn Application in Options, FxFoto copies the files to an FxFotoBurnCD directory within Documents or My Documents and you must start separate CD creator software to burn the contents.  FxFoto automatically removes FxFotoBurnCD after you indicated that you have finished recording the CD-ROM.
Note: Even if you are using Windows XP or Vista, you may not want FxFoto to directly record to CD.  FxFoto uses the Windows CD Writing Wizard, which does not yet support DVD recorders and which may be incompatible with some third party CD recording software.  If you have CDR software from companies other than Roxio, such as some Sonic software, it may disable the Windows CD Writing Wizard and result in an error message when the wizard attempts to write directly to a CDR.  To avoid this problem, check Use Separate CD Burn Application in the FxFoto Options.  This causes FxFoto to save files to be burned in a separate FxFotoBurnCD directory off Documents or My Documents so that you can switch to your separate CD or DVD creator software to record.  If you have the Standard Edition, CD recording requires an FxFoto Upgrade.
When you press the Continue button, FxFoto creates an FxFotoUpload folder off of Documents or My Documents.  It automatically erases any old files in FxFotoUpload (unless a Delete checkbox appears and was left unchecked).  All selected photo images are copied to the FxFotoUpload folder.  Then the chosen online service may appear in a popup web browser window, but for generic uploads FxFoto does not start your browser at this point.
While using the chosen web service, employ its usual upload command that provides a Browse button or some similar device for choosing files to be uploaded from your computer.  Navigate the file selector to Documents or My Documents and then into the special FxFotoUpload sub-folder.  Select all files in FxFotoUpload for uploading.

Remember, the chosen photo files are available for uploading in:

...\My Documents\FxFotoUpload
(When holding photos on portable devices, FxFotoUpload may be placed in the Documents folder on the device, such as E:\Documents\FxFotoUpload, or as a top-level folder like E:\FxFotoUpload.)
After uploading the photos for online prints or sharing, close the browser to return to FxFoto.
See also:


Upload Wizard

Open Recent Files
Choose Images

This dialog appears for the Print, E-Mail and Upload wizards. It also also when creating a CD-ROM, Web Clickable Thumbnails or a PDF File.  You see all open images in the collage.  Choose one or more to be used by clicking on the images.  A green tag appears in the upper-right corner of all images to be included.  Clicking on a photo toggles the green tag either on or off.  Press Include All to mark all images with green tags for inclusion or press Include None to un-mark all images.  Press Next or OK when the desired image or images have been chosen to continue or return to the original dialog.
See also:


Print Wizard

Send Image Email

Upload Wizard

Open Recent Files
Convert to PDF File

This command is supported only by the Media Edition. In other editions, it marks the saved PDF images as "Trial Only" and you must upgrade to the Media Edition to enable this and all other features.

Available both from the File menu and the Save button, this creates a PDF file from the currently open photos or slide show.

Before converting to PDF, open one or more photos or images by clicking on them in the left-pane (or by dragging them into the right pane or using Open or Add Image in the File menu).

In the first step, you see all open pictures or slides. Choose one or more to be saved by clicking on the images. A green tag appears in the upper-right corner of all images to be included. Clicking on a photo toggles the green tag either on or off. Press Include All to mark all images with green tags for inclusion or press Include None to un-mark all images. The chosen photos or slides appear as separate pages within a single PDF file. Note that each PDF file is limited to a maximum of 1,000 image pages or slides.

Next, select one of the image format buttons (where some selections may be disabled if not currently possible). A preview area on the right side of the dialog shows a small version of the selected image to be saved. If more than one image or slide has been chosen, press the blue right or left arrows to preview the other images. The current preview image number and the total number of chosen images, such as "1 / 3" appear below the preview. Press the Back button to return to the photo selection dialog.

Select the Original Image to save the images without any overlaid text, drawing or frame effects. If there are two or more pictures in the collage, press Back to add or remove open photos from those being saved.

The Composed Image save any image annotations (such as frame effects and overlaid text or drawing). It also shows any image rotation. If there are two or more pictures in the collage, press -Back to add or remove open photos from those being saved.

You can also include the surrounding Title and Caption text in the saved image. You must have clicked on the main image, rather than the title or caption. Title and Caption also includes any other images that are glued to the selected one. If there are two or more pictures in the collage, press Back to add or remove open photos from those being saved.

Use Roped Selection to save the collage area outlined by a pre-selected rope, which can include more than one photo. You must use the Mouse to rope modes to pull the desired rectangle outline first before beginning the Convert to PDF command.

You can also save an image including all of the collage inside the Visible View Area for the current window view.

Choose Entire Collage to save an image for each slide or layout. Each selected slide saves as a separate page in the PDF. If the current layout has Page Guides with an inch or centimeter scale, FxFoto will switch the Image Width and Image Height settings to the layout size and show them grayed when you select Entire Collage.  Plus the 300 dpi resolution setting is checked by default for sized layouts.  Otherwise, you must set the Image Width and Image Height for the desired layout or slide print size.  Note that white appears as the background color if the Print, Email, Upload White Background setting has been checked in Options.

Slide Show is similar to Entire Collage, but tells the PDF viewer to show the images full-screen as an automated slide show. The PDF viewer cannot use the same entrance and exit effects or background music that the FxFoto Viewer can. You must choose one of the available wipe transitions from the drop-down menu just below to be used for the entire show. Also set the Slide Transition and Slide Duration times in seconds. The Slide Transition time is limited to 10 seconds and the Slide Duration time is limited to 60 seconds. When you switch to the Slide Show mode, FxFoto automatically selects all open slides or photos to be used and switches to the smaller 96 dpi resolution for screen viewing.

Check Borderless Image to have FxFoto automatically crop a little off the top and bottom or left and right sides of each image if needed to make it exactly fit the Image Width and Image Height proportions.

Check Start PDF Viewer to show the new PDF file in with the default PDF Viewer application, which must be separately installed on your computer.

Check Maximum Quality Embedded JPEG Images to save images inside the PDF file at the maximum 100 quality level. The PDF file will be significantly larger but may represent fine features with more clearly.
Check Perfect Quality Embedded CMYK TIFF Images to use CMYK TIFF format images rather than JPEG inside the PDF file. Using TIFF images will usually make the PDF file many times larger and slower. But TIFF does not have the compression artifacts inherent in JPEG images. Plus professional printers often prefer CMYK ink colors over RGB. This overrides Maximum Quality Embedded JPEG Images if both are checked.
Choose 300 dpi, 96 dpi or Custom Resolution, where you can enter the desired DPI setting. This "dots per inch" setting determines the number of photo pixels per inch in the saved image. For example a 10x8 inch image at 300 dpi would contain 3000x2400 pixels. 300 dpi is recommended for most printing and smaller settings can make prints look fuzzy. A much smaller DPI setting is recommended for on-screen viewing to reduce the PDF file size.

The Image Width and Image Height give the desired dimensions of each image page in the PDF. These are the desired print dimensions and on screen the image size will vary. Select inch or cm (for centimeters) on the right. Note that the Original Image format without Borderless 
checked may vary the PDF image height from this setting to make it fit the original image proportions.

To add white Image Borders around each page, set the Left, Right, Top and Bottom to non-zero values, measured in inches or centimeters. The margins are normally 0.

Type PDF Title Text to be embedded in the PDF file, where it can normally be seen in the PDF Viewer's File / Document Properties command.

The Target Path Name is where the new PDF file will be created. Press its Browse button for a popup file selector and choose where the PDF file will be saved.

Finally, press the Save button at the bottom to save the chosen PDF file.

See also:

Upload Wizard

Open Recent Files

Open Recent Files

This submenu shows up to eight of your recently used image or collage files.  You can easily re-open them (or add another copy of a recent image) by choosing them again.

Hint: Even though the recent files list is remembered when FxFoto exits, you can easily clear the list using the Restore FxFoto Default Settings button in the Options dialog.
See also:


Exit

Adding Collage Images
Exit

This command closes the FxFoto application.  But first, it asks whether to save any modified collages.  As with other programs, you can also exit by clicking the [X] in upper-left corner of the window or with Alt+F4.

See also:

Edit Menu
Edit Menu

Some commands do not appear in all FxFoto editions.
Undo
Redo
Cut
Copy
Paste
Collage Add Moded

Add Row-wise to Collage

Position Photos to Fill Page

Adjust Visible Framing
Insert Slide Mode
Collage Settings
Search Folders
Join Photos into Panorama
Batch Operations
Insert Blank Sheet

Insert Calendar

Show Image on Top
Show Image on Bottom
Rotate Collage Image Right
Rotate Collage Image Left
Flip Collage Image
Restore Original Image
Delete Collage Image
Delete Whole Slide
Non-Selectable Image
See also:

View Menu
Undo

This undoes your last image or collage edit and restores the image or collage to the previous state.  You may also press the hooked left arrow on the toolbar or Ctrl+Z.

When you first open an image file which you have previously changed in an earlier FxFoto session, you can press Undo to restore to the original image prior to all changes.  Press Undo before making any further change (or after undoing the changes this session) and you are asked whether to restore the original version of the selected image.  You can also use Restore Original Image in the Edit menu.  (Note that the original images are only preserved if you leave the default Backup Original Image Files checked in Options).
Note:  When you edit photos or images, FxFoto's undo feature saves the old version in a very high quality JPEG image.  However if you set a Custom Quality greater than 95 under JPEG Quality in Options, then that even higher quality is also used when saving old undo versions. 
See also:

Redo
Redo

This re-does the last Undo operation and restores the image or collage to its state before thhe Undo.  You may also press the hooked right arrow on the toolbar or Ctrl+Y.

See also:

Cut to the Clipboard
Cut to the Clipboard

This deletes the currently selected right-pane image or the currently roped area in an image and places it on the clipboard.  It cuts only the selected area if a rope outline exists.  You can also press Ctrl+X.  Note that you can also use Delete Collage Image in the Edit menu to remove accents from the collage.  If the selected image uses transparency, then a transparent PNG image is placed on the clipboard, but most other applications will handle the transparency.
See also:

Copy to the Clipboard
Saving Images
Copy to the Clipboard

This makes a copy of the currently selected right-pane image and places it on the clipboard.  It can also copy just the roped area on an image if a rectangular rope selection outline exists.  If there is no selected photo and no roped area, it copies the current collage window view.  You can also press Ctrl+C. or right click on a collage image and choose Copy to Clipboard from the popup menu. If the selected image uses transparency, then a transparent PNG image is placed on the clipboard, but most other applications will handle the transparency.
See also:


Paste from the Clipboard

Saving Images
Paste from the Clipboard

This creates a new image or text object using information from the clipboard (which must hold either an image, text or HTML text).  You can also press Ctrl+V.
See also:


Collage Add Mode

Adding Collage Images
Collage Add Mode

This Edit menu command is equivalent to pressing the [image: image40.png]


 Collage Add dialog bar button.   When not in Collage Add mode, opened images are automatically placed on a new slide (unless you are using a collage theme with unfilled photo slots on the current slide).  But when Collage Add is pressed, new images open into the current slide.  This allows you to create a collage with multiple photographs in each slide.  If you have the Standard Edition, this command requires an FxFoto Upgrade.  In the Standard Edition you can try multi-photo collages and view the results, but cannot save, copy or print more than one photo per slide.
When this mode is unchecked (or the toolbar button us up) then opened images start a new slide.  If Insert Slide Mode is set, then the new slide is just after the current one and all later slide numbers are moved down.  Otherwise the new slide goes at the end of the show.

Also, in Collage Add mode the Back and Next buttons on either side switch between Tour Stops in the current slide’s collage and only continue to the previous or next slide after any tour stops have been visited.  But in the normal mode with the button up, Back and Next always switch between slides.  (Note that when shown in the Viewer, Back and Next always work as they do in the Collage Add mode and visit any tour stops you have created.)
See also:


Add Row-wise to Collage
Add Row-wise to Collage

This Edit menu command duplicates the Automatically add new images to collage in row-wise order checkbox in the Collage Properties dialog.  When checked, added collage images are initially placed to the right of the previous image until the end of a row is reached.  Uncheck to place added images below the last in a column.  Note that this setting applies only with the Collage Add mode where new images open to the same slide.  If you have the Standard Edition, this command requires an FxFoto Upgrade.
See also:


Position Photos to Fill Page
Position Photos to Fill Page

This Edit menu command is also available from the Add toolbar button.   It arranges and sizes opened photos to fill the current slide layout as well as possible.  It moves text annotations with their photos, but not unattached accent images or glue groups.  The current Default Margin Between Images in the Collage Settings Page Guides controls the spacing between the readjusted photos.

 Without page guides, this command automatically resizes the collage coordinates to fill the currently selected printer page at high resolution.  Since FxFoto normally keeps the maximum photo resolution, image print at full resolution without the command.  However, expanding the collage coordinates can allow added text to be sized correctly for high-resolution printing.
Note that Edit Photos for Large Prints can be checked in the Options to automatically perform this command when a new photo is opened, but only for photos and not when there are text annotations, glue groups, or other layout accent images.
See also:


Adjust Visible Framing
Adjust Visible Framing

This Edit menu command duplicates the Adjust button in the Frame dialog.  This command also appears in the right-click popup menu if the selected collage image already has a limited visible area.  The F7 key may also be used.
Adjust Visible Framing allows you to pseudo-crop the photo so that only a portion is visible.  Since the photo is not actually cropped, you can use Adjust again later to shift the visible portion and show portions previously outside of the visible area.  When you drop a photo into a template, it is automatically pseudo-cropped to fit the frame shape and the visible portion is initially centered.  Use Adjust to change the visible portion if the desired part of the photo does not show when dropped into a template.
When Adjust Visible Framing is checked, FxFoto shows the whole photo with a dashed red line surrounding the visible area inside the frame.  When checked, you can slide the photo to adjust the visible area.  You can also grow or shrink the photo with the grab handles so that a smaller or larger portion is visible when framed.  Use the command a second time to turn off Adjust mode and see the photo framed again.
The Adjust Visible Framing mode can be used to adjust the visible area inside any sort of frame or even an unframed photo with the No Frame type.  Adjust mode shows the image without rotation, but any rotation reappears when you leave Adjust mode.  While adjusting, you can rotate the photo relative to its frame with the diagonal rotation pull tabs.  If the photo has been dropped over an irregularly cropped target or one that uses partial transparency, then the photo appears fully opaque within the pattern and areas that will not appear are partially transparent.  You can control the opaqueness for unseen portions using the Frame Adjust Outer Transparency setting in the Options dialog.
Note that the Adjust mode turns off and the dashed red line disappears when you start most commands.
See also:


Insert Slide Mode
Insert Slide Mode
When checked, new slides insert in the middle of the presentation rather than at the end.  Higher slide numbers are automatically incremented by one.  Note that this setting does not apply during the Collage Add mode where new images open to the same slide.  If you have the Standard Edition, this command requires an FxFoto Upgrade.
See also:


Search Folders
Search Folders
This command allows you to find left-pane photographs from specific folders, with specific names, with specific creation dates or with specified keywords.  It can also be used to immediately jump to any folder.  It is a button on the left side of the top dialog bar and is also available from the Edit menu or by pressing Ctrl+F.
Choose either All matching photographs or Next matching photograph by pressing the appropriate button at the top of the dialog.  The first creates a special green Search Results folder with all of the photos matching your criteria.  The other moves you to the next matching left-pane folder and photo.
You can specify a Folder Name to find only photos from a given FxFoto folder.  A drop down list lets you scroll through all available folders.  The Browse button lets you find the folder from a tree of disks and directories on your computer.  Leave the Folder Name blank to find photos from any FxFoto folder.  You can also type only the beginning of a folder name to find all matching folders beginning with the same letters.
Press the Jump to Folder button under the Folder Name to immediately show the chosen folder in the left-pane.  Jump to Folder button allows you to quickly find any FxFoto folder without a full search.
You can also specify a Image Name to find only photos or other folder items with a given file name.  Type the desired base file name (not including any beginning disk or path).  You can type only a portion of the name to find all matching files that include the specified word or letters in their names.  Leave this field blank to find all items regardless of their file names.
You can also specify a Date Range for the desired photographs.  This allows you to search for pictures if you know approximately when they were taken.  You can optionally specify only a beginning or only an ending data to search for all photos taken after or before a given creation date.

Finally you can specify one or more Keywords to search for.  Of course this only works if you have applied keywords to photos when they were imported or via the Picture Information command.  Click on keywords to select them for use in the search or click again to unselect.  Choose Match All to require that all selected keywords be specified in a matching photograph.  Or choose Match Any to find the photo if it has any of the keywords.  The New Keyword and Purge Keyword buttons allow you to add or remove words from FxFoto’s standard list.
Press the Search button to begin the search.  The left-pane folder view will move to either the special temporary Search Results folder at the bottom or the next found folder and photo.
The Search Results folder does not have separate copies of the matching photographs.  They are still in their original folders.  But you can open photos by clicking on them in the Search Results.  You can also drag them to other folders (which removes them from their original folder), but cannot rearrange the Search Results folder itself.

Search Results remain until you exit FxFoto.  You can remove the Search Results folder sooner by clicking on its small photo icon right of the title and choosing Remove Whole Folder.
See also:


Photo Stitching
Join Photos with Photo Stitching

If you have the Standard Edition, this command requires an FxFoto Upgrade.  This command is not available in Quick Layouts.
If you have taken a series of photographs of the same landscape or scene that horizontally overlap, FxFoto can automatically join them into a single panorama image.  The photos should be taken with only horizontal camera rotation or scanning.  They must overlap significantly so that FxFoto can determine how they fit together.  The minimum overlap is about 10% of picture width, but for good results you should take the photos with significantly more overlap, usually 30% to 50% or more. They should not have vertical camera movement, zoom changes, camera tilting or lighting differences, though FxFoto attempts to compensate for small differences.  Unless you are scanning nearby documents, it is best to rotate the camera on a tripod if possible.  It is even better to use a special mount that pivots the camera at the lens to minimize parallax errors.  If no tripod is available, still try to rotate the camera on an axis running through the camera lens rather than swing it around at arm’s length.  And of course, try to make sure that nearby people or objects do not move between shots.
Start by opening two or more horizontally overlapping photos into the right-pane collage window, either by clicking on them in their left pane folder or with the Add Image command.  Then start this Join Photos command from the Edit menu or the Stitch button in the Add Wizards.  First you must Select the Photos in Order by clicking on the desired photo thumbnails in left-to-right order.  The left-most photo must be number 1.  Press Next to continue with the Photo Stitch Settings dialog.
Select Panorama from One Viewpoint if you have taken landscape photos from a fixed location, rotating the camera.  The photos are projected onto a cylinder surrounding the camera viewpoint.  Or select Scanned Camera Viewpoints if you have moved the camera parallel to nearby documents or objects at a fixed height or distance.  The flat photos are joined without cylindrical projection.
For cylindrical panorama projections, you must specify your Camera View Angle.  This is the field of view seen by your camera and it varies with zoom focal length.  You can either specify the Field of View Angle in degrees or the Lens Focal Length in millimeters equivalent to a 35mm camera lens.  Wider the view angles (or shorter focal lengths) bend the original photos more because they cover a more of the panorama cylinder.  Many consumer cameras have a wide-angle (non-zoomed) focal length equivalent of about 35mm, which gives a 53 degree Field of View Angle.  If you have cropped the photos or if you held the camera sideways in portrait mode, you should reduce the Field of View Angle to correspond to the left-most image to be stitched.  After entering a new Field of View Angle or Lens Focal Length, you can press the Update button to see the equivalent other setting in the dialog.
Check Automatic Brightness Compensation to adjust the overall luminance of each right-hand photo as it is stitched onto those to its left.  This can help match the two halves of the stitched panorama.
Check Automatic Contrast Compensation to adjust the contrast balance of each right-hand photo as it is stitched onto those to its left.  This can help match the two halves of the stitched panorama.

Check Auto Improve Compensation to correct the photos with a limited degree of the FxFoto Auto Improve adjustment.  This can sometimes help compensate for photos taken under very different lighting conditions and maybe preferable to using the separate Improve command on the photos before stitching, which can make it more difficult for FxFoto to automatically find the best stitch point.  However this setting is unchecked by default and is not recommended in most cases.

Check Maximum Camera Tilt Compensation to automatically rotate each right-hand photo to best match those to its left.  Then enter the maximum degrees of tilt allowed.  The default 4 degrees automatically compensates for up to 4 degrees of either clockwise or counter-clockwise camera rotation from horizontal.

Check Maximum Camera Zoom Compensation to automatically blow up or reduce each right-hand photo to best match those to its left.  This is not recommended when you have selected Panorama from One Viewpoint because it typically not needed when photographing distant objects from a fixed location and because it slows down the stitching process by up to a factor of four.  If you have Scanned the Camera Viewpoint over nearby documents or objects, it is more difficult to keep the camera height constant and Maximum Camera Zoom Compensation may be needed for best results, even though it requires much more processing time.  When checked, enter the desired maximum compensation as a percentage of the photo width.  For example, 6 percent allows the photo to be up to 6% too large or 6% too small.
Check Fixed Stitch Point to manually adjust the dividing line separating photos.  This can allow you to move the stitch line off of important features.  But adjustment is difficult and it is not needed in normal circumstances.  If checked, enter a value specifying a percentage of the left photo’s width.  For each two photos, the stitch line will be this distance from the left photo’s left side.
Check Extra Best Fit Search to have FxFoto do extra work to find the best relative position of each photo.  This slows stitching down very significantly and is not needed or recommended in most cases.

Check Extra Stitch Point Adjustment to have FxFoto do extra adjustments to the relative positions and join point of the photos.  This does not usually take appreciable extra time and is recommended in most cases.  But if FxFoto has trouble finding the best stitch point, unchecking this setting (or checking if off) may help.
Check Auto Balance for Photo Alignment to have FxFoto use balanced versions of the photos when finding the best relative positions.  This auto balance is invisible in the result and is different than the Automatic Brightness and Contrast Compensation settings above.  This option does not take much extra time and is recommended in most cases.  But if FxFoto has trouble finding the best stitch point, unchecking this setting (or checking if off) may help.
Check Overlap Photos Above and Below to allow photos that do not line well vertically to show overlapping portions beyond the join line.  Note that for the best results, your photos should not have significant vertical differences and may never differ by more than 50% vertically.  This setting is unchecked by default.  When checked, more of the original photos may appear in the result.  However, even when checked, FxFoto may automatically stop from showing overlapping portions beyond the join point if it determines that they may line up correctly.
Check Cylinder Projections Only to have FxFoto just replace your source photos with rounded cylindrical projects that you can then slide over each other in the collage to manually position them.  When checked, FxFoto does not automatically create a stitched panorama.  To use this, you must choose Panorama from One Viewpoint and you should normally have opened the source photos onto the same slide.  After you press Begin, the photos are distorted for the given View Angle so that they should superimpose correctly in a collage.  Note that FxFoto’s Color Brush Set Transparency for Whole Picture can then be used to make the photo on top partially transparent to assist manual positioning.
Set the Blending at Join Point to the number of pixels that are blended together where the stitched photos join.  The default is 32 pixels, which is the amount of blending on either side of the join line.  More pixels may help smooth differences.  Fewer pixels may make differences less visible as long as they do not fall within the blend region.
Press Select Photos in Order to return to the thumbnail selector dialog to review or change the photos to be stitched and their left-to-right order.

Press Begin to begin stitching the selected photos.  A progress bar dialog appears and advances to 100% for each pair of photos from left to right.  For example, if joining three photos, the stitching is complete when the final 3 / 3 progress bar finishes.

Once stitching is finished for the last photo, the combined image appears in a new slide and you are asked whether to save the joined image to disk.  Choose Yes to start the Save Image As wizard where you can add the panorama to a specified left folder or save it some other place on your disk.   If you choose No, you can still use Save Image As latter, possibly after you have Cropped the combined image to square the edges.
See also:


Batch Operations

Show Image on Top
Batch Operations

If you have the Standard Edition, this command requires an FxFoto Upgrade.
This command is available from the Add toolbar button and the Edit menu.  It allows you to flatten and change the pixel resolution of one or more open photo images.  It can also change the aspect, automatically clipping a little off the top and bottom or left and right so the resulting images have an exact width and height pixel size.  In addition it can automatically switch images to black and white and auto-improve them.  Finally it can save the changes back in place of the original photo files.
Before starting this command, open the desired photos into the right pane.  You can use the Open Folder Photos command to open some or all of the photos from a left-pane folder.
First this command asks you to choose from among the open photos.  Only the chosen images are modified or saved with these Batch Operations.  You see all open photos. Choose one or more to be used by clicking on the images.  A green tag appears in the upper-right corner of all images to be included. Clicking on a photo toggles the green tag either on or off.  Press Include All to mark all images with green tags for inclusion or press Include None to un-mark all images.  Press Next when the desired image or images have been chosen to continue.
The second dialog lets you choose the desired operations.  The checked operations are performed in order from top to bottom on each of the selected photos.
Check Flatten selected images to merge all text and images that appear on top of the selection image.  It also removes any rotation so that it appears within the flattened non-rotated image, which can speed up rendering.  Flattening is an advanced feature and you should normally leave this unchecked.  When used, it can reduce the complexity of a multi-image layout because it modifies the underlying photo image to include the images of all text, frames and other images that appear above it.  It removes the separate text and image objects that appear above, but only if they are totally inside the bounds of the selected image.  Once a photo image has been flattened, the text and frame can no longer be changed since they become part of the photo and are non-editable.  Accents and other images that appear above are also merged into the photo and cannot be moved relative to it afterward.  So use the Flatten operation with care. Note that it is not necessary to Flatten a photo in order to save a composed version of it that includes the text, frame and other annotations that appear with it.  The Save Image As command or the Save Batch Operation below can save a composed version of the photo file that includes the annotations.  Use Flatten only when you need to reduce the number of separate image objects in a large collage or slide show.  For example, it may be useful to combine all images in a complex slide into a single image to make a huge slide show smaller.  Fixed Window Placement images cannot be flattened.
Check Resize selected images to change the pixel size or resolution.  Again, this is an advanced feature that is not usually needed for normal image editing.  It allows you to decrease or increase the pixel size of the opened image.  This changes the default size used when it is saved to JPEG or other image file format. So using Resize can reduce (or increase) the memory and disk space required to represent the images.  Reducing the size decreases the image resolution so that it looks fuzzier when enlarged. Note that increasing the size does not really increase the resolution even though it uses more memory and disk space.  That is because adding more color dots to an image cannot recover image detail that is not there.
When Resize is checked, you must enter the desired pixel Width and/or Height.  If you choose Set the Width or Set the Height, then the entire photo remains uncropped at the chosen size. But if you choose Set Both the Width and Height, then you can convert the selected images to a new aspect ratio, making them wider or taller.  FxFoto automatically crops off the top and bottom or left and right sides of each image to make it fit the chosen size.  If just once image has been selected, then you can press the Collage Resolution button to automatically set the Width and Height fields to that image's natural resolution in the layout or slide show. This is the resolution that would be used when the image is de-resolved into the saved collage file and will depend on how large the photo is relative to the layout or slide in collage units. When editing individual photos, this Collage Resolution is not as meaningful and usually results in a size that may be too small for printing.  Collage Resolution is disabled if more than one image has been selected for resizing.
Check Make the selected images Black & White to remove the color and represent photos with shades of grey.
Check Auto Improve selected images to do the same Auto Improve operation available in under the Correct toolbar.  It uses the current Auto Settings. However if you also check Black & White above, the batch operation automatically uses the Monochrome Auto Improve mode.
Check Save selected images to save the composed image back to its original disk file, including any frame, text and accent images that appear on top of it.  This is similar to using Save Mods to overwrite the original image file.  But it cannot save images that were opened from an encapsulated collage file and which do not have their own separate JPEG, TIFF, PNG or BMP image file. Note that because saving the composed image is the same thing as flattening it in the image file, you should not normally also check Flatten above when Save is used.  Note that you cannot undo Save, though it does support the Restore Original Image command.  The Save option is not enabled in the Standard Edition.
Check Clear selected images to close the images.  This option is normally used in conjunction with Save selected images.  The image objects are removed from the right pane.  Any unsaved changes are lost and you cannot undo Clear.  This option is not enabled in the Standard Edition.
Press Begin to perform the selected operations on the chosen images. Or press Back to change the image selections.
See also:


Insert Blank Sheet
Insert Blank Sheet

If you have the Standard Edition, this command requires an FxFoto Upgrade.
This command inserts a blank colored image into the collage or current slide.  This can be useful when using Crop Patterns to create monochrome collage accents.  Use the Insert Blank Sheet command instead of opening a photo or paper image when you simply need a uniformly colored blank image.  This command is available in the File menu and also from the Add toolbar button.  Or you can press the F4 key.
A Color selector dialog appears. Choose the desired blank paper color and press OK.  A square blank image with the chosen color is placed in the middle of the current right pane collage view.  Move it as desired (since it may be large enough to entirely cover other collage images) and use using Crop to cutout the desired embellishment pattern.

Note: The Color can be set with the Color Brush toolbar's Get Color at Picture Click Point tool.

Hint: The pixel size of the blank sheet image is determined by the Maximum Added Image Size in the Collage Settings.  To create a large paper or embellishment image, it can help to set a large Maximum Added Image Size before using the Insert Blank Sheet command, which will result in a higher resolution image, rather than just dragging the blank sheet larger after creating it.
See also:


Insert Calendar
Insert Calendar

This command inserts an image of a calendar month into the current collage.  It requires the FxFoto Creative, Media or Quick Layouts.
Choose the Month and Year for the desired calendar.  Pull down the menu to select the month and type any desired year.
Check Include Title Text to include the Month or Month and Year or Typed Title Text at the top of the calendar image.  Font & Size and the adjoining Text Color button select the font used for the title line.  All Caps Month Name can be checked to show the month name without lower case letters.  Left, Center or Right can be checked to position the title text.  A non-zero Extra Space Below value increases the space between the title line and the calendar below it.

Check Include Days of the Week to show the Sunday, Monday, Tuesday, etc. names of the week days above the calendar grid.  Normally the left-most day is Sunday, but First Day of Week can be changed to start the week on any day desired.  Font & Size and the adjoining Text Color button select the font used for the day names.  One Letter or Three Letter Abbreviations can be check to show M T W or Mon Tue Wed abbreviations.  All Caps Day Names can show the names without lower case letters.  Left, Center or Right can be checked to position the day names relative to their columns below.
Check Include Date Numbers to show the 1, 2, 3 dates in the calendar grid.  Font & Size and the adjoining Text Color button select the font used for the date number text.  The Horizontal and Vertical Offset plus Right Justified and Bottom Justified can be used to change the position of the date numbers within their grid box.  When the offset values are 0, FxFoto uses a default offset rather than no offset.
Check Include Grid Lines to draw lines around the date boxes.  The Line Color can be clicked to set the color of the lines.  3D Lines allows the lines to be shaded to simulate a 3D effect and works best when lines are not too wide.  Sparse Grid can be checked to skip drawing lines around boxes before the first and last dates in the month.
The Background Color normally has Clear checked to allow the collage background image or color to show through.  When Clear is unchecked, you can click the color to make the calendar image opaque.

The Horizontal Date Cell Size and Vertical Date Cell Size control the pixel size of the grid boxes.  Smaller values will make the grid smaller in comparison to a given font size.  The default 750 values and default font sizes are large to allow for smoothly detailed characters.

The Anti-Aliased Smooth Text checkbox can turn anti-aliasing on or off for the calendar text.  However, this checkbox normally has no effect unless small font sizes are used.
Press OK to create the calendar month image and insert it in the middle of the current right-pane collage view.

Note:  The calendar is an image and has no editable text.  To change it, you can remove the image and redo this command to create a new calendar image.

Tip: The calendar image can be very large and use an excessive amount of memory resources if your computer does not have a lot of RAM memory.  You can reduce the memory require by making the Horizontal and Vertical Cell Sizes smaller, though this may make the printed calendar text less crisp.  If your computer is not have a large amount of RAM memory, try making both the Horizontal and Vertical Cell Sizes 400 instead of the default 750 pixels.  You should reduce the font sizes proportionally:  Title Text font size 49 instead of 92, Days of Week font size 27 instead of 50, and Date Numbers font size 33 instead of 62.  The Line Thickness can also be reduced to 12 instead of 25.
See also:


Select Photos in Order
Select Photos in Order

This dialog appears when you start the Join Photos to choose the photos to be stitched together.  It re-appears when you press the Select Photos in Order button from that dialog.

Thumbnails of all photos open in the right-pane collage window appear.  Click on the desired panorama photos in their left-to-right order.  The chosen photos must horizontally overlap and must be number 1 for the left-most, 2 for the next to the right, and so on.   You must click on at least two photographs to select them with blue order numbers.

Press the Start Again button to clear all blue order numbers so that you can click the left-most photo number 1 again.
Press the Next button to proceed to the Photo Stitch Settings dialog.
See also:


Photo Stitch Settings

Show Image on Top
Show Image on Top

This command rearranges the draw order so that the currently selected right-pane collage image appears above all others.  Any other collage images that overlap the selected image will appear underneath it.  If the selected image is part of a glue group, then all associated images also show on top.
This command is also available in the popup menu when you right click on a collage image.

See also:


Show Image on Bottom
Show Image on Bottom

This command rearranges the draw order so that the currently selected right-pane collage image appears underneath all others.  Any other collage images that overlap the selected image will appear over it and obscure it.  If the selected image is part of a glue group, then all associated images also show on the bottom.

This command is also available in the popup menu when you right click on a collage image.

See also:


Show Image on Top

Rotate Collage Image Right
Rotate Collage Image Right

This command rotates the currently selected right-pane collage image clockwise by 90 degrees.  In photo editing mode when the photo was opened from a left-pane folder, FxFoto asks whether you also want the folder image rotated.  Otherwise, only the open collage copy is rotated without automatically being saved.

Unlike the rotation pull area in the upper-left corner of the selected collage image, this command always rotates by exactly 90 degrees and saves the rotated image back to its left-pane folder.
This command is also available in the popup menu when you right click on a collage image.
See also:


Rotate Collage Image Left
Rotate Collage Image Left

This command rotates the currently selected right-pane collage image counter clockwise by 90 degrees.  In photo editing mode when the photo was opened from a left-pane folder, FxFoto asks whether you also want the folder image rotated.  Otherwise, only the open collage copy is rotated without automatically being saved.

Unlike the rotation pull area in the upper-left corner of the selected collage image, this command always rotates by exactly 90 degrees and saves the rotated image back to its left-pane folder.
This command is also available in the popup menu when you right click on a collage image.

See also:


Rotate Collage Image Right

Flip Collage Image
Flip Collage Image

This command makes the horizontal mirror image of the currently selected right-pane collage image, flipping the left and right sides.  In photo editing mode when the photo was opened from a left-pane folder, FxFoto asks whether you also want the folder image flipped.  Otherwise, only the open collage copy is rotated without automatically being saved

This command is also available in the popup menu when you right click on a collage image.

See also:


Restore Original Image
Restore Original Image

This command Edit menu command restores the original photograph or other image file for the currently selected right-pane collage image after first asking if you are sure.  This command is also available in the popup menu when you right click on a collage image.  You can also restore the original image by using the Undo command when you first open a modified photo.
Note that the original images are only preserved if you leave the default Backup Original Image Files checked in Options.  FxFoto saves original backups in *.FXB files.  To stop FxFoto from creating FXB files, uncheck Backup Original Image Files in Options.
See also:


Delete Collage Image
Delete Collage Image

This command removes the currently selected photograph, image or text object from the collage after first asking if you are sure. It just removes the image from your collage or show and does not erase the original photo unless the only copy is encapsulated in the collage. It is available in the popup menu when you right click on a collage image. You can also use the Del on your keyboard or choose Delete Collage Image or Delete Whole Slide from the Edit menu.

Check Delete Whole Slide or Layout to remove all slide images for the currently showing slide. FxFoto can have more than one picture or collage layout included in the collage even if you are not building a slide show, so be aware that this checkbox can delete an entire multi-photo layout. When checked, FxFoto asks again whether you are really sure before removing all slide images. The Delete Whole Slide command in the Edit menu checks checks this by default. 

If the selected image is part of a group, the Remove Whole Glue Group or Matte checkbox is enabled. Leaving this checked and choosing Yes deletes all associated images. Unchecking it before choosing Yes only deletes the single selected image object and leaves the rest of the matte or glue group. Choosing No keeps the all images regardless of the checkbox.

See also:


Non-Selectable Collage Image
Non-Selectable Collage Image

This command can make the currently selected right pane image non-selectable so that clicking on it with the left mouse button selects whatever image object is underneath it.  Making the top image non-selectable allows you to arrange objects underneath without moving it temporarily out of the way.  This is especially useful when an image is partially transparent and totally covers another that needs to be adjusted.  For example, you may sometimes use a border overlay image which is transparent in the middle.  To allow the photo inside to be adjusted, make the overlay image non-selectable.
This command is also available in the popup menu when you right click on a collage image.

When the image is non-selectable, a check mark appears next to this command in the menu and left clicking will no longer select it with pull handles.  Instead any other image underneath it that you point to will be selected and can be moved or resized.  The grab handles for the selected object underneath may be obscured even though it is selected for dragging with the mouse.

A non-selectable object is effectively fixed in the collage so that it cannot be moved or edited.  However you can still select it by clicking with the right mouse button.  To turn off the non-selectable property, right click on the image and choose this command from the popup menu. The menu check mark disappears and the top image can now be left clicked and edited normally.
See also:


Discard Modified Photographs
Discard Modified Photos

This command is available only by pressing Ctrl+B on the keyboard.  It clears the current collage of all images without saving any modifications you have made to your photos.

See also:


View Menu
View Menu

Some commands do not appear in all FxFoto editions.
Collage Viewer shows the current right-pane collage in the FxFoto Viewer.
Folder Slide Show shows the currently selected left-pane folder in the FxFoto Viewer.

Full Screen Photo shows only currently selected photo full screen in the FxFoto Viewer.  This command is also available in the right-click popup menu over the right pane.
Back (or Alt + Left Arrow) shows the previous slide or image.

Next (or Alt + Right Arrow) shows the next slide or image.

Whole Collage View
Zoom to Photo
Copy Current View
Pilot to Copied View
Toolbar
Status Bar
Snap to Grid Dots
Show Grid Scale
Clear Rope
Jump to Folder
Folder Settings
Review Photos
Review Slides
Mouse Mode
See also:

Favorites Menu
Collage Viewer

This command starts the FxFoto Viewer application to present the current collage or slide show.  Just press the Viewer button on the left side of the top dialog bar.  Just press the Viewer toolbar button or use the equivalent View menu command.
You can also view a slide show of all the current left-pane folder’s photos from the Folder dialog bar button.

These use the same as the free Viewer that people can download from www.FxFoto.com/FxViewer to see FxFoto collages and slide shows that you send them.  The Viewer command is a good way to preview your collages and try any slide shows or photo tours before you send them to others.  If you have the Standard Edition, you need an FxFoto Upgrade to create permanent collages and slide shows.  FxFoto Quick Layouts does not support slide shows.
If the collage or its images have unsaved changes, they are temporarily saved automatically so that you can see them in the viewer.  Once in the Viewer, you can open other collage documents, exit back to FxFoto or switch back to FxFoto without exiting the Viewer.

See also:

Whole Collage View
Whole Collage View

This pilots your view to show the entire collage or current slide from altitude.
This command is available using the [image: image41.png]


 dialog bar button.  It is also in the View and right-click popup menus.
See also:

Zoom to Photo
Zoom Photo
This moves your view of the collage up or down so that the selected or last added image fills the right pane.
This View Menu command is also available using the [image: image42.png]


 dialog bar button.  Use [image: image43.png]


 to show the Whole Collage view.
See also:

Copy Current View
Copy Current View

This View menu command remembers the currently visible collage area and slide number so that you can return to this view later using Pilot to Copied View.

You can also use the copied view in various other commands to set views to be shown at different times in the Viewer.  The left top width height collage pixel coordinates for the view and the slide number are also copied to the clipboard.  The copied view is remembered after you exit and restart FxFoto.  There is only one copied view, which applies to whichever collage is currently open.

See also:

Pilot to Copied View
Pilot to Copied View

This View menu command returns you to view a previously remembered area of the current collage from the most recent Copy Current View.  Note that if you have moved images or switched collages, the view may pilot to a blank area of the current collage.  Use Whole Collage View to return to a known area. 

See also:

Toolbar
Toolbar

This hides or shows the wide toolbar at the top of the FxFoto window.  Hiding the toolbar gives you more room on the right pane window to arrange collage layouts.  Note that you can also grab the divider bar between the left pane folders and the right pane collage window and drag it with the left mouse button to expand the layout horizontally for even more room.  Since many commands are available only in the toolbar, you will need to switch back to show the toolbar as needed.  You can also press the F5 key to toggle the toolbar when working with the right or left panes.  The toolbar always appears initially when you start FxFoto.
See also:

Status Bar
Status Bar

This hides or shows the status bar at the bottom of the FxFoto window which is used only to show descriptions of various menu commands.

See also:

Snap to Grid Dots
Snap to Grid Dots
This View menu command turns the grid dots alignment off or back on.  The grid is useful for drawing and for moving images to force things to line up horizontally or vertically.  The spacing of the grid is usually set in the New Collage Wizard for page guides and can be set or changed in the Collage Settings Page Guides and Other Draw Settings dialogs.
If the current collage specifies page guides with fixed inch or centimeter grid scaling, then the dots still appear even when snap-to is turned off so that you can layout your collage.  Otherwise the dots disappear from the right collage window when snap-to is turned off.  Using this command automatically turns on Show Grid Scale if needed to show the grid dots.

You can also press Ctrl+G to toggle grid alignment on or off.
See also:

Show Grid Scale
Show Grid Scale

This View menu command turns the collage grid scale off or back on.  It does nothing unless the current collage has a grid scale (which requires at least the Deluxe Edition).
Hiding the Grid Scale allows you to view your collage without the grid guide dots or lines and also without the left and top inch or centimeter scale numbers.  Use this command a second time to toggle the grid scale back on.

The grid is useful for drawing and for moving images to force things to line up horizontally or vertically.  The grid scale is set in the New Collage Wizard for page guides and can be set or changed in the Collage Settings Page Guides.

This command automatically turns off Snap to Grid Dots if needed when the grid scale is not shown.

You can also press Ctrl+H to toggle the grid scale on or off.
See also:

Snap to Grid Dots
Clear Rope
Clear Rope

This View menu command erases the current selection rope, if any.  Note that pulling a new rope outline also clears the old rope unless you pull on rectangle edges or draw a new section of a rope.  Clear Rope is in the Mouse button dialog.

See also:

Review or Remove Photos
Review or Remove Photos

This dialog appears when you press the [image: image44.png]


 button on the top dialog bar and also from the Settings dialog.  Or choose Review Photos from the View menu.  It allows you to review and remove images from the collage.  You can also clear the whole collage.  Note that you can also use Delete Image in the Edit menu or press the Del key to remove the selected image or object.  

You see thumbnail images of all photographs currently open in the right-pane collage window.  These can be recently browsed photos from the left-pane folders or images from the open collage or slide show.  But this dialog does not show any accent or button images included in the collage.

You can choose one or more photos to be removed by clicking on the images.  A red tag appears in the upper-right corner of the images to be removed.  Clicking on a photo toggles the red tag either on or off.  Press Red Tag All to mark all images with red tags for removal or press Red Tag None to un-mark all images.  Press Remove all Red Tagged Photos when the desired photo or photos have been chosen to remove them from the collage.  The removed images cannot be restored with Undo.
The currently selected image initially appears with a blue selection outline.  You can switch the blue selection outline to another by clicking or right-clicking on the desired photo.  Press Only Remove the Blue Outlined Photo to remove the image from the collage.  This button ignores any red tags and the blue outlined image need not have a tag to be removed.  You can use Undo to restore the removed image.  Press Show Blue Outlined Photo to switch the right-pane collage view to the selected image without removing it.
Press Clear Whole Collage to remove all images from the right pane.  This closes and discards any open photos, collage layout or slide show, though you are asked to save any modifications you have made first.  The images need not have red tags to be removed.  This is similar to starting a new collage.  It is a good command to use if you have clicked on many left-pane folder photos to examine them in the right-pane, but are not building a collage or slide show to be saved.  The removed images cannot be restored with Undo.

Press Review Slides for another popup window showing small images of whole slides rather than individual photos.  This Slide Order dialog allows you to jump to a slide or re-sequence the slide presentation order.  It can also be started from the View menu and from Slide Settings.  FxFoto Quick Layouts does not support slide shows.
Check Small Images to force the thumbnails to a small 40 pixel size that can allow you to see more slides without scrolling. When Small Images is not checked, the Folder Thumbnail Size controls the image size in this and other popup dialogs as well as in FxFoto's left pane folders. The Small Images checkbox is just to the left of the Cancel button.

See also:

Review Slides
Review Slides and Slide Order

This dialog pops up when you press [image: image45.bmp] Slide Order on the Slide Settings and Review or Remove Photos dialogs.  It is also available from Review Slides in the View menu.  It allows you to review and rearrange the presentation order of your slide show.  Plus it allow you to quickly switch to another slide.  FxFoto Quick Layouts does not support slide shows.
You see small images of all slides in the collage with their existing slide numbers in order.

By default, Drag & Drop is selected on the lower left. In this mode you can drag slide images to rearrange the sequence by holding down the left mouse button. Release the button when the red insertion point line appears in the desired new position. To insert after the last slide in a row, point to the left of the first slide in the next row. Check Small Images to force the thumbnails to a small 40 pixel size that can allow you to see more slides without scrolling. When Small Images is not checked, the Folder Thumbnail Size controls the image size in this and other popup dialogs as well as in FxFoto's left pane folders.

When you choose Click in Desired Slide Order on the bottom left, you see small images of all slides in the collage with their existing slide numbers in grey. Click on the slide images in the new desired order, starting with the first. As you click on the slide images, their tags change from gray to blue and show their new sequence number. The clicked slides move to the beginning and appear in the new order. Press Start Again to go back and rearrange the order of earlier slides. You can right click on an image to select it and advance the numbering to that slide without changing the order. This allows you to avoid clicking all beginning slides up to a certain point when no changes in their old order are desired. You can switch back to the Drag & Drop mode at any point, keeping the new order.

The Jump to Slide button closes this dialog and switches to the last clicked slide. Like OK, it keeps any new slide order. In Drag & Drop mode, the last clicked slide selected with a blue outline. This dialog initially selects the current slide showing in FxFoto's right pane.

Press OK when the slide order is as desired. This operation cannot be undone. Press Cancel to revert back to the old slide order.

Note: You can remove a slide from the show using Delete Whole Slide in the Edit menu.

See also:


Review Photos

Special Effects

Slide Settings

Mouse Mode
Mouse Mode

These commands switch the effect of clicking and dragging the mouse inside the FxFoto window.  The mode can be selected with the Mouse toolbar button.  Beware that many of the other toolbar dialogs force the mouse to a compatible mode.  Setting the mouse mode from the View menu when an incompatible dialog appears may switch to the Mouse toolbar.
See also:

Favorites Menu
Favorites Menu

Add to Favorites
Favorites
See also:

Tools Menu
Add to Favorites

This dialog can add the currently selected right-pane collage image or the currently open collage or slide show document to one of your favorites folders.  It can also create or delete favorites folders.  Normally, favorites are only links to the actual image or collage files.  But you can also add a copy of the image or collage to the favorites folder.  This is often necessary when the current image is encapsulated in the collage and so may not have a known separate file.  Please Note: The Portable Pictures version of FxFoto does not maintain a portable Favorites list.   Separate Favorites are kept for each PC.
To save an image (or text object) as a favorite, click on it to select before using Add to Favorites.

Normally Selected Image Link or Selected Image Copy is checked near the bottom of the dialog.  Switch to Collage Link or Collage File Copy to save the current collage or slide show document instead.  Some of these types may be disabled if they are impossible for the current selection.

Type the Name to appear for the image or collage in your Favorites menu.

Choose the Folder where the new favorite should appear.  The FxFoto folder always appears at the top and its items appear directly at the bottom of your Favorites menu.  Note that they also appear in the FxFoto folder in your Windows Explorer Favorites.  Other sub-folders can be created with the Add New Folder button.  You can also remove folders and all their favorites with Erase Selected Folder.  But be careful, erased favorites cannot be recovered.

Note that the normal file selector used to add images collages has an Add Favorite button which can be used to add a selected file to your Favorites without opening it.

Note: FxFoto's Favorites menu is available as an FxFoto folder in Internet Explorer's Favorites. To remove or manage FxFoto's Favorites, you can use Microsoft's Internet Explorer application an look for the FxFoto folder under Favorites.

See also:

Favorites
Favorites

The rest of the Favorites menu below Add to Favorites shows your previously added favorites.  Folders are at the top and can be clicked to see their contents in a sub-menu.  The favorites saved to the main FxFoto folder appear at the bottom of the menu.  Just click on one of the items to open it into your right-pane collage.  For images, the favorite is added to the current collage just as with the Open or Add Image command.  Collage favorites replace the existing collage or slide show, but you are asked to save pending changes to the old collage document first.

See also:

Tools Menu
Tools Menu

This menu replicates various commands accessible from top dialog bar buttons.  Some commands do not appear in all FxFoto editions.

1. New Collage

2. Add Image

3. Save Wizards

Collage Wizards

Left Folder Commands

Improve

Remove Red Eye

Remove Blemish

Clone Brush

Color Brush

Stamp Brush

Filter Effects

Crop

Frame

Text

Draw

Slide

Info

Mouse

Install Zipped Kit

Install Unzipped Kit

Install New Font

Remove Font

FxFoto Options
See also:

Help Menu
New Collage Wizards

This dialog of useful wizards and commands for starting new collages is reached by pressing the New button at the top left of the toolbar or from the Tools menu.  Press a button to start the desired wizard command.

Some of these commands are not supported by all editions of FxFoto.  Buttons not supported have their text descriptions grayed, but can be pressed to try them without being able to save or print the results.  The New Collage button is limited in the Standard Edition and just clears all right-pane photos.  However New Collage provides an optional New Collage Wizard Trial.  If you have the Standard Edition, the full versions these commands require an FxFoto Upgrade.

Press Photo Editing to open individual photos and other image files for correction, cropping, framing, text and drawing annotations.  Then use the Save Image As or Save Modified Images commands to save the edited images to standard JPEG photo files that can be opened any photo or imaging software.  You can also save TIFF, PNG and BMP format image files.
Press Slide Show Collage to start a new slide show with a white background.  This is equivalent the Slide Show type in the New Collage Wizard.

Press 8x8 Scrapbooking Page Collage to start a new collage with 8x8 inch page guides and a background image that you choose in a file selector that pops up next.  This is equivalent the Multi-Photo Collage type in the New Collage Wizard with 8x8 Inch Collage Page Guide Limits.  The Layout Background dialog appears next.
Press 12x12 Scrapbooking Page Collage to start a new collage with 12x12 inch page guides and a background image that you choose in a file selector that pops up next.  This is equivalent the Multi-Photo Collage type in the New Collage Wizard with 12x12 Inch Collage Page Guide Limits. The Layout Background dialog appears next.

Press Any Scrapbooking Page Size to start a new collage with custom page guides for any desired printer, paper or card size.  The Layout Size dialog appears next, followed by Layout Background.
Note: For the 8x8, 12x12 and Card types, Keep Maximum Photo Resolution is turned on initially if Default Keep Max Resolution Shortcuts is checked in the FxFoto Options dialog.  Turning off Keep Default Max Resolution Shortcuts before starting the collage can save computer memory resources and allow you to build larger or more complex collages with limited computer memory.  You can set Keep Maximum Photo Resolution off for an existing collage in the Collage Settings Page Guides tab.

Press Quick Sketch Template to use a sketch template image for a layout where you can drag and drop paper and photo images into colored areas.  Quick Sketch Templates require FxFoto Creative, Media or Quick Layouts.
Press Grid Custom Template to create a custom template with rows and columns of photos and/or text.  The Custom Grid Template dialog appears where you can preview and adjust the template.
Press Theme Template Layout to open one of FxFoto’s easy collage or scrapbook page layouts.  A selector pops up next to choose the template.  Click on names to see a preview of each.  The selected layout template opens into the right pane where you can drag and drop photos.  See Using Templates for details.
Press New Collage Wizard to create a blank new collage layout or slide show with specialized settings.
Press Open Collage to 
re-open an old collage layout or show for editing.
Press View the Quick Start Guide to show the Quick Start topic in this documentation.

Press Upgrade to bring up the www.FxFoto.com web site on your browser and purchase a more advanced FxFoto edition.
Just press the desired button to start the command.

See also:

Add Images
Add Image

These commands adding images to the right-pane collage layout or slide show or left-pane To Do Folder.  This dialog is reached by pressing the Add button at the top left of the toolbar or from the Tools menu.  Press a button to start the desired wizard command.

Some of these commands are not supported by all editions of FxFoto.  Buttons not supported have their text descriptions grayed, but can be pressed to try them without being able to save or print the results.  If you have the Standard Edition, the full versions of these commands require an FxFoto Upgrade.
Add Image pops up a file selector that lets you open an image file into the right pane collage.
ToDo Folder Image pops up a file selector that lets you open one or more images into a special To Do Folder in the left pane.  From the To Do Folder, you can click or drag the images into the right collage pane, removing them from the left-pane folder.
Jump to Folder quickly moves the left-pane view to show a chosen folder.  A popup menu of folder names appears next.  Then from the desired left-pane folder, click or drag images into the right collage pane.
Matte or Accent allows you to add a matte group or stretchable box or bar accent into the right-pane collage.
Blank Sheet inserts a blank colored square that can be cropped to create collage embellishments.
Calendar Month inserts an image of a calendar month into the current collage.
Insert Custom Button allows you to create a custom button for the collage or slide show.
Stitch Photos can automatically join photos into a single panorama image when you have taken a series of photographs of the same landscape or scene that horizontally overlap.

Position Photos to Fill Page arranges and sizes opened photos to fill the current slide layout.

Batch Operations can automatically flatten, resize and improve selected open images.
Just press the desired button to start the command.

See also:

Save Wizards
Save Wizards

Thiese commands allow you to print, email, upload and save images, collage layouts and slide shows.  The dialog is reached by pressing the Save button at the top left of the toolbar or from the Tools menu.  Press a button to start the desired wizard command.

Some of these commands are not supported by all editions of FxFoto.  Buttons not supported have their text descriptions grayed and pressing them allows you to upgrade to enable deluxe features.
Print Photos or Collage Views starts the Print Wizard to print right-pane photos or collage layouts.
Email Images or Collage starts the Email Wizard to attach photos or collage views to a new email message.
Upload Images or Collage starts the Upload Wizard to prepare photos or collage views for uploading to online services or web mail.
Save Image As allows you to save a right pane photo or collage layout as a static image file in JPEG or other standard formats.
Save Mods allows you to save modified photos for photo editing or the current collage or slide show.  This button's text description is grayed if there are no unsaved changes.
Save Collage Wizard allows you to save the current collage layout or slide show to a chosen collage file.
Burn Photos or Show CD-ROM allows you to record the current slide show and photos to a CD-ROM for viewing on Windows computers.
Make Web or Flash Show converts the current slide show to files that can be uploaded to a web site. It can also create a web site with thumbnails that can be clicked to enlarge the photos.
Transfer Show to Movie converts the current slide show into an MPEG movie file that can be recorded to DVD or VCD with separate software that comes with most DVD burners.

Convert to PDF saves one or more photos or a slide show to a PDF or Portable Document File.
Just press the desired button to start the command.

See also:

FxFoto Settings
FxFoto Settings

This dialog of useful collage wizards and commands is reached by pressing the Settings button at the top left of the toolbar or from the Tools menu.  Press a button to start the desired wizard command.

Collage Settings allows you to view and modify settings for the current right-pane collage or slide show.
FxFoto Options allows you to view and modify various advanced FxFoto settings.
Folder Setup allows you to view and modify various settings and setup commands for the left-pane folders.

Drag & Drop Settings allows you to view and modify various settings controlling dropping images into the right pane with and without a Quick Sketch Templage
Review Photos shows all open photos an allows them to be removed from the right-pane collage.
Review Slides shows thumbnails of all right-pane slides and allows you to arrange their order.
Just press the desired button to start the command.

See also:

Collage Wizards
Collage Wizards
This dialog of useful collage wizards and commands is from the Tools menu.  Press a button to start the desired wizard command.
Some of these commands are not supported by all editions of FxFoto.  Buttons not supported have their text descriptions grayed and pressing them allows you to upgrade to enable deluxe features.  The New Collage and Collage Settings buttons are limited in the Standard Edition.  New Collage just clears all right-pane photos and Collage Settings just presents a right-pane background color selector popup for the Standard Edition.


New Collage

Collage Settings

Insert Custom Button

Add Accent or Matte to Collage

Save Collage Wizard

Burn Photos or Show CD-ROM

Make Web or Flash Show

Transfer Show to Movie

Join Photos

Save Image As

Print Wizard

Email Collage

Review Photos

Open Collage or Image

Shortcuts

Insert Blank Sheet

Insert Calendar

Options

Save Mods

Upload to Online Services
Just press the desired button to start the command.
See also:

Collage Settings
Collage Settings
If you have the Standard Edition, this command requires an FxFoto Upgrade.  It is limited in the Standard Edition to a simple color selector which can change the right-pane background color.  The full version, with the tabbed dialog described below, is not available in the Standard Edition.
In FxFoto Deluxe, the Collage Settings command (also called Collage Background from the collage right-click popup menu) shows a large dialog above the FxFoto window with a various tabs that control the collage document.

When you right click the mouse in the right collage pane, the popup menu includes Collage Background at the bottom.  The right-click Collage Background normally shows the Background Settings.  However, it can also be used to move the selected collage image to the background.  If appropriate for the current collage and if an image is selected, the right-click Collage Background command asks if you want to Set Collage Background to Selected Image?  Press Yes to remove the selected image from the collage foreground and replace the collage background image with it.  Press No to show the Background Settings dialog.
The right-click Collage Background command makes it easy to use an edited paper or photo image as the collage background,  Open the photo or paper image to crop and edit as desired.  Then right click on it and choose Collage Background.

Background and Theme

Background Music

Page Guides

3D Perspective

Collage Properties

Collage Viewer Settings
See also:

Folder Commands
Background and Theme
This is a tab in the Collage Settings dialog.  Note that as elsewhere in FxFoto, you set a color by clicking on a colored button and choosing from the popup color selector.

On the left side of the dialog, choose either Window Fill or Fill Pattern by pressing the desired button.  Fill Pattern shows a different Collage Color to the borders of the collage and a Background Color outside the collage area.  Window Fill shows the Background Color everywhere.

Check Background Image and press the Choose Image File button to select an image to be used instead of a background color.  For Window Fill mode, the Background Image stretches a single copy of the image across the page guides rectangle or view window.  FxFoto’s supplied Patterns images are generally too small to stretch well and you should usually choose some larger image or photo from elsewhere for Window Fill mode.  For Fill Pattern mode, the image is repeated in a row-wise pattern throughout the collage.  In Fill Pattern mode, you can choose from the folder of Patterns shipped with FxFoto or you may choose another image file elsewhere, but the image width and height should be small to allow it to repeat.  Even when there is a Background Image, you may want to set the Background Color or Collage Color to approximate the image so that transparent overlaid text blends better into the image.
Hint: You can also set the background image for Window Fill collages by opening an image into the collage foreground and right clicking on it to choose Collage Background from the popup menu.
Note: FxFoto specially handles pre-scaled background images with #PG@... included in their filenames.  For example FileCard#PG@6in.jpg would show with red page margin guides exactly 6 inches wide and FileCard_#pg@10cm.jpg would be 10 centimeters wide.
Check Gradient Color to blend the collage background color from the Collage Color at the top the Gradient Color at the bottom.

You can also choose a Collage Texture to be applied to the background color (but not if there is a gradient or a fill image).

Check Collage Edges to draw a boundary line with the specified color around the collage.  Also check Shaded Edges and choose a different color to have the right and bottom boundary lines appear with a second color for a slightly beveled 3D-look effect.

Note: The Background Colors and/or Image are repeated for all slides.  To use a different background image for each slide, open the background as a normal collage photo, move it to the bottom using the right-click menu, and stretch it to cover the whole collage.

Check Plug-in Box Edges to force a 3D-effect box to be drawn around the plug-in window when the collage is published inside a web site.  This can be helpful if the collage background color does not match the surrounding web page color.
Collage Theme Template shows the current theme.  This is normally selected with the New Collage Wizard.  You can change it here either by pressing the Browse button or by typing a new name or blank.  However, there is only one background per show, so changing the theme will not load new background colors or graphics.  It will change the foreground photo, text and accent images associated with the theme when you start a new collage on the next slide (after finishing all photo blanks on the current slide number).  Blank the theme to create the next slide manually with no theme template.  See the Using Templates for more information.
See also:

Using Templates
Background Music
Background or Slide Music and Narration
If you have the Standard Edition, permanently saving collages or slide shows with music or audio requires an FxFoto Upgrade.
When used from the Slide Music or Audio button on the Slide Settings dialog, this dialog is titled Slide Music or Audio Narration and sets music or audio that normally begins with the associated slide.  You can also set background music for the show using the Background Music tab in Collage Settings. The Background Music or Audio Narration dialog appears for the Set Background Music or Audio button in the New Collage and Save Collage wizards.  The background music for the show normally stops with the first slide that specifies its own music.
You can choose a piece of music to accompany the collage or slide show when it appears in the FxFoto Viewer.  You can also record narration using a microphone plugged into your computer, though you cannot combine narration audio and music at the same time.  You can specify one audio selection (recorded narration or music) for each slide in the show, plus one additional “background” audio selection.
Any background audio plays first when the show starts until the first slide which specifies another audio selection appears.  Not all slides need to specify audio and the music or narration can continue until the next slide that specifies audio.  The background audio can also be played when a slide’s audio finishes.  This allows you to restart background music after the narration for a slide.  Normally the audio for a slide interrupts whatever is playing when the slide appears.  However, you can also choose a “queued start” for slide audio, so that it does not start until the previous selection completely finishes.  Using queued starts allows you to sequence whole music selections that play in order without interruption by specifying them for the first few slides, even though the songs might be much longer than the slide time.  Note that queued start and other music sequencing improvements require at least version 3.3 FxFoto Viewer and may not play identically on older versions.

The Viewer supports MIDI music, which is a very compact format that keeps collages and slides shows small for faster transmission over the Internet.  MIDI Instrument quality and relative and absolute volume levels will vary with the user’s sound board or other hardware.  FxFoto also supports MP3 music or audio files, which are compact but not as small as MIDI.  Older versions of the FxFoto Viewer (before 2.1.046) do not support MP3.  WAV audio is the least compact and is not recommended for collages and slide shows that will be sent over the Internet.  Though uncommon, some computers are not capable of playing MIDI, MP3 or WAV music or are configured only for specific music applications.  The Media Edition’s Transfer to Movie command can include specified MP3 and WAV music or sound in created movies, but not MIDI music.  Also, Flash supports only popular MP3 bit rates and some non-standard MP3 files may not work in Flash slide shows.

Press Choose the Music File and choose the desired music selection.  FxFoto supports MIDI music files, which are compact and fairly flexible files with *.MID extensions. However MIDI music cannot appear in DVD Movies nor in Flash Slide Shows. MP3 music or audio is preferred for slide shows you will publish via DVD or over the Internet. WAV audio can also be used, but is not nearly as compact.  You can browse to other directories on your computer for other MIDI, MP3 or WAV files.  The default Music File type shows MIDI and MP3 files.  From the music selector, pull down the File type to show only MIDI, MP3 or WAV files.  If you have upgraded to the Media Edition, an additional <I>Convertible Music</I> type is available and you can choose OGG (Ogg Vorbis) audio files.  However, outside of DVD Movies, these types must be converted into WAV files. The resulting WAV files are usually very large and should not be used in collages to be distributed over the Internet. Also, OGG convertible files are not supported when running FxFoto Portable Pictures with a removable device.
A few simple MIDI music files from classical composers are shipped with FxFoto in a Music directory.  You can also choose files from elsewhere on your disk, such as My Music or \Windows\Media.  However, most music is copyrighted and should not be included in collages and slide shows that will be copied to other computers or people.

Press Record Narration to create the audio selection from your computer microphone input jack.  You must have plugged a compatible microphone into your computer and must have selected the Microphone input for recording and raised its level in the Windows Volume Control.  You can open the Volume Control from the Windows Control Panel (often under Sounds and Audio Devices where you may need to press Advanced to get the full control) and also from the speaker icon on the lower-right Windows tray.  Normally the Windows Volume Control shows only playback controls.  From its Options menu choose Properties and then select Recording.  Make sure that the Microphone control has Select checked and that the volume level is adjusted before you record.  When you press Record Narration, a Recording Narration dialog pops up and counts the seconds of recording time.  Press the Stop Recording button (or press the Enter or Esc or space bar key) when finished narrating.  Your computer sound card may have a small buffer delay and you may need to pause a fraction of a second before stopping to avoid cutting off the last word.  To save space, FxFoto records narration in 11 KHz monochrome audio, so music recorded via the microphone will not be high fidelity.  For convenience when you record narration, FxFoto may automatically check Play Once and Adjust Slide Time to match recording so be sure to reset them if desired.
Press Clear Selection to turn off any music or audio for the slide or background.
Press Test the Selection to hear the current music or audio recording.  Press Stop the Test to stop the playback.  The test playback also stops when you leave the dialog.
If you reached this dialog from Slide Settings, an extra Jump to Next Slide button appears. This allows you to quickly cycle through the slide's music and audio settings. It saves any audio changes for the current slide first.  The next slide's appears below in FxFoto's right pane and you can press Record Narration to describe it.  Jump to Next Slide makes it easier to Record Narration all slides in a show.

Select Play Once to have the Viewer stop playing when the selection finishes if no latter slide has specified audio.  Select Loop Continuously to repeat the selection from its beginning again and again until another selection is started by another slide.  When selecting audio for a slide, an additional Play Background Music Next selection is available which causes the show’s background music or audio to play from its beginning after the slide’s audio finishes.  You must separately set background music or audio in the New Collage or with the Collage Settings Background Music tab for Play Background Next.
Two additional checkboxes only appear when setting audio for a slide.  Adjust Slide Time to match the recording is automatically checked when you have just recorded a piece of narration. It changes the slide's time to match the narration when you press OK.  Also in the Media Edition only, the Adjust Slide Time to match the recording checkbox is enabled after Choose the Music File for MP3 and WAV files and can be checked to force the slide's time to match the length of the newly chosen file.  But for MIDI music this checkbox is disabled.  Unless you use Record Narration, it also remains disabled without the full Media Edition or if FxFoto cannot determine the duration of the chosen MP3 or WAV file.
Two additional checkboxes only appear when setting audio for a slide.  Adjust Slide Time to match the recording is automatically checked when you have just recorded a piece of narration.  It changes the slide’s time to match the narration when you press OK.  But this checkbox does not apply to music files or old narration recordings and so may be disabled.

For slide audio, you can check Queued Start (wait for previous selection to end) to force the Viewer to add the selection to a playback queue rather than interrupting whatever is playing in the middle.  The selection starts when the previous selection is completely finished.  Checking Queued Start allows you to sequence a number of long songs to be played in their entirety by choosing them for the first few slides of the show.  Note that later slide music may be automatically queued even without this checkbox.  If a later slide is already done when previously queued audio finishes, then the slide’s music automatically waits.
Be sure to press OK to accept any new audio selection.
See also:

Page Guides
Page Guides
This is a tab in the Collage Settings dialog.  It allows you to use green guide lines to show the desired collage limits.  Page Guides also allow you to layout collages for printing on a fixed inch or centimeter grid.

Choose the desired Collage Page Guide Limits for the target printer or viewer window.
The No Limits - Free Form Collage choice does not show the green page limit lines around your collage or slide.  The collage can grow as large as desired without limits.  Use this setting for browsing photographs or building simple single-photo slides.
Choose Printer Page Layout for page guides that show the actual page limits for a selected printer and paper type when you also choose Inches or Centimeters.  FxFoto will assume the last printer used or the default printer.  Press the Select Printer button to set for a different printer.  Most printers allow you to select Portrait (tall) or Landscape (wide) paper orientations.  They may have a selection of available paper sizes and other properties.  The selected printer should be the default when you next use the Print Wizard and you should use that the chosen printer with Entire Collage format printing.  The collage layout will only print to the chosen Inches or Centimeters scale when you use Entire Collage printing.

Choose 8 x 8 Inch Collage or 12 x 12 Inch Collage for a square scrapbooking-style page or other complex collage.  Designers often prefer square layouts for more balanced compositions.  The 12 x 12 size is a standard for paper scrapbooking, but 8 x 8 is popular for digital scrapbooking because it is compatible with most printers and requires significantly fewer computer resources.  Unlike Printer Page Layout, these choices do not show the collage relative to the printer paper.  The green page guide lines represent the printable area rather than the edge of the paper.  The area is normally printed centered on whatever printer page you end up using, though you can specify left and top page offsets in the Print Wizard to position the guide box as you like.  If the printer cannot handle the size (as with 12 x 12 for printers that cannot print on wide paper), then FxFoto automatically reduces the printed collage so that it fits on the available printer page.  (Note: You might also use Printer Page Layout with margins of Left 0.5, Right 0.5, Top 0.5 and Bottom 2.5 to create an 8x8 inch collage on 8.5x11 inch paper.)
Choose the Custom Page Size page guides to specify any Page Width and Page Height in inches, centimeters or pixels without specifying a target printer.  When you choose Inches or Centimeters for Custom Page Size, you should enter the desired Page Width or Page Height in those units.  Otherwise you can enter a pixel size.  The green page guide lines represent the printable area rather than the edge of the paper.  The area is normally printed centered on whatever printer page you end up using, though you can specify left and top page offsets in the Print Wizard to position the guide box as you like.
Only the Printer Page Layout through Custom Page Size page guide choices allow you to layout collages with a fixed Inches or Centimeters scale for printing.  Select the other Window page guide sizes (Large, Medium or Small Window) for collages primarily intended for viewing on screen rather than printing.  These other types support Pixel layouts rather than printer Inches or Centimeters.

Note: If you change the Page Guide size, FxFoto will automatically resize all of your collage images proportionally after your press OK.  For example, if you change from 8x8 to 12x12 to convert an existing layout to a larger page.  However, if you have already saved and re-read the collage without Keep maximum photo resolution, then images will not have as much resolution as if the collage has been 12x12 from the start and may not print as crisply.
Press Select Printer to choose the printer and printer page preferences when you have selected Printer Page Layout page guides.  The page guides are set accordingly.
The Page Width and Page Height show the page or window pixel size for the current page choice.  If you have chosen the Custom Page Size, then you should enter the desired page size in Page Width and Page Height.
Note: The pixel page guide width and height are not necessarily the print resolution.  When Keep Maximum Resolution is checked, photos and text can print at higher resolution.  The Page Width and Page Height pixel size (also called document coordinates) give the minimum granularity of photo and text placement and controls the relative thickness of frames. 

When using Printer Page Layout through Custom Page Size you can select Inches or Centimeters for the page layout scale.  The various margin and default image size and spacing settings switch to the chosen units.  For other page guide types, Pixels units are used and FxFoto sizes the collage to fit in the viewer window or printed page.
For Printer Page Layout and Custom Page Size, the Printer Page Margins (Left, Right, Top and Bottom) are enabled.  The outer green page guide lines in the right-pane collage window represent the edges of the chosen paper.  An inner red line shows the area within the selected margins.  If the margins are left at 0, FxFoto shows the unprintable borders of the page for your printer with the inner red lines.
When you add images to your collage, the Maximum Added Image Size controls their largest dimension.  If the image is wider or taller, then its size is reduced to fit the maximum.  This allows you to control images sizes to fit your collage without adjusting each new image with pull tabs.  FxFoto automatically arranges added images in row-wise or vertical-column order, depending on the collage setting.  The Default Margin between Images and Maximum Row-Wise Width control the layout of added photos.  The Margin between Text & Images controls how close any text you place is above or below the image initially.  The Extra Margin at Edges places more space between the photos and the page guides or print margins.  Note that without the Collage Add mode where new images open to a new slide and row-wise placement is not relevant.  Plus you can easily use the selection pull tabs to resize or move a photo as desired after adding it.  All of these settings switch to default values whenever you change the Collage Page Size Limits type, but you can then adjust them as desired.  The default values depend on the Collage Type and normally allow either 1, 4 or 16 images per collage page without further adjustment.

When you have chosen one of the Window Page Guide Limits, you can press the Reset Margins button to adjust the page guides box to surround all current collage objects with the given Extra Margin at Edges.  Reset Margins is useful when you already have your collage composed as desired, but the page guide box does not match.  However, Reset Margins cannot be used with Printer Page Layout page guides.  Since the FxFoto Viewer uses the page guide box to determine the initial view of the collage, you can use Reset Margins before saving the collage to force an appropriate view.  Adjust the Extra Margin at Edges to add extra space around the collage.

The Grid Scale is enabled only when you have chosen Inches or Centimeters for Printer Page Layout or Custom Page Size page guides.  Check to show a grid of regularly spaced dots that help you to layout photos, text and other objects in inches or centimeters.  Then fill in the desired number of grid ticks per inch or centimeter on the right (labeled Per inch or Per cm).  For example, if you choose 2 grid dots per inch and the paper width is 11 inches, then there will be 22 grid guide dots across the collage within the page guides, spaced at half inch intervals, and spacing photos three dots apart would place 1.5 inches between them.  Fractions allow any desired dot spacing.  For example entering .5 dots / inch would only show grid dots every two inches.  Note that you can use the Show Grid Scale or Ctrl+H to toggle the Grid Scale on or off at any time without visiting this dialog.
When Grid Scale is checked, you can also check Labels to show scale numbers along the left and top edges of the right-pane collage window.  These scale numbers show inches or centimeters from the top-left corner of the page or collage area.  You can also check Lines to show horizontal and vertical lines for the grid rather than just dots at the intersections.
The Grid Scale allows you to layout the collage in terms of inches or centimeters rather than document coordinate pixels.  They can optionally also be used to automatically align images onto the grid using the Snap to Grid Dots toggle command (or Ctrl+G on the keyboard).  You can also turn the grid scale off and back on with the Show Grid Scale toggle (or Ctrl+H) to temporarily see your collage without the overlaid grid and scale numbers.

The Keep maximum photo resolution checkbox controls whether FxFoto keeps extra resolution for photos that are smaller in the collage than their original size.  When checked, FxFoto keeps as much resolution as possible for printing rather than de-resolving photos for viewing on screen.  FxFoto also keeps extra resolution for printing text with Anti-Aliasing.  Uncheck Keep maximum photo resolution for smaller encapsulated collages and slide shows intended for screen viewing (rather than printing) and for sending over the Internet.
You should usually check Keep maximum photo resolution for collages that will be printed.  However checking this option can slow some FxFoto operations and result in very large collage or slide show document files.  Uncheck Keep maximum photo resolution for printable collages that will contain a large number of photographs, especially for computers without much available memory.  Once saved, your collage requires significantly less computer memory resources.  Yet when you choose Printer Page Layout Page Guides, the collage retains more than enough resolution for most printers.
Checking Squeeze or expand layout to fit resizes all collage images to fit the page guides when you press OK.  For example, if there are images outside the guides, all images shrink so that the collage just fits inside.  Or if there is extra blank background beyond the images, then the collage proportionally expands to just fit the guides. Note that for 3D and 3D Scrolling collage types, you normally want extra images and text below the page guides that scrolls into view and so should keep Squeeze unchecked.
You can check 600 DPI for higher resolution collages that may print with slightly sharper text.  Normally, FxFoto uses 300 or 400 dots per inch, which requires significantly less computer memory resources.  Generally you should not check 600 DPI unless you have at least 512 or 1024 MB of computer memory.  Even then, leaving it unchecked will usually give good results and significantly faster operation.
See also:

3D Perspective
3D Perspective

This is a tab in the Collage Settings dialog.  It controls how 3D Perspective appears for scrolling Star Wars® like collage viewer presentations.  However, it does not turn on 3D Perspective for the collage in the Viewer.  You must do that if desired by checking Show Collage in 3D Perspective in the next Collage Properties tab dialog.

Check Edit Now with 3D Perspective to turn on 3D when you press OK.

Check Show Haze in the Distance to fade the 3D effect in the distance before the clip limit.  It computationally impossible to show an infinitely large collage area all the way to the 3D vanishing point and so the there is a cutoff point which can look somewhat more natural with this haze effect.

Check Deresolve large windows in 3D to allow the Viewer and also your FxFoto editor application to show 3D perspective with less resolution.  The 3D effect is computationally intensive especially for larger windows on slower computers.  This setting makes movements less jerky at the expense of screen fuzziness.  Small enough windows are shown at full resolution (as defined by the 3D Deresolve Min Screen Area setting in the Options dialog for the target computer).

You may find that specifying a smaller than normal Viewer window size in the Collage Properties tab dialog makes 3D smooth enough on most computers even when Deresolve large windows in 3D is not checked.  Try turning off 3D Deresolution and setting the Collage Properties Force the Viewer to a given pixel window size with 400 as Wide and 300 as High.  Even smaller sizes are possible.

The 3D Mode controls how far into the distance the collage appears before being clipped and also controls whether it is clipped to the left and right beyond the standard width.  Clipping with less distance and width reduces the 3D computation for smoother motion.

The Vanishing Point Offset controls where the 3D vanishing point is placed relative to the top the window.  Negative settings place it above the top of the window (and -50 is the normal default).  Positive settings place it lower inside the window for a more severe perspective effect.

See also:

Collage Properties
Collage Properties

This is a tab in the Collage Settings dialog.

You can choose a different Collage Type at the left side of the dialog and all the other settings will change to your last-used defaults for the new type.  See the New Collage Wizard help for descriptions of the types.  You can press the Default Settings button to switch back to the standard settings for the chosen Collage Type.

You can check or uncheck the other settings as desired.  In addition to applying to the saved collage, most settings considered non-essential for the collage type are also remembered for future collages you create with the same type.  Note that many of these settings also appear during the Save Collage Wizard.

Check Private Editing Only so that only you can change the collage.  A private collage can still be viewed by anyone with the FxFoto Viewer.  But it can only be opened with your registered copy of the FxFoto editor application.  Not all FxFoto Editions can set Private Editing Only.  This feature requires the Media Edition.
Check Temporary Collage to avoid being asked to save the collage when closing or exiting.  Temporary collages are used for browsing images that are not intended to be permanently arranged in a collage file.  However, when you make certain changes to a collage (such as repositioning photos or editing the slide order), FxFoto automatically assumes that you are building a collage or slide show and asks to save it even if temporary.  When Temporary Collage is checked and you correct a picture, you are asked whether to save the modified image file to disk.  Otherwise, picture changes are normally encapsulated in non-temporary collages when they are saved and you should use the Save Image As or Save Modified Images commands to save the modified picture to a separate image file.
Press the Set Expiration Date button to stop viewers from using your collage or slide show after a specified date and time.  On the popup calendar, choose a future expiration date or press No Expiration to clear any existing limit.  The calendar initially shows today’s date at 12:00 AM when no expiration date has been set for the collage.  You must choose a future date and time.  FxFoto beeps if you leave the date at 12:00 AM today or try to choose a past date.  When you set an expiration, FxFoto also automatically sets Private Editing Only for the show so that it cannot be modified by others.  Press the No Expiration button to allow the show to be viewed without limit.  Not all FxFoto Editions can set an Expiration Date and this button may ask you to upgrade if you are using and edition that does not support it.  This feature requires the Media Edition.
Check Encapsulate to include the images inside the collage file.  Encapsulated collages or slide shows have copies of their images included inside the .FXF or .FXE collage document file.  If unchecked, the document file just references separate image files by name and images cannot appear if you move the collage file to another computer without the referenced files.  Non-encapsulated collages and slide shows are smaller but are not portable.  Also, non-encapsulated collages cause image modifications to overwrite the original images when you save the collage.  But encapsulated collage documents save copies of the modified images without changing your original images.  You should usually keep Encapsulate checked.
Check Keep HTML as Text to encapsulate your text as formatted HTML rather than as an image file.  Keeping HTML text generally results in a smaller collage file and also preserves the text for future editing.  If you uncheck this, you will not be able to use the Text command to examine or change any text after the collage has been saved and then re-opened.  However, if you move the collage to another computer with different fonts, the Viewer must try to match the available fonts with those you originally specified.  Therefore, the text may appear a little different in different Viewer systems.  Uncheck this item for a completely uniform look.  It is usually best to uncheck it only when the collage is complete and ready to publish (and you may want to make a backup copy of the original with editable text.)

Check Include Thumbnail Images to save separate small thumbnail images of large photographs that initially appear with less detail from high altitude.  This option is primarily intended for advanced users who publish collages from web pages.  The Viewer loads the thumbnail versions first (if reading the collage directly over the Internet from a web site) and so the user sees them first before the larger full-resolution images have time to load over a slow connection.  This option is less important if the collage is read over a fast network or is e-mailed as a file where the viewer cannot incrementally read it.  In most cases, you should leave it unchecked.

Check De-Resolve Images to a 1:1 View to reduce image sizes as needed to match the 100% Zoom level in the Viewer.  If you have loaded large photographs and especially if you have reduced their size on the collage, this option can save significant space by compacting the images to the standard collage resolution.  However, the Viewer cannot then print the photographs at their higher original resolution.  You can check Deresolve 4x Smaller to make the encapsulated images even smaller than the normal 1:1 size.  Encapsulated collages are much more compact but images are more fuzzy.  Note that the collage Keep maximum photo resolution Page Guides setting this overrides this one.
Check Show NavBar Tools in the Viewer to force the NavBar with its navigation joystick and speed slider to appear on the left side of the Viewer.  You cannot check this if you choose to Lock the Camera.

Check Show 3D Perspective in the Viewer to cause the Viewer to show the collage in 3D mode.

Check Enable Click Zoom Down to cause the Viewer to show a magnifying glass icon when over small thumbnail images from high up.  Clicking on an image zooms the Viewer down to the full 1:1 detail level centered on the image.

Check Automatically Assign Tour Stop Numbers to give each image you add to the collage sequentially higher tour stop or slide number.

Check Allow Blowup View to show images enlarged beyond their normal 1:1 size when the viewer window is big enough.  Images will be larger in a larger window but may be fuzzy if they are encapsulated and de-resolved to their 1:1 view.

Check Borderless Viewer Window to force all slides to completely fill the Viewer window. FxFoto automatically cuts off a little of each slide image on the top and bottom or on the left and right if needed to make it fit the window or full-screen shape. Borderless works best for single-photo slides without Title or Caption text outside the actual photo (which might be cut off for a borderless slide). Wipe entrance effects usually look best with a single photo on a borderless slide so that the entering photo completely covers the display window. Note that you can also make individual slides borderless in the Slide toolbar's Special Effects tab, using the Borderless checkbox, as long as the Borderless setting here is off.

Check Lock the Camera to prevent the user from navigating the Viewer except with the standard Back, Home, and Next buttons.  You cannot check this if you choose Show NavBar Tools.

Check Disable Printing and Copying to stop the Viewer from producing copies of your images.  The Viewer’s Print and Copy commands are disabled.

Check Start the Viewer with High Image Thumbnails to initially show the entire collage and all images from as high as necessary.  This is overridden if you specify a specific initial camera view in the next dialog.  Note that you need not have Include Image Thumbnails checked for this feature.

Check Start the Viewer North of Images and Scroll Down to show a slow top-to-bottom scroll of the whole collage in the Viewer.  Note that this mode overrides any initial camera view you set in the next dialog.  It causes the 2D or 3D Scroll effect.  The user can press Home to return back to the top and continue scrolling.

Check Looping Slide Show to allow the Viewer to loop back to the first slide after the last.  If unchecked, the show stops after the last slide and the Next and Back buttons cannot loop around the end or beginning of the show.

Check Collage Controls Printing Parameters to keep a separate copy of most Print Settings in the collage.  The collage settings override normal printing defaults.

Check Precalculate Viewer Transitions Between Slides to have the FxFoto Viewer calculate the slide transition views during idle time between slides when there is no movement. This can help slide entrance effects to display more smoothly. However, depending on the entrance effect and the amount of idle time between slides, it may not always be possible to show the entire transition smoothly. Also unchecking this allows the Viewer to use substantially less RAM memory resources during a slide show.

Check Automatically Add in Row-Wise Order to cause added collage images to be initially placed to the right of the previous image until the end of a row is reached.  Uncheck to place added images below the last in a column.  When checked the Max Collage Width field is enabled to the right to specify the row width.  Note that this setting applies only with the Collage Add mode where new images open to the same slide.  This setting is also available in the Edit menu.
Check Force the Viewer to a given Window Size to specify a non-default Viewer window in the next dialog.  When checked you can specify the desired Wide and High Viewer size or check Max for maximized or Full for full-screen mode.

See also:

Collage Viewer Settings
Collage Viewer Settings

This is a tab in the Collage Settings dialog.  Note that many of these settings also appear during the Save Collage Wizard.       

You can specify which of the standard Navigation Buttons appear at the top or bottom of the Viewer window.  The Back and Next buttons step forward and backward through the tour or slides (or return to previous location if the user navigates).  The Home button returns to the beginning of the tour or slide show or the default initial camera you specify.  The NavBar button allows the user to toggle the left-hand navigation toolbar in the Viewer (and is not recommended if you have locked the Viewer camera). The Done button causes the Viewer to exit (but first presents a Slide Time dialog which allows the user to modify the time per slide and continue.  Check None to omit these buttons when the collage appears in the Viewer or check Above or Below to place the selected buttons centered at the top or the bottom of the Viewer window.
The Allow Slide Time Adjust can be unchecked to stop the user from seeing a Viewer dialog that allows the default time per slide to be adjusted to speed up or slow down the show.  This dialog normally appears when the user clicks on a full screen show or presses a Done button.

The Any Click for Done can be checked to cause any user click (or key press) in the Viewer to work like a Done button, showing the done dialog to exit or adjust slide times (or just exit if Allow Slide Time Adjust is unchecked).  Even when checked, the click for done feature is automatically disabled when the collage has clickable buttons or links.  Note that the Esc key still works like a Done button even when this setting is unchecked.
You can also specify the speed of Navigation in the Viewer when the collage opens.  The User’s Default setting leaves the speed and navigation mode unchanged.  The others set the speed for collages where the camera is not locked.  The Custom setting allows any desired speed.  To change the speed of 3D and 2D Scrolling collages, you must choose Custom and enter the desired speed.
You can specify a new Default Camera View to Show First in the Viewer.  Press Show Current View to specify the view you currently see.  Press Show Copied View to use the last Copied View you saved in the View menu.  Or press Clear Initial Camera to stop from specifying an initial view and use the default instead.  Warning: The initial camera may be overridden by the Start Viewer North of Images and Scroll Down setting in the Collage Properties dialog.  It overrides the Start with High Thumbnails View setting.  Be sure to coordinate these settings between the two adjacent tabs. 

See also:

Add Custom Button
Collage Properties
Add Custom Button

This command allows you to create a custom button for the collage or slide show.  These custom buttons look very professional and use one of four translucent colors which light up when the mouse passes over them.  But unlike pre-created button graphics, FxFoto automatically creates a custom button with exactly the anti-aliased text you specify and the exact width desired.  They can either be positioned on the collage background or fixed on the Viewer window so that the collage slides under them.  Note: Before you can add a custom button to a new collage, you should first add another image or text object.

Enter the desired Button Text to appear.  The button automatically grows wider with more text.

Specify the Button Color, which can be blue, green, red or gray.

You can optionally specify a Min Pixel Width for the button.  Normally the button is sized to fit your text.  But to create a number of standardized buttons all with the same width, set this to a non-zero value and keep the text short enough to fit in that width.

Check on of the various radio buttons to select the link action performed when the button is clicked in the Viewer.  The same actions as described in the Image Click Link dialog are available.

Choose Move Camera View when button is clicked, where you press either the Target Current View or Target Copied View to set the target coordinates.

Choose Link to Browser URL and type a web page or document address or press From Favories to choose the URL from your Windows Explorer Favorites folders.

Or choose one of the standard button actions: Back, NavBar, Done, Home or Next for the button.

Check Fix button in the window to keep the button from moving with the collage background.  A fixed button allows the collage to slide under it as you navigate the collage.  Uncheck this to place the button at a specific point on the collage background (such as below an image).

Then press Create Button or OK to add the specified button to the collage.

See also:

Folder Commands
Folder Commands

The Folder button on the lower left side of the top dialog bar shows various commands which apply to the folders and thumbnail images on the left.  An expanded version of this menu also appears when you right click on a selected thumbnail.  A more limited menu appears when you click on the small folder title image.
To use one of these commands, click on the desired left-pane folder photo to open the preview and then press the toolbar’s Folder button.  You can also right click on the photo to select it without opening and this same Folder menu pops up.  Some of these commands do not appear in all FxFoto editions.
These Folder menu commands are described:

Open Photo
Add Photo to Collage
Open Folder Photos
Use as Stamp Image
Use as Background
Thumbnail Size
Jump to Folder
Folder Order & Setup
Minimize or Maximize All Folders
Picture Information
Rotate Picture Right
Rotate Picture Left
Move Picture(s)
Delete Picture(s)
Copy Folder To or From PC
Archive Folder to CD-ROM
Folder Password Locking
Hidden Folder Photos
Remove Whole Folder
Rescan Folder
Rename Folder
Folder Print
Folder Slide Show
Open Photo is the first choice when you right click on a folder photograph.  The selected photo opens into the right-pane collage area just as it does when you left-click on the photograph.  It either starts a new slide or adds to the current slide collage depending on the Collage Add  Mode.  This menu choice appears only when you right click on a folder or folder photo and not for the Folder toolbar button.

Add Photo to Collage is the second choice when you right click on a folder photograph.  The selected photo always adds to the current right-pane collage slide, even when the Collage Add  Mode is not selected.  This command is an easy way to add multiple photographs to the same slide, making a photo collage.  The Add Row-wise command determines whether the new image is placed after any previous photos in the current slide in row-wise or column order.  You can then move and resize the photos in the collage using pull tabs.  This menu choice appears only when you right click on a folder or folder photo and not for the Folder toolbar button.
Open Folder Photos allows you to choose and open multiple images from the selected folder in a single operation.

Use as Stamp Image sets the currently selected folder image to be used by both the File Stamp and Clip Stamp tools in either the Draw or Stamp Brush dialogs.

Use as Background sets the currently selected folder image as the collage background image.  This command is disabled if the current collage cannot accept a background image because does not have page guides to enclose the background or because it is set for Fill Pattern mode where special repeating pattern images are required.
Thumbnail Size adjusts the left-pane picture size (which is also the size of thumbnail images shown in many popup dialogs).

Minimize All Folders is equivalent to checking the [-] minus box in all folders to minimize them, showing only the folder name, creation date range and tiny thumbnail of the first photo.  This can make it easier to find a particular folder or to drag between non-adjacent folders.  Just click individual [+] plus boxes to expand the folders you want to see.  FxFoto reverts to all folders fully showing when it starts or re-starts.

Maximize All Folders appears instead if all folders are currently minimized.  So for the equivalent of checking the [+] plus box in all folders, first press Minimized All Folders if needed and then repeat the command when it has switched to Maximize All Folders.
Picture Information allows you to examine and change keywords and other information associated with the currently selected left-pane thumbnail.  Right click on the photo to assure that it is selected.

Rotate Picture Right rotates the selected left-pane photo 90 degrees clockwise.

Rotate Picture Left rotates the selected left-pane photo 90 degrees counterclockwise.

Move Picture(s) allows you to move or copy the images from the currently selected left-pane folder to another folder.

Copy Folder To or From PC only appears in the Portable Pictures version of FxFoto.  It is similar to Move Picture(s), but always copies the whole selected folder to the a folder by the same name on the other disk.  It copies a removable device folder to the PC or a PC folder to the removable device.  It always copies images and does not remove them from the selected folder.  If the target already has a folder with the same name, then it adds all of the images from the selected folder and will duplicate images that have previously been copied.  Otherwise it creates a new folder on the target side with the same name.

Delete Picture allows you to erase the currently selected left-pane photo.  It can optionally remove only the thumbnail from FxFoto without deleting the underlying photo file.

Archive Folder to CD-ROM copies all photograph files for the currently selected folder to CD and optionally removes them from your computer to save space.

Hidden Folder Photos allows you to hide selected images so they no longer appear in the folder.  You can latter use the same command to show them again.

Remove Whole Folder removes the selected folder from FxFoto.  Remember that the selected folder is the one containing the selected photo with the blue outline.  The special Search Results folder can also be removed.  Just click on the small title image right of Search Results and choose Remove Whole Folder.  You can also use this command to remove multiple folders at once.
Rescan Folder looks through the selected folder’s target directory and adds or removes folder thumbnails when the underlying photo files have changed.  It can also re-order the folder images chronologically or alphabetically.
Rename Folder can rename the currently selected folder.  Note that the selected folder is the one containing the currently selected left-pane photo with a blue outline.

Folder Slide Show starts the FxFoto Viewer showing a slide show of all of the images in the currently selected left-pane folder (the folder with the blue outlined current photo).  It normally shows photos but not any special Collage or Movie thumbnails.  But it can optionally show a collage or slide show contained in the left-pane folder.  Just right click or click on the desired left-pane Collage thumbnail if needed to select it and then the Folder Slide Show command asks whether to show the selected Collage rather than the other folder images.  When the Viewer appears, click anywhere or press the Esc key to show a dialog that allows you to adjust the time per slide and continue or to exit the Viewer.
See also:

Open Folder Photos
Thumbnail Size
Picture Information
Rename Folder
Open Folder Photos

This is a command in the Folder menu.  One or more images from the currently selected left-pane folder can be opened into the right collage pane to be used in various commands.  Before starting this command, make sure the Collage Add Mode is set as desired depending on whether you want the opened images to go into the same collage slide or each become a new slide.

Note: This command opens plain images, both photos and scrapbooking background and element images, but cannot open any collage, template or matte files that are also in the folder.  Collages, templates and mattes must be clicked open individually.  They appear with a small symbol in the upper left corner of their thumbnail.

First you must Choose Folder Photos to be opened.  A popup dialog shows thumbnails of all images in the selected left-pane folder.  Initially, the currently selected photo has a green tag, but you can click images to include or exclude them from those to be opened.  Press Include All to tag all of the folder’s images for opening.  Press Include None to turn off the green tags for all folder images, but you must then click at least one photo to be opened.
When the desired images have green include tags, press Open.  A progress bar appears as the selected images are opened.  Opening a large number of images, especially into a single collage on the same slide can use excessive memory, causing slowness or other problems.
Note that this command opens only pimages and not collages or slide shows.  Any selected collage files are ignored.  Collages and slide shows replace all open image and so can only be opened one at a time by clicking on their left-pane Collage icons.

See also:

Thumbnail Size
Thumbnail Size

This is a command in the Folder menu.  Use the slider control to change the width of thumbnails appearing in the left-pane folders window (and also for thumbnail images shown by many popup dialogs such as Import).  Thumbnails may be 32 to 160 pixels wide.  As you move the slider, the folder thumbnails change size.  However, the final size is set only after you press OK and reverts if you press Cancel.  As you increase the size, the preview thumbnail may look fuzzy but will resolve to full resolution after you press OK.
See also:

Jump to Folder
Jump to Folder

This is a command is in the Folder menu and also the Add wizards.  It allows you to quickly show any folder without scrolling the left pane to it.  Choose the desired folder name from the drop-down menu.  You can also type the name or the beginning of the name.  Uncheck Alphabetical Pull-Down Folder Order to see the folders in the drop-down menu in the same order as they currently appear in the left pane.  Check Show Only FxFoto_Clips Folders to omit normal folders from the drop-down menu and show only special scrapbooking kits that come with the Creative Edition CD.
See also:

Folder Order & Setup
Folder Order & Setup
This is a command in the Folder menu which allows you to modify the way your left-pane folders appear.  It is also available from the Folder Setup button under Settings.  Some of these settings also appear in the Options dialog.
Alphabetical Folder Order can be checked to rearrange the folders alphabetically instead of by beginning photo creation date and time.
Animate Folder Scrolling can be unchecked so that the left pane thumbnails scroll up and down exactly with the scroll bar tab.  If checked, then images move at a slower speed to reach a new scroll point, quickly showing the images in between.

Show Timeline can be unchecked to omit the left-hand folder timeline.

Show Folder Tooltip Information can be unchecked to stop file name, creation date, and extra description text from popping up when you hover the mouse over left-pane folder thumbnails.  Unchecking this also omits the arrowheads normally drawn over the small thumbnail images to the right of folder names.  These arrowheads serve as a reminder that clicking the image presents a menu of commands for the folder.

Minimize All Folders on Startup will make all left-pane folders minimized and showing only their names whenever you first start FxFoto.  More folders are visible when minimized but startup may take slightly longer.  You can then click individual folder [+] plus boxes to show their images.
Reverse Folder Order can be checked reverse the alphabetical or chronological order so that the end of the alphabet or the oldest date appears at the top.

Uncheck Remove from To Do on Open to permanently keep files in your To Do Folder.  The special To Do Folder is automatically created when you use the Get To Do Folder Image command.  When Remove from To Do on Open is checked and you drag or click open To Do images, they are automatically removed from the left pane folder.  By unchecking this option you can keep these images for reuse later.  This is the same as the >Remove Opened Images from the To Do Folder in the Drag & Drop Settings.
Show Portable Folders First only appears in the Portable Pictures version of FxFoto.  Check it to arrange the folders so that all blue portable folders from the removable device are first at the top while all red PC folders follow at the bottom.  If unchecked, then the portable and PC folders are interspersed according to the currently chosen chronological or alphabetical sort order.

Install Zipped Kit

Press the Install Zipped Kit button to in the Folder Order & Setup dialog or choose Install Zipped Kit from the Tools menu to have FxFoto unzip a chosen file into a new left-pane folder.  
Before using this command, you must download or otherwise obtain a standard zip file with images, such as a digital scrapbooking kit with paper and embellishment images.  Download the zipped file and save it to a know location somewhere on your disk, such as in Pictures or My Pictures.  
Install Zipped Kit pops up a file selector and you should choose the zip file to be installed and press Open.

A second popup asks you to Enter name for the new left-pane folder.  By default, FxFoto will create a folder with the same name as the zip file, but you can change the name as desired and press OK.  (If the zip file was downloaded directly to an FxFoto_Clips sub-folder, then Install Zipped Kit assumes you want to use that as your left-pane folder and does not ask for a folder name.)
FxFoto automatically unzips the kit and places the included files in a folder by the same name under the special FxFoto_Clips area off of Pictures or My Pictures, where FxFoto keeps special graphics folders.  Or you can pre-create a folder off of FxFoto_Clips and save the zip file there to have the kit installed in the same folder.  FxFoto automatically places all kit files in the same new folder even if the zip file grouped them in multiple sub-folders.

After unzipping, FxFoto automatically scans and creates a left-pane folder and thumbnails for all included images (including PNG and GIF files).  FxFoto automatically sorts the kit folder alphabetically by image name.

The Install Zipped Kit command may not be included in your edition of FxFoto.
Install Unzipped Kit

Press the Install Unzipped Kit button to in the Folder Order & Setup dialog or choose Install Unzipped Kit from the Tools menu to have FxFoto scan a chosen folder into a new left-pane folder.  A popup tree selector appears and you should choose the Windows folder where the kit image files have been previously unzipped or copied.  
Then a second popup question asks whether FxFoto should also install any sub-folders found in the selected folder.  Choose Yes to install both the selected folder and any sub-folders found with JPEG, PNG, TIFF or GIF graphics files.  If the selected folder does not have graphics files then only sub-folders are installed.  Choose No to only install the selected folder even if it has sub-folders with graphics files.  Choose Cancel to abort without installing.
FxFoto automatically scans and creates a left-pane folder and thumbnails for all included images (including PNG and GIF files).  FxFoto automatically sorts the kit folder alphabetically by image name.

The Install Unzipped Kit command may not be included in your edition of FxFoto.
Drag & Drop Settings

Press this button from Settings or Folder Order & Setup dialogs for a separate dialog of settings that control how images are dropped into right-pane collages which are not Quick Sketch Templates.  This dialog also appears when you press Ctrl+Q.  Normally images are dragged and dropped from left-pane folders, but they can also be dragged from Windows Explorer or other applications that support drag and drop.  Most of these settings apply only for FxFoto Creative, Media or Quick Layouts.
When a dropped file does not replace another image, check Drag and Drop Next to Last Image to position it in the standard collage next-image position FxFoto would choose if you clicked open the image file instead.  When unchecked, the image is placed near the drop point where you release the mouse button.  This setting is also available in the Options dialog.

Uncheck Keep Extra Frame Adjust Margins to cause FxFoto to crop photos that are dropped over non-matching images or template areas.  When checked, FxFoto keeps the non-visible portions of the photo for possible use later with Adjust Visible Framing.  If not checked, then FxFoto crops non-visible portions, conserving memory resources.
Uncheck Remove Opened Images from the To Do Folder to permanently keep files in your To Do Folder.  The special To Do Folder is automatically created when you use the Get To Do Folder Image command.  Normally when you drag or click open the To Do images, they are automatically removed from the left pane folder.  By checking Remove Opened Images from the To Do Folder you can keep these images for reuse later.

The Replace Old Images settings control whether images dropped on top of other right-pane collage images replace the old image.
Check No to always add the new image and keep the old one too.  This is the same as checking Do Not Ask About Replacing Old Images Again in the Replace Dropped Image popup dialog.  The other two choices allow the Replace Dropped Image popup question to appear.
Check Yes to keep the whole replacement image without rotation or cropping.  The Replace Dropped Image popup question appears with this setting selected by default.
Check Crop and Rotate to use the old image as a mask to similarly crop the new image into the same shape.  However, the new image is always sized as large as possible to fit the old image's crop shape and is centered.  The new image is also automatically rotated to match the old image being replaced.  The Replace Dropped Image popup question appears with this setting selected by default.

The remaining settings apply to Quick Sketch Templates.

Check Eliminate Surrounded Text to have FxFoto try to cover text letters that are inside of template fields when you drop in images.  Adjust the Embedded Text Maximum Area Percent setting further below to avoid eliminating larger photo areas embedded inside paper mattes.  Only embedded areas smaller than this threshold are eliminated, but that may include small embedded patterns that are not text.
Hint: When the template image has text that touches or crosses the border of a template area, it will still show through even with the Eliminate Surrounded Text option.  If possible, choose template images without text to avoid problems.  Otherwise, you may have to erase the text from the template image before using it.  Open the template image file into the right pane normally.  (Or if you have already opened it with this Quick Sketch Template command, right click on it and uncheck Non-Selectable Image so that you can edit it.)  From the Draw toolbar dialog, choose the Get Color tool and click on the adjoining gray or colored area to get its color.  Then choose the Brush Pen tool (and do not check Transpar).  Carefully brush the color over text at the edge of the area.  On the other side of the area boundary, use Get Color again to get the adjoining area color and then use Brush Pen again to erase the text that overhangs the edge on that side.  You can usually leave text letters that are entirely embedded inside a single template area as long as Eliminate Surrounded Text is checked.
Check Warn When Click Open Without Drag & Drop to see popup reminder that photos and papers must normally be dropped onto the desired sketch template area.  If you click open an image without dragging it, the warning appears unless this setting has been unchecked.
Check Make Template Areas Slightly Larger to Overlap to slightly pad images dropped into template areas.  This can help cover gaps between areas.  The Pixels to Overlap Template Areas field further below can be adjusted to control the amount of overlap, up ot a maximum of 9 pixels.
Check Rope Dropped Photos Without Automatic Crop to adjust dropped photos before cropping them to the template area outline.  As described below, FxFoto distinguishes between dropped paper and photo images and this setting only applies when a photo is dropped.  When unchecked, the photo is automatically centered in the template area and cropped to fit.  When checked, a rope outline is created around the template area and the un-cropped photo is placed under it.  Switch to the Mouse toolbar dialog if needed to grab and drag, resize and/or rotate the photo to position it as desired.  Then switch to the Crop toolbar dialog and use the Crop Image button to finish cropping the photo.

When you drop an image onto a Quick Sketch Template, it is treated differently depending on whether it is a photo or a paper image.  Photos only fill a single template area even if there are other areas with the same color.  Paper images span all template areas with the same color and do not re-size to exactly fit the template area (so that different papers all appear at the same template scale).  By default, Automatic Paper vs Photo Detection is checked to have FxFoto guess whether a dropped image is paper.  Only images which are 2400x2400 or 3600x3600 pixels (8x8 or 12x12 inches at 300 dpi) are assumed to be paper.  Other images are assumed to be photos.  You can check Drop Images as Photos or Drop Images as Paper to force all images to be treated as one or the other.  Moreover, you can switch this setting as desired just before dragging and dropping an new image.

The Color Match Tolerance adjusts how much template field colors can vary without being treated as separate regions.
Adjust the Surrounded Text Maximum Area Percent setting to avoid eliminating larger photo areas embedded inside paper mattes.

Adjust the Pixels to Overlap Template Areas setting to control the overlap used when Make Template Areas Slightly Larger to Overlap has been checked.  The overlap cannot be set to more than 9 pixels.
The Minimum Pixel Threshold for Paper Areas adjusts how large a template colored spot can be before it is treated as a separate matching area when paper is dropped.  Templates which use text often have small spots of gray around the text that is the same color as real template areas and this setting allows FxFoto to ignore such small splotches.

Tip:  The sketch template background and dropped paper images automatically have Non-Selectable Image checked so that they cannot be moved out of position by mistake.  You can right click on and uncheck Non-Selectable Image to move or edited dropped paper images.  Dropped photos are left selectable so that Frame Adjust can be used.  But you may want to right-click and make photos Non-Selectable so that they cannot move.
Note:  In order to allow you to add embellishments to a layout, PNG images do not normally replace Quick Sketch Template areas or underlying images.  The same applies to GIF, BMP and VIB image files.  So normally only JPEG or TIFF photo or paper images can be dragged and dropped to replace Quick Sketch Template areas or other images and embellishment-type images are just added on top.  However, this feature is disabled if you have selected Drop Images as Photos.  By checking Drop Images as Photos, you can drop any type of image as a replacement for a template area or another image.
Get Creative Extras
Press the Get Creative Extras button to start your web browser and show the Creative Extras Download page where you can download and install the extra digital scrapbooking kits and graphics that are available with the FxFoto Creative and Media Editions. The same page also has the extra software download required the first time you use certain Creative and Media commands. If your browser does not pop up, you can optionally start it separately at this address: 

http://www.FxFoto.com/FxExtraDownload.htm

The Get Creative Extras> requires the Creative or Media Edition and is disabled in other editions.  Please Note: The downloads will not install unless you have already have FxFoto Creative or Media Edition installed and enabled with the proper Registration Number.

See also:

Picture Information
Picture Information

This is a command in the Folder menu.  It shows and possibly modifies information for the selected left-pane thumbnail photograph.  Note: Some you cannot modify information in the special My Camera folder that appears in some versions of FxFoto.
Centered in a sunken box at the top is the complete disk path and file name for the photograph.  Press Copy Photo File Path Name to the Clipboard to get a copy of the text file name that you can paste into another application’s file selector to open the photo.  This also allows the photo to be used with the Clip Stamp Stamp Brush tool.  Note that if the photograph was archived to CD-ROM, then it may show a special name that begins with =: and includes the CD’s [label] and cannot be used elsewhere.
Press Rename the Photo File to change the photograph’s name.  A popup dialog shows you the photo’s current base file name (without any beginning disk or path and without the extension).  Type a new name and press OK to rename the photo file as desired.  Type only the base name without beginning disk or path and without the ending .JPG extension.
Click on one or more Keywords to select those that apply to the left-pane photograph.  Click again on a word to unselect it.  Press New Keyword to add a new word of your choice to FxFoto’s standard list.  Press Purge Keyword to remove the selected keyword from FxFoto’s list and the selected photo.  However, Purge does not remove the keyword from any previous images to which it was applied.  Hint: You can apply the same keywords to more than one photo in a single step by opening all desired photos into the right pane and then using the Info Picture Description toolbar's Apply All button.
You can also type one or more lines of text Description for the photo.  This becomes popup text when the mouse hovers over the photo once it is opened into a collage and presented in the FxFoto Viewer.

Below the Change Date button, another box shows the photo’s creation date (when the picture was taken) plus some of the more important EXIF Camera Information.  The EXIF information is present only if the photo file includes it.  Press the Change Date button to modify the date and/or time

The Camera source device name is also shown if known.  You can set or change this text as desired, possibly using it to record other sorts of information about the photo.
Press OK to apply any changes to the selected left-pane folder photograph.  Press Cancel to discard any changes.
Important:  When you add or change the Keywords, Description, Camera or Date, FxFoto saves the information in a special database for the folder and not in the photo's file.  You should periodically backup FxFoto folder database or you may risk loosing this information.  See Backing Up Your FxFoto Data.
See also:

Delete Picture
Move Picture(s)

This is a command in the Folder menu.  One or more images from the currently selected left-pane folder can be moved or copied to a different folder.  Make sure the desired source folder thumbnail is selected with a blue outline.  (Note that you can also move a single photo by simply dragging it to another folder or within the same folder.)
First you must Choose Folder Photos to be moved or copied.  A popup dialog shows thumbnails of all images in the selected left-pane folder.  Initially, the currently selected photo has a green tag but you can click images to include or exclude them from those to be moved or copied.  Press Include All to tag all of the source folder’s images for moving.  Press Include None to turn off the green tags for all folder images, but you must then click at least one photo to be moved.

When the desired images have green include tags, press Next and choose where the selected images will go.  If you have not selected any source images, FxFoto beeps and returns to the first Choose Folder Photos dialog.
Choose the desired existing Target Folder Name from the pull-down menu (or type its name).  You can also create a new folder by entering the desired new name (which must not match that of an existing folder).  FxFoto warns you before creating a new folder if typed name does not already exist.  Uncheck Alphabetical Pull-Down Folder Order to see the folders in the drop-down menu in the same order as they currently appear in the left pane.  
The Source Folder shows the name of the currently selected source folder and the number of selected images to be moved or copied.  If desired, you can press the Back button to return to the first Choose Folder Photos and change your selections.
Check Copy to duplicate images in the chosen target folder.  Otherwise the pictures are moved to the target and removed from its old source folder.  (Note that you cannot copy a photo back to its source folder.  Also read-only folders such as Search Results may not be targets and always use Copy when they are the source.)
Check Show the Source Folder Afterward to continue viewing the source folder from its beginning. Otherwise, FxFoto will jump to display the destination folder.
Press Finish to complete the move or copy.  If you have not chosen a Target Folder, FxFoto beeps keeps showing the Move Picture(s) dialog.  If the target is in a Locked folder, you must enter a password for the folder before continuing.
See also:

Archive Folder
Delete Picture(s)

This is a command in the Folder menu.  The currently selected left-pane image and possibly others can be removed from the folder and optionally erased from your computer disk.
When you right click on a folder image and choose Delete Picture from the popup menu, only the clicked picture is erased.  Press OK to remove the selected photo or collage from your left-pane FxFoto Folder.

When you click the small icon to the right of the folder title and choose Delete Folder Pictures or when you click the Folder toolbar button and choose Delete Picture(s), then a popup selector lets you choose one or more pictures from the folder with red [X] tags to be deleted.  From the popup select, you can use the Include All or Include None buttons to tag all or none of the folder for removal.  Then press Next to continue to the final dialog where you press the Delete button to remove the selected images.
Check Also Erase the photo files from your disk to delete the underlying photo files.  When checked, the underlying photo file or files are erased and moved to the Windows Recycle Bin.  If you remove a photo file by mistake, it is still available in the Windows Recycle Bin.  Remember that you must empty your Windows Recycle Bin to recover the disk space used by removed files.  If the checkbox is left unchecked, then only the picture's thumbnail is removed from FxFoto's left pane and the file remains on your computer.
Press Cancel to keep the picture or pictures.

See also:

Move Picture(s)
Archive Folder to CD-ROM
This Folder command copies all photograph files for the currently selected folder to a similarly named directory on CD-ROM.  You must have a CDR drive with a recordable CD blank (or one with unused space).  You cannot use a CD that has been formatted for Direct CD access.  Use a new unformatted CDR or one that has been recorded with separate CD creator software or the Windows CD Writing Wizard, but has space left.  (Note that this command archives unlocked non-encrypted copies even if the folder has been locked, but the Folder Password Locking command can record encrypted copies).

FxFoto requires Windows XP (or better) to directly write to CD.  For older versions of Windows or when you have checked Use Separate CD Burn Application in Options, FxFoto copies the archive folder to an FxFotoBurnCD directory within Documents or My Documents and you must start separate CD creator software to burn the contents.  FxFoto automatically removes FxFotoBurnCD after you indicated that you have finished recording the CD-ROM.
Note: Even if you are using Windows XP or Vista, you may not want FxFoto to directly burn to CD.  FxFoto uses the Windows CD Writing Wizard, which does not yet support DVD recorders and which may be incompatible with some third party CD recording software.  If you have CDR software from companies other than Roxio, such as some Sonic software, it may disable the Windows CD Writing Wizard and result in an error message when the wizard attempts to write directly to a CDR.  To avoid this problem, check Use Separate CD Burn Application in the FxFoto Options.  This causes FxFoto to save files to be burned in a separate FxFotoBurnCD directory off Documents or My Documents so that you can switch to your separate CD or DVD creator software to record.
After the folder photographs are recorded to CD, you can optionally choose to erase the photographs from your computer disk, leaving them only on the archive CD.  Note that this option is does not appear for read-only folders such as your Search Results.
If you choose YES, you may optionally Also Remove the Folder and Thumbnails from FxFoto.  Leave this unchecked to keep the archived folder with all thumbnails in FxFoto’s left pane.  Whenever you open an archived photo, FxFoto will ask you to insert the archive CD-ROM.  Some FxFoto operations such as rotating folder images will not be allowed for the folder in the future if its photos are only archived on CD.  If you check Also Remove the Folder and Thumbnails from FxFoto, then the folder is removed from FxFoto when you press YES.
If you choose YES, the photographs still remain archived on the CD-ROM.  Removing the archived folder is a good way of saving space on your computer.  You can later use FxFoto’s Import Disk Drive or Directory command to retrieve the photographs from the CD-ROM directory to a new FxFoto folder.  To restore with Import, press the Disk drive or directory button and Browse your CD-ROM drive.  Select the CD’s subdirectory for the archived folder.   (The directory to Import will be a sub-folder within the CD, normally with the name of the archived FxFoto folder, and not the whole CD-ROM).
Press the YES button and, if Also Remove the Folder and Thumbnails is not checked, then you will be asked to Choose the Archive CD Label which is the CD name FxFoto will request when the folder images are needed.

Press the NO button to keep the FxFoto folder and all photo files on your computer’s disk.

See also:

Archive CD Label
Choose Archive CD Label

Choose the name that FxFoto will request when you need to re-insert the CD-ROM to view an archived photo.  This is usually the label on the CD.  The default is the name of the folder that was archived.  Type your own name if desired and press OK to finish removing the archived images from your computer.
See also:

Archive Folder to CD-ROM
Folder Password Locking
Folder Password Locking

This command is supported only by the Media Edition and FxFoto Portable Pictures.  In other editions, it asks you to upgrade to the Media Edition and enable this and all other features.
This Folder command allows you to lock or unlock a left-pane folder.  All photos, movies, collages and slide shows in a locked folder can only be opened with the correct password and cannot be used by applications other than FxFoto.  This command can also make an encrypted CD-ROM copy of the selected left pane folder contents or copy a single encrypted photo or collage show to the FxFotoUpload directory, so you can upload or distribute password protected photos or shows.
Choose Unlock Folder to convert a previously locked folder back to normal and decrypt folder files so that they can be opened by FxFoto and other applications without a password.  This command also unlocks any hidden folder photos.
Choose Lock Folder to securely encrypt all photos, movies, collages and slides shows in the selected folder.  You must enter a New Password and then repeat the same password.  Be very careful that you know the password, which can contain both upper and lower case letters as well as special characters.  If you enter the desired password wrong or otherwise loose or forget it, the folder and all its contents will be useless.  You may want to backup the folder contents first.  You may also want to record the password in a separate secure location.  After you press OK FxFoto will go through all folder thumbnails and encrypt their files.  When you latter import, move or save images or collages to the folder, FxFoto will automatically encrypt them with the password (and will ask you to enter the password first if you have not already opened the folder).  This command also locks any hidden folder photos.  Locked folders show a blue padlock icon.
Choose Record Locked Folder to CD-ROM to copy all folder photos and shows to a CD-ROM in encrypted format using a chosen New Password.  The password need not be the same as used to lock the folder and indeed you can record encrypted files from an unlocked folder.  Hidden photos are not recorded.  FxFoto requires Windows XP (or better) to directly write to CD.  For older versions of Windows or when you have checked Use Separate CD Burn Application in Options, FxFoto copies the archive folder to an FxFotoBurnCD directory within Documents or My Documents and you must start separate CD creator software to burn the contents.  FxFoto automatically removes FxFotoBurnCD after you indicated that you have finished recording the CD-ROM.

Choose Copy Locked Selection to FxFotoUpload to copy just one photo or show file from the folder.  Only the blue-outlined selected photo or collage is copied with encrypting using the chosen New Password.  The password need not be the same as used to lock the folder and indeed you can copy encrypted files from an unlocked folder.  The encrypted file is added to a special easy-to-find FxFotoUpload directory folder under Documents or My Documents.  You can then switch to another application such as email or a browser web site and attach or upload the encrypted file.

Password protected collages or slide shows can be used with the free FxFoto Viewer, version 3.0.055 or latter, but the viewer will ask for the correct password.  Password protected photo files can only be opened with the complete FxFoto application and the correct password.  Password protected movies imported from cameras can only be opened with using FxFoto.  Movies are less secure since FxFoto must make a temporary non-encrypted copy to pass to the separate movie player application because FxFoto does not itself show movies.
Hint: To change the password for a locked folder, use this command and choose Lock Folder again with a different password.
Warning:  If you forget the password, it is impossible to open the folder or use any of the folder photos or other files.  Locked folders securely encrypt their files so that they can only be opened with FxFoto and only with the correct password.  Different folders can have different passwords.  If a password is lost, the folder files cannot be recovered, not even by Triscape Support.  The encryption is fully secure and no one can use encrypted files without the exact password.

Hint: If FxFoto Scanning finds previously locked photos that are not in a normal locked folder (possibly because FxFoto was uninstalled or because the locked files were copied with another application), they will show as beige left-pane icons with a padlock icon and the file name, but without thumbnail images.  They can be opened if you know the password that was originally used to lock them.  To remake a normal locked folder, use this Folder Password Locking command and choose Lock Folder with the same password.  Then to restore the normal left-pane thumbnail images use Rescan Folder.
See also:

Archive Folder to CD-ROM
FxFoto Password
FxFoto Password

FxFoto passwords protection can only be set by the Media Edition and FxFoto Portable Pictures.

This dialog appears when a password is required to use a locked folder or one of the folder’s photo, movie, collage or slide show files.  Locked folders initially appear minimized.  When you click [+] to maximize a locked FxFoto folder, this dialog appears and you must enter the folder’s password.  This dialog will also appear if you choose a locked folder as the target for Import or Move Picture(s), or if you use Save Image As or Save Collage  to save into a locked folder that is not already open.  This dialog will also appear if you try to open any of the photos, movies, collages or slides shows from a locked folder using Open Collage  or Open or Add Image from the File menu.
If you open another locked folder with the same password, this dialog does not appear again and the last password is automatically used.  Once you have entered a password, it remains until you Exit from FxFoto.  The folder contents and the contents of any other folder with the same password can be used by anyone with access to the computer until you exit FxFoto.

Passwords are set with Folder Password Locking and you must enter exactly the same password, including upper and lower case letters and special characters (but spaces are ignored).  If you forget the password, it is impossible to open the folder or use any of the folder photos or other files.  Locked folders securely encrypt their files so that they can only be opened with FxFoto and only with the correct password.  Different folders can have different passwords.  If a password is lost, the folder files cannot be recovered, not even by Triscape Support.  The encryption is fully secure and no one can use encrypted files without the exact password.

See also:

Folder Password Locking
Hidden Folder Photos
Hidden Folder Photos

This is a command in the Folder menu.  It shows a popup dialog with thumbnail images for all photos in the currently selected left-pane folder.  You hide selected folder photos by clicking to mark them with red X tags.  Or re-show hidden photos by clicking them again to remove their red X tags.  Press Hide All to tag all of the folder’s photos for hiding.  Press Hide None to turn off the red tags to show all folder photos.

Press OK and the selected photos will disappear from the left-pane view of the folder.  Use this command latter to show hidden photos again.  Hidden photos still appear in the Folder Slide Show.  Also Archive Folder and re-scanning the folder always stop hiding all photos.
Folders with one or more hidden photos or collage shows show a dark blue * asterisk when they are maximized.  The asterisk appears at the top to the right of the [-] minimize icon.  But it does not appear with minimized folders.
See also:

Rename Folder
Rename Folder

This is a command in the Folder menu.  The name for the currently selected left-pane folder appears and you can type a new name and press OK to change.  FxFoto requires that folder names be unique and it may add an ending number to your chosen name if required.  This command does not rename the actual disk directory where the folder images are stored.
See also:

Remove Whole Folder
Remove Whole Folder

This is a command in the Folder menu.  Press OK to remove the currently selected folder from FxFoto's left-pane folder.  Remember that the selected folder is the one containing the selected photo with the blue outline.  The special Search Results folder can also be removed.  Just click on the small title image right of Search Results and choose Remove Whole Folder.

If desired, check Also Erase All Folder Photos to move the folder’s image files to the Recycle Bin.
Note: The special To Do Folder does not have its own files and the photo files are not erased from the To Do Folder even when Also Erase All Folder Photos is checked.
This same command can be used to remove multiple folders at the same time, though you should use this feature carefully.  If you check Also Remove All Other Maximized Folders, then all folders that are not minimized are removed.  To remove multiple folders, you should first Minimize All Folders.  Then scroll through your folders and click the [+] to maximize the ones you think you no longer need.  Review the images in the maximized folder to be sure you no longer need them and if you change you mind, click the [-] to minimize.  Once only the unwanted folders are maximized with their images showing, use the Remove Whole Folder command for one of them and check Also Remove All Other Maximized Folders.  You can also check Erase All Folder Photos to delete the folder's underlying image files and move them to the Windows Recycle Bin.
Press OK to remove the folder or folders.
See also:

Rescan Folder
Rescan Folder

This is a command in the Folder menu.  It looks through the selected folder’s target directory and adds or removes folder thumbnails when the underlying photo files have changed.  It can also re-order the folder images chronologically or alphabetically.

Check Leave Old Folder Order to keep the folder thumbnails in the existing sequence.

Check Re-Order Folder Photos Chronologically to arrange the thumbnails by the dates and times the images were taken or otherwise created.

Check Re-Order Folder Photos Alphabetically to arrange the thumbnails by their file name.

If you have moved the folder to another place from outside of FxFoto, then you must switch the folder's directory before rescanning so that FxFoto will be able to find and open the images in their new location.  The Windows directory where folder photos resides shows where FxFoto thinks the folder is.  Press the Browse button for a popup tree selector to switch to where the folder files now reside.  This does not move the folder.  It just tells FxFoto where you have already moved it with Windows Explorer or another application.
Press Scan to begin rescanning the chosen folder.
See also:

Folder Print
Print Folder Photos or Collage Layouts
This is a command in the Folder menu. It can print selected photos or collage layouts from a left pane folder without first opening them into the right pane.
Warning: Folder Print always clears the right pane. It closes any open photos or collage layout or slides show. But it first asks you to save if the open collage or photos have been modified and you can cancel if desired.
Hint: This command can be useful if you organize a scrapbook or other publication as separate collage layouts in a special left-pane folder and want to print all pages. You can arrange the folder's collages in the desired page order and print all or some pages in order. However, not all printers can handle large multi-page print jobs well, especially because photos require a great deal more memory resources than word processor text printing. Large jobs may cause some printers to slow down so much that the nothing happens for a very long time. Some printers can even misprint or skip pages when given too much high resolution photo data at a time. Before printing a large number of photos or layouts, first try just a few pages, especially if your computer or printer has limited memory resources.
Choose Folder Files to Print

First choose the folder images or layouts to print. A green tag appears in the upper-right corner of all images to be included.   Clicking on an image toggles the green tag either on or off. Press Include All to mark all folder files with green tags for inclusion or press Include None to un-mark all. You should not choose movie files since FxFoto can only print images and collage layouts.
Slide shows or other collages with more than one slide can be used, but only the first slide layout prints. Unlike FxFoto's Print Wizard, this command always prints one photo or collage layout per page. The first slide of any chosen collage file prints in the Entire Collage Print Wizard Format and photos or other image files use the Original Image format.

Folder Print Settings

Check Print White Background to print white instead of the collage background color, which saves ink and may look better on many printers.  However, Theme Templates override this setting and always print the theme’s background.  Also, any background image for the collage is always printed.

Normally FxFoto resolves the print source image to 6400 pixels width or height, the equivalent of about 600 dots per inch.  When your computer’s physical memory is limited (less than about 420 MB), FxFoto may use a smaller resolution to avoid overtaxing your computer resources, but uses at least 3000 pixels of resolution.  For example, FxFoto might use about 5000 pixels resolution on a computer with 256 MB of memory.  To send as much resolution as possible to the printer, check Print Maximum Resolution, but this may be slow, especially if the computer has limited resources.  Or you can check Print Custom Resolution and enter a number of pixels either smaller than 6400 (for faster printing) or larger as desired.  A few printer drivers may run out of memory with large resolutions and require a smaller custom setting, but this is unusual.  To reduce the memory requirements or for faster printing, try the custom resolution set to 3000, 2600, 2000, 1600 or 1000.  Some printers may blend colors better at lower resolutions for a better looking result.

Check Rotate Image to Best Fit the Page if you want wide photos or images to be rotated 90 degrees relative to your printer’s current setting (whether landscape or portrait) so that they best fit the available page.  However and Title and/or Caption you select to print on this dialog are always printed at the top and bottom of the page (given your current landscape or portrait printer configuration) and so can end up sideways relative to the image.  When printing snapshots, the individual photographs are rotated as needed to best fit and not all photos on the page may be oriented in the same direction.

Check Rotate an extra 90 degrees and/or Rotate an extra 180 degrees to fix image rotation as desired.  This feature is useful for producing greeting cards and also for snapshot albums where all shots of the page need the same orientation.
Check Borderless Printing to force non-snapshot printing (where there is one photograph per page) to completely fill the printer page.  When checked, the photo images are automatically cropped on the left and right or top and bottom to exactly fit the printer’s selected page size without extra margins.  If your printer can print to the edges of the paper size you select, then this option can produce borderless prints without any surrounding white area.  But for true borderless prints, your printer must be capable and you must choose a borderless paper type and/or the borderless option in the final Print dialog’s Preferences at the end of this wizard.  You should normally uncheck Add Title and Caption for borderless printing.  Framed photos or those with outside text annotations are poor candidates for borderless printing since parts of the frame or annotation text can be cut off.

Check Show Crop Mark Lines Outside the Printed Image to draw short black guide lines at the four image corners indicating the horizontal and vertical edges as an aid for cutting out the image.  Note that depending on the image size and the printable paper size, there may not be room for the crop marks and some may not appear.  For example, an 8x8 inch layout printed on 8.5x11 inch paper may not show horizontal crop marks on many printers because the printable area is not large enough.  It is usually a good idea to also keep the next Center Image Inside the Physical Printer Page options checked to leave as much room as possible for the crop marks.
Check Center Image Inside the Physical Printer Page to have FxFoto attempt to center the printed image or images so that the top versus bottom and left versus right borders are equalized on the printed page.  Many printers have a printable area that is not centered on the paper, often because they reserve a last strip to paper while printing the page bottom.  By checking this setting, FxFoto will add an equal strip of border on the other side of the page to center the printing.  This can result in a smaller printed image.  To maximize the printed image size, uncheck this setting to allow unequal borders around the printed image.  FxFoto depends on the printer settings being properly set for the paper you are using and cannot center the printing if the paper size is incorrectly set or if the printer incorrectly reports its printable page area.  When you use the Limit Printed Area described below, this Center Image checkbox also forces the limited print box to be centered on the paper rather than printed in the upper-left corner.
Check Add Page Margins to force FxFoto to move the left and top edges of the print.  Then fill in the desired non-zero left and/or top margins in inches or cm (which can be fractions such as 1.25 inches).  Non-zero margins include the unprintable area at the edge of the paper and must exceed the minimum blank area the printer requires at the edge.  The margins are ignored if larger than your printer’s page size or if they are set to zero.    Be sure to leave enough room after the margins the required print area.  The margins are automatically reduced if they are too big to allow the required print area, if any.  Note that unless you uncheck the previous Center Image setting, the printed image will be centered in the page area remaining right and below the given margins, which can have the effect of further increasing the margins.  Uncheck Center Image when using Add Page Margins and Limit Printed Area for better control of image placement on the page.  Leave Add Page Margins unchecked to have FxFoto fill the available printer page.
Check Limit Printed Area to force FxFoto to print only a limited page area.  Then fill in maximum width and height values in inches or cm (which can be fractions such as 3.5 inches).  Normally this setting should be left unchecked so that FxFoto fills the available printer page.  If you need FxFoto to limit the printed area of the page to a specific width and height, check and set the desired size in inches or centimeters.  For example, passport photos may require a specific image size.  The rest of the printer page right and below the printed area is left blank.  This setting only limits the printed image if smaller than the page size set in the printer’s preferences.  If your printer is set for a smaller paper size, the limits are ignored.  To force a single photo to print to the exact width and height dimensions, you should also check Borderless Printing (which is just above the Limit Printed Area checkbox).  With borderless printing, the photo will be automatically cropped as needed to fit the specified size.  Without borderless printing, extra white area may be added above and below or left and right in order to show the entire photograph.  When printing multiple snapshots per page, the limits are for the entire page of photos and not the individual images, which will be smaller.  Use the Center Image checkbox described above to print the given size centered on the paper rather than in the upper left corner.

Please Note: Collages using Printer Page Layout inch or centimeter Page Guides ignore the Add Page Margins and Limited Print Area settings when printing with the Entire Collage Format.  The margins and limits set on this dialog have no effect for Printer Page Layout collages because the layout predetermines the page margins and size. Collages using inch or cm Custom Page Size guides also ignore the Limited Print Area for Entire Collage.  In addition, FxFoto ignores Borderless Printing and may ignore the Center Image setting when printing collage layouts.

Check Add Title and Caption to place a custom message at the top and/or bottom of the page.  You can type whatever you like in two lines that appear centered on the page.  Typing [[NAME]] inserts the image or folder name and [[DATE]] inserts the image or collage last-modified date in your text. You can also specify [[PAGE]] for the page number.  By default, the name appears at the top and the date and page number at the bottom.  Since title and caption text usually detracts from the greeting card style, it is automatically omitted.

Start the Print Job

Press Finish from the second Settings dialog to present the Windows Print dialog where you can select the desired printer and change its Preferences before starting the print job. You must set the printer's preferences for the type or size paper being used. Neither FxFoto nor the printer can tell what paper is loaded. FxFoto can only print as large as the paper size selected in your printer preferences. So if you are using small photo paper, then FxFoto can print a full page photo to the desired size, but only if the printer supports the desired paper size and only if you have set that size in your printer's Preferences after you press Finish in the FxFoto Print Wizard. The Preferences dialog is part of your printer driver and will vary from printer to printer, so check you printer documentation for details.
Hint: FxFoto keeps a copy of the last printer settings used from FxFoto and supplies them as the default when it prints the next time. You can clear those remembered settings so that your printer's default settings are used with the Restore FxFoto Default Settings button in FxFoto's Options dialog.
See also:

Correct Photos and Edit Images
Correct Photos and Edit Images
The Correct button on the top dialog bar shows various tabs which allow you to correct and improve the last clicked or opened photograph or other image object in the right collage window.  The Correct toolbar does not appear in FxFoto Quick Layouts, which does not support photo editing.

Improve

Remove Red Eye

Remove Blemish

Clone Brush

Color Brush

Stamp Brush

Filter Effects
See also:

Crop
Improve

This is a tab under the Correct button.  It adjusts the brightness, contrast, gamma and color balance of the last clicked or opened images.  This dialog is not available in FxFoto Quick Layouts.
Press Auto Improve to automatically adjust the selected photograph.  Auto Improve will make most photographs look better.  It is especially helpful for dark or low contrast photos taken without proper lighting.

Press Auto Settings to adjust the advanced parameters used for Auto Improve.  Note that there is a Batch Auto Improve available from Auto Settings that can improve all open photos.
The Brightness Contrast Gamma and Color Balance Controls buttons show secondary dialogs with sliders to manually adjust the image balance.
You can also improve only a selected area of the photo to bring out detail in spots that are too dark or too light.  In an otherwise balanced photo, the Improve Image Area tool can show more detail in overly dark or bright objects, such as a black dog or a face too near the flash.
Press the Use Circle Click Tool button so that it stays down.  Adjust the Circle Width so that the circle cursor that appears when you move the mouse inside the right window is large enough to cover difficult-to-see area of the photo.  Also adjust the Darker – Lighter slider for the desired degree of darkening or lightening.  The three slider positions on the right increasingly lighten the clicked area.  The three left positions darken.  Point the mouse circle over the photo and click on one or more areas to improve the local brightness and contrast.  Repeated clicks over the same area increase the effect.  Click again on Use Circle Click Tool to turn off the circle cursor and allow normal mouse navigation in the right-hand window for the Improve tab.

Note that similar Lighten and Darken tools are available in the Filter tab, where you can optionally draw a rope around the desired area or clear the rope to lighten or darken the entire photo.
See also:

Auto Improve Settings
Brightness Contrast Gamma
Color Balance Controls
Remove Red Eye
Auto Improve Settings

This dialog is reached by pressing the Auto Settings button on the Improve toobar.  This dialog is not available in FxFoto Quick Layouts.
There are two available Auto Improve methods.  The Color Auto Improve default adjusts the red, green and blue balance separately.  You can optionally check Monochrome Auto Improve to adjust the monochrome brightness and contrast.  The Color Auto Improve can slightly distort colors, but is generally more pleasing to the eye.  Either method allows you to set appropriate Low and High Cutoff values used for automatic correct.  The cutoff settings specify the percentage of the darkest and brightest image pixels that are ignored so that intermediate values can be expanded to for better dynamic range.  Change them if desired, although the default low and high cutoff values work well in many cases.  Larger cutoff values result in more extreme correction and more distortion of the photo colors and brightness.  Both methods also allow you to optionally perform some degree of Automatic Gamma Correction after the balance.  By default Gamma 1.2 is applied for either method.
Press the Batch Auto Improve button to do the Auto Improve command for all open right-pane images with a single command. This is the same as pressing the main dialog's Auto Improve button multiple times after selecting each of the open photos.  Note that pressing Undo undoes the improved images one at a time.
See also:

Improve
Balance Controls
Balance Controls
This dialog appears when you press the Brightness Contrast Gamma button in the Improve dialog.  It adjusts the brightness in the selected photograph image.  This dialog is not available in FxFoto Quick Layouts.
Adjust the Brightness, Contrast, Highlights, Shadows and/or Gamma sliders to adjust the selected image.  The Highlights and Shadows sliders adjust only the bright or dark parts of the image.  Gamma correction adjusts linear brightness for the exponential way the eye perceives.   You see the results in the image soon after you release the slider.

When Soft Shoulders is checked, the image shows more detail for the darkest and lightest image features. With Soft Shoulders checked, high-contrast images decrease the contrast slightly for totally black and totally white areas so you can see some details outside the contrast limits. The Contrast Soft Shoulder Percentage Options setting controls the degree that the contrast is softened for very dark and very light areas.

Press the Reset button to move all sliders back to their initial centered positions.

Press the Standard Gamma to move the slider approximately to the common 2.5 value.

Press the Undo button to undo the changes and start again.

Press Apply to accept the changes or Cancel to revert to the uncorrected image.
See also:

Improve
Color Balance Controls
Color Balance Controls
This dialog appears when you press the Color Balance Controls button in the Improve dialog.    It adjusts the colors in the selected photograph images.  This dialog is not available in FxFoto Quick Layouts.
You can adjust the Hue, Saturation, Red/Blue Balance and Red, Green or Blue tints either separately or together with the available slider controls.  You see the results in the image soon after you release a slider.  

Press the Undo button to undo the changes and start again.

Press Apply to accept the changes or Cancel to revert to the uncorrected image.
See also:

Improve
Remove Red Eye
Red Eye Correction

This is a tab under the Correct button.  It sets up the Red Eye removal tool used to click a circle over photographic red eyes.  This dialog is not available in FxFoto Quick Layouts.
Adjust the Correction Circle Width slider control so that the circle cursor which appears when you move the mouse inside the right collage window is large enough to cover the red eye.  The outside of the circle should surround the red eye without touching it.  Try to more or less center the circle on the eye before clicking to remove the red.
Normally you should choose the Standard or Extra sensitivities. Standard Sensitivity uses the color of the non-eye skin at the outside of the correction circle to set a redness threshold used within the circle.

Extra Sensitivity looks for the circular red eye area.  It increases the sensitivity within that inner eye area, while decreasing it toward the edges of the correction circle.  Thus, when it locates the red eye area, Extra Sensitivity can remove more red than Standard Sensitivity and yet is less likely to recolor skin near the edges of the correction circle.  Even when Standard Sensitivity is checked, you can right click the mouse for Extra Sensitivity.
Custom Sensitivity allows you to change the red-detection sensitivity with a slider.  If you use too much sensitivity then reddish skin areas within the correction circles can be re-colored.  With too little sensitivity, the red does not entirely disappear when you click over the eye
Redo Whole Circle does not test for red but applies the correction everywhere within the circle.   But the correction still adjusts for the underlying image intensity.  To use this mode, the correction circle must be small and precisely located.
Paint Whole Circle applies the Correction Color uniformly in the circle (and effectively paint a round dark circle on the image).  To use this mode, the correction circle must be small and precisely located.
Automatic Intensity is checked by default.  When checked, FxFoto automatically reduces the intensity of corrected red areas to better match the darkness of the surrounding iris.  This automatic correction occurs only when FxFoto finds a large red area that is significantly lighter that the surrounding iris.  It attempts to compensate for the tendency of photos with red eye to also have a large overly bright area where the camera flash has been reflected from inside the eye.  Uncheck this setting to keep the red intensity unchanged and correct only the red color.
Reduce High Intensities can be checked to correct overly-bright eye highlights that are sometimes caused flash photography.  It provides additional intensity reduction beyond any Automatic Intensity reduction, and applies whether or not you have checked Automatic Intensity.  It also reduces the intensity of very bright highlights even if not red.  If checked, you may need to use extra care in placing the correction circle to cover the eye.
Change the Correction Color by clicking the colored button for a popup dialog.  The default pure black works well in most cases.  Beware that the Correction Color should be a dull and dark for the best results.  The correction automatically lightens the color for eye highlights.  Normally the Reduce Correction Color Saturation should be left checked for a more realistic blue or green eye color.  It does not apply to the default black.
To correct the red eye, move the circle cursor over it in the right-pane collage window and click with the left or right mouse button.  If you have chosen Standard Sensitivity, then clicking with the right button uses Extra Sensitivity, while the left button uses Standard Sensitivity.

The Undo button discards the last correction.

See also:

Blemish Correction
Blemish Correction

This is a tab under the Correct button.

FxFoto blemish correction removes photo features inside a specified circle cursor or roped area.  You should use the smallest circle cursor or rope area that completely covers the blemish area without touching it.  If FxFoto beeps or reports an error when you click the circle cursor, then your circle is too large to be corrected in a reasonable amount of time.  When there is an error, use a smaller Circle Cursor area size (or zoom in toward the photo to enlarge the blemish area) before trying again.  This dialog is not available in FxFoto Quick Layouts.
You can remove blemishes and other unwanted photographic features by clicking on the image with a round Blemish removal tool.  Make sure that Circle Cursor button is pressed.  Choose the Click Correction Circle Width and then just click over the photo blemish in the right-pane collage window.  It is important that the edges of the correction circle entirely surround the blemish without touching it.
Or you can draw a rope outline around the unwanted feature and press Erase Roped Blemish from this dialog.  Available buttons allow you to draw or modify the selection outline if you have not already done so.
For either sort of blemish removal, you can optionally feather the effect at the edges using the Edge Feathering slider.  Even without feathering, FxFoto can usually remove a properly outlined blemish or feature with little or no visible trace.

The Undo button discards the last correction.

See also:

Clone Brush
Clone Brush

This is a tab under the Correct button.  This dialog is not available in FxFoto Quick Layouts.
On the right, choose either Clone Brush or Undo Brush.
The Clone Brush allows you to point to a source area on an image and then to a different destination area to copy portions of the image from one to the other.  It can also copy a portion of one photo into another if they are both visible in the same slide using the Deluxe Edition.  It operates as a “brush” where you can slowly drag the mouse with the left button held down to copy a swath of the image.  Or you can just click on the destination for to copy a single circle or square area.  You can easily align the source and destination along a feature so that you brush out an unwanted feature with a background that matches the rest of the picture.  For example, to brush clapboard siding that lines up, just align the source with one of the siding lines and then start the destination at the same point of a similar line.

You can choose a Circle or Square brush and the Brush Width in image pixels.  Note that the source and destination are always the same size and shape.  You can also choose to Feather the edges of the brush so that the copied image better blends with the image surrounding the destination.
First right click on the center of the beginning source are to be copied on your right-pane collage photo.  This sets a green cursor to show the source.  Then click or drag with the left mouse button where you want the source copied.  As you click or drag, the source area follows the target cursor, staying at the same relative offset, until you choose to click another source.  Note that you can choose a new source point by clicking again with the right mouse button.
There are also two Advanced Settings sliders that are normally zero (or all the way to the left).  The Flood Limit can be advanced to limit the clone brush to flooding only areas with colors roughly matching the cursor center point.  This is like a backwards Color Match Tolerance slider in the Color Brush tab.  It allows you to limit the clone brush to a given colored area on the photo even if the brush outline goes beyond.  Try a Flood Limit of 80 or 90 to match a brush over a fairly uniformly colored object in the photo.   Slide the Flood Limit further to the right to restrict the flood to more closely matching colors.  Slide it further to the left for looser color matching.
The Transparency can be advanced to make the clone brush partially clear.  If advanced half way to 128, it blends the source and target 50% so that both appear in the result.  Slide the Transparency further to the right to make the source more transparent or further to the left to make the source more visible.
The Undo Brush can be enabled instead of the Clone Brush on the right side of the toolbar. The Undo Brush works similarly to the Clone Brush, but without a source area. It copies parts of the unmodified image and so can be used to selectively undo recent changes you have made to the selected image. Set the Brush Width slider and the Circle or Square checkboxes as for the regular Clone Brush. Then just point to the desired area and click or drag with the left mouse button. Use the Edge Feathering and Transparency sliders to reduce the strength of the Undo Brush, leaving some of the modifications showing. The Flood Limit also works as it does for the Clone Brush. In the Standard Edition you can try the Undo Brush, but cannot save, copy or print the modified photo.
The Undo button discards the last correction (even if you were using the Undo Brush).
Note: The clone brush can copy from one source photo to another.  For cloning between photos, you must be using the Deluxe Edition and must open both photos into the same slide and have them both visible in the right collage window.  Right click on the source photo region to be cloned and then left click or drag at the desired spot in the target photo.  FxFoto attempts to scale the cloned source image proportionally to its relative size in the collage.  Thus by dragging the source photo box larger or smaller, you can adjust the relative size of the cloned feature in the target photo.

Warning: The clone brush is not recommended for rotated or framed photographs.  You should normally apply corrections before rotating and adding framing and other annotations.  Using the clone brush on a rotated image is slower than on an image with a zero rotation angle and may show a slightly fuzzy image temporarily during the stroke.  Using the clone brush on a framed image can be less precise than correcting the original unframed photo.  Using the clone brush on images with certain kinds of fixed-aspect frames automatically turns on the Adjust mode so a red frame line appears and areas outside of the frame become visible.
See also:

Color Brush
Color Brush
This is a tab under the Correct button.  It can be used to re-color the last clicked or opened photograph in a few different ways.  The first three flood and transparency choices are available in all editions, but the last two Brush tools are trial-only in the Standard Edition.  This dialog is not available in FxFoto Quick Layouts.
Flood Color

Choose Flood Color or Change Clicked Color Everywhere to change the color under a clicked point with the selected New Color.
Often you would like to cut out a person or feature but may have trouble drawing a rope outline precisely enough for Crop to perform exactly the cutout you need.  In this case you may be able to use Flood Color with the Transparency slider all the way over to full (255).  Also adjust the Color Match Tolerance as needed.  Then click on the right-pane photo on background areas around the feature to turn them clear.  The Color Match Tolerance must be set to fill similar colors to the one under the cursor click without flooding into other photo elements.  The Undo button can backup as you adjust the settings by trial and error.  You may click as often as needed to flood fill the desired background areas.  This makes it easier to crop the photo without background showing when it is placed over other images in the collage.  (Note that the final two circle and square brush modes below also allow you to draw transparency to selected areas of the photo.)
The Flood Color mode can also be used to fill a non-transparent (or partially transparent) New Color in areas of your photograph.  This can re-color background and uniformly colored foreground objects.
Sometimes you want to change the same color used in multiple places on the photograph.  Choose Change Clicked Color Everywhere to avoid localizing the change to the clicked point as with Flood Fill.
Tip:  The New Color is not seen when Transparency is set to full (255).  But it can slightly color the results around the edge of the Flood Fill region in some cases.  So before sliding Transparency to full, you can set the New Color to one that blends in with the picture for the best results.

Set Transparency

It is sometimes effective to turn the entire photograph partially transparent so that collage elements under it show through.  Use Set Transparency for the Whole Picture, adjust the Transparency slider, and then click anywhere on the picture.  If the image already has completely transparent areas, they are left totally clear while the opaque or partially opaque areas are changed to the new transparency setting.
Get Color

Checking Get Color allows you set the New Color used in other modes by clicking on the desired color in an open photo.  It is the same as the Get Color tool in the Draw dialog.
Color Brush

You can also draw or tint selected photo areas with either a Circle Color Brush or a Square Color Brush.  If you have the Standard Edition, this the Color Brushes require an FxFoto Upgrade.  In the Standard Edition you can try the various effects and view the results, but cannot save, copy or print the modified photo.
Set the desired New Color to draw.  Set the Transparency slider fully left to 0 to draw with an opaque color.  Slide Transparency partially to the right to tint the underlying photo with the color.  Do not slide the Transparency all the way right or the color will not appear at all.  Set the Brush Width for the desired brush size.  You can also choose Feathering at the edges of the brush so that the drawn color gradually fades into the surrounding image.
You can also use the Circle or Square Brush to draw transparency onto the image.  Slide the Transparency all the way to the right so it is set to 255.  Instead of drawing a color or tint onto the image, the brush makes the image clear so that collage elements under it show through.  This can effectively crop unwanted areas inside the photo or embellishment.  You can even use non-zero Feathering to gradually transition from the image into the transparent areas.  For example, you might use this to brush clearness into the middle of a paper clip embellishment, hiding the part of the clip that would disappear underneath the paper it is attached to in real life.
Then either click or drag with the left mouse button over the right-pane photo.  If using partial Transparency, then you can move the brush cursor back over previously covered areas while the mouse is down without increasing the tint.  After you release the mouse button, FxFoto applies the brush stroke to the image, which may take a few seconds for larger photos.  The partial Transparency tint increases if you click or drag again over the same area.
Hint:  To tint just certain photo objects, set the New Color to the desired tint color and adjust the Transparency to a non-zero value.  The larger the Transparency value, the lighter the tint effect.  You can also tint a roped area using the Filter Effects Monochrome or Tint (Rope) choice.  But the Color Brush allows you to a apply tinting with a brush.
Note:  The New Color is the same as the Main color in the Draw dialog.  Also note that the Draw dialog’s Brush Pen tool is the same as the Circle Color Brush with no transparency and 25% feathering and does not require you to switch dialogs for the Get Color tool.

Note:  The Stamp Brush has a Translucency tool that can also be used to add full transparency or partial translucency to portions of an image.
Note:  Try to use the Color Brush on non-rotated images.  If possible, use the brush first and then rotate the image as desired.  When used on rotated images, the color brush may work more slowly and may temporarily show a slightly fuzzy image until you end the stroke. 
The Undo button discards the last change for any of the modes.

See also:

Stamp Brush
Stamp Brush
This is a tab under the Correct button.  The Standard Edition supports only the Transparency Brush and Smudge Brush tools.  The Stamp brushes require an FxFoto Upgrade.  In the Standard Edition you can try the Stamp brushes, but cannot save, copy or print the modified photo.  This dialog is not available in FxFoto Quick Layouts.
Stamp Tools

Press File Stamp or Clip Stamp to stamp an image anywhere on the collage.  You can optionally check Stutter Brush to drag the stamp and repeatedly apply the image.
When you press the File Stamp button, a Choose Stamp Image File selector dialog appears if needed to choose a photo or other image file to be stamped.  To choose another image file, press the Browse button.  FxFoto can use WMF, GIF, PNG, BMP, Triscape VIB, JPEG or TIFF image files.  Note that clip art is often saved in WMF or GIF format.  You may need to navigate the file selector to another directory folder to find an image.  Note that FxFoto uses standard Placeable WMF files and cannot read EMF metafiles.

Or press the Clip Stamp button to stamp whatever image is currently on the Windows clipboard.  If you have a separate Clip Art library, you may be able to switch to that application and use its Copy command to place an image on the clipboard.  FxFoto can handle both bitmap and metafile images.  It can also handle an image file path name in the form of text on the clipboard.

Hint:  To use a photo or embellishment image from FxFoto's left pane, right click on its folder thumbnail and choose Use as Stamp Image.  The selected folder image is set for use as either the File Stamp or Clip Stamp.
Check Stutter Brush to allow for repeat stamping when you drag the mouse and also to apply random jittering to the stamp images.  Uncheck Stutter Brush to add a single stamp image without jitter per mouse click.
Check Stamp Shadow to automatically add drop shadows to stamp images.  Press the Set button to adjust the shadow stamp settings.  Note that once you have stamped the image, you can change its shadow by pressing the Info button and choosing the Image Placement and Shadow tab.  Then click on the stamp image to select it so that its shadow settings appear.

Check Stamp on Image to apply the stamped image directly to the selected photo or image.  Normally, stamped images are separate collage objects that can be independently moved and rotated and use transparency to allow the underlying photo to show through where the stamp is transparent.   With Stamp on Image, using the Stamp Brush directly edits the selected photo and the stamp image becomes part of the underlying image.  Stamp on Image is only enabled when Stutter Brush is checked.  Even when Stamp on Image is checked, FxFoto will still create a separate stamp object if the brush stroke is partially off the selected image or if Stamp Shadow is checked.  Note that as long as the stroke stays inside the object, Stamp on Image can even apply more stamps to an old stamp object so that additional strokes need not add additional separate objects to the collage. Also note that Stamp on Image does not apply to the collage background image, only to selectable images opened into the collage.
Choose the desired image size with the Stamp Width slider.  A cursor box appears when you point in the right pane indicating the size to be stamped.  Note that the stamped image may exceed the cursor box vertically if the chosen image is taller than its width since it is drawn with the chosen width.  The stamp image size will vary depending on whether you zoom the right pane view down or up so that the indicated box width is always filled with the stamped image.

Adjust the Stutter Spacing slider when Stutter Brush is checked.  This controls the spacing between repeated stamp images when the brush is dragged mouse.  The Stutter Spacing can be positive or negative and a 0 value near the middle spaces the stamp images by the Stamp Width so they do not overlap or have extra space in between horizontally.  Set a positive Stutter Spacing to the right to add additional space between images along the brush stroke.   Set a negative Stutter Spacing to the left to partially overlap images along the stroke.  Note that the Stutter Spacing value is a percentage of the Stamp Width and is normally between -80% and positive 100%.  At the extreme right, the Stutter Spacing slider can set values up to 500 to add more space between repeated stamps along the brush stroke.

Adjust the Horizontal Jitter when Stutter Brush is checked to randomly vary each stamped image position left or right.  Set the Horizontal Jitter slider all the way left to 0 for no jitter and to uniformly position stamped images along a brush stroke.  Horizontal Jitter values up to 100 give the maximum degree of jitter as a percentage of the Stamp Width.
Adjust the Vertical Jitter when Stutter Brush is checked to randomly vary each stamped image position up or down.  Set the Vertical Jitter slider all the way left to 0 for no jitter and to uniformly position stamped images along a brush stroke.  Vertical Jitter values up to 100 give the maximum degree of jitter as a percentage of the Stamp Width.
Adjust the Angle Jitter when Stutter Brush is checked to randomly vary each stamped image rotation angle.  Set the Angle Jitter slider all the way left to 0 to no jitter and to keep the stamped images with any rotation.  Angle Jitter values up to 100 give the maximum jitter up to plus or minus 180 degrees.
Just click with the left mouse button to stamp one or more copies of the chosen image.  When you have checked Stutter Brush, you may also drag with the left mouse button to repeatedly stamp along a line or curve.  FxFoto will show a dashed line along the brush stroke until you release the left mouse button.  Then the dashed line is replaced by the stuttered stamp image or images.
When Stutter Brush is checked, you can still just click the left mouse button for a single stamp copy.  If the Jitter sliders are non-zero, then each stamped images will be randomly moved and/or rotated.

When Stutter Brush is checked, you may sometimes want to draw a straight horizontal or vertical brush stroke to stutter the images along a neat line.  Unlike the other brush tools, the Stamp Brush snaps to Grid Dots if they are enabled.  From the View menu or after pressing Set, check Snap to Grid Dots.  A grid of dots appears and the stutter brush will stay on the dots during the stroke.  To space the dots further apart, press the Set button to adjust the Grid Guide Dots.  Remember to toggle the Snap to Grid Dots back off when you are done.
WMF metafile clipart uses vector graphics that can be drawn at different resolutions or levels of detail.  The Stamp Pixel Width Options setting can be used to control the resolution of stamped WMF clipart.

Translucent Brush
Press the Translucent Brush button to draw transparency or partial transparency into the selected photo or image.  If the image already has completely transparent areas, they are left totally clear while the opaque or partially opaque areas are changed to the new transparency setting.
Choose Circle Brush or Square Brush.  Set the Brush Width slider to control the size of the circle or square cursor.  Set the Transparency slider to control the amount of translucency.  When Transparency is 255 all the way to the right, then the brush makes the image totally transparent (and is the same as the Color Brush with maximum transparency).  Move Transparency left to smaller values to make the brushed areas translucent so you can see both the photo and also underlying collage images.  Set the Edge Feathering slider to non-zero values to blend the translucent area with the surrounding opaque photo.
Then click or drag with the left mouse button over a selected photo or image in the right pane.
Smudge Brush
Press the Smudge Brush button to draw with smudged fuzzy version of underlying image.  The Smudge Brush allows you to smear unwanted details so they are less visible.
Choose Circle Brush or Square Brush.  Set the Brush Width slider to control the size of the circle or square cursor.  Set the Smudge Intensity slider to control the amount of fuzziness.  Move Smudge Intensity left to smaller values to make the brushed areas less smudged.  Set the Edge Feathering slider to non-zero values to blend the smudged area with the surrounding un-smudged photo.

Then click or drag with the left mouse button over a selected photo or image in the right pane.
The Undo button discards the last change for any of the modes.

See also:

Filter Effects
Filter Effects

The Standard Edition supports only the first two effects, White Balance and Sharpen with Unsharp Mask.  If you have the Standard Edition, the other effects require an FxFoto Upgrade.  In the Standard Edition you can try the other effects and view the results, but cannot save, copy or print the modified photo.  This dialog is not available in FxFoto Quick Layouts.
This is a tab under the Correct button.  It can apply a standard Filter to the last clicked or opened collage image.  Choose the Effect type from the scrolling drop-down list on the left.  Then set the slider values checkboxes and colors for the chosen effect.  Following is a list of all available effects in the order they appear.  Each is described in more detail further below.
Basic Filters
White Balance

Sharpen with Unsharp Mask, Sharpen Filter
Blur Filter, Soften Filter, Anti-Alias, Despeckle

Painting and Embossing Effects
Oil Painting, Watercolor
Pen & Wash, Shaded Sketch, Edges Only Sketch
Embossed, Carved, Embossed Colors, Carved Colors
Distortion Effects
Horizontal Motion, Vertical Motion

Tilt Up, Tilt Down, Tilt Left, Tilt Right

Sphere, Fish Eye, Swirl, Pixelize, Skinny
Artificial Effects
Posterize, Soft Posterize

Negative Intensities, Negative Colors

Solarize Intensities, Solarize Colors

Color Effects
Wash Out, Saturate, Bleach
Winter Dull, Spring Greens, Summer Blues, Autumn Reds

Color Adjust, Color Change, Tint, Monochrome, Duotone
Rope Color and Spotlight Effects
Sepia, Black & White, Tint, Monochrome
Flood Color, Flood Gradient

Embossed, Oil Painting, Defocus, Wash Out
Rope 3D Effects
Colored 3D, Metallic 3D, Image 3D Shading

Translucent 3D, Surrounding Haze

Rope Special Effects
Distress Noise, Spot Glow
Lighten Inside, Darken Inside

Faded Inside, Transparent Inside, Transparent Color
Rope Edge and Texture Effects
Faded Edge, Burnt Edge, Colored Edge, Grunge Edge
Paper Texture, Stone Texture

Weave Texture, Coarse Weave, Big Weave

Soft Cloth Texture, Crumpled Texture

Most effects can optionally change only a rectangular area within the selected image.  Click the Pull or Adjust Rectangle Area button on the top right to pull a rope rectangle around the desired area.  Or hold the mouse over one edge of the rope and drag the rectangle in or out to adjust.  Click the Clear Rope button to use the effect on the entire image.  If a rope already exists when you switch to Filter Effects, it is used even if you have not pressed the rope buttons.  But you can press Clear Rope even if it is already down to remove a pre-existing rope and apply effects to the whole photo.
The effects marked with (Rope) at the end of the list also allow you to draw an oval or other rope shape.  For these Rope Effects the Pull Oval Area, Pattern and Draw Loop buttons are enabled.  And they label the slider for Edge Feathering to reduce the effect near the rope edge.  Hint: You can use the Transparent Inside (Rope) effect to allow other non-rope effects to show only within a roped area.  Open two versions of the same photo in the same collage and apply the desired effect to one before sliding it exactly underneath the second.  Then used Transparent Inside (Rope) on the second top version.
Tip: Instead of using rope, you can use the Color Brush to draw in any effect by opening two copies of the same photo.  It is a little more complex, but you may find it easier to brush the desired areas than to draw a rope outline.  Plus you can even use it for non-rope effects.  For example, you might want keep flowers colored but make the rest of a photo black and white.  First, make sure the Collage Add mode toolbar button is down and click open two copies of the same photo.  Apply the Black & White effect without rope to the entire second photo so that it is all black and white.  Slide it over the first color version of the same photo so that it is exactly on top and the two line up.  Then go to the Color Brush and choose the Circle Brush (or maybe the Square Brush).  Move the Transparency slider all the way to the right to 255 and set the Brush Width as desired.  When you brush over the top black and white photo, you are applying transparency so that the color version underneath shows through.  So you could brush over the flowers where you want to show color.  When done, use the Save Image As command and use the Composed Image format to save the visible composite of the two photos with the color showing through in some areas.  This same technique could be used with any of the other Filter Effects.  You can apply the effect to the bottom photo so that the effect shows through where you brush rather than having the effect disappear there.
Basic Filters
The White Balance allows you to balance the selected image’s red versus blue coloring.  Digital cameras can sometimes distort photographic color by emphasizing blue or red.  You must specify what should be a white (or neutral grey) area of the photo by pulling a rope box around a small portion of the image.  Press Pull or Adjust Rectangle Area and then drag a box over a neutral area with the left mouse button.  If there is no rectangle rope, then FxFoto uses the entire photo to determine the balance, which is generally not very satisfactory.  The White Balance and Sharpen with Unsharp Mask effects are available in the Standard Edition.  All other effects require the Deluxe or Creative Editions.
The Sharpen with Unsharp Masking Filter is often more effective than the simpler Sharpen Filter.  Both can help with photos that are slightly out of focus.
The Soften Filter is less severe than the Blur Filter, but both will smudge photographic features and hide some defects.  (Note that Defocus (Rope) is another version of blur further down the list which allows you to defocus either inside or outside a roped area.)  The Anti-Alias Filter can also blur if applied with too much intensity.  But it can also smooth out pixilated jaggedness at the edge of linear features.  Filters always apply to the entire image.  Set the Intensity slider to adjust the severity of the effect.

Despeckle removes small light or dark spots from photos.  You should normally check Small for single pixel noise.  Med and Large can remove larger spots but will tend to deresolve the photo to a greater degree.  You can optionally check more than one to further increase the spot size.  The slider adjusts the Noise Sensitivity and spots that differ from their neighborhood by more than this threshold are removed.
Painting and Embossing Effects

The Oil Painting and Watercolor effects let you adjust the Brush Size with the slider.  Larger brushes take more time.  They also provide a slider to make the result Lighter with more saturated colors.  The Lighter slider for Oil Painting is neutral at 3 and values 0 and 1 to the left darken the image.  Check Texture to make the resulting painting to look like it is over canvas or paper.  Check Resize to automatically deresolve the photo to about one megapixel if larger.  High resolution photos show less paint effect unless a large Brush Size is used, which can be very slow.  Check Resize for a better looking effect with a smaller Brush Size when the photo dimensions exceed 1200 pixels.  (Note that Oil Painting (Rope) further down the list allows you to use the painting effect either inside or outside a roped area.)
The Pen & Wash, Shaded Sketch and Edges Only Sketch effects let you adjust the Edge Sensitivity and draw lines at image transitions with the selected Color.  Pen & Wash draws edges lines over the photo colored background while Sketch draws over a monochrome photo background.  Edges Only Sketch draws just the edge lines over the current collage background color.  For Pen & Wash or Shaded Sketch, use the Lighter slider to wash out the photo background (or check both for extreme lightness).  For all three effects, adjust Thicker slider to draw heavier lines at the edges.  Adjusting Thicker may also require you to adjust the Edge Sensitivity.  Check Resize to automatically deresolve the photo to about one megapixel if larger.  High resolution photos whose dimensions exceed 1200 pixels can sometimes show a better line drawing effect with Resize checked.  For Shaded Sketch, check Texture to apply a rough texture to the result.
The Embossed and Carved effects make a monochrome image with the given Color so that features appear to be higher or lower.  Embossed Colors and Carved Colors raise or lower photo features by the slider amount.  (Embossed (Rope) further down the list allows you to emboss inside or outside a roped area.)
Distortion Effects

Horizontal Motion and Vertical Motion blur the image in the given direction by the slider amount.

Tilt Up, Tilt Down, Tilt Left and Tilt Right rotate the image in the given direction with realistic 3D perspective.  The Intensity slider determines the angle of simulated rotation, where the maximum 100 value corresponds to 90 degrees.  You should normally leave the Viewpoint slider at 100, but can use it to adjust the perspective, which is related to how close the eye is to the image.  Note that larger Intensity angles will leave much of the original image transparent and you may want to Crop the excess.  Check Distort to tilt without realistic 3D foreshortening by decreasing its size in the given direction.  
The Sphere, Fish Eye and Swirl effects distort the image as described with the slider varying the amount of distortion.  All of these effects leave parts of the image at the edges transparent.

Pixelize divides the image into small uniformly colored squares and the slider varies the size of these pixel-like squares.  This effectively deresolves the image.

Skinny (Box) compresses a chosen vertical band of the image so that people and objects within look thinner.  Press Pull or Adjust Rectangle Area and pull a box over the image to mark the vertical band that should look skinnier.  Only the left and right edges of the rope rectangle matter, since this effect always uses a band extending from the top to the bottom of the image.  If there is no rope box, then the middle third of the photo is compressed.  The Feather slider adjusts the percentage region on the left and right used to blend the compressed skinny band with the normal uncompressed areas outside that band.  The Intensity sets the amount of compression and higher values may begin to look unrealistic.
Artificial Effects

Posterize reduces the number of color levels used to represent the image.  Increase the Intensity slider to 7 for the maximum effect.  Soft Posterize similarly decreases the number of hue and saturation levels but leaves the original luminance levels for a less stark effect.
Negative Intensities reverses the intensity but not the colors in an image while Negative Colors makes a full color negative.  Solarize Intensities and Solarize Colors only reverse intensities or colors above a threshold value given by the slider.
Color Effects

Wash Out lightens the image while decreasing the contrast.  This effect is similar to placing wax paper over the image.  (Wash Out (Rope) further down the list can apply this effect inside or outside a roped area.)
Saturate increases the color saturation, which makes image colors more vivid.  Check Lighter to also lighten the picture for a watercolor like effect.  Check Darker to also darken the image for a more somber effect.
Bleach selectively desaturates and lightens colors to simulate an aged photograph.  Reds and blues are desaturated more while greens and yellows are shifted toward yellows and browns.

Winter Dull desaturates all colors.  Spring Greens makes foliage-type greens more vivid.  Summer Blues makes sky-like blues more vivid.  Autumn Reds makes reds, oranges and yellows more vivid.  Check Ramp to decrease the effect toward the middle of the image vertically, which tends to be toward the horizon.  So for example, Ramp with Summer Blues will make blues most vivid at the top and bottom of the image but less so toward the middle, where sky and water tend to be further away on the horizon.  Check Negate to make greens, blues or reds less saturated rather than more vivid in increasing Intensity.
Color Adjust lets you selectively adjust a chosen color or range of colors.  Only the basic hue of the selected Color is used and the Color Match Tolerance determines the range of hues that match around it.  The Color Match Tolerance gives the width of the band of hues in degrees on a color wheel, 0 to 360, and half the value is the limit above and below the selected Color hue.  Check Feather to also match hues somewhat beyond those limits with decreasing effect.  Check Negate to match all hues outside the selected range rather than inside (for example, everything but greens).  Check +Red or +Blue to slightly shift the matching colors toward red or blue on the color wheel.  Check both +Red and +Blue to shift matching hues 180 degrees around the color wheel to the opposite color.  Adjust the Saturation and Luminance sliders above or below 100 to increase or decrease the vividness and lightness of all matching colors.
Color Change is similar to Color Adjust, but allows you to shift the matching colors to a specified New color.  Click the Old color button on the left to set the color to be matched and the New color ;button to set the color to be substituted.  You may want to use the Draw dialog's Get Color tool or the Flood Color effect's GetColor checkbox to set the Old color to a real image color.  Remember that only the basic hue of the selected color is used for matching and colors with different lightness and saturation will still match.  To change a color with more precise matching, you may want to use the Color Brush dialog's Flood or Change tools instead.
Tint applies a chosen Color to the image.  The slider controls the amount of color mixed in with the original image.  When the slider is all of the way right at 100, this effect is similar to Monochrome.  (Note that Tint (Rope) and Monochrome (Rope) further down the list allow you to tint inside or outside a roped area.  Also, the Color Brush dialog allows you to tint photo objects with a mouse controlled cursor.)
Monochrome converts the image to a single given Color with the slider adjusting whether color saturations are come from the given Color (slider left toward 0) or from the given original image (slider right toward 100).
Duotone produces a monochrome image using two or three inks.  It can help make black and white images print with more precision on color printers where only one ink is available for gray scale images.  Duotone can also be useful as an artistic effect.  Select two Colors, which are usually black and one other ink color such as yellow, magenta or cyan.  The corresponding Balance sliders adjust whether the color is used mostly for dark or light grays.  A Balance of 100 is neutral, while smaller settings use the color mostly for darker luminance values and settings over 100 use it mostly for lighter tones.  The default values of 100 for black and 20 for yellow (or other non-black color) work well.  Check +Black to add black as a third color for a tri-tone image.  When +Black is used, the other Colors should be not be grays and should normally not use up all three basic colors (red, green and blue or cyan, magenta and yellow) or the result will just be black and white.
Rope Effects

All of the effects at the end of the list with names ending in (Rope) work with any sort of rope, not just rectangles.  When one of these effects is selected, all of the outline rope buttons are enabled on the right to draw or change a roped region over the selected image.  Press Clear Rope to apply the effect to the entire image.  You can pull Oval or Pattern areas or draw a Rope Loop area of any desired shape.  See the Crop topic for more information on the various shapes and patterns.
You can move or adjust an existing rope just as in Crop.  For a Rectangle Area just point to a side and drag it inward or outward with the left mouse button.  Or point to one of the four corners to drag the entire rectangle.  To adjust the width of an Oval Area or a Pattern, point to the left or right most point of the oval and drag it inward or outward.  To adjust the oval or pattern height, drag the top or bottom most point.  Or point anywhere else along the oval or pattern to drag the entire rope to a new location.  To redraw part of an existing rope, press the Draw Loop button, point over the existing rope, press the left mouse button and draw a new outline to another point further along the rope.  To move a drawn rope, switch to Rectangle Area mode, point anywhere along the rope and drag with the left button.

When there is no rope, most of these effects apply to the whole image.  Faded Edge, Burnt Edge and Colored Edge apply edging around the whole image when there is no rope.  The 3D and Surrounding Haze effects automatically separate foreground and background colors when there is no rope and use the foreground boundary line or lines.
Most of the (Rope) effects use the Edge Feathering slider to feather the effect near the rope boundary.  Check Percent for a greater amount of feathering where the slider value is a percent of the rope diameter rather than a number of pixels.  Using non-zero feathering with a large roped area may be slow.
An Outside checkbox appears for the Sepia through Wash Out effects and also for Distress Noise.  Checking Outside applies the effect outside of the roped area rather than within.  The effect is applied outside the roped area, extending somewhat inside the rope as controlled by the Edge Feathering slider.  Note that the feather region is always just inside the rope whether or not Outside is checked.
When Outside is checked and there is no rope, FxFoto assumes the largest circle that touches the edges of the image and the feather slider is always a percent of the image size, even if Percent is unchecked.  Further, when Outside is checked without a rope and Edge Feathering is 0 or 1, then FxFoto feathers 25% of the image for a pleasing glow effect.

Rope Color and Spotlight Effects

Sepia (Rope) and Black & White (Rope) convert to yellowish monochrome or black monochrome colors and also allow you to draw non-square ropes and feather at the edges.  Check Outside to apply the effect outside the roped area.  For Sepia, check Darker for different and move vivid brown tones that do not look as aged.
Tint (Rope) works like the Tint effect.  It converts to the given Color but allows you to use non-rectangular oval and drawn ropes with feathering near the edges.  Use the second Intensity slider to vary the degree of tinting.  Check Outside to apply the effect outside the roped area.  (Note that the Color Brush allows you to tint photo objects with a mouse controlled cursor.)
Monochrome (Rope) works like the Monochrome effect and converts the roped area to a given Color.  Check Outside to apply the effect outside the roped area.
Flood Color (Rope) and Flood Gradient (Rope) allow you to recolor the area inside the rope, possibly with Edge Feathering to blend with the surrounding image. These are similar to the Color Brush effects, but allow for colored rope patterns and also can make the image partially transparent so that underlying images show through.  The Transpar slider controls the transparency of the resulting image area.  Leave it all the way left at 0 for a normal opaque image or slide it to values between 0 and 255 for translucency that that lets underlying collage images partially show through.  For Flood Color, press the Color button to set the uniform color, which is the same as the default for the Color Brush.  Check GetColor to automatically change the Color to the averaged color inside the roped area when you press Apply.  When GetColor is checked, Flood Color does not change the image but instead just sets the Color.  Use GetColor to get the best matching color in a selected area, which can then be used to flood over the same area or elsewhere.  Using GetColor and then flooding that color into the same area can make a uniform backdrop for text journaling over a photo.  For Flood Gradient, you choose two Colors and the flooded color blends between the two. The gradient normally blends from the first to the second color vertically over the roped area.  Check Diag to blend diagonally from upper left to lower right.  Check Horz to blend horizontally from left to right.
Embossed (Rope) is a version of the Emboss effect earlier in the list, but uses a roped area with edge feathering.  Check Outside to apply the effect outside the roped area.
Oil Painting (Rope), Defocus (Rope) and Wash Out (Rope) are also versions of earlier effects using roped areas and edge feathering.  Defocus (Rope) is like the Blur filter.  The Brush Size or Intensity slider allows you to vary the intensity of the effect.  Check Outside to apply the effect outside the roped area.  Using Wash Out (Rope) or Defocus (Rope) with Outside checked allows you to spotlight the chosen area.
Rope 3D Effects

These five effects separate the image into foreground and background portions.  The 3D effects use the dividing line around the foreground to show a surface with a third dimension rising out of the image.  The 3D surface starts at the foreground edge and rises in a smooth curve controlled by the Edge Width slider.  Beyond the Edge Width the 3D surface becomes flat on the inside of the foreground.  If the Edge Width is wider than the foreground area, then the 3D surface stops rising when it meets the edge curving up from the opposite side.  The Surrounding Haze uses the dividing line to add a feathered haze color outside on the background area.
These effects must automatically determine the foreground and background image areas.  If you have drawn a rope outline, then that is used and the foreground area is inside the rope.  If there is no rope (or you press Clear Rope before applying the effect), then FxFoto automatically finds background colors and includes all other colors in the foreground area or areas.  If the image has a reasonable amount of transparency so that substantial portions are clear, then all opaque areas become the foreground.  Otherwise, FxFoto finds the most common similar colors around the four sides of the image for the background and uses all others as the foreground area or areas.  Note that the way the foreground is determined can be overridden with checkboxes in the More dialog.

Tip:  These effects are often used with text in order to apply realistic 3D shading or a surrounding haze to text. To allow these effects to find the text, there should not be any rope and you should press Clear Rope first if needed.  Also, the text should be Normal Text and should not already have any text effect applied to it.  The text should have a clear or solid color background without any texture.  Finally, it usually helps to use a large Font Size (72 or maybe even larger) when creating the text so that edges are less pixelated, resulting a smoother surface.  Note that after you apply these or any other Filter Effects to text, the text object becomes a pure image and you cannot edit the text further.  (But you can still reapply these effects with different settings.)
Tip:  For photos, the automatic separation of foreground and background may not be realistic unless the image has a large uniformly colored background.  With photos, you may want to pull an Oval or Pattern rope around one area.  Since the 3D effects use the rope outline to determine a surface, the 3D surface will be smoother when the surrounding rope is smoother.  

Set the Edge Width slider to control the width of the curved part of 3D surfaces before they become flat in the middle.  If Edge Width is too wide, then the curved surface will meet in the middle at a sharp peak.  If Edge Width is too small, then 3D surface may not look as good.

Check Auto for the first three 3D effects to have them automatically determine the best width up to the Edge Width setting.  When Auto is checked, the Edge Width should be wider than needed and FxFoto automatically uses a smaller Edge Width value corresponding to the widest part of the foreground that it encounters.  Using Auto usually causes the effect to take more time.  Check Percent to allow for lager widths by setting Edge Width in the 1 - 50 percent range of the total rope width or height (whichever is smaller).
Choose Colored 3D to re-color the foreground with 3D shading.  Choose the desired Color to replace all foreground areas.  The selected Color hue is used by the intensity and saturation are varied to show the 3D surface shading.  When shading text, you may want to choose a Color which matches the original text color to avoid having the original color partially show through at the edges.  Choose the Ambient and Spotlight lighting intensities with sliders on the left and change the light colors with buttons below those sliders.  Press the underlined More button for a popup dialog with additional settings.  Check Auto to automatically use a smaller Edge Width if the foreground is narrower at its widest point.  Check Flat for a 3D surface with less curve that rises from the image at a 45 degree starting angle rather than perpendicularly.  
Choose Metallic 3D to re-color the foreground with 3D shading with settings that look more like metal.  Unlike Colored 3D, the Metallic 3D effect automatically varies the ambient light so that there is less reflected light on the flat inner portion of the foreground.  Metallic 3D may look best with a smaller Edge Width setting so there is a narrow curved portion at the edges and large flat area in the middle of the foreground.  The other settings work similarly to Colored 3D, though there are different defaults for the metallic look.  By default Edge Width is 12 and Ambient is 10 rather than 50.  In the More dialog, Colored Shading Intensity is 25 rather than 50 and Spotlight Surface Shininess is 16 rather than 8.  By default the Color is light beige (red 255, green 247, blue 223) for the look of gold.
Choose Image 3D Shading to shade the photo or text's original colors rather than apply a uniform new color.  There is no Color setting for this effect since the image shows through but is re-shaded for a 3D look.  The other settings work similarly to Colored 3D,
Choose Translucent 3D to distort the photo or image in a way that simulates a clear lens over the foreground.  The Translucent 3D effect usually works best with a real photo and with an Oval or Pattern drawn rope to outline the foreground area.  A curved surface is used as a transparent lens to bend the underlying foreground image.  Also a haze with the given Color is applied at the edges to simulate where the lens becomes partially opaque.  Set the Haze Edge slider to control the amount of opaque haze at the edges as a percentage of the Edge Width.  Set the Refraction slider to control the amount the underlying image is distorted by the lens.  Check Auto to automatically use a smaller Edge Width if the foreground is narrower at its widest point.
Choose Surrounding Haze to add partially opaque haze to the background areas just outside the foreground edge.  Set the Color to the desired haze color, normally black.  Set the Intensity slider to control the darkness of the haze.  Set the Spacing slider to space the surrounding haze further out from the foreground edge.  When Spacing is zero, the haze begins at the edge and feathers to the chosen Edge Width.  When Spacing is larger than zero, it is a percentage of the Edge Width and a band of non-haze surrounds the foreground and feathers into the band of haze.
Rope Special Effects

The Distress Noise (Rope) adds speckled partially-transparent noise or grunge to the roped area or to the whole image if there is no rope.  Adjust the Intensity slider to increase or decrease the amount of noise (or actually to make it more or less opaque).  By default, the Color is black for dark black or grey grunge.  Press the Color button to change the color of the added noise.  Check Outside to apply the effect outside the roped area.
The Spot Glow (Rope) effect adds a colored glow or haze around photo objects so they look like they are glowing or like lights seen through a fog.  The Edge Feathering slider controls how far the glow extends beyond the object or rope.  Edge Feathering should usually be non-zero for a glowing or fog-like effect.  Adjust the Threshold slider to apply the glow effect only to the lightest parts of the image inside the rope (or to the whole image if there is no rope).  Lower Threshold values apply the glow effect is uniformly applied throughout the roped area and feathered beyond.  Higher Thresholds chooses only the portions of the photo inside the rope that are already relatively light.  Adjust the Intensity slider to increase the added glow.  Normally you should rope approximately the area that you want to glow, such as light bulb or sign.  By default, the Color is white for a white glowing effect.  Press the Color button to change the glow color.
The Lighten Inside (Rope) and Darken Inside (Rope) effects are similar to the Improve Circle Click tool to correct too-dark or overexposed areas.  But these can be used with an arbitrary rope and adjustable feathering.  
The Faded Inside (Rope) effect brightens the image, but does not reduce contrast like the Wash Out effects.  In order to give you more control, the Lighten, Darken and Faded effects make only a small change per Apply.  For a greater amount of lightening or darkening, press the Apply button more than once.

The Transparent Inside (Rope) effect makes the area within the rope clear so that collage images below show through.  This allows you to use one image as a frame that surrounds another collage photo image.  The various rope Patterns can be used to create interesting photo borders this way.  Use the Edge Feathering slider to control the transition to transparency.

The Transparent Color (Rope) effect substitutes a transparency gradient for the selected Color.  For example, if the Color is white then all fully white areas of the image become fully transparent and darker areas are progressively more opaque.  Other colors can be used and this effect increases the transparency where the image best matches that color.  Check Reverse to use maximum opaqueness for image colors that are closest to the selected Color.   Tip:  For an interesting cartoon-like effect, try checking Reverse with the Color white and then place the modified photo over a white background.  The darkest image areas become transparent so that the white background shows through.  Lighter colors remain and darker colors become increasingly white.
Rope Edge and Texture Effects

The Faded Edge whitens and Burn Edge blackens the feathered edge region just inside the rope.  Colored Edge uses the selected Color just inside the rope.  If there is no rope, these edge effects modify the border of the whole image.  
The Grunge Edge randomizes the edge thickness as if it were roughly inked or chalked by hand.  The Intensity slider controls how quickly the thickness varies.  The Threshold slide controls the minimum thickness as a percentage of the total maximum Edge Width.  For example, if Threshold is set to 25, then the edge thickness will vary between 25% and 100% of the Edge Width.  The Texture and More checkboxes control the simulated texture applied to the edge color.  Leave both unchecked for less texture.  Check More for a rougher texture.  Check Texture to use a woven canvas-like texture instead of paper and check both for a rougher weave texture.  Check Reverse to reverse the texture, making the dark parts lighter.
For all of the edge effects, the Edge Width slider controls the thickness used and Percent can be checked to make the Edge Width a percent of the total width.  To add a border around a non-rectangular cropped photo, you can check Keep crop rope in the Crop dialog so that the outline rope remains to be used with one of these edge effects.

The list also includes standard Textures which can be applied to the image for special effects like paper, stone, cloth and crumpled paper.  Check Resize to apply larger versions of the textures appropriate for high-resolution photographs.  The Texture effects can optionally be applied to only a roped portion of the image.  When one of the textures is selected, the outline rope buttons are enabled on the right to draw or change a roped region over the selected image.  Press Clear Rope to apply the texture to the entire image.  When a roped region is defined, you can use the Edge Feathering slider to feather the effect near the rope boundary.  The Percent checkbox allows more feathering as a percent of the rope area.  Beware that limiting the texture to a roped region can be very slow and you should only select a limited area of the photograph (no more than 200 pixels square).

Press the Apply button to apply the chosen filter effect.

The Undo button discards the last correction.

See also:

Crop Image
More Settings for 3D
More Settings for 3D Filter Effects

This dialog appears when you press the underlined More button that appears on the left for some of the Filter Effects.  It provides additional advanced settings for the 3D effects.

The Colored Shading Intensity controls the amount of non-shiny matte-look 3D shading.  This is also known as the Gaurand shading intensity.  By default it is 50 percent, except for metallic where it is 25 percent by default.
The Spotlight Surface Shininess controls the reflected spotlight, also known as Phong shading.  Higher values result in more compact bands of reflection for a shinier look.  Lower values result in broader shiny bands for a more matte look.  Higher values may reduce the shine intensity and you may want to increase the Spotlight intensity on the main Filter Effects dialog to compensate.  The default setting is 8 for normal 3D and 16 for a more metallic look.

The Metallic Flat Ambient Factor controls the percent reduction of ambient light that is reflected from non-curved surfaces for the Metallic 3D effect.  The default is 33 percent so that flat metal shows one third the ambient light.
The Spotlight Angle from Vertical controls the degrees the spotlight is lowered from overhead.  By default the spotlight is from the upper left at a 45 degree angle.
The Spotlight Rotation from Upper Left controls the direction of the spotlight relative to the center of the image in degrees.  The default 0 value directs the spotlight from the upper left.  A value of 90 would move clockwise it to the upper right and a value of -90 would move it counter clockwise to the lower left.

The Depth as a Percentage of the Width controls how much the 3D surface rises off the image.  Normally it is 100 percent so that the surface curve rises by the Edge Width in the main Filter Effects dialog.  Smaller or larger settings cause a shallower or deeper surface.

The Mask Transparency Threshold controls how opaque the image needs to be to qualify as part of the foreground.  By default it is 255 for fully opaque and all areas which are at least partially transparent are included In the background.  This setting applies only if the background versus foreground mask is determined by the transparency of the image.

Check Always Use Transparency for Mask to force the transparency information in the image to be used for determining the foreground even if there is a rope or if not much of the image is transparent.

Check Always Use Common Colors for Mask to force the image colors to be used for determining the foreground even if there is a rope or if a lot of the image is transparent.
See also:

Filter Effects
Crop Image
Crop Image

You reach this dialog by pressing the Crop button on the top dialog bar.  Cropping cuts out a portion of the last clicked or opened image in the right collage window.  To crop an image, you must first select the crop outline with the rope.
Note: Some Templates automatically adjust photos to fit their template by hiding some of the image so that it fits the available space.  You can use the Adjust button in the Frame dialog to move the visible portion of a theme photo.  If you use this dialog to crop such a photo, FxFoto will re-center the remaining image in the theme template, hiding some of the image to make it fit.  
The Rectangle Crop Area button allows you to pull a box around the area of the photograph to be preserved.  Just point to one corner of the box, press the left mouse button, pull to the opposite corner and release.
You can also use the Rectangle Crop Area mode to adjust or drag the rope box.  Just point to a side and drag it inward or outward with the left mouse button.  Or point to one of the four corners to drag the entire rectangle.
The Oval Crop Area button allows you to pull an oval or circle in a manner similar to pulling a rectangle.  The oval is surrounded by the pulled box.

You can also use the Oval Crop Area mode to drag or adjust the rope.  To adjust the width of the oval, point to the left or right most point of the oval and drag it inward or outward with the left mouse button.  To adjust the height of the oval, point to the top or bottom most point.  Or point anywhere else along the oval to drag it to a new location.

The Pattern button allows you to pull an oval or rectangular shape with a choice of special pattern and cookie-cutter edge effects.  Choose the desired Pattern in the drop down menu.
The top Cutters Library choice in the Pattern menu pops up a selector with dozens of additional special patterns such as a Bell, Butterfly, Candle or Car.  But the Cutters Library requires FxFoto Creative, Media or Quick Layouts.  Just click on the Pattern drop-down and then click again on Cutters Library to see the popup library selector.  The library appears whenever the drop-down closes with Cutters Library selected.  Click on the desired pattern name and press Open to choose a library pattern.  Existing rope switches to the new pattern or you can pull a new box with the left mouse button.  Some of the Cutters Library patterns look best with at certain box shapes and if curves look wrong, try a wider or narrower box.  The Cutter Library patterns whose names begin with Symbol are alphabet and number symbols with A-Z, 0-9 and a few special characters.  Some symbols like O have an inner hole which requires the rope to double back on itself.  Such symbols will look best if cropped without feathering.  Stencil-like variations on these letters that allow for feathering have names ending with s.  Names beginning with Less or Max are variations on the box patterns.  Names beginning with More are variations on the Sawtooth through Tear Drop patterns with twice as many bumps around the oval.  Names beginning with Oval are versions of patterns based on ovals with curved sides.  There are over 100 special patterns in the Cutters Library and you may want to drag the selector dialog wider and/or taller to see more names without scrolling.  The Cutters Library consists of special *.fxv files installed in a Cutters subdirectory off of FxFoto’s installation directory.
The Deluxe Edition can use any of the other drop-down Pattern choices.  The next four patterns, Slight Rounding - Most Rounding, are special rectangles with rounded corners.  The next four box patterns, Sawtooth Box - Torn Edge Box, are rectangles with various edge patterns.  The Torn Edge Box creates a random edge pattern that simulates torn paper.  The random pattern changes as you pull or adjust the rope size so that you can adjust for different tear patterns.  The rest of the patterns are variations on oval shapes.  Drag from one corner of the desired area to the other just as you do with the Rectangle or Oval modes.  You can also use the Pattern mode to drag or adjust the previously pulled pattern rope.  To adjust the width of the pattern, point to the left or right most point of the rope and drag it inward or outward with the left mouse button.  To adjust the height of the pattern, point to the top or bottom most point.  Or point anywhere else along the rope to drag it to a new location.  Finally, you can select a new Pattern from the drop down menu to change a previously pulled pattern rope.
If you have the Standard Edition, Cropping with a Pattern requires an FxFoto Upgrade.  In the Standard Edition you can try pattern cropping and view the results, but cannot save, copy or print the modified photo.
The Draw Loop button allows you to draw an irregularly shaped outline around the crop region.  Press the left button and draw the loop, releasing the mouse at or near the starting point.
You can also use Draw Loop mode to modify or extend an existing rope outline, even if it is a rectangle or oval.  Just point over the existing rope, press the left button and draw a new outline to another point further along the old rope.  Release the button while over the old rope and the drawn line replaces the old rope between the start and end points.

Once you have used Draw Loop to draw an irregular rope shape, you can switch to the Rectangle Crop Area or Oval Crop Area modes to drag the entire rope outline.  Switch modes and point anywhere along the rope and hold down the left button to do drag to a new location.
When you press the Draw Loop button, the Click Auto Loop slider may appear.  If enabled, you can click on a photo area without dragging the mouse to have FxFoto automatically draw a rope around a similarly colored and shaded photo area.  Adjust the Click Auto Loop slider to control the color matching tolerance, with smaller values requiring a more uniform photo area to be included and larger values matching a wider area.  Then just click without dragging the mouse on a right pane photo area.  Hold down the Ctrl or Shift key while clicking to add another loop in addition to any existing rope.  This allows you to crop multiple areas of the same image at once.  The Click Auto Loop feature may not be included in your edition of FxFoto and the slider may be disabled.  It requires the Creative or Media Editions.
Note: Most photo objects have too much shading or color variation to be fully included in an Auto Loop.  Once you have used the Click Auto Loop to create a rope, you can add to it by clicking again inside the rope on a slightly different color or by clicking nearby outside the rope (though clicking outside will create a new rope if the matching area does not intersect the old rope).  You can also modify the rope by drawing a new portion using the same Draw Loop mode. 
You can also choose to Feather the cropped edge near the rope outline so that the image fades rather than abruptly cuts off.  Check Percent to have the Feather slider value express a percentage of the crop area width or height (whichever is less) or uncheck to specify feathering in pixels.

You can force any desired Rectangle or Oval Crop Area proportions using Fixed Rope Aspect.  Pull down the menu for common choices such as 1.333 for the 4:3 ratio used in most digital photos or 0.750 for a tall portrait-style 3:4 photo.  Choose 1.5 for the 3:2 ratio seen in 35mm film and standard 4x6 prints and 0.667 for a tall 2:3 portrait aspect.  Or use 1.618 for Golden Mean proportions.  Use 1.000 for a square or for a circle with oval cropping.  You can also type any other desired width / height aspect ratio instead of using one of the pre-defined values in the drop down menu.  For example, type 2.0 for a rectangle that is twice as wide as it is tall and 0.5 for the opposite.  Choose blank or zero to stop restricting the rope aspect.  When Fixed Rope Aspect is a positive ratio, just pull the mouse from one side of the desired box to the other, either vertically or horizontally.  The other dimension automatically adjusts to give the desired proportion and stays centered on the mouse.  Note that this setting applies to all Rectangle and Oval ropes and is also in Options.  Also note that the Blemish and Filter Effects rope button automatically turn off the Fixed Rope Aspect.  If desired, you can switch to this Crop dialog to pull a rope with a Fixed Rope Aspect and then switch to those dialogs to use it.  Changing the Fixed Rope Aspect does not change the existing rope until you adjust it or pull a new one.
Note: To stop using a Fixed Rope Aspect just select the blank choice at the top of the drop-down menu.  Then you can pull a rectangle or oval rope to any shape.
Check Crop on top to force the cropped image to appear on top of all other photographs and images in the collage.  This is useful if you are cutting out a portion of one photo to slide over another.

Check Keep crop rope to stop FxFoto from automatically clearing the crop area outline after the crop operation.  This can be useful if you are using a rectangular crop area, since you can easily adjust the crop area if it turns out to be not quite what you wanted.  After cropping, press Undo to restore the un-cropped photo and then adjust the crop rectangle by pulling on one or more of its edges before re-doing the crop.
Press the Crop Image button to complete the crop and eliminate areas of the photograph outside the rope.  Press Undo to discard the last change.

Note:  If Edit Photos for Large Prints is checked in the Options and only one photo is open on the current slide or layout, then the cropped image automatically expands to fill the page guides or current printer page after you press Crop.
Hint: To apply a colored border around the cropped image, check Keep crop rope before pressing Crop Image.  Then press the Correct toolbar button and switch to the Filter Effects tab.  Scroll down the Colored Edge (Rope), Burnt Edge (Rope) or Faded Edge (Rope) effect and Apply without changing or clearing the rope.  However, if you have the Standard Edition, these Filter Effects require an FxFoto Upgrade.
Hint: Sometimes you may want to crop only one edges of a photo or to apply one of the box patterns to just one edge.  Do this by pulling or adjusting the crop rectangle so that the rope is outside the photo on the other three sides.  You must leave enough space between the photo and the rope to allow for any feathering.  Only the portions of the image that intersect the rope are cropped.  You may need to zoom your right-pane collage view out so that there is extra room around the photo to draw the crop rope.  To zoom out, press the blue [-] area in the square joystick on the right side of the toolbar.  Use the slow - fast slider under the  joystick to adjust the zoom speed if needed.

Hint: To use cropping to make collage embellishments, you may want to crop blank colored paper rather than a photo or special paper image.  The Insert Blank Sheet command (available in the File menu and from the Add Wizards) allows you to insert a large square with any selected color that you can then crop with a pattern or other rope shape to make single-color embellishments.
Hint: Rather than using Draw Loop to draw precisely around irregular objects to be cut out, it is often easier to use Color Brush under the Correct button to flood fill background areas with transparency.  Then you can use a less precise rope outline to cut out the approximate area including the transparent background which will not appear when the image is dragged over another in the collage.
Also: The same Color Brush has Circle and Square Brush selections that can be used with the Transparency slider all the way to the right at 255 to make areas of the photo clear so that underlying collage elements show though.  With Transparency 255, the Color Brush becomes a clear brush that can be used to effectively crop unwanted areas inside the photo or embellishment.  You can even use non-zero Feathering to gradually transition from the image into the transparent areas.  For example, you might use this to brush clearness into the middle of a paper clip embellishment, hiding the part of the clip that would disappear underneath the paper it is attached to in real life.
Note: Except for non-feathered rectangles, cropping produces a partially transparent image.  Normal JPEG picture files do not store transparency information and so saving a cropped image to the JPEG format can loose the non-rectangular crop.  To save a cropped image file for latter inclusion in an FxFoto collage, use Save Image As and choose the Triscape VIB Image (*.vib) Save as type in the second step Browse file selector.  Triscape VIB images preserve transparency information and compress about as well as normal JPEG photographs.
See also:

Frame Image
Frame Image

You reach this dialog by pressing the Frame button on the top dialog bar.  It provides a variety of framing effects that you can apply around the last clicked or opened image in the right collage window. Choose from a scrollable list of common frame types on the left.  Various other settings on the right are enabled when certain frame types are selected.  Colors are set by clicking a colored button for a popup selector dialog.

The Snapshot type adds a monochrome border with an outline in place of a matt outline.  It also adds a drop shadow to the image by turning on the shadow property that can be adjusted in the Image Object tab under the Info toolbar button.  Use the Custom Settings to set the snapshot's  Border Color, Surround Width and Line Color.
When you choose one of the Skin Image types, press the Choose Skin button to choose the frame image from a library of files.  After pressing Choose Skin a selector dialog appears with available skin frame files.  Click on a skin name to see a sample image below.  Under most versions of Windows, you can drag the edge of the selector dialog wider or taller to see more skin names without scrolling.
Skins automatically stretch to fit the photo.  Many of them stretch to any photo aspect, no matter how wide or tall.  Skins names beginning with Tall or Wide are fixed-aspect frames and automatically cut off some off the photo on either side or above and below to fit.  Use the Adjust button as described below to move the photo under a fixed aspect frame so that a different area is visible.
Press the Custom Settings button for secondary dialog with all individual framing options.  See that topic for more information on the various frame capabilities.
Press Apply to apply the chosen framing effects.  

Press Apply All to also apply the chosen framing effects to other existing and/or future images for the collage.

Adjust Mode

Press the Adjust button to show the whole photo with a dashed red line surrounding the visible area inside the frame.  If you have dropped the photo into a template, then FxFoto automatically shows only the center portion of the photo that fits inside the frame or drop target.  With the Adjust button down, you can slide the photo to adjust the visible area.  You can also grow or shrink the photo with the grab handles so that a smaller or larger portion is visible when framed.  Click the Adjust button again to raise it and see the photo framed again.
The Adjust mode can be used to adjust the visible area inside any sort of frame or even an unframed photo with the No Frame type.  Adjust mode shows the image without rotation, but any rotation reappears when you leave Adjust mode.  While adjusting, you can rotate the photo relative to its frame with the diagonal rotation pull tabs.  If the photo has been dropped over an irregularly cropped target or one that uses partial transparency, then the photo appears fully opaque within the pattern and areas that will not appear are partially transparent.  You can control the opaqueness for unseen portions using the Frame Adjust Outer Transparency setting in the Options dialog.
The Adjust mode can also be turned on or off with an Adjust Visible Framing in the Edit menu.  When the selected photo allows for adjustment, Adjust Visible Framing also appears in the right-click popup menu.  Note that the Adjust mode turns off and the dashed red line disappears when you start most commands.

To stop the pseudo-cropping set by a fixed-aspect frame or the Adjust mode so that the entire photo appears, select No Frame at the top of the list and press Apply.  If No Frame already appears, you must switch to another frame type first and then back to No Frame.
Hint: In addition to these Frame effects, you can use FxFoto’s Filter Effects to add colored, burnt and faded borders around a photo or within a drawn rope inside the photo.  To get a colored border effect, use Crop and check Keep crop rope.  Then switch to Filter Effects and scroll down to the Colored Edge (Rope) effect near the bottom of the list.  Or try the nearby Burnt Edge (Rope) or Faded Edge (Rope) effects.
Hint: For an outlined border, use Custom Settings and check Colored Border and Matt Inward Bevel.  Choose the Surround Width and Border Color.  Then enter 1 for the Matt Width and check Non-Std Matt Color to specify a dark outline color.  To place a drop shadow outside of such an outlined border, apply the border frame effect and then click to the Info toolbar’s Image Placement and Shadow tab where you can check Add Shadow and then press Apply.  By combining an outlined white border with an outside shadow, you can produce a frame effect similar to a mounted slide or bordered print.
See also:

Custom Frame Settings
Text
Custom Frame Settings

You reach this dialog by pressing the Custom Settings button in Frame.  It provides complete control of all individual framing effect settings. Check the desired framing effects on the left.  Or check none to turn off all framing.  Various other settings on the right are enabled when certain effects on the left are checked.  Colors are set by clicking a colored button for a popup selector dialog.

The Oval Cutout Image provides a crop effect to the image with an oval that completely fills the image rectangle.  This effect often looks great with a Fade (the next checkbox).

The Fade effect feathers the photographic image at its edges.  Choose the Fade Width in pixels.

One-Pixel Line surrounds the image with a narrow border line with the given Line Color.  A dark blue line can be very effective.

Check Shadow to show a feathered shadow below and right of the image.  If you also choose Oval Cutout, the shadow conforms to the crop oval.  Choose the Shadow Width in pixels.

Surround Colored Background places a band of color around the image.  Choose the Surround Color and also check the Gradient Color if desired and select a different color for the bottom of the frame.  The Surround Color at the top smoothly blends to the Gradient Color at the bottom.

Alternately, you can surround the image with a Surround Shaded Background.  This works similarly to the Surround Colored Background setting, but applies Phong shading to the surround color or gradient colors for a shiny highlight effect.  Set the Shading Ambient Light to a non-zero value to apply ambient white light outside the highlight area.  Set the Shading Highlight value to vary the highlight intensity.

Check Matt Inward Bevel for a matt-like effect around the photograph (or around any surround colored area).  You can set a non-zero Matt Width value for a non-standard bevel width and can optionally set a Non-Std Matt Color.  The standard matt color (when this last is unchecked) uses the collage background color for the matt.

Shaded Color Outer Frame surrounds the image with a 3D-effect frame whose Outer Frame Width and Outer Frame Color you can choose.  You can also set the Outer Frame Margin and Frame  Margin Color to include an extra margin just inside of this frame but outside of any  matt or surround background.

Alternately, Image Skin Outer Frame surrounds the image with a frame chosen from a library of special frame images.  Press Choose Frame Skin to select the image file to be used.  Note that the frame image is automatically stretched to fit around the picture and the frame image preview shows only the frame corners without any inner picture.

Check Snapshot Outline to show a line outside of the border in place of the Matt Inward Bevel using the Line Color.  Normally the Snapshot Outline is one pixel, but you can also check Matt Inward Bevel and then set the Matt Width for a wider outline.  For the full snapshot effect,also check Colored Border.
Press Apply or OK to apply the chosen framing effects.  OK also returns to the standard Frame dialog where Custom Frame Settings appears as the type if you have chosen a non-standard set of framing options. 

See also:

Frame
Text
Text Type

You reach this dialog by pressing the Text button on the top dialog bar.

Adding Text to a Photograph

If you have selected a photo or other non-text image, you can add text whose position is locked to the image.  When you move the photo, the text moves with it.  But you can still reposition the text relative to the main image

Choose Title text above selected image to place a title at the top.

Choose Dialog balloon text on top of selected image to place a comics-style white outline balloon over the photo into which you can type text to show what someone is saying.  The balloon is a fixed width but its height can grow to accommodate your dialog.  You can also switch to a wider or left-hook balloon later from the Other Text Settings dialog.  After you finish entering the text, you can move the balloon text object anywhere over (or even off) of the image to place it near the desired person.  Just click on it and drag it just outside the pull boxes.

Choose Caption text below selected image to place one or more lines at the bottom of the photograph.

Choose Overlay text in middle of selected image to create a new text object with a transparent background color over the center of the main image.  You can type one or more lines as desired and can reposition or rotate it later using its pull boxes.  Initially the text is half the width of the photo image.  To make it smaller or larger, you way want to change its width using the [> - <] or [< + >] buttons in the Edit Text dialog.  You can add more than one text object on top of the same main image.

Choose Overlay text at top of selected image is similar to Overlay text in middle but initially places the text at the top of the main image.
Choose Overlay text at bottom of selected image is similar to Overlay text in middle but initially places the text at the bottom of the main image.
You can also press the All button to add label with of these types to the selected image plus optionally to all other photos open in the collage or slide show.  A Label All dialog pops up to choose the label location and whether to apply the same label to all photos.  Then the Text Edit dialog appears with the last used label as the initial default text.  Using substitution commands in the text such as [[ID]]: [[FOLDER]] – [[NAME]] – [[DATE]] allows each photo to be separately identified.  If you make changes to the label, they appear in the currently selected photo.  If you have chosen to label all photos, when you press OK from after editing the text, the same label is applied to any other open photos
Creating a Separate Text Object

Choose New Text Object to create a text object not locked to the current image.  It is positioned like a newly added image in the collage, either on the current slide or on a new slide depending on the Collage Add mode.  Note that you can also use the Open or Add Image to open a text or HTML file as a new text object.

Editing an Existing Text Object 

Choose Edit the selected text object if you have clicked on some text that you want to change.  Before pressing this button, make sure you have selected the desired text object so it appears with selection handles and not the main image.  Note that when you re-edit an existing text object, FxFoto does not move the collage view to better show the text.  You can set up the view as desired to see all or part of the collage slide before clicking on a text object and editing it.
Note:  When you use Save Image to save a photo with text, you are saving an image of the text rather than editable text.  When you latter re-open the saved image, you will not be able to edit the text.  When you use Save Collage to save a collage or slide show containing text, the text can be changed when you re-open the saved collage document (as long as you have not unchecked Keep text as HTML for the Collage Settings).  However the FxFoto Standard Edition can only save image files (with non-editable text) and cannot save collage documents.
See also:

Text Edit
Label All
Draw
Label All

This dialog appears when you press the All button in Text Type.  Choose the location to label relative to each photo.  Most choices correspond to buttons described under Text Type.  Two additional choices, Overlay text at Top and Overlay text at Bottom, are similar to the normal Overlay text at Center, except that the text label is initially placed at the top or bottom of the photo rather than in the middle.

Check Add the label to all pictures to apply the same label text (possibly with substitution commands such as [[NAME]]) to all open photos in your collage or slide show.  Uncheck it to label only the currently selected photo.

Press OK to continue with the Text Edit dialog, where the last-used label text appears.
You reach this dialog by pressing the Text button on the top dialog bar.

See also:

Text Edit
Text Type
Draw
Text Edit

This dialog allows you to type and format text to appear in the currently selected text object.  Note that you must press OK or maybe Cancel to finish editing the text before you can use the mouse to move or rotate it below in the right pane.
Text Area
Type one or more lines in the Text area.  Note that you can press the Enter key inside the Text area to force a line break in the formatted text.  If you continue to type in a paragraph, your words will wrap in the Text area but will not force a line break in the formatted collage text below.

As you type, your formatted text quickly appears below in the actual collage object.  FxFoto normally updates the display a second or so after you stop typing.  You can turn off the automatic update or change the interval with the Misc button.  The FxFoto text editor is not quite “what you see is what you get”, but it does show you formatted text while you work.

Special Text

FxFoto allows you to type a few substitution commands in the Text area surrounded by double square brackets.  Type [[NAME]] to show the photo file base name without path or extension.  Type [[FOLDER]] to show the photo’s FxFoto folder name, if any.  Type [[ID]] to show the image serial number identification in the collage, where 1 is the first photo, 2 the second, and so on.  Type [[DATE]] to show the photo creation date.  Type [[SLIDE]] to show the collage slide number that includes the photo.  Type [[CAMERA]] to show the photo’s source device information.  These special substitution commands are converted to the corresponding information for the photo or image, which appears if you re-edit the text object.
You may type a number of special HTML keywords for special characters that may not appear on your keyboard.  These must begin with the & ampersand character.  They normally end with a ; semicolon but you can optionally omit that.  Following are some of the more useful ones: &cent for ¢, &euro for €, &pound for £, &yen for ¥, &deg for º, &copy for ©, &reg for ®, &gt for >, &lt  for <, &amp for &, &frac14 for ¼, &frac12 for ½, &frac34 for ¾, &para for ¶, &sect for §, &sup1 for ¹, &sup2 for ², and  &sup3 for ³.
For special characters, you may also hold down the Alt key and type an ASCII code using the numeric keypad on the right side of your keyboard.  You must release the Alt key before the character appears.  Use Alt+0162 for ¢, Alt+0163 for £, Alt+ 0128 for €, Alt+0165 for ¥, Alt+0169 for ©, Alt+0174 for ®, Alt+0176 for °.
There are a variety of simple controls to change the formatting.  Behind the scenes, these are actually applying HTML formatting around your typed text.  Advanced users familiar with HTML syntax can easily type HTML codes inside the Text box. (For example: Normal and <B>Bold</B> and <I>Italic</I> text).  If you import complex formatted HTML, you may see HTML formatting commands interspersed with the text.  But for normal applications, you can apply formatting to your text with the various Edit Text buttons without seeing or understanding HTML.

Formatting Controls
Press the Font & Size button to choose the text font and size to be used for the entire text object.  An example of the font appears to the right and clicking there also pops up the font selector.  For large collages and page guides, FxFoto automatically adjusts fonts for the estimated print page and the size can vary if you stretch the text object or collage page size.
Even though FxFoto's dialogs and documentation are in English, Unicode fonts allow collage text to be in any language under versions of Windows that support Unicode.  Note that many fonts may not support characters from all languages.  FxFoto can only show characters from a language if you have setup Windows to allow you to type those characters on your keyboard (or if you Paste them into the Text area from another application) and if you choose a font which supports the required characters.  Older versions of Windows before XP may not support Unicode or may only support a single local language and character set.  For languages such as Hebrew and Arabic, you can press the Misc button to set Right-to-left Text.
Press the Text Color button to change the color of the text.  Both the current font and color are shown on the right.

Press Background & Arc to set the text Background Color and also the Background Texture or Style and the Text Field Width.  A transparent background may make the text box area blend better with your collage background but can make the edges of the edges of the text itself a little less smooth.    Rather than using Clear, it may be better to choose the same text background color as the collage background.  The Text Field Width controls how much text fits on a line.  These settings are duplicated in the Misc button dialog.  See Other Text Settings for more information.

Also press the Background & Arc button to set special Curved Arc and Jitter text effects.  These settings are duplicated in the Misc button dialog.  The Arc and Jitter text effects require FxFoto Creative, Media or Quick Layouts, but can be previewed in the Standard Edition.
To make the text larger, you should normally press Font & Size and increase the Size.  To increase the line width so that more text appears before breaking to the next line, use the Background & Arc button and increase the Text Field Width (or just press the [<+>] button one or more times).  This automatically makes the text box wider in the collage, but you can resize it with the pull handles after you finish editing the text and press OK.
You can also choose to show Bold, Italic and/or Underlined text with the supplied buttons, which apply to all text typed in the object.

The two [> - <] and [< + >] buttons with inward and outward facing arrow heads quickly shrink or grow the text width.  This is the pixel width at which text wraps to the next line.  These buttons shrink or grow the width by about 20% each time you click them.  Use them to remove excess width for small text objects or to grow the width so that more text fits on a line.  For large text objects and with complex effects, it may take a few seconds for the text to render and the new width to appear.  FxFoto beeps if the size cannot grow further due to computer resource constraints and you should reduce the Font Size.  You can also set the Text Width numerically in the Background dialog.

You can optionally press Bullets or Numbering to show the lines of your text in outline format, which is great for many slide presentations.

The Indent More and Indent Less buttons insert simple HTML codes in at the current cursor point in your Text area to change the indentation as you type.  You will see the codes in the Text area but only the indentation in the formatted text appears below.

The Effect pull-down menu allows you to choose from a variety of special text effects such as shadows, 3D, cutouts and outline borders.  Most effects work best with larger fonts.  Some effects like 3D are more visible if you choose a medium dark text background color with the Background button.  Effects may also look better when used with a non-transparent Background color.  Note that Filter Effects, if available, also has 3D effects that can be applied to Normal Text later.
Hint: The "shadow" effects may not work well with clear-background overlay text.  However, FxFoto's Image Shadow works well with clear text as well as other cropped images.  Just leave the Effect set to Normal Text and press OK to exit.  Then go to the Info - Image Placement and Shadow toolbar and use its Add Shadow control.  Or just right click on the text and check Add Shadow to Image.</P>

Press Left Align, Center, Right Align or Justify to change the left and right justification of your text.  

Press the Anti-Alias button to draw smoother text using anti-aliasing.  This avoids pixilated jaggedness for a more professional appearance.  For text that already will print at about 600 dpi or better, Anti-Alias does nothing.  For text that is about 300 dpi, Anti-Alias increases the text resolution by about 50%.  For lower resolution layouts, Anti-Alias increases the text resolution a larger amount and uses the Keep Maximum Resolution setting to determine whether  to increase the text pixel size or use blended grey-scale pixels for smother text.  Using Anti-Alias may require extra memory and can be slow for large font sizes, especially with Effects.  You may need to select Normal Text as the Effect for very large collage text with Anti-Alias.
Press the Misc button for the Other Text Settings dialog with additional less frequently used options.  Some of these same settings are available from the Background & Arc button.  Use the Misc button to set Right-to-left Text.
Other Controls

Press the Spelling button to check the spelling of your current text.  To check just a limited selection, highlight the text by dragging the mouse over it before you press the Spelling button. Checking spelling requires FxFoto Creative, Media or Quick Layouts and this button is disabled for other editions.
Press the Copy button to copy the highlighted text to the clipboard.  Drag the mouse over the desired text with the left button down to select it before pressing Copy.  If no text is highlighted, Copy places all typed text with HTML formatting on the clipboard.

You can also press Paste to insert text from the clipboard at the current selection.  If the text area is empty with nothing typed, Paste can insert formatted HTML information copied from a word processor or other application, but only if you have checked Paste Formatted HTML in the Misc dialog.
Press the Apply button to immediately see your changes without leaving the Text Edit dialog.  Note that changes normally appear after you stop typing for a second or two, even without Apply,

Press the OK button to save your edits and close the dialog.  Press Cancel to abort your changes.  But before changes are lost, Cancel asks if you want to save them.
Hints
Tip: Some fonts, especially in Italics, may not completely show the first or last characters on a line.  You can add an HTML non-breaking space character to avoid cutting off the edge of overhanging characters.  Type &NBSP (Ampersand NBSP) at the end or beginning of lines to add non-breaking space.  For example WOW&NBSP or &NBSPWOW&NBSP would allow slanted overhanging W’s in WOW to fully appear.  If the chosen Font Size is too big for the text width, FxFoto automatically reduces the size.  So in some cases, you may have to use the [<+>] button to widen the text or reduce the Font Size before the ending &NBSP works.
Note: When you create Title, Overlay, or Caption text for an image, the initial text has the same pixel width as the image.  Text for narrow images will wrap after only a few words, especially using a large font.  Press the Misc button and set the Text Field Width to a bigger number of pixels if you need wider text lines.  When you close the Edit Text dialog, you can drag the text object’s pull boxes to grow or shrink the text as desired.  By default, the left and right edges of the text object line up with the image.  But you can pull it larger and drag it as desired relative to the image so that it overhangs on one or both sides.  By increasing the text width with the [<+>] button and OK and then pulling and re-centering a larger text box, you can make a large readable title or caption for even a small image.

Also: Very large text using advanced Effects and Anti-Alias at the same time can be slow and you may want to choose the Normal Text as the Effect and/or un-press Anti-Alias for text objects with very large font sizes that cover a large part of the printer page.
See also:

Other Text Settings
Other Text Settings

You reach this dialog by pressing the Misc button in the lower-left corner of the Text Edit dialog.  A more limited version is reached through the Background & Arc button.
Curved Arc and Jitter Text Settings

The Arc and Jitter text effects require FxFoto Creative, Media or Quick Layouts, but can be previewed in the Standard Edition.
You can choose a special text effect from the Arc Text Effect Type drop-down menu.  The Curved Arc types show the text along a curved or wavy horizontal line and the Degree of Arc slider can adjust the amount of curve from -180 degrees downward to +180 degrees upward.  You can rotate the text object as desired after you finish editing, so curved or straight text can go in any direction.
The Corner types place the text along two adjoining sides of a square with a rounded corner in the middle and the Degree of Arc slider adjust the 0 - 100 percent of the rounded portion, where a higher setting causes more rounding at the corner.
The Circle types show the text around a full circle if the text line is long enough, starting at one of four sides.  The Circle types only allow one full-length line and additional lines may be cutoff or not appear at all if they do not fit.  You should normally use left alignment for circular text with more than one line. Note:  When you choose Circle no text appears if the font size is too large for a least one line inside the text object.  If no text appears, try reducing the font size or increasing the Text Field Width or pressing the [<+>] button in the main Edit Text dialog.
For any of the types and also for the default Normal Straight Text type, you can check Jitter Character Angles and/or Jitter Character Offsets to randomly vary individual character placements for a hand-made look.  Also check Add Extra Jitter to Characters for a greater amount of character jitter.  The jitter will change randomly depending on the typed text.
The chosen effect will appear only after you press OK to accept the new settings.
Text Background Settings

The Background Color allows you to set the color of the text object behind the typed text.  It can be Clear for text that appears over another image.  For text appearing over a uniform collage background, a non-clear colored text background (which you can change by pressing the color button) can look better because anti-aliased text can better blend with this background to reduce text jaggedness.
With Clear checked, you can also check Set Clear Feather Color and then click the color button to set the color used to blend the edges of text effects.  Otherwise, FxFoto automatically chooses the feather color based on the average underlying photo or image color, the solid solid background color or the text color depending on the situation.  If the transition between text and the background has a narrow band of the wrong color, use Set Clear Feather Color and change the color to better match the background image under the text.
You can also choose a different Background Texture or Style from the pull-down menu.  The available textures apply to the whole image object background behind your text.  Or you can choose a standard, wide or left-hook dialog balloon background to show your text over a white cartoon-style balloon.  The left balloon style has the pointer on the left side rather than the right.  When you create a Dialog Balloon text object in the Text Type dialog, the normal balloon is used.  But you can change to a wider or left-hooked balloon style here.

Sometimes if you import HTML, it will already specify a background color or image.  You can check Override HTML to override this setting and force your text to appear over the background color and/or style you select here.  Note that the Clear background color requires that Override HTML also be checked since standard HTML does not support transparency.  Override HTML is checked automatically if you have also checked Clear.
Other Settings

The Text Field Width can change the width and resolution of the text.  It is the pixel width at which your text wraps to the next line.  A larger width allows more text to fit on a line.  Or you can give the text more resolution for smoother printing if increase this width and also proportionally increase the font size.  But changing the Text Field Width changes the width of the text box relative to the collage.  You may want to resize the text box using grab handles after you finish editing the text and press OK in the main text dialog.  You can also quickly change the width using the [>-<] and [<+>] buttons in the main Text Edit dialog.
Check Auto Reduce to have the Text Field Width automatically adjusted to fit the text you type after you press OK from the Edit Text dialog.  This can help reduce the memory resources used by your collage layout and also avoids large blank regions at the side of the text object that may be invisible.  However, when Auto Reduce is checked and you edit the text latter, you may need to increase the Text Field Width or press the [<+>] button to avoid having the text wrap to a new line too soon.  The Auto Reduce setting is ignored for Curved Arc and Dialog Balloon text.
The following settings appear only from Edit Text’s Misc button:

The Extra Space Between Lines can change the text line spacing by adding or subtracting pixels between lines.  Use 0 for normal spacing.  A positive number like 10 will leave more blank space between lines and expand the text vertically.  A negative number like -10 can compress the text vertically.  But you should keep negative numbers small enough to allow the lines to progress downward.
Set the Automatic Apply interval the change how long FxFoto waits after you type changes before showing them collage.  Set this to 0 (zero) to turn off the automatic apply feature so that you must press the Apply or OK buttons to see the formatted text.

Check Allow more than one Overlay Text if you need to insert multiple separate text objects over the same photo image.

Check Paste Formatted HTML to allow the Paste Edit Text button to paste formatted text from word processors.  Normally Paste inserts only plain text.  But if Paste Formatted HTML has been checked and if the Edit Text area is totally blank, then Paste will use formatted HTML if available on the clipboard.  This can allow you to transfer text with simple formatting such as bold and italics from many word processors.  However the HTML tags can be complex and confusing, making it difficult to edit and so this feature is off by default.
Check Right-to-left Text to have FxFoto reverse the characters in the collage so that the first character appears to the right and the last to the left.  Right-to-left text is used by some languages including Hebrew and Arabic.  With this option checked, FxFoto can correctly display text in those languages.  For other languages, this should normally be unchecked.  Note that in some versions of Windows, when you type characters from some languages in the Text Edit dialog, they may appear right-to-left regardless of this setting.  The Right-to-left Text checkbox effects only how the text appears in the collage and text in the dialog may appear either left-to-right or right-to-left depending on Windows and the selected font.  Note that the Default Right-to-left Collage Text setting in the Options dialog allows you to force all new text objects to initially use Right-to-left Text.
Check Use 3 Times Larger Font Text Size to specify larger fonts with Font & Size in the main Edit Text dialog. When checked the font is three times larger than the chosen size.  This allows you to create very large text with the Size menu choices of 72 or less without having to type a much larger Size number.
Check Render at High Resolution when Printing or Saving Image to have FxFoto redo the text whenever you print or save the image to match the output resolution.  This option can result in higher quality text output because FxFoto renders at the device resolution if there is sufficient memory.  But this option can significantly slow printing or saving layouts with large blocks of text and it can sometime result in minor changes to the text's appearance.  Note that the Default Right-to-left Collage Text setting in the Options dialog allows you to force all new text objects to initially use this option with Render for High Resolution Printing.
Press Install New Windows Font or  Remove Windows Font  for shortcuts to Tools menu commands add or remove the fonts in the Font & Size list.
See also:

Check Spelling
Check Spelling

The Check Spelling dialog appears when you press the Edit Text Spelling button if a word requiring your attention is detected.  The Spelling button is just above the Text area where you have typed.  You can use the dialog to specify whether the word should be ignored or changed.  To change the work click on the desired replacement in the Suggestions list and press the Change button.  Or you can type the correct word in the Not in Dictionary field and press Change.  Checking spelling requires FxFoto Creative, Media or Quick Layouts.
Note:  Spelling dictionaries for both American English and British English are available and initially American English is selected.  To switch, press the Options button and choose the Main Dictionary language from the drop-down menu.  The language selection is remembered when you use Spelling again in the future.
Ignore causes this occurrence of a misspelled word to be skipped. If the same misspelled word appears later, it will be reported again.

Ignore All causes this and all further occurrences of a misspelled word to be skipped.  You might use this button if the word reported as a misspelling is actually spelled correctly.  If the word is one you use frequently, you may wish to ignore it permanently by selecting the Add button.
Change causes the reported word to be replaced. If the problem word was edited, the edited word is used as the replacement. Otherwise, the selected suggestion is used as the replacement.  Only this occurrence of the reported word is replaced. If you want this and all following occurrences of the word replaced, select the Change All button.
Change All causes this and all following occurrences of the reported word to be replaced.  If the problem word was edited, the edited word is used as the replacement.  Otherwise, the selected suggestion is used as the replacement.  If you want only this occurrence of the word to be replaced, use the Change button.
Add causes the reported word to be added to the user dictionary.  Use the Add button if a correctly spelled word you use often is reported as a misspelling (e.g., your family name).  If the word is not used frequently, you may want to select the Ignore or Ignore All buttons instead.
Undo removes the last change made.  The Undo button can be pressed several times to remove the last several changes.

More searches more thoroughly for suggested replacements for the current misspelled word. Each time you press the More button, a deeper search is made.  The More button is disabled once all possible suggestions have been located.

Options displays the Options dialog.  You can use the Options dialog to set spelling-checker options.
Cancel stops the current spelling check.
The Not in Dictionary field contains a word which may be misspelled or otherwise incorrect, and is presented with a candidate replacement word.  You can change the word by selecting the Change button, or skip it by selecting the Ignore button.  You can also type the correct word in the Not in Dictionary field and press Change or Change All.
The Suggestions list contains a list of suggested replacements for the word reported as misspelled.  Subsequent presses of the Suggest button may yield more suggestions. The word selected in the Suggestions list will be used as the replacement when the Change or Change All buttons are pressed, unless the word in the problem box was edited.
See also:

Spelling Options
Spelling Options

This appears when you press the Options button from the Check Spelling dialog. Checking spelling requires FxFoto Creative, Media or Quick Layouts.
Ignore Capitalized Words: When enabled, any words beginning with a capital letter are ignored (i.e., are skipped over without being checked). You might enable this option if the text being checked contains many proper names.

Ignore All-Caps Words: When enabled, any words containing all capital letters are ignored (i.e., are skipped without being checked). You might enable this option if the text being checked contains many acronyms.

Ignore Words with Numbers: When enabled, any words containing embedded digits are ignored (i.e., are skipped without being checked). Examples of such words include Win95 and Q4. You might enable this option if the text being checked contains many code words or other symbols containing digits.

Ignore Words with Mixed Case: When enabled, any words containing an unusual mixture of upper- and lower-case letters are ignored (i.e., are skipped without being checked). Examples of such words include MicroHouse and CapsLock. You might enable this option if the text being checked contains many variable names or other symbols which use case changes to distinguish words.

Ignore Domain Names: When enabled, any words that appear to be Internet domain names (such as wintertree-software.com) are ignored (i.e., are skipped without being checked).

Report Doubled Words: When enabled, any word appearing twice in a row is reported via the  Check-Spelling Dialog.

Case Sensitive: When enabled, a distinction is made between capitalized and non-capitalized words. For example, canada is considered different from Canada, so canada would be reported as a misspelling. When the option is disabled, canada and Canada are considered identical. Note that the performance of the spelling checker will be reduced if this option is disabled.

Phonetic Suggestions: When enabled, suggestions are made based on phonetic (sounds-like) similarity to the misspelled word. This option tends to improve suggestions for badly misspelled words. Enabling this option will increase the time required to locate suggestions. Note that either this option or the Typographical Suggestions option must be enabled or no suggestions will be offered.

Typographical Suggestions: When enabled, suggestions are made based on typographical (looks-like) similarity to the misspelled word. This option is appropriate for people who are generally good spellers. Note that either this option or the Phonetic Suggestions option must be enabled or no suggestions will be offered.

Suggest Split Words: When enabled, two separate words will be suggested as a replacement for a misspelling containing two joined words. For example, is the would be suggested as a replacement for isthe.

Auto Correct: When enabled, words marked with "Auto Change" actions will automatically be changed to their specified replacements. When disabled, you will be prompted before the words are changed.

Main Dictionary Language: This option allows you to set the language of the main dictionary used to check spelling. The list shows only languages for which dictionaries are installed on your system. To check spelling in a different language, select the language in the list.

Suggestions: Determines the speed and accuracy of the initial search for suggested replacements for misspelled words. When a misspelled word is detected, a search is automatically made for suggestions. This option controls the speed and accuracy of this automatic search. Pressing the Suggest button in the Check-Spelling Dialog causes an increasingly more accurate (but slower) search for suggestions.

OK closes the Options Dialog, and saves any changes made to the option settings.

Cancel closes the Options Dialog, and discards any changes made to the option settings.

See also:

Drawing
Drawing

The Draw button on the top dialog bar allows you to select pens types, colors and widths and sets the mouse for drawing inside the right-pane collage area.
When drawing, you can either draw on top of a photo image or you can draw on the collage background.  When you draw on top of an image, drawn lines and polygons become part of the image object and move or rotate with it.  The drawing is then part of the composed image and can be merged with the photograph by saving it using the Composed Image option with the Save Image As or Send Image EMail commands.

If you begin drawing on the background, outside of all images, then the drawing stroke becomes part of the collage background for the current slide.  There are also special “Over” and “Under” tools which draw onto the background even if the drawing stroke begins over one of the images.  Drawn background objects normally appear only for a single slide.  However, if you draw on the background prior to adding the first slide photo, then that drawing appears under all future slides.  A collage can combine both image and background drawing elements.
Stamp drawing adds a separate image object to the collage each time and the stamped images do not become a part of any underlying photo.  But they can still be merged with the photograph by saving the Composed Image with Save Image As.

Warning: If you have drawn onto the background for a given slide number, you should use the Slide Order button in Slide Settings to renumber slides.  If you simply change the slide number for an image, the background drawing remains associated with the old slide number.

Note: You cannot draw on “fixed window” images such as Custom Buttons and an error beep occurs if you try.  Drawing is only possible on non-fixed collage images or on the collage background.

Pen Tools
Press a button on the left side to select the type of drawing tool.  Lines have fixed pixel widths independent of the viewing altitude, but the round and slanted-line Pens are narrower when seen from a distance and so can look more realistic with animated collage movement.  The Polygon tool fills the area inside the drawn line.  Both the Pens and the Polygon can use the second Outline drawing color (if different than the first Main color) to show an outline at the edges.  The Dotted and Dashed Lines show the second color betweens the dots or dashes.  The Over Pen, Under Pen and Under Area tools draw lines and polygons which are always a part of the collage background and go either above or underneath any image objects they intersect.

The Brush Pen tool draws on photos with a feathered color.  It is a version of the Color Brush Circle Color Brush which always uses 25% feathering and no transparency tinting.   Unlike that Circle Color Brush, Brush Pen can draw with both colors.  Click or drag with the left mouse button to draw with the Main color.  Click or drag with the right mouse button to use the second Outline color.  Either way, the drawn line is feathered at the edges to better blend with the surrounding photography.

The Clear Pen tool draws complete transparency on photos so that the collage background shows through.  Use it to remove parts of photos or embellishments such as the inner loop of a paper clip that would be hidden under paper.
The Get Color tool can set actual photo colors for the Brush Pen so you can apply more realistic touch ups.  Unlike the other pens, Brush Pen can only draw on photo images and not on the collage background.  Also, the Change and Erase tools cannot be used with Brush Pen drawing and the Brush Pen does not snap to grid guide dots.  If you have the Standard Edition, this the Brush Pen requires an FxFoto Upgrade.  In the Standard Edition you can try the various effects and view the results, but cannot save, copy or print the modified photo.
Other Tools

The Change tool allows you to change to color or width of a previously drawn line or polygon.  Set a new main or outline color and/or line width and click on the old line or polygon.

The To Bottom and To Top tools allow you to click on a previously drawn line or polygon to change its drawing order so that it appears above or below other draw elements.  However Over Pen, Under Pen or Under Area elements always stay either over or under all images.

You can also use To Bottom and To Top to change the drawing order of photo images in the collage when you click on one and not on a drawn line or polygon.  Note that you can also change the image drawing order by right clicking on a collage photo and choosing Show Image on Top or Show Image on Bottom from the popup menu.  Plus there is an Info Image Object Show on Top button.

The Get Color tool allows you to set the main or second drawing colors for future use by clicking on a colored point inside an image.  Left click over a photo to set the Main color with the photo color at that point.  Right click to set the second Outline color.  Get Color only works when you click on a photo and not on the collage background.  This same tool is also available in the Color Brush dialog.
The Erase Object tool allows you to click on a previously drawn line or polygon to remove it from the collage.  It can also delete a whole photo image object if you click on one and not on a drawn line or polygon, but it warns you first and asks whether you want to continue.

Stamp Tools
The File Stamp and Clip Stamp drawing tools allow you to stamp an image anywhere on the collage.  Note that the Stamp Brush tab under Correct provides these stamp tools with additional options and controls including a stutter stamp brush with added jitter.
When you press the File Stamp button, a Choose Stamp Image File selector dialog appears and you must choose a photo or other image file to be stamped.  FxFoto can use WMF, GIF, PNG, BMP, Triscape VIB, JPEG or TIFF image files.  Note that clip art is often saved in WMF or GIF format.  You may need to navigate the file selector to another directory folder to find an image.  To change the stamp file image, just press the File Stamp button again even if it is already depressed.  Note that FxFoto uses standard Placeable WMF files and cannot read EMF metafiles.
Or press the Clip Stamp button to stamp whatever image is currently on the Windows clipboard.  If you have a separate Clip Art library, you may be able to switch to that application and use its Copy command to place an image on the clipboard.  FxFoto can handle both bitmap and metafile images.  It can also handle an image file path name in the form of text on the clipboard.
You can choose the desired image size with the Stamp Width slider.  A cursor box appears when you point in the right pane indicating the size to be stamped.  Note that the stamped image may exceed the cursor box vertically if the chosen image is taller than its width since it is drawn with the chosen width.  The stamped image becomes a separate object which you can later move and resize with grab handles.  The stamp image size will vary depending on whether you zoom the right pane view down or up so that the indicated cursor box width is always filled with the stamped image.
When File Stamp or Click Stamp is pressed, a Shadow checkbox appears in the upper right corner of the draw dialog.  Checking Shadow automatically adds drop shadows when you stamp images.  Press Other for additional shadow settings.  Note that once you have stamped the image, you can change its shadow by pressing the Info button and choosing the Image Placement and Shadow tab.  Then click on the stamp image to select it so that its shadow settings appear.

Just click with the left mouse button to stamp one or more copies of the chosen image.
WMF metafile clipart uses vector graphics that can be drawn at different resolutions or levels of detail.  The Stamp Pixel Width Options setting can be used to control the resolution of stamped WMF clipart.

Hint:  To use a photo or embellishment image from FxFoto's left pane, right click on its folder thumbnail and choose Use as Stamp Image.  The selected folder image is set for use as either the File Stamp or Clip Stamp.
If you have the Standard Edition, Stamp drawing requires an FxFoto Upgrade.  In the Standard Edition you can try stamping and view the results, but cannot save, copy or print the stamped images.
Draw Settings

Choose the Main and second Outline drawing colors by clicking on the colored buttons for a popup color selector dialog.  Often you may want to set the same color for both (so that pens and polygons do not show an outline) and you can easily do this with the Both Colors button.

Note: The Pen drawing tools can normally use two colors with the second outlining the filled stroke.  However, when drawing to images which are partially transparent, the second outline color is automatically ignored.  In order to maintain image transparency, the Pens can only draw a single color onto transparent or edge-faded pictures.
Set the Line Width slider control to the desired pixel size of lines and outlines.  Pens appear at this width at the natural 1:1 altitude, but grow and shrink as you move up and down.

Choose Drag Draw, Gyro Draw or Click Draw to change the way you use the mouse to draw lines and polygon outlines.  The Drag Draw type allows you to draw by dragging the mouse with the left button pressed.
Gyro Draw mode works like Drag Draw except that it smoothes the line (as if the pen were “gyroscopically” stabilized) for less jagged look.  The Other button presents second version of these choices where you can control the amount of smoothing in the pull-down menu for Gyro smooth draw.

The Click Draw mode allows you to click on line segment waypoints along the desired line.  It connects the clicked points with straight line segments in between.  While drawing in Click Draw mode, you finish the line by pressing the X button on the right side of the dialog bar or by pressing the Esc key.

Other Draw Commands

Press the Other button for another dialog of more advanced drawing features.

See also:

Slide
Other Draw Controls
Other Settings and Options
This dialog appears when you press the Other button on the Draw dialog or the Set button on the Stamp Brush dialog (where only some of the settings are enabled).
The Mouse Draw Type repeats the setting available in the main Draw dialog.  When Gyro is selected, you can vary the amount of smoothing between 2 and 31 points.
The Snap to Grid Dots can be enabled to force your drawn lines to snap to a regular horizontal and vertical spacing.  When enabled, dragged image objects also snap to the grid.  This makes it easy to draw straight horizontal or vertical lines and to arrange lines and objects with regular spacing.  There is also a Snap to Grid Dots View menu command to toggle the guide dots on or off.
You can also set the Draw Line Width with a typed number of pixels rather than a slider control.
Check Add Stamp Shadow to automatically add a drop shadow to newly stamped images for the File Stamp or Clip Stamp modes and also for the Stamp Brush.  This is the same setting as the Shadow checkbox in the main Draw dialog.  When Add Stamp Shadow is checked, you can set the default shadow settings for images stamped in the future.  Change the Shadow Height to the desired pixel coordinates that the shadow is offset right and below the image.  Larger Shadow Height values make the image appear higher above the background.  Change the Darkness to a value between 1 and 255 to adjust the intensity of the shadow.  Lower Darkness values make the shadow more transparent so that it is lighter and more of the underlying color or image shows through.  A Darkness value of 255 makes the shadow totally opaque.  The default value of 70 often works well.  Change the Feather to a value between 1 and 15 to control the feathering at shadow edges.  The default value of 4 automatically varies the feathering for small images.  You can press the Shadow Color button to change from the default black for a tinted light shadow effect.

The Draw with Rope button allows you to convert a rope outline into a drawn line or polygon.  It is a good way to draw rectangles ovals and circles.  Make sure you have chosen the desired Pen Type and Width first.  Only the Line, Pen and Polygon drawing tools can be used.  Others such as the Stamp and Brush Pen do not work for Draw with Rope.
If you have not already created the rope selection, you can do so from this dialog by pressing the Rectangle or Oval buttons (or Draw Loop for a freely drawn rope outline).  After returning to this Other Settings dialog, press the Draw with Rope button to create a line or polygon with the current rope outline.

See also:

Slide
Slide
The Slide button on top dialog bar shows various tabs which allow you to arrange slide shows, guided tours and hyperlinks when the collage is seen with the FxFoto Viewer application. 

These dialogs control slide show attributes which can only be saved in upgraded Foto Editions.  They are not available in FxFoto Quick Layouts.

Slide Settings

Special Effects

Tour Panning

Click Image Link
See also:

Drawing

Info
Slide Settings

This is a tab under the Slide button.  It controls the slide associated with the currently selected image.  Slide show attributes can only be saved in upgraded FxFoto Editions.  This dialog is not available in FxFoto Quick Layouts.
Note that you must press the Apply or Apply All buttons before any new settings take effect (with the exception of the Slide Order).  Changes you make in this dialog can be lost if you switch to another without pressing Apply first.

The Slide Number shows where the current image appears in the slide show.  You can change this number, but it not recommended.  Instead, press the Slide Order button to click a new slide presentation order.

The Cross Fade gives the seconds (or fractional seconds) that this slide takes to fade in when presented in the viewer.  Use zero for no cross-fade.  Note that the Special Entrance and Exit Effects ignore this setting.

Check Auto Show Next Slide and set the desired Slide Duration to have this slide automatically switch to your next slide after being viewed for a predetermined time.   If unchecked, then the Viewer Next button (or Ctrl+RightArrow key or maybe the space bar) must be pressed to advance through the slides.   This setting applies only to the Viewer.  The editor shows entrance and exit effects but does not automatically advance through slides.

Check Disable User Navigation to stop the user from moving the camera view during this slide and thereafter.

Check Pan to First Tour Stop to have the camera view slowly move to whichever image for the slide (often the current image) has the lowest non-zero Tour Stop number.  This allows the slide to be presented with a panning movement effect similar to photographs shown in many documentary movies.  The speed of the movement is controlled by Seconds to Travel setting in the image’s Tour Panning dialog.

Check Execute Link Next to have the next slide be the Click Image Link for the current object.  This special case allows you to design Viewer presentations which automatically restart (if you use a Home link) or open another collage document (if you se a Browser URL link to a .FXF or .FXE FxFoto collage document filename).  Other types of links can also be used for this object for other special effects.  However, this advanced feature is usually left unchecked.
The Slide Order button allows you to rearrange the presentation order for this and all other slides.
The Slide Music or Audio button to sets or changes the background music played by the Viewer beginning when the current slide appears.  Or it can record narration with a microphone.  Associating different music with different slides allows you to switch music during the show.  The audio does not switch back or stop when the slide is done.  Instead, the slide music continues until another slide specifies a music file or until the music file ends when non-looping.  The general background music for the collage or slide show plays only until the first slide with music.  Note that to set beginning background music for the show is set by the Background Music tab in Collage Settings or the Set Background Music or Audio button in the New Collage and Save Collage wizards.

The Initial Camera View button allows set a specific camera view for the slide.

The Apply button changes the last clicked or opened image with the current slide settings.  If there are multiple images for the current slide, the new duration and cross fade settings are applied to them all.
The Apply All button allows these slide settings to be duplicated for all slides (except for the Slide Number which applies only to the current image).  It also changes default slide settings for new slides added in the future and for new collage documents created in the future.

See also:


Slide

Slide Order

Initial Camera View

Special Effects
Initial Camera View for Slide

This dialog controls slide show attributes which can only be saved in upgraded FxFoto Editions.  This dialog is not available in FxFoto Quick Layouts.  It pops up when you press Initial Camera View from Slide Settings dialog and controls the viewing position and altitude seen when the slide first appears in a Viewer slide show.
Press the Target Current View button to have the slide appear just as it does during this dialog.
Press the Target Copied View button to have it moved to the most recently remembered viewpoint from the Copy Current View command in the View Menu.
Press the Use Default View button to use the normal slide view showing the whole slide centered.  When all of the images for a slide specify the Default View (with all zero coordinates), then the Viewer automatically fits all slide images into the initial slide view.  It zooms up or down as needed so that all images completely appear.

You can set a different Target View for the slide by setting a target on just one of the photos or images included in the slide.  If target views are set for multiple images, the Viewer must choose one (normally the last image added).

The Viewer may show the slide with a different window size than your current right-pane collage window.  But the camera coordinates of the Target View will be preserved (after adjusting the aspect ratio as needed).  If the right-pane collage window is smaller than the full-screen Viewer window, then the slide view will be larger, but images will appear in the same relative window locations.
If you check Target 100% Zoom Altitude then the viewer will show the slide so that at its 1:1 zoom level even if that means that portions of the slide are off the edge of the window.  The center of the target will be the same but the view altitude will be fixed at 1:1 in the viewer.
The Show Borderless in Viewer checkbox makes the current slide completely fill the Viewer window. FxFoto automatically cuts off a little of the slide image on the top and bottom or on the left and right if needed to make it fit the window or full-screen shape. Borderless works best for single-photo slides without Title or Caption text outside the actual photo (which might be cut off for a borderless slide). Wipe effects usually look best with a single photo on a borderless slide so that the entering photo completely covers the display window. Note that you can also make the entire show borderless in the Collage Settings Collage Properties tab, using the Borderless Viewer Window checkbox, which will force all slides to be borderless independent of the Borderless setting here.

See also:


Slide Settings

Special Effects
Special Effects

This is a tab under the Slide button.  It controls how the selected object first appears in a slide and how it disappears when the slide transitions to the next.

Note that you must press the Apply or Apply All buttons before any new settings take effect.  Changes you make in this dialog can be lost if you switch to another without pressing Apply first.

This dialog controls slide show attributes which can only be saved in upgraded FxFoto Editions.  This dialog is not available in FxFoto Quick Layouts.
Set the Entrance Effect from the pull-down menu.  You can set the Entrance Delay and Entrance Speed for the effect.  Fractional seconds are allowed.  You can press the Test Effect button to try them out.  Note that the bounce effects typically take too long to be previewed completely with Test Effect.  Press the Apply All button to apply the same entrance effect to every image in all slides.  Apply All changes all slides currently in the show, but not those added later.  Choose Random Entrance or Random Wipe at the bottom of the Entrance Effect list to apply a different randomly chosen effect to each photo.
The "wipe" effects at the bottom of the Entrance Effect menu are similar to "Cross Fade" because the slide gradually appears over the last. But instead of fading in, parts of the selected image appear first and gradually wipe over the rest of their area. Note that the "wipe" effects can increase the size of a Flash movie and you may want to avoid them for slide shows that you intend to e-mail or upload to the web. Since the "wipe" effects are usually borderless, they are not normally mixed with the other entrance effects in the same show. So the Random Entrance does not choose wipe effects, while the Random Wipe always chooses them or "Cross Fade".
The Borderless checkbox at the top can apply to any Entrance Effect but is recommended for the "wipe", where it is checked by default. When Borderless is checked the current slide completely fills the Viewer window and FxFoto automatically cuts off a little of the slide image on the top and bottom or on the left and right if needed to make it fit the window or full-screen shape. Borderless works best for single-photo slides without Title or Caption text outside the actual photo (which might be cut off for a borderless slide). Wipe effects usually look best with a single photo on a borderless slide so that the entering photo completely covers the display window.  The various "wipe" entrances should normally be Borderless since when the old slide has the normal "cross-fade" exit, it will remain visible under the entering wipe only if the entering slide is borderless. Otherwise the old slide must fade out as directed because it may not be entirely covered by the new one.  Note that you can also make the entire show borderless in the Collage Settings Collage Properties tab, using the Borderless Viewer Window checkbox, which will force all slides to be borderless independent of the Borderless setting here.

Set the Exit Effect from the pull-down menu.  You can set the Exit Delay and Exit Speed for the effect.  Fractional seconds are allowed.  You can press the Test Effect button to try them out.  Press the Apply All button to apply the same entrance effect to every image in all slides.  Apply All changes all slides currently in the show, but not those added later.  Choose Random at the bottom of the Exit Effect list to apply a different randomly chosen effect to each photo.
When the current slide has more than one image, you should not mix Cross Fade and any of the other Exit Effects.  The Cross Fade Exit Effect starts after any other Exit Effects for other images in the slide.  Yet the other images move back to their normal positions after special exit effects and so can appear in the wrong position while the Cross Fade images fade out.  Use Fade Out First instead of Cross Fade for the Exit Effect when other slide images use other special Exit Effects.
The Speed you specify is really the number of seconds for the entrance or exit. A larger value makes the effect occur more slowly. The Speed settings are initially default to the Cross Fade time set in the Slide Settings tab. For Bounce In entrances, the speed setting is ignored.

Note: Multi-photo layouts and scrapbook pages do not normally contain more than one slide. Even if there are multiple slide layouts in such collages, they do not show entrance and exit effects. Large layouts can consume considerable computer RAM memory resources and these effects require both the entering and exiting layout to appear concurrently, doubling the resources required. So FxFoto ignores entrance and exit settings for the Multi-Photo Collage type, which includes the various Scrapbook page sizes. Instead it always jumps from one slide layout to the next.

See also:


Slide

Tour Panning
Tour Panning
This is a tab under the Slide button.  It allows you to pan the viewer over the current slide or to a specified tour stop associated with the current selected image.  Slide panning moves the viewpoint slowly over the image.  Tour stops are like second level slides within a show.  For the current slide, all defined tour stops are visited before the show continues with the next slide.  Slide panning uses one of the slide’s images as a special first tour stop to control the panning.  If there are other images in the slide, their tour stops can be used for subsequent stops if desired.
Note that you must press the Apply or Apply All buttons before new settings take effect. Also, pressing OK from the Camera View at Stop button popup dialog applies changes.  Changes you make in this dialog can be lost if you switch to another without pressing Apply first.

This dialog controls slide show attributes which can only be saved in upgraded FxFoto Editions.  This dialog is not available in FxFoto Quick Layouts.
Check Automatic Slide Panning to move the viewer camera slowly across the slide when it first appears.

Choose a Pan Extent to control the type of motion.  Side to Side panning moves from one side of the center to the other.  Side to Center and Center to Side move a shorter distance.  Edge to Edge moves further, from one edge to the other.  No Slide Panning turns off panning for the current slide.  Be sure to switch from No Slide Panning before choosing the pan direction.
Also choose a Pan Direction.  There are eight possible directions corresponding to the points on a compass as if the picture a map.  For example, North moves the slide image up toward the top of the screen while East moves it to the right.  You can also choose a Random Direction.
Also check Zoom Down to move the camera down for a closer view of the images during the panning.  

Then press Apply to set panning for the current slide or Apply Panning to All Slides to set panning for all slides (but not new slides you add afterward to the show).  You may want to use the Random Direction Pan Direction before pressing Apply Panning to All Slides   Automatic Slide Panning sets the Pan to First Tour Stop checkbox and the Initial Camera View in the Slide Settings tab.  It also sets the Camera View at Stop and Tour Stop Number 1 for this tab (even though they are disabled for manual change when you have checked Automatic Slide Panning).  The Seconds to Travel time associated with the Camera View at Stop button is automatically set for the duration of the slide (or five seconds if the slide waits for the Next button).  Apply Panning to All Slides changes all slides currently in the show, but not those added later.
Check Image Tour Stop to manually set the target and travel time for the currently selected image.  You have more precise control of the viewer camera with this setting.  Each tour stop or slide must be associated with one of your image objects.  Other objects can optionally appear at the stop and the selected image can optionally appear at other stops, but each stop must have a primary image which is assigned the stop number.  Click on the desired image to select it before setting its tour stop.
Tour stops or slides have numbers can range from 1 to 65000 and can include fractions.  For example stop 1.5 would appear between stops 1 and 2.  This makes it easy to insert new stops between existing ones.   The tour stops are shown in order from low numbers to high and the numbers need not be contiguous and need not start with 1.

Set the selected object’s Tour Stop Number to 0 (zero) if it has no associated stop.

Default stop numbers are assigned for some of the collage types in the order that you add images to the collage.  But you can reorder them simply by clicking on an image and changing its Tour Stop Number in this dialog.

Normally, the stop or slide appears until the user presses the Next button.  Check Automatic move to next tour stop or slide number to set a timeout value in seconds when the Viewer automatically advances.

By default, the camera view for the stop centers the selected image in the view at the normal 1:1 altitude.  You can adjust the stop viewpoint with the Camera View at Stop.  

The Apply button change the last clicked or opened image with the current tour stop settings.

You can apply non-zero Tour Stop numbers to one or more photos in the same slide (with the same Slide Number).  The FxFoto Viewer moves from the initial or whole-slide view to the each of the stops before continuing with the next slide.  The FxFoto editor’s Next button can also autopilot the camera to each non-zero stop.  When the Collage Add Mode toolbar button (between the Back and Next blue arrow buttons) is down, then Back and Next visit tour stops before continuing with another slide.  But when the Collage Add Mode button is up then Back and Next always switch between slides in the editor.
See also:


Slide

Image Click Link
Tour Stop Camera View

This dialog pops up when you press Camera View at Stop from Tour Panning dialog.  It controls slide show attributes which can only be saved in upgraded FxFoto Editions.  This dialog is not available in FxFoto Quick Layouts.
These settings are valid with a non-zero stop number for the last clicked image.  Only the primary image object controlling the stop can set the camera at that stop.
Press the Target Current View button to have the stop appear just as it does during this dialog.
Press the Target Copied View button to have it moved to the most recently remembered viewpoint from the Copy Current View command in the View Menu.
Press the Center View on Image button to restore the default behavior where the image appears centered in the view.

See also:


Tour Panning
Image Click Link

This is a tab under the Slide button.  Here you can choose what happens when the user clicks on the currently selected image object in the Viewer.  

Note that you must press the Apply button before any new settings take effect.  Changes you make in this dialog can be lost if you switch to another without pressing Apply first.  

This dialog controls slide show attributes which can only be saved in upgraded FxFoto Editions.  This dialog is not available in FxFoto Quick Layouts.
Press the No Link button if the image object should not be a link.

Press the Move Camera View when clicked button to have the Viewer auto-pilot to a specified location in the collage.  You can enter the desired camera collage coordinates.  But normally, you press the Target Current View or Target Copied View to have the image move to either the currently visible collage area or to the last view remembered with the Copy Current View command in the View menu.  Alternately, you can check one of the standard button actions (Back, NavBar, Done, Home or Next) to be used when the image is clicked.

Press the Browser URL Line when clicked button to launch the standard browser to view the specified web page or document, possibly over the Internet.  You can type a standard URL (such as http://www.fxfoto.com/welcome.htm) or can press the From Favorites button to choose from one your Windows Explorer Favorites folders.  You can also type the path name of another FxFoto collage file (ending with either the .FXF or .FXE extensions) as the URL to have the Viewer start a different collage presentation with the link.  You can optionally begin the Browser URL or collage file with a period and a forward slash to have the Viewer use the collage document folder.  The “./” implies that a folder-relative file name follows.  For example, ./Demo.fxf would start a new Demo.fxf collage presentation located in the same folder as the current collage.
See also:

Slide
Info
Info

The Info button on top dialog bar shows various tabs which allow you to examine and set non-graphic information about the last clicked or opened image in the right-pane collage window. 


Picture Description

Image Object

Image Placement and Shadow
See also:

Slide
Mouse
Picture Description

This is the first tab that appears when you press the Info button on the top dialog bar.  You see and change various description information associated with the last clicked or last opened image in your right-pane collage.  Note that these changes are also applied to the left-pane folder photo if applicable.
Note that you must press the Apply button before any new settings take effect.  Changes you make in this dialog can be lost if you switch to another without pressing Apply first.
The Choose Keywords allows you to select one or more keywords that apply to the photograph and which can be used later to Search for it.  Click a second time on a word to unselect it for the photo.  If you opened the photo from a left-pane folder, the selected keywords are saved for it in that folder when you press Apply.  The Add Keyword button allows you to enter a new keyword in FxFoto’s standard list.  Purge Keyword removes the selected keyword from FxFoto’s list.  Apply All works like Apply (and applies all Picture Description settings to the current photo) but also adds the selected keywords to all other photographs that have been opened in the collage.  Apply All allows you to add one or more keywords to multiple photographs.  Click the desired left-pane folder photos to open them.  Set one or more keywords for one of them and press Apply All to set those keywords for the current photo and add them to any previously set keywords for all of the others.  If the current photo has keywords that you do not want added to all of the others, then de-select those before pressing Apply All.  Then re-select them and press just the Apply button to keep them for the current photo.
The Popup Description can be non-blank to specify a message that appears in the Viewer when the mouse hovers over the image. The popup text can have multiple lines and is a useful for adding extra information to your collages in a non-intrusive way.

To the right of the description, another box shows the photo’s creation date plus some of the more important EXIF Camera Information.  The EXIF information is present only if the photo file includes it and the Keep EXIF Photo Information Options setting was checked when the photo was originally opened.  Press the New Data button to modify the date and/or time.
See also:

Image Object
Image Placement and Shadow
Mouse Mode
Image Object

This is the second tab that appears when you press the Info button on the top dialog bar.  You see and change various non-graphic information associated with the last clicked or last opened image in your right-pane collage.

Note that you must press the Apply button before any new settings take effect.  Changes you make in this dialog can be lost if you switch to another without pressing Apply first.  

The Image Object Name is a unique name for the image within the collage.  It is automatically assigned when you add an image file using the file name.  You can change it as desired (with an upper limit of 32 characters), but one or more digits may be added to the end to make it unique.

The Image Object Number is a unique number for the image within the collage that is automatically assigned and cannot be changed.

The Glue Group is normally blank or 0. Enter a non-zero number to include the image within a glue group so that it moves, resizes and rotates with the other group images.  Each glue group has a unique number which may not be the same as any of the Image Object Numbers.  If you choose a number already assigned to one of the images objects, FxFoto will beep and change this back to blank when you press Apply.  Note that you can also set glue groups using the Glue Grouped Images button in the Mouse dialog.
The Locked to Object allows the image to be associated with another in the collage.  This normally means that it is text which is overlaid on the main image or is a title or caption above or below it.  Locked object behave like glue group objects except that they do not show a dotted outline when the main object is selected and can be moved relative to the main object without using the Shift key.  Normally Locked to Object is blank or 0.  Enter a Image Object Number for another object to lock this image to the other.  The main image must also have its own object number entered in the Locked to Object field. 
Check Click to Zoom Down to allow the user to click on the object from high altitudes to automatically zoom down to view it at the 1:1 zoom level in certain collages.  This setting only applies to collages with Enable Click Zoom Down checked in Collage Properties.   This setting can be unchecked in such collages to stop the click-zoom for certain photographs.
Check Embed as PNG to force the selected image to be encapsulated in a saved collage file in PNG format rather than the default JPEG format.  This usually results in significantly less compression for photo images and larger collage files.  But it eliminates small artifacts that are inherent in JPEG compression and assures that the saved image is not degraded in any way.

If enabled, you can use the next six checkboxes to help author templates.  They control what happens when a new image is dropped on top of the object and when the object is clicked.  Normally no more than one of these six should be checked.  Remember that you must use Apply to set these choices.  Then use the Save Collage Wizard to create a document file with an .FXT filename extension.  Be sure to check Show thumbnail in the first dialog of the Save Collage Wizard so that a preview is included for the theme.  To appear in FxFoto’s New Collage Theme Browse selector, you must save or copy the .fxt collage file to the Themes subdirectory off of the FxFoto installation directory, normally C:\Program Files\FxFoto\Themes\.  You must have the  Media Edition to author templates and these checkboxes are disabled in other editions.  
Check Quick Sketch Drop to use the selected image as a Quick Sketch Template where images can replace differently colored fields.  This is automatically checked when the Quick Sketch Template command has been used.

Check Quick Replace Drop to automatically replace the selected image whenever a new one is dropped on top of it.  Normally FxFoto asks before replacing an image, but with this checkbox you can author templates with layered objects that are automatically treated as drop targets without the question.  Because transparency is preserved in the newly dropped image, these targets allow for feathering and the edges and partial transparency that are not possible with background Quick Sketch Drop image areas.

Check No Quick Drop to stop newly dropped images from replacing the selected object.  This avoids the question that FxFoto normally asks when an image is dropped over another and allows for permanent embellishments to be used in templates.
Check Theme Click Text if the selected object is editable text and you want the user to be able to click on the text object to enter new text.  But you cannot click on the text again before you save the collage file or the Theme Click Text is turned off.  Hint: Remember to turn off Auto Reduce when editing the template text with the Misc button's Text Field Width settings.  That allows you to leave extra available width if the user types more text.  Otherwise, the typed text must be squeezed into the available width and the font size may not appear as large as you intend.
Check Theme Target Photo to make the object into a rectangular drop target in a theme template.  Unlike Quick Replace Drop, this does not preserve transparency or non-rectangular cropping.  The dropped photo is "pseudo" cropped to fit so that some of the edges do not appear without the Adjust Visible Framing command.  You may want to use special drop target image files that say Photo rather than a normal photograph to make it obvious where photos go in the template.
Check Theme No Crop Photo to make the object into a variable-aspect rectangular drop target.  Unlike Theme Target Photo, the width versus height aspect of the dropped photo remains and the template image height adjusts.  In other words, there is no "pseudo" cropping with Theme No Crop Photo and this choice should not be used in templates where the image should not change shape or get taller.  Most templates use Theme Target Photo instead.

Press the Show on Top button to move the selected object to the end of the collage’s drawing list so that it shows on top of all other objects.  Note that you can also change the image drawing order by right clicking on a collage photo and choosing Show Image on Top or Show Image on Bottom from the popup menu.  Plus there are Draw tools to move the clicked object to the top or bottom.
Press Delete Object to remove the selected object from the collage.  This can be reversed with Undo.

Press Show Next Object to select and show the next object in the collage.  This can be useful to find objects hidden under other large images so that they can be Shown on Top, since you cannot click on a covered object to select it.

Press the Apply button to apply any changes made to the object settings.

See also:

Image Description
Image Placement and Shadow
Mouse Mode
Image Placement and Shadow
This is the last tab that appears when you press the Info button on the top dialog bar.  You see and change the position of the last clicked or last opened image in your right-pane collage.  It also allows you to view and change the image’s shadow settings.  If not already selected, click on the desired image before making changes.
Note that you must press the Apply button before any new settings take effect.  Changes you make in this dialog can be lost if you switch to another without pressing Apply first.  

Image Placement

The Left, Top, Width, and Height fields specified the object’s location and size in collage pixel coordinates.  The Rotation Angle is specified in clockwise degrees from the horizontal. This placement and rotation information is usually set more easily by dragging on or near the image’s selection pull boxes.  But if desired, you can type new numbers to move or resize the object.

Fixed Window Placement can be checked to make the object fixed relative to the viewer window (rather than relative to the collage).  Fixed objects are normally used for standard and custom navigation buttons to allow the collage to slide underneath as the view changes.  However any sort of image or text object and be fixed in the window if desired.  Fixed objects can behave differently than normal collage photos in many situations and cannot be chosen for many operations.
Remember to press Apply after making changes.

Image Shadow
Any image object, including photos, accents, stamps and even text, can be shown with a drop shadow.  Check or uncheck Add Shadow to turn the shadow on or off for the selected image.
Move the Shadow Height slider to adjust the pixel coordinates that the shadow is offset right and below the image.  Larger Shadow Height values make the image appear higher above the background.

Move the Darkness slider to a value between 1 and 255 to adjust the intensity of the shadow.  Lower Darkness values make the shadow more transparent so that it is lighter and more of the underlying color or image shows through.  A Darkness value of 255 makes the shadow totally opaque.  The default Darkness of 70 often works well.
Move the Feather slider to a value between 1 and 15 to adjust the feathering applied at the edges of shadows for a more realistic look.  Set the Feather value to 4 for default feathering which automatically adjusts to compensate for smaller images.
You can also press the Shadow Color button to change from the default black for a tinted light shadow effect.
By default, shadows appear below and right of the image and the Shadow Angle is 45 degrees.  Change the Shadow Angle to place the shadow at some other position relative to the image.  The Shadow Angle gives degrees from horizontal right, so for example, 0 is directly right of the image, 45 is below and right, 90 is below, 135 is below and left, 180 or -180 is left, -135 is above and left, -90 is above, and -45 is above and right.
Note that the Stamp Brush and Draw File Stamp and Clip Stamp modes allow you to apply a shadow to each stamped image without using this dialog.  See the Draw Other dialog for default stamp shadow settings.
Also note that text can have two different kinds of shadows.  Normally, the Effect setting in the Edit Text dialog is used for small text shadows.  But it is also possible to apply a larger shadow to the text image using this dialog’s Add Shadow.  However, for the image shadow to be cast by the actual text rather than the text image rectangle, you must set the text Background to Clear.  Yet Clear text does not usually look quite as smooth as text using a solid background, so the Edit Text shadow Effects are often the better choice.
Remember to press Apply after making changes.

See also:

Image Description
Image Object
Mouse Mode
Mouse

Press the Mouse button on the top dialog bar for mouse navigation of the collage view and possibly to select one of the other mouse modes.  These commands switch the effect of clicking and dragging the mouse inside the right-pane collage window.

Mouse Navigation

The primary three modes allow the mouse to move you around the collage.  The most recently used of these three navigation modes is used whenever you switch to the Mouse button.
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 Grab Scroll mode allows you to hold down the left mouse button over the collage to drag the view horizontally.  You can also click the left button near one of the edges to move a fixed distance horizontally in that direction.  Holding down the right button allows you to move vertically as with the Grab Zoom mode.  The cursor changes to a four-arrow icon when scrolling and there may be a second’s delay on cases where you are allowed to click with the button for another command.  When you point near the edges of the right-pane collage window, you can click to move a fixed distance in that direction.
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 Drive Zoom mode allows you to press the left mouse button to zoom down toward the collage point under the cursor.  Release the button to stop zooming.  You can also hold down the right mouse button to zoom up to a higher altitude to view more of the collage.  The Drive Zoom mode also allows you to point near the edges of the right-pane collage window and hold down the left button to drive the view horizontally in that direction.  Once driving horizontally, you can move the mouse cursor to change direction and speed.  Drive Zoom always stops moving when you release the mouse button.
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 Grab Zoom mode works like Grab Scroll except that dragging the mouse toward the top of the screen zooms out for a higher view of the collage while dragging the mouse toward the bottom the screen moves lower to zoom in.  Dragging the right mouse button allows you to scroll horizontally as with the Grab Scroll mode.  When you point near the edges of the right-pane collage window, you can click to move a fixed distance in that direction.
Rope Outline
There are also three modes for drawing a rope outline selection.  The selection area is then used for various image editing and drawing commands.  Note that many image editing commands using the rope provide convenient buttons in their dialogs to draw the appropriate rope.  Note that the Fixed Rope Aspect Ratio setting in Options forces the Rectangle or Oval rope outline to a given proportions and must be 0 for normal operation.
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 Rectangle Rope allows you to pull a rectangular rope box as the new selection.  Just move the mouse cursor to one corner of the desired box.  If using the Fixed Rope Aspect Ratio setting in Options, the box proportions are fixed and you should drag to the across or down rather than diagonally.  Then press the left mouse button and drag to the opposite box corner.  You can then point to any of the four sides of a previously drawn rectangle rope and drag the side inward or outward to precisely adjust your selection box.  Or point to one of the four box corners to drag the entire rectangle to a new location.  You can also use the Draw Rope mode to redraw part of the outline.
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 Oval Rope allows you to pull a circle or oval as the selection.  It works like Rectangle Rope, except that the oval bounded by the pulled box is drawn.  If using the Fixed Rope Aspect Ratio setting in Options, the oval proportions are fixed and you should drag to the across or down rather than diagonally.  You can then point to one of left, right, top or bottom most point along the oval to adjust the oval’s shape by dragging that edge inward or outward.  Or point anywhere else along the previously drawn oval to drag the entire outline to a new location.  You can also use the Draw Rope mode to redraw part of oval outline.  Note that the Crop dialog has an additional Pattern mode for special oval rope cookie-cutter patterns.
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 Draw Rope allows you to draw a freehand rope outline.  You should continue to hold down the left button until you have drawn back to (approximately) the beginning point to complete the loop.  You can also use this mode to redraw a portion of the existing outline, even if drawn with one of the other two rope modes.  Just point to the outline and press the left button and draw a new outline section which ends back over the old outline at another point before releasing the button.  Once you have drawn a freehand rope outline, you can switch to the Rectangle Rope or Oval Rope modes to drag the entire outline.  After switching modes, point anywhere along the rope and drag with the left mouse button.
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 Clear Rope is the same as Clear Rope in the View Menu and discards any existing selection outline rope.  It can be pressed at any time to erase the current rope outline but is not a mouse mode.
Glue Groups
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 Glue Grouped Images allows you to glue two or more images together in the right collage pane so that they move, resize and rotate with each other.  When pressed, you can pull an outline around all of the collage images to be glued together.
Drag a box around the images to be glued with the left mouse button.  A new or different group is created with all images inside the pulled box.  Then when you click on one of the glued images to select it with pull tabs, all of the other images in the group will show blue dotted outline without the pull tabs.  When you adjust the selected image using its pull tabs, all of the other images glued to it will adjust similarly so that the group stays together.

You can also add to a group just by clicking on more images.  So by clicking on two images in a row, you glue them together.

The Glue Grouped Images button is automatically released and FxFoto beeps when you pull a box that groups two or more images.  So FxFoto normally returns to one of the Mouse Navigation modes after you have used it.  If you just click on images to group them, Glue Grouped Images stays down until you press one of the other buttons or switch to another toolbar dialog.
In other dialogs or when using one of the Mouse Navigation modes and not this Glue Grouped Images mode, you can glue and unglue using the Ctrl key on your keyboard.  So when the Glue Grouped Images button is not pressed, hold down the Ctrl key and click on an image to glue it to the previously selected image.  Or if the clicked image was already selected with pull tabs, clicking on it again with the Ctrl key will unglue it.  Note: that these Ctrl key operations only apply with normal navigation and may not be available when using one of the special drawing or photo editing brushes.

Also in other dialogs or when using one of the Mouse Navigation modes, you can adjust the position, size or rotation of a glued image without ungluing it with the Shift key.  Hold down Shift on your keyboard while dragging to temporarily unglue it and move it independently of the rest of the group.  Note: that this Shift key operation only applies with normal navigation and may not be available when using one of the special drawing or photo editing brushes.
The Ctrl and Shift keys also perform special functions for regular unglued images.  When you hold Ctrl and Shift down, rotation snaps to 90 degree angles.  Shift allows you to stretch an image horizontally or vertically when resizing.  Ctrl allows an image to be resized around its center point.  But when the selected image is part of a glue group, the Ctrl and Shift glue functions override.  You must unglue the image to use them for non-glue functions.

Note that you can also unglue and image from its group by right clicking on it and choosing Detach Image from Group in the popup menu.  Detach Image from Group only appears in the right-click menu if the selected image is part of a glue group.
You can save a glued group of images as a Matte collage.  This is a special collage document that adds to the current collage when opened rather than replacing it.  In the left-pane folders, Mattes appear with a special [+] icon drawn over them.  Once you have saved grouped images, you can add another copy of them into the same collage or into a different collage latter by simply clicking open the matte group folder thumbnail.
Miscellaneous
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 Drag & Drop allows you to click on an image in the right-pane collage window and drag it to some other window.  You can drag it into one of the left-pane folders to move it there.  Or you can drag it to another application to open the picture.
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 Mouse Draw mode allows you to drag or click with the left mouse button (and sometimes the right) for various drawing actions.  It normally uses your most recent Draw settings to allow drawing in the right-hand window.  If you most recently used a special Correct tool such as RedEye, Blemish, Clone or Change then this button sets a circle or square cursor over the right-hand window for corrections with the most recent settings.

See also:

Install New Font
Install New Font

This command may not be included in your edition of FxFoto.  It requires the FxFoto Creative or Media Editions.
Available from the Tools Menu and also the Edit Text Misc dialog, this command allows you to add a new font to Windows so that it appears in FxFoto’s Edit Text Font & Size list and also in other applications which use fonts.  This command works similarly to Fonts in the Windows Control Panel, where File / Install New Font can also add fonts.
A file selector allows you to choose a .TTF / .FNT / .FOT font file on your disk, possibly where you have downloaded and saved it.  For convenience, it remembers the folder you use for next time.  It copies the selected font file to the Windows Fonts folder (normally C:\Windows\Fonts) and adds it to Windows’ list of installed fonts.  If the chosen font file was not already in the Windows Fonts folder, this command makes a copy but leaves the original.
See also:

Remove Font
Remove Font

This command may not be included in your edition of FxFoto.  It requires the Creative or Media Editions.
Available from the Tools Menu and also the Edit Text Misc dialog, this command allows you to remove an existing font from Windows so that it no longer appears in FxFoto’s Edit Text Font & Size list or in other applications which use fonts.  A file selector allows you to choose a .TTF / .FNT / .FOT font file on your disk.  It looks for a font file with the same name in the Windows Fonts folder (normally C:\Windows\Fonts) and removes that copy from Windows’ list of installed fonts.  It moves the Windows Fonts copy to the Recycle Bin.  Only the copy in the Windows Fonts folder is removed and any original copy elsewhere remains and can be installed again latter.
See also:

FxFoto Options
FxFoto Options

Available from the Tools Menu, this dialog presents various advanced FxFoto settings.

General Settings

Check Start with Printer Page Layout Guides to show printer page guides when FxFoto first starts rather than the free-form Photo Editing mode. The guides show the currently selected printer's page size and printable area. This is the last printer selected from FxFoto and may not be the Windows default printer. The Collage Add Mode is enabled so that opened images add to the layout rather than separate slides.

Check Reload Last Collage on startup to show the previous collage if you start the program without a specified file.

Uncheck Special File Selector with Image Previews to stop showing a custom file selector with preview and favorites capabilities when choosing image files.  When unchecked, the standard Windows file selector always appears.  (Note that unchecking Preview in the special file selector just turns of the previewed images for speed but does not switch to the standard file selector.)
Uncheck Normal Windows XP Selector Previews to show FxFoto’s special selector with preview and favorites capabilities even with Windows XP or Vista.  Normally, the Windows XP or Vista file selector can show thumbnail images in addition to file names, making FxFoto’s special preview selector less necessary.  So when this setting is left checked and you have Windows XP or better, FxFoto uses the normal Windows selector except for specialized file types such as accents and themes that Windows cannot show as thumbnails.  This setting is ignored if the previous Special File Selector with Image Previews is unchecked.
Uncheck Use Scroll Bars to eliminate the right-pane collage window scroll bars the next time you start FxFoto.  FxFoto’s powerful navigation features mean that scroll bars are not necessary to move around the collage, but are provided by default.  Please Note:  You must exit and restart the software before this option can take effect.
Check Allow Just One Application Instance to stop multiple FxFoto instances from being open in different Windows at the same time.  If FxFoto is the default handler for JPEG image files opened from Windows, then they open into the same FxFoto collage layout or slide show.  Please Note:  You must exit and restart the software before this option can take effect.

Folder Settings

Check Minimize All Left Folders on Startup to initially show all left-pane folders minimized and showing only their names whenever you first start FxFoto.  This is equivalent to using the Minimize All Folders command.  More folders are visible when minimized but startup may take slightly longer.  You can then click individual folder [+] plus boxes to show their photos.
Uncheck Show Left Folder Tooltip Information to stop file name, creation date, and extra description text from popping up when you hover the mouse over left-pane folder thumbnails.  Unchecking this also omits the arrowheads normally drawn over the small thumbnail images to the right of folder names.  These arrowheads serve as a reminder that clicking the image presents a menu of commands for the folder.

Uncheck Animate Left Image Folders Scrolling to have the left-pane thumbnail images scroll up and down with the scroll bar rather than pilot themselves at a reasonable speed to the new scroll position.

Check Alphabetize Left Image Folders to show the left-pane thumbnail folders in alphabetical order.  When unchecked, they appear in chronological order using the earliest creation date from each folder.
Uncheck Show Timeline to omit the left-hand folder timeline.

Uncheck Never Animate Timeline Clicks to allow FxFoto to scroll to a clicked timeline folder rather than jump when the Folder Animation is enabled.
Check Reverse Left Folder Order to cause FxFoto’s left-pane folders to appear in reversed order, with the oldest folders first for chronological order or with the higher numbers or letters first for alphabetical order.
Print and Save

Uncheck Print, Email, Upload White Background to print the colored collage background as you see it in the view.  When checked, FxFoto uses a white background regardless of the collage background color.  Leaving this checked can save ink and often looks better. This same setting applies to Emailed and Uploaded collage images.  It also applies when Saving PDF files.  However, Themes override this setting and always show the theme’s background.

Check Rotate Printed Images to Best Fit the Page to print sideways if needed to better fit the image to the printer page.

Check Keep EXIF Photo Information to have FxFoto read extra information saved in JPEG photo files by most digital cameras.  Some of the extra EXIF information can be seen in the Info Picture Description dialog for the currently selected open photo.  Plus FxFoto uses the EXIF Image Description, if present, for the photo’s Description and/or Keywords list.  Otherwise, FxFoto does not require this extra information.  When photos with EXIF information are saved using Save Image As the EXIF information is copied to the target JPEG file, but only for the Original Image, Composed Image and Title and Caption with Image choices and only if this option setting was checked when the photo was opened.  EXIF information, if available, is also used by Save Modified Image.  When photos are encapsulated into FxFoto collages and slide shows, EXIF information is included if available, but only if transparency or non-rectangular cropping have not been used (since transparency is does not save in normal JPEG format) .  Note that FxFoto automatically sets the EXIF Image Description to the Description and/or Keywords set in FxFoto’s Picture Description dialog.  Otherwise, it leaves the EXIF information unchanged when it saves JPEG photo files.
Check Keep EXIF Photo Thumbnails to have FxFoto add a small version of the photograph when Save Image As writes EXIF information to JPEG files.  This thumbnail image allows some cameras and software to display the photo or to display it more quickly.  FxFoto uses EXIF thumbnail images only to make Scan faster and for faster file selector previews.
Uncheck Ask to Save Modified Images on Open to stop FxFoto from reminding you to save an edited photo when you open the next.  The Save Modified Images dialog allows you to uncheck Do Not Ask About Save Modified Images on Open.  To restore the save warning when you open the next photo, just check this option setting.
Check Use Separate CD Burn Application to stop FxFoto from using the Windows CD Writing Wizard to burn to CD-ROM, even when supported under Windows XP or better.  Instead FxFoto always writes the CD image to a special FxFotoBurnCD directory off Documents or My Documents and allows you to switch to separate software to record the CD or DVD.  This option allows you to use FxFoto to burn a DVD under Windows XP even though the Windows CD Writing Wizard does not support recordable DVD drives.  It may also be needed if your CD software is incompatible with the Windows CD Writing Wizard.  This option does nothing under older versions of Windows which always require a separate application to record to CD-ROM.
Collage Settings
The Keep maximum photo resolution checkbox controls whether FxFoto keeps extra resolution for photos that are smaller in the collage than their original size.  When the Maximum Size for Added Images limits the size of photos, they are de-resolved to match the collage when framed or drawn upon.  They will not loose clarity at the collage's 1:1 viewing altitude.  But if you zoom closer or print them, you may see the decreased resolution unless you check this option.  However checking this option can slow some FxFoto operations and result in very large collage or slide show document files.  This setting duplicates one in the Page Guides dialog.

Check Default Keep Max Resolution Shortcuts to cause the 8x8 and 12x12 Scrapbooking Page Collage Startup Shortcuts to set the Keep Maximum Photo Resolution parameter even though those Page Guide sizes normally do not need additional photo resolution for crisp printing.
Uncheck Collage Relative Paths to always save absolute file path names for non-encapsulated collage images.  By default, FxFoto saves relative names for files in the same folder as the collage file or in sub-folders and so the referenced images appear if the whole folder is copy elsewhere.  This setting does not matter for encapsulated collage files.

Check Copy Encapsulated Collage Images to make FxFoto make copies of the original compressed images when re-saving an encapsulated collage or slide show file.  This avoids multi-generation compression degradation.  When unchecked, FxFoto re-compresses all images when re-saving collages and can use a different JPEG Quality if that setting has been changed.
Image Editing

Check Backup Original Image Files to have FxFoto automatically make a copy of the original file when you modify and image file (when the original has not already been backed up).  The Save Image As command or closing a Files Collage with non-encapsulated image files that have been modified can overwrite the original photographic image.  This option allows the original image to be preserved.  The original can be restored during a latter session by opening the modified image and then using Undo when there are no further changes to undo.  To stop FxFoto from creating *.FXB files, uncheck this option.
Check Links Allowed while Editing to allow clicking on links and collage-window buttons in the FxFoto editor to activate the link.  By default, links are disabled since they can interfere with editing operations.

Uncheck Animated Auto-Pilot to have the view jump to new locations rather than smoothly move over the collage landscape.

Check Auto-Pilot to Added Images to moves the view to show each new image filling the right pane when you first Open them.  When unchecked, FxFoto does not move the view if the new image is visible.  If the new image is out of view when this setting is unchecked, FxFoto shows the whole collage with all images in the current slide including the new one.
Check Easy One-Click NavBar Joystick to disable drive-style control for left-hand joystick.  When checked, you just click to move a fixed distance rather than hold down the mouse button.  However, you will have less precise navigation control in this mode.

Check Drag and Drop Next to Last Image to position drag & drop files in the standard collage next-image position FxFoto would choose if you Opened the image file instead.  When unchecked, the image is placed near the drop point where you release the mouse button. 
Check Edit Photos for Large Prints to automatically expand a single image to fill the layout or printer page after you Crop it.  This option also arranges and sizes opened photos to fill the layout page as well as possible when the layout contains only photos, similar to the Position Photos to Fill Page command. It also increases the resolution width of new text for printing when there are not page guides. Check this option if you usually print one or maybe a few large annotated photos per page.  When unchecked, FxFoto assumes a more complex layout with smaller images and does not resize or rearrange photos when you open or crop them.
Text Settings

Check Default Render High Resolution Printing to initially set all new Text objects to be redone to match the output resolution whenever you print or save.  This option can result in higher quality text output because FxFoto renders at the device resolution if there is sufficient memory.  But this option can significantly slow printing or saving layouts with large blocks of text and it can sometime result in minor changes to the text's appearance.  You can also set Render at High Resolution when Printing or Saving Image for each text object from the Misc button.

Check Default Right-to-left Text to initially set all new Text objects to display right-to-left as in Hebrew or Arabic.  You can also set Right-to-left Text for each text object from the Misc button.
Check Three Times the Font Size to use text larger fonts by default.  When checked the font is three times larger than the chosen size (though this can be also be turned on or off in the Misc Other Text settings for individual text objects).  This allows you to create very large text with the Size menu choices of 72 or less without having to type a much larger Size number.
Check Extra Text Object Margins to add ten extra blank pixels one all sides of new text objects.  This extra margin does consumes computer resources but does not usually change the text appearance, except to add some extra space when the text is aligned with the top or bottom of an image.

Navigation Speed

Change the Slow, Medium and Fast settings to adjust the three standard navigation speeds. 

JPEG Quality

The JPEG Quality is used whenever photographs are saved by FxFoto, either as separate JPEG files or encapsulated in collage files.  Check Normal Quality for the standard quality which compresses the files as much as possibly without sacrificing too much quality.  Check Very High Quality to use only a small amount of compression.  This results in a somewhat more faithful photograph that usually consumes significantly more disk space.  We recommend you check this only in situations were image quality is much more important than image or collage file size.  Or check Custom Quality to enter any quality level between 1 and 100.  Quality level 0 is equivalent to the Normal Quality Level.  Note: When you edit photos or images, FxFoto's undo feature saves the old version in a very high quality JPEG image.  However if you set a Custom Quality greater than 95, then that even higher quality is also used when saving old undo versions.
Other Settings

The Maximum Size for Added Images can be set to automatically de-resolve large images wider or taller than the given setting when they are opened.  Larger images cannot be seen all at once at the 1:1 view level and can be slow in some cases.  This setting is also available in the Page Guides dialog.  Note that the Keep Maximum Photo Resolution setting allows a photo to render with maximum resolution even when a smaller maximum size confines it to a smaller box on the collage.  Note that FxFoto will automatically reset this to 800 pixels for the next collage or show if less.
The Maximum Size for Saved Images limits the pixel width or height of image files saved by the Save Image, Upload and EMail commands.  Creating huge JPEG image files for large collages can require excessive computer resources or be very slow.  The 3600 pixel default limits saved images to somewhat less that 10 megapixels or 12 inches at 300 dots per inch.
The Left-Pane Thumbnail Images Size controls the pixel width of folder thumbnails shown on the left.  The default value of 96 can be increased to up to 160 pixels for larger thumbnails or decreased as low as 32 pixels for smaller images.

The Maximum Temp Browsed Pictures limits the number of photographs that can be opened in the default temporary Files Collage type.  If you click on more than this maximum for a temporary collage, the earliest photos are automatically closed.

The Maximum Slide Thumbnails Shown limits the number of slide images shown by some wizards.  These commands allow you to select or omit slides to be included in the saved show.  But creating these slide images can be slow if you are not building a real slide show.  FxFoto automatically saves slide thumbnails for speed when it knows you are building a slide show.  But for other types of collages, FxFoto does not keep slide thumbnails and cannot show a large number of slides in popup selectors.  If there are more slides than the setting given here, such commands show individual photos rather than complete slides, though you can still omit slides by omitting all of the individual photos on those slides.  This limit does not apply to slide shows.
The Maximum Search Results Pictures limits the number of photographs that can be found for an All Matching Photographs Search.
Change the 3D Deresolve Min Screen Area to zero to always show 3D Perspective at full resolution if you have a very fast computer.  Otherwise set it to the view screen pixels (width times height) beyond which 3D must be de-resolved to be acceptably smooth.

The Frame Adjust Outer Transparency controls how opaque non-visible portions of the photo appear during Adjust Visible Framing.  Type a value between 0 and 255, where smaller values cause more transparency and 255 if fully opaque.
Change the Low Memory Warning Percentage to adjust the RAM memory level at which the Low Memory Warning appears when you open photos or images.  The default is 66 for 66% of available memory (after a portion of memory is reserved for the operating system).  A higher number like 75 would delay the warning until 75% of memory is used.  Beware that FxFoto and Windows require memory resources beyond those used by the collage and so you will usually encounter problems well before the collage memory usage reaches 100%.
The Stamp Pixel Width controls the resolution that WMF Draw Stamped images use.  Windows metafile clipart uses vector graphics which can be drawn at any level of detail.  But additional resolution costs memory and collage file size and may not be visible on screen.  Enter a 0 (zero) value for the default, which is the actual 1:1 resolution of the stamp width box in the collage or 800 pixels for more detail when Keep Maximum Photo Resolution mode is on.  Enter a non-zero pixel width to control the minimum level of detail in stamped images.  However, if the 1:1 resolution of the stamp width box is greater than the non-zero Stamp Pixel Width setting, then the higher resolution stamp box is still used.  This setting does not affect stamped bitmap images, which have an inherent resolution that cannot be improved.
Change the Fixed Rope Aspect Ratio to a non-zero value to force rectangular and oval rope outlines to a given width / height aspect.  This allows you to pull and adjust Crop areas with desired proportions and it is duplicated by the Fixed Rope Aspect pull-down in the Crop dialog.  It is also used for all other commands that use the rope outline.  For example, type 1.333 for the 4:3 aspect that is normal in most digital photographs.  Use 1.5 for the 3:2 aspect used with 35mm film and 4x6 prints.  Or use 1.618 to force Golden Mean rope rectangles and ovals.  Hint: When using a non-zero aspect, move the mouse either vertically or horizontally when pulling a rectangle or oval rope so that the other box dimension adjusts as needed, staying centered on the mouse.  If you pull diagonally (as is normal without a fixed aspect), FxFoto adjusts the narrowest box dimension.  For normal operation, this setting must be 0 to use arbitrary rope dimensions.
The Default Seconds per Slide in Movies determines the duration of movie slides when the slide show uses buttons to switch slides in the FxFoto Viewer.  It is the default slide time used when a slide does not have a specified duration.  It is ignored when the slide does have a Slide Duration.  This setting is used by both the Transfer Show to Movie and Make Web or Flash Show commands. For the Make Web or Flash Show command, this setting must be changed here in the Options dialog if needed because it is not duplicated in the command's dialog.

The Contrast Soft Shoulders Percentage controls the degree of softening used in the Brightness - Contrast - Gamma controls when Soft Shoulders is checked. Increase the percentage to show more detail. By default, very dark areas use 25% contrast. Zero is not allowed and the 25% default is used instead (and you should uncheck Soft Shoulders to turn this feature off). Normally, the degree of softening for very bright or white areas is double the given percentage. But you can specify the high-brightness percentage by multiplying it by 100 and adding it into the desired dark percentage. For example, 7550 would use 50% for dark areas and 75% for white areas, while 125 would use 1% for very little white softening while keeping the default 25% for very dark areas.
The Saved JPEG DPI can be set to a non-zero value to force FxFoto to add the specified dots-per-inch setting to the saved JPEG file's EXIF information. Some software uses this DPI value to determine the print or display size for the photo, though most software including FxFoto ignores this setting. When set to 0, FxFoto keeps any existing EXIF DPI setting for the photo. When saving individual images that are part of scaled layouts, FxFoto ignores this setting and uses the collage scale to automatically determine the saved DPI.

Press the Browse button for Import Target Folder Parent Directory to examine or change the place where FxFoto’s Import places new folders.  Photos are normally imported to folder directories created within Pictures or My Pictures.  Select another folder directory to create new import folders as children of the chosen disk and/or directory.  Note that this does not move the FxFoto_Clips area where scrapbooking kits are installed. But you can place FxFoto_Clips and also other created folders in FxFoto's installation folder when you first install by checking Place new image data folders in the installation folder in the installer's setup dialog.
Restore Default Settings

Press the Restore FxFoto Default Settings button to clear all of your remembered FxFoto registry information and use the original defaults for all settings.  You are asked if you are sure, since you cannot undo this operation.  If no collage images are open, then this also resets to default collage settings.
See also:
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See also:

FxFoto Support
Help Contents

This command shows the FxFoto documentation that you are reading.  It is available from the Help Menu and by pressing the F1 key
See also:

Quick Start Guide
Tips on Startup
Tips on Startup

This command shows the next in a series of helpful tips on using FxFoto.  Press Next Tip at the bottom to continue viewing more tips.  Press Close when done.

The same Startup Shortcuts and Tips dialog also contains a number of convenient commands for starting new collages and slide shows and is also available in the File menu.

Uncheck Show shortcuts and tips when FxFoto starts to stop showing tips and shortcuts when you first start FxFoto.  Or use this Help Menu command to and check the box to re-enable tips on startup.

See also:

Quick Start Guide
Demonstrate FxFoto
Demonstrate FxFoto

This command shows the FxFoto demonstration, which is a collage that that can be installed by FxFoto during setup.  After you install FxFoto, it asks to run this demonstration.  Later you can use this Help Menu command to re-start to this slide show, which demonstrates various FxFoto capabilities and operations.  This command is not available in FxFoto Quick Layouts.
See also:

Quick Start Guide
FAQ Online
FxFoto Support

You can contact FxFoto support using the Support Online command in the Help menu.  This starts your web browser and shows the FxFoto Support page on our www.FxFoto.com web site.  Or visit http://www.fxfoto.com/fxsupport.htm.  Use the provided form to submit questions and comments.
But before you contact us with a question, please check carefully to make sure it is not covered in this help documentation or on our www.FxFoto.com web site.  Check the FAQ Online for answers to Frequently Asked Questions from our support staff.  If possible, upgrade to the most recent version of the software before contacting us.  Use the Check Latest Version Online command to automatically determine if a newer version is available.
Please give us as much background as possible with your question, including the exact text of any error messages, exactly what you were doing prior to encountering the problem and also the FxFoto and Windows versions you are running as well as the make and model of your digital camera.  If you are a registered user, please also provide your name and registration serial number (which appears in the last line of the Licensed to: area of the About FxFoto dialog).

You can also contact us at:

Triscape, Inc.

PO Box 908
Windham, NH 03087 USA
We particularly value your feedback.  And once again, thank you for your support, which allows us to provide the best possible support in return.

Updating or Repairing the FxFoto Installation
To check whether there is a newer version of FxFoto, use the Check Latest Version Online command in the FxFoto Help menu.

Hint: Rather than reinstalling, in many cases you can use the Restore FxFoto Default Settings button in the Options dialog to clear FxFoto’s settings.  If you reinstall, do not check Keep existing FxFoto option settings in the Setup dialog and the default settings are restored.
To update to the most recent version of FxFoto, just visit www.FxFoto.com and download the latest version from the http://www.fxfoto.com/fxdownload.htm page.  Click the same Download FxFoto link, whether you are upgrading or installing FxFoto for the first time.  As of this writing, there is no charge for updates, even for major upgrades.

To update, you should not uninstall FxFoto first because this would erase your photo folder organization and settings.
Then just run or open the downloaded FxFotoSetup.exe and follow the instructions.  When upgrading an existing copy of FxFoto, you should not check “Scan local disks for existing photographs” in the Setup dialog.  It will normally be unchecked by default.  Scanning for photographs can change your old photo folder organization.  You may want to check “Keep existing FxFoto option settings”, which will be unchecked by default.  The options settings remember your last used settings for various commands, but erasing them does not change your photo organization.
To repair an existing FxFoto installation, just rerun or reopen your downloaded FxFotoSetup.exe installation (or download the latest version from www.FxFoto.com).  Then check Repair in the Setup dialog.  For a more invasive repair, choose Yes when asked whether to Rebuild FxFoto Folders.  This will remove all existing FxFoto folder organization (but not the underlying photos) and force FxFoto to rebuild all folders when you next start it.  Or choose No to re-scan the existing FxFoto folder organization for new or removed photos.
Backing Up Your FxFoto Data
The Archive Folder to CD-ROM command is an easy way to backup folders and their photograph files.  The remainder of this section has information for advanced users who want to backup the entire FxFoto state.

On Windows XP, Vista and Windows 2000, FxFoto folder information is stored for each user in files within an FxFotoDB sub-directory of the user’s Application Data.  For example C: \ Documents and Settings \ User Name \ Application Data \ FxFotoDB.  For Windows 98 and ME, FxFoto folder information is stored in files within the DB sub-directory of the FxFoto installation directory.  This is normally C: \ Program Files \ FxFoto \ DB.  You can make backup copies of all FxFotoDB or DB files to save the current FxFoto folders but not the underlying photo files.  The FxFotoDB or DB files contain path names to the actual photos elsewhere.

To backup the underling photo files, you must make copies of all disk directories that contain photo image files.  These are usually (but not always) in your Pictures or My Pictures directory and its sub-directories.

To backup the current FxFoto options and other miscellaneous settings, you must make a copy of the information in the HKEY_CURRENT_USER \ Software \ Triscape \ FxFoto registry key.  You can use the Windows RegEdit application to export this key to a disk file and then backup that file.  You should also backup the FxSetup and FxViewer registry keys.  Or just export the entire Triscape registry key.
See also:

Uninstalling FxFoto
Keyboard Commands
FAQ Online
Frequently Asked Questions Online

This Help Menu command to starts your web browser and displays the www.FxFoto.com page with Frequently Asked Questions.  This information is frequently updated by the Triscape support staff.  You may also reach this page by from a link on the FxFoto Support page at www.FxFoto.com.

See also:

Quick Start Guide
Purchase FxFoto Upgrades
Upgrade to Deluxe Editions
This command is available in the Help menu and also via Upgrade or Buy buttons in some dialogs.  It starts your web browser and displays the online page where you can purchase FxFoto.  If you have Quick Layouts, it allows you to purchase the full FxFoto Creative Edition with photo organization and editing effects.  See the Purchase topic for additional details.
If a limited-time upgrade discount coupon is valid, it is automatically entered for you.  The upgrade unlocks advanced features such as the ability to create and save multi-photo collages and slide shows.  Purchasing a license is the best way to support Triscape and help us continue to supply you with quality software.  We thank you for your support!

You can also purchase the upgrade by simply visiting www.FxFoto.com.  Either way, you can use your credit card with our secure server to immediately obtain a Registration Number that you must enter to enable all deluxe features.
Please Note:  When you upgrade, you will receive a User Name and Registration Number.  You must enter these in the FxFoto Registration Number dialog to enable the upgraded edition.  That dialog automatically appears when you have used the Upgrade command and switch back to FxFoto from your web browser.  Otherwise, you should use the Enter Registration Number command in FxFoto’s Help menu to enter your registration and unlock deluxe features.
See also:

Upgrade FxFoto
Enter Registration Number
Enter Registration Number
When you first install a purchased edition of FxFoto, this dialog may appear.  It also appears when you purchase or register the Standard Edition.  Plus it appears in the Help menu.  See the Purchase topic for additional details.
Your User Name must be typed exactly as it was when you obtained the license (although capitalization and punctuation may vary).  A different version of your name will not work.  In some cases the User Name may be a short code like CE that identifies the FxFoto edition.  This code must still be entered correctly.
The Registration Number has sixteen numerals and letters such as 1234-5678-90AH-CXEF.  The dashes between the four-character groups are optional, as are capitalization and spaces.  The number should use only digits plus the letters A, C, E, F, H, X.  Registration Numbers with H and X require at least FxFoto version 4 and for older versions you must substitute the letter B for H and the letter D for X.  Newer versions use H and X, which are less easily confused with numerals.  0 is always a zero, but typing the letter O works too.
It is usually best to use right-click Copy and Paste commands to copy your User Name and Registration Number into this dialog exactly as they appear on your registration.  On the source e-mail or web page, hold down the left mouse button and drag to highlight to User Name.  Then right click and choose “Copy”.  Then switch to FxFoto and right click in the name field to choose “Paste”.  Repeat for the Registration Number.
The User Organization is optional and you may enter your company, school or other organization name if desired.

After entering your registration information, press OK.  A Thank You message indicates that the registration was accepted.  Otherwise you entered either your User Name or your Registration Number incorrectly and can try again.
The Purchase button starts your web browser showing the FxFoto Upgrade or Registration order page.  Ignore this button if you have already obtained your registration Number.

When the trial period has expired or after about a month an unregistered copy of FxFoto Standard will ask you to enter a registration when you first start it.   A special version of this dialog indicates that You must register FxFoto to continue to use FxFoto.  You can press Visit www.FxFoto.com to bring up your web browser to register.  When this message appears, you must enter your valid User Name and Registration Number and press OK.  Pressing Cancel simply causes FxFoto to exit.  All of your photographs are still available on your computer even without FxFoto, typically in sub-folders off of Pictures or My Pictures.
See also:

Purchase FxFoto Upgrades
Activate FxFoto
Activate FxFoto

This dialog may appear when you first start FxFoto.  Your FxFoto registration must be activated on your computer.  There are two ways to activate FxFoto so that you can continue to use all features.  Activation contacts Triscape’s Internet server at www.FxFoto.com to enable your registration.  However, only a short Activation Code Number is send, which contains your FxFoto registration serial number and a hardware identifier.  No personal information is sent and the hardware identifier is completely anonymous and cannot be used to find you or your computer.

Automatic Activation

If your computer is connected to the Internet, you can activate in seconds.  Leave Automatically Activate Online Now checked.  Make sure that you are currently connected and online.  If you have a dialup modem, you should connect first before continuing.  Press the Continue button and FxFoto will automatically send your Activation Code Number to the www.FxFoto.com Internet server and receive the Activation Response.  This normally takes only a few seconds and a progress bar appears while FxFoto waits for the response.

Manual Activation

If your computer is not connected to the Internet, you can activate using any other computer that is connected with a web browser.  Check Manually Activate using any Web Browser and an Activation Code Number appears below.

You must make a copy of the Activation Code Number so that you can later enter it with the web browser.  Write down the twenty-two digit number.  Or press Copy Number to Clipboard and paste it into a word processor document to print it.

Then at any online web browser, visit FxFoto’s Manual Activation site here:

http://www.FxFoto.com/activate
You can usually type just fxfoto.com/activate as the address since the http://www. is assumed by most browsers.  You can even press Popup Web Browser Now from FxFoto’s dialog to use your browser on the same computer, though the automatic activation is easier.

FxFoto’s online Manual Activation page will ask you to enter your Activation Code Number.  You must type it in without mistakes, though the dashes are optional.  (If you have copied it to the clipboard and are using the browser on the same computer, you can right click and paste it into the form without typing.)  

Then press the Submit button on the browser page and an Activation Response Number appears.  Print or write down the response number, which has twenty digits similar to this 12345-1234567-123-12345.
Return to FxFoto to enter the Activation Response Number.  You must enter it without mistakes, though the dashes are optional.  Then press Continue to confirm the activation.
If desired you can Cancel the Activation dialog and exit FxFoto.  The Activation dialog will reappear the next time you start FxFoto and allow you to recheck Manually Activate and enter the Activation Response Number from the web site.
See also:

Check Latest Version Online
Check Latest Version Online

This Help Menu command starts your web browser and displays the www.FxFoto.com page showing whether your FxFoto is the newest version available.  If an improved version of FxFoto is available, it allows you to click on a download link to get the latest version online.  If you choose to download the new version, you must exit from FxFoto before installing the update.  We recommend that you update to the latest version if needed to receive recent improvements and corrections if you have not recently downloaded your copy directly from our www.FxFoto.com web site.

See also:

About FxFoto
About FxFoto

This dialog documents the FxFoto model and version number and provides important copyright and trademark information.  The Triscape FxFoto application and all associated software, data and documentation are Copyright ( by Triscape Inc. and all rights are reserved.  Triscape, FxFoto and Portable Pictures are trademarks of Triscape Inc.
Even though the FxFoto Standard Edition is described as “free”, this means that a copy is licensed to you without charge and that you must abide by all applicable terms in the license agreement.  See License.txt in the installation directory or www.FxFoto.com.

FxFoto requires Windows 98 or better and a Pentium PC or equivalent with at least 256 MB of memory and a display size of at least 800x600 pixels.  A Pentium II or better (or a Pentium I with MMX) is recommended and at least 512 MB of memory is also recommended.  At least 16-bit display color quality is recommended.
Credits

FxFoto was created and programmed by Steven C. Simonoff.
This software uses ZLib routines created by Jean-loup Gailly and Mark Adler.
This software is also based in part on the work of the Independent JPEG Group.
PNG image support is based in part on the PNG Reference Library provided by Group 42, Inc. and contributing authors.  See www.libpng.com.

TIFF support is based in part on software copyright 1988-1997 by Sam Leffler and copyright 1991-1997 by Silicon Graphics, Inc.  Permission to use, copy, modify, distribute, and sell the TIFF support software and its documentation for any purpose was granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.
MPEG support is based in part on software created by Robert Tibljas and Zeljko Nikolic.
Flash support is based in part on software created by Stuart MacKay and Flagstone Software Ltd., which retains copyright to the Transform SWF library.
PDF support is based in part on software created by UtilityWarrior.

Downloadable setup software employs 7-Zip compression, copyright by Igor Pavlov and distributed under the GNU Lesser General Public License.  See www.7-Zip.org.

Some themes and frames use images provided by Clip Art, Inc.  See www.ClipArtInc.com.

The scrapbooking kits included with some editions of FxFoto contain artwork created and copyright by selected designers.  Unless otherwise noted, the scrapbooking graphics are licensed to FxFoto users for non-commercial home use only.  
Scrapbooking Kit Designer Credits:
Creative CD
Kim Hill (www.CGEssentials.com)

Miriam Lima (www.LimaBeanDesigns.com)

Katie Mann (www.ScrapOutsideTheBox.com)

Gina Miller (www.GinaMillerDesigns.com)

Corina Nielsen (www.FunkyPlaygroundDesigns.com)

Donna Pelletier (www.ScrapOutsideTheBox.com)

Sherrie Piegdon (www.PixelGypsyDesigns.com)

Dianne Rigdon (www.ShabbyElements.com)

Angela Sharrow (www.ScrapDish.com)

Christine Smith (www.TheDigiChick.com)

Recipes Project CD
Roberta D'Achille (www.renderedmemories.com)

Jeanine Baechtold (www.scrapbook-bytes.com, www.scrapdish.com)
Jennifer Caputo (www.thedigishoppe.com)

Tamara Dantes (www.addictedtodigital.com)

Kim Hill (www.cgessentials.com)

Elizabeth Lane (elane999@gmail.com)

Katie Mann (www.scrapoutsidethebox.com)

Janice Dye-Szucs, aka Maya (www.scrapbookgraphics.com)

Lorraine Yuriar (katsskraps.yuriar.com)

Susan White created extra templates included with the scrapbooking graphics library.

Additional Skin Image Frames and Accents included with some editions of FxFoto contain artwork created by Anne Shelton from the Anne Shelton's Graphic Collection and copyright by Artecy Cross Stitch (www.artecy.com).  These extra frames are for home use and have names beginning with xtAS. 
See also:

FxFoto Support
FxFoto Portable Pictures
FxFoto Portable Pictures

The Portable Pictures initial dialog appears when you start a special version of FxFoto designed to reside on special U3 compatible removable flash disks (sometimes called key drives).  FxFoto Portable Pictures (tm) allows you to keep FxFoto and your photographs on a small portable device.
Just plug into any Windows XP or other compatible PC to instantly use FxFoto along with all of your portable pictures without reinstalling on each new computer.

Starting and Exiting FxFoto Portable Pictures

Plug in the U3 device on any computer with Windows XP or better and the U3 Launchpad automatically appears after a few seconds on the bottom right Windows tray area.  Click the U3 icon and choose FxFoto Portable Pictures from the U3 Launchpad menu.
This version of FxFoto requires an FxFoto Portable Pictures registration.  If required, enter the User Name and Registration Number purchased online at www.FxFoto.com.

The first time you start Portable Pictures, it creates a DemoPics folder of a few low-resolution demonstration photos on the device and may spend a little extra time scanning the Documents area of the device for existing folders with photos, which it also shows in the left-pane.  You can use the Remove Whole Folder command for any left-pane photo folders you don’t want shown in Portable Pictures.

The first time you start Portable Pictures on a PC that has not been scanned for photos, it also allows you to scan and view PC photos in the left pane as described below under the Startup Dialog settings.  Scanning a new PC for photo folders can require many extra minutes, depending on the number of PC photos found, and will leave FxFoto’s folder organization on the PC after you unplug the device.

When you exit Portable Pictures, it beeps the computer speakers after it finishes saving your data back to the removable device.  Make sure you properly save your work before pressing the U3 Launchpad’s Eject button.  When you Eject, FxFoto closes immediately and cannot save any changes you may have made to open photos or collages.  You should not unplug the U3 device without first exiting from Portable Pictures and using the U3 Lauchpad Eject.
My Camera Folder
If a compatible digital camera is also connected when FxFoto Portable Pictures starts, the camera’s photos may available in a special My Camera folder inside FxFoto.  FxFoto can only read photos from the My Camera folder and does not let you modify them in place.  You can import or move the My Camera photos to other FxFoto folders to organize and modify them.
As with FxFoto Import, you must have installed your camera’s driver software on the computer and set the camera to its transfer mode if needed before plugging it in.  FxFoto will only recognize compatible cameras which appear as a removable disk with a DCIM directory.  A few cameras use WIA or TWAIN drivers to interface with the computer and FxFoto cannot create the special My Camera folder for these.  However, Portable Pictures can still Import from them.  Also, memory cards from non-DCF cameras can often be removed and plugged into a card reader to provide DCF-compatible photos that FxFoto can show in My Camera.

The My Camera folder appears on a special green background and is always at the top of the left-side folders window in FxFoto.  My Camera cannot be modified.  You can open photos and drag them to other folders.  You can also use Move Picture(s) to copy and or all of them to other folders.  But the original copy remains on your camera and you cannot drag or copy new photos into My Camera and must save modified photos from My Camera to some other folder.
Portable Folders
Your portable on-device photos appear in folders with FxFoto standard light blue background color.  FxFoto normally places your Portable Pictures folders in a Photos directory folder on the removable device, usually off of Documents.
PC Folders

FxFoto keeps your pictures on the removable device, normally inside a special Photos directory.  But FxFoto Portable Pictures can also use photos that reside on the local PC that the device happens to be plugged into.  These PC folders are not portable and are only available on one computer.  They appear on a special light red background that has a red PC symbol.  Various FxFoto commands present drop-down menus of all available folders.  In these menus, the non-portable folders are marked with an extra [PC] after the folder name.  Normal portable folders contained on the removable device appear on a blue background.
You can use the FxFoto Move Picture(s) command to move or copy photos from the portable device to the PC or vice versa.  You can also use Copy Folder To or From PC to copy between the portable device and the local PC.  Note that the red PC folders appear as normal blue folders without the PC icon if you start the non-portable version of FxFoto installed on the computer.
You can use the Show Portable Folders First Folder command to separate the blue portable folders and the red [PC] folders.  Keep it checked to show the portable device folders first toward the top with all [PC] folders following.  The red and blue folders are sorted chronologically or alphabetically within their color group.  Uncheck to show all folders mingled together.

The Portable Pictures Startup Dialog

When you first start Portable Pictures, a light blue dialog appears first before you see the larger FxFoto application window.  The volume name and drive letter of the removable disk device to be used appears at the top of the dialog.
If FxFoto has found a compatible digital camera plugged into the computer, Include My Camera folder of photos on your camera is enabled.  Uncheck this to stop FxFoto from finding the camera’s photos and building the special green My Camera folder.

If FxFoto has never scanned for photos on the local PC, Scan for photos on this PC appears as the next checkbox.  Uncheck it to stop FxFoto from scanning the PC’s photos into special red PC folders, which can take a significant amount of time.  If PC photos have already been scanned, then Show previously scanned photos on this PC appears instead as the next checkbox.  Uncheck this to skip showing the red PC folders in FxFoto.  However, unless this is checked, you will not be able to copy or move pictures between the removable device and the PC.
Press Continue to start FxFoto Portable Pictures.  Press Cancel to exit FxFoto immediately without changing any of the settings.
See also:

Portable Pictures Folder Placment
Portable Pictures Folder Placement

This dialog appears when you choose a target folder for various FxFoto Portable Pictures commands.  Because Portable Pictures can handle folders both on the removable device and on the local PC, this dialog allows you to choose the desired placement for the selected folder.  There are three choices but only one or two are normally available, depending on the situation.

If you have chosen an existing folder, the first choice is either Add to existing Portable Device folder or Add to existing PC folder, depending on where the folder exists.  The chosen existing folder name appears on the next line.  This choice is disabled if your chosen name does not match any of the previously created FxFoto folders.

Check Create new Portable Device folder to start a new folder on the Portable Pictures removable device or disk.  The new folder name to be created appears on the next line.  This choice is disabled if the chosen folder name already exists on the removable device.
Check Create new PC folder to start a new folder on the PC rather than on the portable device.  The new folder name to be created appears on the next line.  This choice is disabled if the chosen folder name already exists on the PC or if you did not choose to see PC folders when you started Portable Pictures.
Note that FxFoto always maintains unique folder names.  If you already have a folder with a given name, then FxFoto must change the name slightly to make a unique new folder name.
After selecting the desired placement, press OK to continue.  Press Cancel to return to the previous dialog and select a different target folder name.
See also:

FxFoto Portable Pictures
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